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Lage und Funktion der Teile

Informationen zur Verwendung und Funktion der einzelnen Komponenten finden Sie auf der angegebenen Seite.

Hauptgerat

1
12
5
1. Biigel fiir Schulterriemen (11) 7. Mikrofonfixierbiigel
2. Taste ASSIGN7/DIRECT MENU (47) 8. Mikrofonhalter (42)
3. N (N-Markierung) 9. GPS-Antenne
« Halten Sie zum Herstellen einer 10. Multi-Interface-Schuh (vorn)

Funkverbindung zwischen Camcorder und
Smartphone ein NFC-kompatibles
Smartphone nahe an diese Markierung.
Niheres dazu finden Sie in der
Bedienungsanleitung zum Smartphone.

* NFC (Near Field Communication) ist ein
internationaler Standard fiir
Funkkommunikation iiber kurze Distanz.

4. Taste ASSIGNS/FOCUS MAG
5. Schalter ZOOM (unten) (34)
6. Multi-Interface-Schuh (hinten)
S Multi
7 interface Shoe

Nihere Hinweise zu dem Zubehor, das an den
Multi-Interface-Schuh angeschlossen werden
kann, erhalten Sie bei der zustdndigen
Handelsvertretung.

¢ Verwenden Sie kein Zubehor mit dufieren
Schrauben. Diese konnen den Multi-Interface-
Schuh beschidigen.

11.
12.

¢ Verwenden Sie kein Zubehor mit duBeren
Schrauben. Diese konnen den Multi-Interface-
Schuh beschidigen.

Motorzoomhebel (34)
WLAN-Antenne
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1. Internes Mikrofon (41)

2. Aufnahme-/Tally-Anzeige (vorn) (151)
Leuchtet bei der Aufnahme.
Blinkt wenn die verbleibende Speicherkapazitit
auf dem Aufzeichnungsmedium oder die
Batterie zur Neige gehen.

. Taste ASSIGN6

. Taste FULL AUTO (33)

. Schalter ND FILTER

. ND FILTER-Modusschalter

. Taste ASSIGN3/VIDEO SIGNAL
MONITOR

8. Taste ASSIGN1/ZEBRA
9. Taste ASSIGN2/PEAKING
10. Schalter INPUT1 (41)
11. Schalter CH1 (INT/EXT/MI SHOE) (41)
12. Regler AUDIO LEVEL (CH1) (41)
13. Regler AUDIO LEVEL (CH3)
14. Regler AUDIO LEVEL (CH4)
15. Regler AUDIO LEVEL (CH2)
16. Schalter CH2 (INT/EXT/MI SHOE)
17. Schalter INPUT2 (41)
18. Taste ASSIGN5
19. Schalter SHUTTER
20. Taste ASSIGN4/ONLINE
21. ND-Steuerregler
22. Taste WB SET
23. Gegenlichtblende mit Objektivschutz (25)
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Taste BATT RELEASE (23)
Befestigung fiir Akkusatz (23)
Multi/Micro USB-Anschluss (103)
USB3.0 (HOST)-Anschluss (Typ A)

. Anschluss SDI OUT (100)
. Regler fiir Dioptrien-Einstellung (26)
. Schalter ON/STANDBY (24)

I: ON
&: STANDBY

. Ein-/Aus-Anzeige
. USB2.0 (HOST)-Anschluss (Typ A) (69)
. Schalter IN/OUT (Eingangs-/

Ausgangswahl)

Luftauslass

« Die Bereiche um den Luftauslass konnen heif3
werden.
* Decken Sie den Luftauslass nicht ab.

Zoomhebel am Griff (35)

Aufnahmetaste am Griff

‘Wenn der Hebel auf die Position HOLD
eingestellt ist, funktioniert die Aufnahmetaste
am Griff nicht.

Anschluss AUDIO INPUT1 (41)
Anschluss AUDIO INPUT2 (41)
Kabelhalter

Hier konnen Sie ein Mikrofonkabel o. A.
fixieren.

Griffband
Wahlschalter (Tasten 4/%/«/%/SET)
Aufnahmetaste (33)

78 91011

20.

21.

22.

23.
24.
25.
26.
27.

12 13
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Lufteinlass

¢ Decken Sie den Lufteinlass nicht ab.

Anschluss REMOTE

Der Anschluss REMOTE dient zum Steuern
von Aufnahmestart/-stopp und anderen
Funktionen auf dem Videogerit und den daran
angeschlossenen Peripheriegeriten.

Kabelschelle

¢ Nur zum Sichern von Kabeln verwenden.
Anschluss GENLOCK IN/VIDEO OUT
Anschluss fiir verkabeltes LAN
Anschluss TC IN/OUT

Anschluss HDMI OUT (100)

UTILITY SD/MS-Einschub/
Zugriffsanzeige

Fiir die Proxy-Aufnahme sowie zum Speichern
und Laden von Einstellungen (File-Funktion)
und fiir Upgrades (Softwareaktualisierung).
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. Zoomring (35)

* Nachdem Sie den Schalter ON/STANDBY in die
Position ON gestellt haben, bewegen Sie den
Ring nicht, bis der Initialisierungsvorgang des
Objektivs abgeschlossen wurde. Andernfalls wird
die ordnungsgeméBe Fokussierung verhindert.

. Fokussierring (35)
. Schalter Full MF (35)

Sie konnen den manuellen Fokusmodus ein-/
ausschalten, indem Sie den Fokussierring vor-/
zuriickbewegen.

. Hebel fiir den Objektivdeckel (25)

Zum Offnen/SchlieBen des Objektivdeckels.
Schalter MACRO (36)

Schalter FOCUS (35)

Biigel fiir Schulterriemen

Taste STEADY SHOT (43)
Blendenring (37)

Schalter IRIS (37)

Buchse {) (Kopfhorer)

Fiir Kopfhorer mit Stereoministecker.
Aufnahme-/Tally-Anzeige (hinten) (151)
Leuchtet bei der Aufnahme.

Blinkt wenn die verbleibende Speicherkapazitit
auf dem Aufzeichnungsmedium oder die
Batterie zur Neige gehen.

Taste SLOT SELECT
Einschub/Zugriffsanzeige fiir SxS-
Speicherkarte A (27)

Einschub/Zugriffsanzeige fiir SxS-
Speicherkarte B (27)

16.

17.
18.
19.
20.

21.
22.
23.
24.
25.

14 15

Taste EJECT

Die Taste EJECT springt auf Driicken heraus.
Erneut driicken, um eine Karte
herauszunehmen.

* Wird wihrend der Aufzeichnung die Taste
EJECT gedriickt, stoppt die Aufzeichnung.

Anschluss DC IN
Taste CANCEL/BACK (108)
Regler SEL/SET (108)

Taste MENU (108)

An der Taste befindet sich ein fiihlbarer
Streifen, damit sie leichter gefunden werden
kann.

Schalter WHT BAL (40)

Schalter GAIN (38)

Taste ASSIGN10/IRIS PUSH AUTO
Taste ASSIGN9

Taste FOCUS PUSH AUTO (36)

So bringen Sie einen Schulterriemen an
Bringen Sie einen Schulterriemen an den Biigeln
fiir den Schulterriemen an.
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THUMBNAIL  F [V _PLAY/|'AUSE FIWD LCD_PRIGHT

O 0 6 6

VOLUME
5_ @ DURATION
MENU CANCEL  TC/U-BIT

NS P ©

19 18 17

. Taste THUMBNALIL (92)

. Taste STOP (93)

. Taste STATUS CHECK (17)
. Taste PREV (93)

. Tasten #/¥/«/+/SET (108)

. Taste MENU (108)

. Taste F REV (93)

. Taste PLAY/PAUSE (93)

. Taste F FWD (93)

Taste NEXT (93)

Taste LCD BRIGHT (26)
Taste DISPLAY (13)
LCD-Bildschirm (26)
Sucher (26)

GroBe Augenmuschel
Lufteinlass

« Decken Sie den Lufteinlass nicht ab.
Tasten VOLUME (36)

Taste DURATION/TC/U-BIT (43)
Taste CANCEL (108)

1. Offnungen fiir Stativgewinde (1/4 Zoll,
3/8 Zoll)
Kompatibel mit 1/4-20UNC-Schrauben und mit
3/8-16UNC-Schrauben.
Bringen Sie hier ein Stativ an (optional
erhiltlich, Lange der Schraube maximal
5,5 mm).



Bildschirmanzeige

LCD-/Sucherbildschirm

Wiihrend der Aufnahme, im Aufnahmebereitschaftsmodus und bei der Wiedergabe werden
Statusinformationen und Einstellungen des Camcorders auf dem LCD-/Sucherbildschirm eingeblendet.
Die Informationen konnen iiber die Taste DISPLAY ein- bzw. ausgeblendet werden.

Die Informationen konnen auch einzeln ein- und ausgeblendet werden (Seite 128).

Bildschirminformationen wéahrend der Aufnahme

1 2 3 456789

166 min

10 ’ 36
i =

13 :

14 —{[Recc STOP)

15—

16

17— 6Emn
948min Clip Name 012846676501254667680125455 28

(Cow ND Clean)
AF5.6) (L=

19 20 212223 24

25 26 27

. Anzeige des Netzwerkstatus (Seite 15)
Hier wird der Status der Netzwerkverbindung
als Symbol angezeigt.

. Hochladeanzeige/Anzahl zu
iibertragender Dateien

. Anzeige des Aufnahmemodus/
Betriebsstatus fiir Einschub A/B

ORec Aufzeichnung liuft

Stby Aufnahmebereitschaft

. Schirfentiefenanzeige

. Intercom-Anzeige (Seite 16)
Zeigt den Status der Intercom-Verbindung als
Symbol an.

. Statusanzeige fiir Netzwerk-Client-Modus
(Seite 16)
Statusanzeige fiir Streaming (Seite 16)
Statusanzeige fiir RTMP/RTMPS-
Streaming (Seite 16)

. Funksignalstirkeanzeige der digitalen
UWP-Einheit (Seite 16)

Zeigt bei Verwendung eines digital
angeschlossenen drahtlosen Audioempfingers
die Funksignalstirke mithilfe von Symbolen an.

8. Anzeige der Bildfrequenz fiir

Aufzeichnung mit Zeitlupe/Zeitraffer

9. Anzeige der verbleibenden

Akkukapazitiat/DC IN-Spannung

10. Anzeige fiir den Fokussiermodus

(Seite 44)
Full ME-Modus Bull ME
MF-Modus MEBE
AF-Modus AB
Gesichtserkennung-AF (AF/ @// %/[1)
Symbol ©

,.Gesichtserkennung*
Symbol ,,Face Only AF*  Qply

Symbol ,,Registriertes )
Gesicht*
Symbol ,,Face Only AF m

«a)

Autofokus angehalten




1.

12.
13.

14.

15.
16.

17.

18.

19.
. Anzeige fiir den ND-Filter (Seite 38)
21.
22.
23.
24,
25.

20

26.
21.

a) Wird angezeigt, wenn kein Gesicht registriert
und keine Gesichter erkannt wurden und wenn
ein Gesicht registriert, aber nicht erkannt wurde.

* Der numerische Wert fiir die Schirfentiefe ist ein
Anhaltswert.

Anzeige der Zoomposition

Hier wird die Zoomposition im Bereich
zwischen 0 (Weitwinkel) und 99 (Tele)
angezeigt.

Anzeige des GPS-Status

Anzeige fiir den Bildstabilisierungsmodus
(SteadyShot)

Rec Control-Anzeige fiir SDI-Ausgang/
HDMI-Ausgang

Wird angezeigt, wenn sowohl Display On/Off
>SDI/HDMI Rec Control im LCD/VF-Menii

und SDI/HDMI Rec Control >Setting im Video-
Menii auf On gesetzt sind.

Anzeige des Digitales Tele

Anzeige der Fokussierhilfe

* Wird bei Verwendung von Gesichtserkennung-
AF nicht angezeigt.

Anzeige der Restkapazitiit des

Speichermediums
Anzeige des WeiBabgleich-Modus
ATW Automatik
ATW Hold Unterbrechen der Automatik
W:P Voreinstellungsmodus
W:A Memory A-Modus
W:B Memory B-Modus
Timecode-Anzeige (Seite 43)

Anzeige fiir Szenendateien (Seite 154)
Anzeige der Blendenposition
Warnanzeige zum Videopegel

Anzeige des Verstirkungswerts (Seite 38)

Anzeige von Blendenmodus/
Belichtungszeit

Anzeige des AE-Modus/AE-Pegels

Audiopegel-Messer

Zeigt den Audiopegel von CH1 und CH2 oder
CH3 und CH4 an.

Je nach der Einstellung der Option Audio
Output >Monitor CH (Seite 125) im Audio-
Menii wird Folgendes angezeigt.

28.

29.
30.

31.
32.

33.

34.
35.

36.

Einstellung von Angezeigter Kanal

Monitor CH

CHI1/CH2 CH1/CH2
CH3/CH4 CH3/CH4
MIX ALL CHI1/CH2
CHI1 CHI1/CH2
CH2 CHI1/CH2
CH3 CH3/CH4
CH4 CH3/CH4

Der Audiopegel kann auf dem Statusbildschirm
iiberwacht werden.

Anzeige VIDEO SIGNAL MONITOR
(Wellenformmonitor/Vektorskop/
Histogramm)

* Wird nicht angezeigt, wenn Output Format im
Video-Menii auf 3840x2160P gesetzt ist.

 Nicht angezeigt, wenn Output On/Off >SDI im
Video-Menii auf Off gesetzt ist.

Anzeige des Clipnamens

Anzeige des Aufzeichnungsformats
(Codec) (Seite 147)

Hier wird das Format angezeigt, in dem auf eine
SxS-Speicherkarte aufgezeichnet wird.
Anzeige des Gammaassistenten

Anzeige des Gammawerts
Gamma-Anzeigewert im HDR-Modus siche

Seite 117. Gamma-Anzeigewert im SDR-
Modus siehe Seite 119.

Anzeige des Proxy-Status

[F)[r@);gy Proxy-Aufzeichnung ein

P[f@);gy Ree Proxy-Aufzeichnung

P[r@xy Reec Proxy-Aufzeichnung

(blinkt) nicht bereit

PxChunk Proxy-Blockaufzeichnung
ein

PxChunk Reg Proxy-Blockaufzeichnung

PxChunk Ree Proxy-Blockaufzeichnung

(blinkt) nicht bereit

4K- und HD (Sub)-Aufnahmeanzeige

Anzeige von Systemfrequenz und
Abtastverfahren

Anzeige des Aufzeichnungsformats
(BildgroBe) (Seite 147)

Hier wird die Bildgrofe angezeigt, mit der auf
eine SxS-Speicherkarte aufgezeichnet wird.



Auf dem Wiedergabebildschirm angezeigte
Informationen

Wiihrend der Wiedergabe werden folgende
Informationen auf dem Bild eingeblendet:

1 2 3 4 5678910

Tl (5t C

@HG2IG0)

I |
11 12 13 14 15 16

1. Anzeige des Netzwerkstatus

2. Hochladeanzeige/Anzahl zu
iibertragender Dateien

3. Clip-Nummer/Gesamtzahl der Clips

4. Anzeige des Wiedergabemodus

5. Anzeige des Wiedergabeformats
(Bildfrequenz)

6. Intercom-Anzeige

7. Statusanzeige fiir Netzwerk-Client-Modus
Statusanzeige fiir Streaming

Statusanzeige fiir RTMP/RTMPS-
Streaming

8. Anzeige des Wiedergabeformats
(BildgroBe)
9. Anzeige der verbleibenden
Akkukapazitit/DC IN-Spannung
10. Anzeige des Wiedergabeformats (Codec)

11. Mediumanzeige
Links neben einer schreibgeschiitzten
Speicherkarte wird die Markierung (3
angezeigt.

12. Anzeige der Zeitdaten
Die Zeitdaten werden angezeigt, wenn Display
On/Oft >Timecode im LCD/VF-Menii auf On
gesetzt ist und die Taste DISPLAY gedriickt
wird.

13. Anzeige des Clipnamens

14. Anzeige des Gammaassistenten

15. Audiopegel-Messer

16. Anzeige des Gammawerts

Symbole fiir die Netzwerkverbindung

Netzwerkmo- Verbin- Symbol
dus dungsstatus

Zugangspunktmodus Betrieb als A '
Zugangspunkt AP

Fehler beim
Betrieb als
Zugangspunkt

verbunden

AR
Stationsmodus ~ WLAN I’ Ia

1> I
WLAN-

Signalstirke
(4 Stufen)

WLAN getrennt .
(auch wihrend

Einrichtung)
WLAN-
Verbindungsfehler k{
Modem/ 3G/4AG- 3G verbunden

Smartphone Signalstirke
(5 Stufen) S&_Sﬁﬂ]
4G verbunden

- %31

Netzwerkverbin-

dung (3G/4G)

ol o]

3G/4G getrennt
(auch wihrend ‘
Einrichtung)

3G/4G-Verbin-
dungsfehler d

Signalstirke
unbekannt ﬁ
(Stérke wird

vom ange-
schlossenen
Modem/Smart-
phone oder

anderen Gerit

nicht signali-

siert)

Wired LAN LAN verbunden %

LAN getrennt
(auch wihrend *

Einrichtung)

LAN- &

Verbindungsfehler




<Anzeigebeispiel mit zwei angeschlossenen

Modems>

Verbindungsstatus Symbol

Nur Modem1 in Betrieb

il

Nur Modem? in Betrieb

il

Beide in Betrieb

k|

Anzeigesymbole der Intercom-Verhindung

Verbindungsstatus Symbol

* Network Client Mode ist Off
* Network Client Mode ist On
und Headset nicht verbunden

keines

Network Client Mode ist On @
Headset verbunden
Headset-Verbindung wird
unterstiitzt, aber nicht

verbunden (Status
Verbindungsbereitschaft)

Network Client Mode ist On
Headset verbunden

Status Intercom-Verbindung
deaktiviert

1S

Network Client Mode ist On @
Status Anrufbereitschaft,

Headset und Intercom sind
verbunden

=

Anzeigesymbole fiir Netzwerk-Client-Modus

Network— Verbin- Symbol

Network Client dungsstatus

Mode—Setting

Off keines

On Normal N@M
Getrennt

NCM

(Bereitschaft)

Verbindungs-
fehler

NCE

Anzeigesymbole fiir Streaming

Network— Verbin- Symbol
Streaming—  dungsstatus

Setting

Off - keines

Network— Verbin- Symbol
Streaming—  dungsstatus
Setting
On Normal STRM
(Streaming
wird
durchgefiihrt)

Konfiguration -

findet statt
(Ubergang
zum

Streaming)

Ubertragungs-

fehler

Anzeigesymbole fiir RTMP/RTMPS-Streaming

Network— Verbin- Symbol
RTMP/ dungsstatus
RTMPS—
Setting
Off - keines
On Normal
(RTMP-
Streaming
wird
durchgefiihrt)

Konfiguration m -

findet statt
(Ubergang
zum RTMP-
Streaming)

Ubertragungs- RTMP

fehler

Symbole der Funksignalstdrke-Anzeige fiir die
digitale UWP-Einheit

Senderstatus Emp- Symbol
fangssta-
tus
Ausgeschaltet Kein w
Empfang ==
Normaler Empfang w W dj:[l
Sendestatus O~
(4-stufige Signal-
stirkeanzeige)
Stummgeschaltet Empfang
(stummge- %ﬁﬂ:
schaltet)




Senderstatus Emp- Symbol
fangssta-

tus

Warnstatus fiir

Empfang w

verbleibende di=
Akkukapazitit (Symbol blinkt)
Stummgeschaltet/  Empfang

Warnstatus fiir M
verbleibende (Symbol blinkt)
Akkukapazitit

Statushildschirm

Sie konnen die Einstellungen und den Status des
Camcorders auf dem Statusbildschirm

iiberpriifen.

Bedienung des Statushildschirms

So blenden Sie den Statusbildschirm ein:
* Driicken Sie die Taste STATUS CHECK.

So wechseln Sie den Statusbildschirm:
¢ Drehen Sie den Regler SEL/SET oder driicken

Sie die Taste #/¥.

So blenden Sie den Statusbildschirm aus:
 Driicken Sie die Taste STATUS CHECK.

Bildschirm ,,Camera Status“
Hier werden Bildqualitit, Zoom-Einstellungen

und Status angezeigt.

White Switch<B>

Einstellwert des
WeiBabgleich-Speichers B

Bildschirm ,,Audio Status“

Hier werden der Eingangspegel, die
Audiopegelanzeige und der Windfilter fiir die
einzelnen Kanile angezeigt.

CHI Pegelanzeige

CHI Pegelanzeige

CHI Input Source

CHI Eingangsquelle

CHI1 Ref./Level

CH1 Referenzeingangspegel

CHI1 Wind Filter

CHI1 Mikrofon-
Windfiltereinstellung

CH2 Pegelanzeige CH2 Pegelanzeige

CH2 Input Source CH2 Eingangsquelle

CH2 Ref./Level CH2 Referenzeingangspegel
CH2 Wind Filter CH2 Mikrofon-

Windfiltereinstellung

CH3 Pegelanzeige

CH3 Pegelanzeige

CH3 Input Source

CH3 Eingangsquelle

CH3 Ref./Level

CH3 Referenzeingangspegel

CH3 Wind Filter

CH3 Mikrofon-
Windfiltereinstellung

CH4 Pegelanzeige CH4 Pegelanzeige

CH4 Input Source CH4 Eingangsquelle

CH4 Ref./Level CH4 Referenzeingangspegel

CH4 Wind Filter CH4 Mikrofon-
Windfiltereinstellung

HDMI Output CH Audiokanal-
Kombinationseinstellung fiir
HDMI-Ausgang

Analog Output CH Audiokanal-
Kombinationseinstellung fiir
Analogausgang

Monitor CH Monitorkanal

Headphone Out Kopthorer-Ausgabetyp

White Switch<A> Einstellwert des
WeiBabgleich-Speichers A

White Switch<P> Einstellung von Preset White

ND<Preset> Einstellung Preset1 bis 3 fiir
ND Filter

Zebral Einstellung Zebral On/Off
und Pegel

Zebra2 Einstellung Zebra2 On/Off
und Pegel

Gamma Gamma-Kategorie und -

kurve

Gain Switch

Einstellung von Gain<L>,
Gain<M>, Gain<H>

Handle Zoom Speed

Einstellung von Handle
Zoom

Scene File

Aktuelle Szenendatei und
Datei-ID

Bildschirm ,,System Status”
Hier werden die Einstellungen fiir das
Videosignal angezeigt.

Frequency/Scan

Systemfrequenz und
Abtastverfahren

File System

Dateisystem-Einstellung

Codec Codec-Einstellung

Simul Rec 2-Einschiibe-
Simultanaufzeichnung
aktiviert/deaktiviert (,,On*/
,Off)

Title Prefix Titelprifix des Clipnamens

Picture Size

Aufzeichnungsformat
BildgroBe

Rec Function

Aktivierte Aufnahmemodi
und Einstellungen




Clip Continuous Rec

Kontinuierliche
Clipaufnahme aktiviert bzw.
deaktiviert (,,On*/,,Off*)

Picture Cache Rec

Bildpuffer-Funktion aktiviert
bzw. deaktiviert (,,0n‘/,,Off*)
und Einstellung

Number Numerische Endung des
Clipnamens
Shooting Mode Einstellung des

Aufnahmemodus

4K & HD (Sub) Rec

4K- und HD (Sub)-
Aufnahmefunktion aktiviert
bzw. deaktiviert (,On‘/,,Off*)

Proxy Rec Proxy-Aufnahme aktiviert
bzw. deaktiviert (,,On‘?/,,Off*)
und Einstellung

Genlock Genlock-Status

Bildschirm ,Video OQutput Status®
Zeigt die Einstellungen fiir SDI, HDMI und

Videoausgabe an.

SDI

GroBe der Bildausgabe
Rec Control-Status
Ausgabe ein/aus

8 Der Taste ASSIGNS
zugewiesene Funktion

9 Der Taste ASSIGN9
zugewiesene Funktion

10 Der Taste ASSIGN10

zugewiesene Funktion

Bildschirm ,,Battery Status“
Zeigt Informationen zum Akku und zur
Stromanschluss an DC IN an.

Detected Battery Akkutyp

Remaining Verbleibende Kapazitit (%)
Charge Count Anzahl der Ladevorginge
Capacity Verbleibende Kapazitit (Ah)
Voltage Spannung (V)

Manufacture Date Fertigungsdatum des Akkus

Video Light Remaining Restladung des Akkus fiir die
Videoleuchte
Power Source Stromquelle

Supplied Voltage Spannung der

angeschlossenen Stromquelle

Bildschirm ,Media Status®
Hier werden der restliche Speicherplatz, die

HDMI GroBe der Bildausgabe . .
Rec Control-Status verfiigbare Aufnahmedauer und die geschitzte
Ausgabe ein/aus Lebensdauer des Aufnahmemediums (SxS-
VIDEO GroBe der Bildausgabe Speicherkarte A/SxS-Speicherkarte B) sowie der
Ausgabe ein/aus UTILITY-Speicherkarte angezeigt.
Gamma Gammawert Informationen zu Zeigt ein Mediensymbol an,
Color Gamut Farbraumeinstellung Speichermedium A wenn sich in Einschub A ein

Gamma Display Assist

Einstellung des Gamma-
Anzeigeassistenten

Bildschirm ,Assignable Button Status*”
Hier werden die Funktionen angezeigt, die den
belegbaren Tasten zugewiesen sind.

Aufzeichnungsmedium
befindet.
Schutz von Zeigt ein Schloss-Symbol an,
Speichermedium A wenn das

Aufzeichnungsmedium in
Einschub A geschiitzt ist.

Restkapazititsanzeige  Zeigt die Restkapazitiit des

1 Der Taste ASSIGNI fiir Speichermedium A Aufzeichnungsmediums in
zugewiesene Funktion Einschub A in Form eines
2 Der Taste ASSIGN2 Prozentsatzes oder Balkens
zugewiesene Funktion an.
3 Der Taste ASSIGN3 Restaufnahmezeit auf ~ Zeigt die unter den aktuellen
zugewiesene Funktion Speichermedium A Aufnahmebedingungen
4 Der Taste ASSIGN4 geschiitzte Restaufnahmezeit
zugewiesene Funktion des Aufzeichnungsmediums
5 Der Taste ASSIGNS in Einschub A in Minuten an.
zugewiesene Funktion Restliche Service- Zeigt die restliche Service-
1 ¥
6 Der Taste ASSIGNG Lebénsdauer yon Leb‘ensd'auer in Prozent (%)
. . Speichermedium A des in Einschub A
zugewiesene Funktion . .
eingesetzten Mediums an,
7 Der Taste ASSIGN7

zugewiesene Funktion

wenn das Medium Daten zur
restlichen Lebensdauer
erfasst




Informationen zu
Speichermedium B

Zeigt ein Mediensymbol an,
wenn sich in Einschub B ein
Aufzeichnungsmedium
befindet.

Handle Rec Button

Hier wird der Zieleinschub
fiir Aufnahme mittels der
Aufnahmetaste am Griff
angezeigt.

Schutz von
Speichermedium B

Zeigt ein Schloss-Symbol an,
wenn das
Aufzeichnungsmedium in
Einschub B geschiitzt ist.

Restkapazititsanzeige
fiir Speichermedium B

Zeigt die Restkapazitit des
Aufzeichnungsmediums in
Einschub B in Form eines
Prozentsatzes oder Balkens
an.

Restaufnahmezeit auf
Speichermedium B

Zeigt die unter den aktuellen
Aufnahmebedingungen

geschitzte Restaufnahmezeit
des Aufzeichnungsmediums

in Einschub B in Minuten an.

Restliche Service-
Lebensdauer von
Speichermedium B

Zeigt die restliche Service-
Lebensdauer in Prozent (%)
des in Einschub B
eingesetzten Mediums an,
wenn das Medium Daten zur
restlichen Lebensdauer
erfasst

Information iiber das
UTILITY-Medium

Zeigt das Mediensymbol an,
wenn im UTILITY SD/MS-
Einschub ein Medium
eingesetzt ist.

Schutz des UTILITY-
Mediums

Zeigt ein Schloss-Symbol an,
wenn das Medium im
UTILITY SD/MS-Einschub
geschiitzt ist.

Restkapazititsanzeige
des UTILITY-Mediums

Zeigt die Restkapazitit des

Mediums im UTILITY SD/
MS-Einschub in Form eines
Prozentsatzes oder Balkens
an.

Restkapazitit des
UTILITY-Mediums

Zeigt die geschiitzte
Restaufnahmezeit des
Aufzeichnungsmediums im
UTILITY SD/MS-Einschub
in Minuten an. Alternativ
wird die verbleibende
Kapazitit in GB angezeigt.

Bildschirm ,Rec Button Settings Status*
Hier wird der Einstellstatus der Aufnahmetaste
und der Aufnahmetaste am Griff angezeigt.

Rec Button

Hier wird der Zieleinschub
fiir Aufnahme mittels der
Aufnahmetaste angezeigt.

Bildschirm ,,GPS Status“
Hier werden der GPS-Positionierungsstatus und
Informationen angezeigt.

GPS

GPS-
Signalpositionierungsstatus

Dilution of Precision

Genauigkeit der

Positionsdaten
Latitude Breitengrad
Longitude Léangengrad
Altitude Hohe

Positioning date and
time

Datum und Uhrzeit der
Positionierung

Current date and time

Aktuelle Zeit und aktuelles
Datum

Time Zone

Zeitzoneneinstellung

Bildschirm ,Network Status*
Hier wird der Status der Netzwerkverbindung

angezeigt.

Wireless LAN

WLAN:-Einstellungen,
Verbindungsstatus

Wired LAN

Einstellungen des
kabelgebundenen Netzwerks,
Verbindungsstatus

Modem1

WLAN:-Einstellungen, Status
von Modem/Smartphone-
Verbindung

Modem?2

WLAN:-Einstellungen, Status
von Modem/Smartphone-
Verbindung

Wireless LAN-Einstellungen

Setting- Status- Beschreibung

Anzeige Anzeige

Off - WLAN-
Einstellung ist
deaktiviert.

Access Point Non Active Kein Betrieb als

Mode Zugangspunkt.
‘Wird bei Fehler an
WLAN-Modul
angezeigt.

Active Betrieb als

Zugangspunkt.




Setting- Status- Beschreibung Setting- Status- Beschreibung
Anzeige Anzeige Anzeige Anzeige
Station Mode ~ Non Active Kein Betrieb im On Disconnected ~ Nicht mit einem
Stationsmodus. Netzwerk
Wird bei Fehler an verbunden.
WLAN-ModuI Connected Mit einem
angezeigt. Netzwerk
Searching Verbindungsauf- verbunden.
bau zum zuletzt Connecting Verbindungsauf-
verbundenen Netz- bau zu einem Netz-
werk wird versucht werk wird
(Zugangspunkt). versucht.
Disconnected ~ Nicht mit einem No Modem Modem-Dongle ist
Netzwerk nicht eingesteckt
verbunden oder Smartphone
(Zugangspunkt). ist nicht
Wird auch angeschlossen
angezeigt, wenn
f}f‘/&ﬂcp keine Bildschirm ,NCM/Streaming Status®
~Adresse Zeigt den Verbindungsstatus und Streaming-
zugewiesen wurde. R i
. Status im Netzwerk-Client-Modus an.
<SSID> Verbunden mitdem
Netzwerk <SSID> Network Mode Status ~ Verbindungsstatus der
(Zugangspunkt). Netzwerkfunktion
(Netzwerk-Client-Modus,
Wired LAN-Einstellungen Streaming, RTMP/RTMPS-
Streaming)
Settll}g- Stat“'s' Beschreibung CCM Name Name von verbundenem
Anzeige Anzeige CCM im Netzwerk-Client-
Off - Wired LAN- Modus
Einstéll}mg ist CCM Address Adresse von verbundenem
deaktiviert. CCM im Netzwerk-Client-
On Disconnected ~ Vom Netzwerk Modus
getrennt. QoS Streamingl Bit  Streaming-Bitrate |
Wird auch Rate
angezeigl, weﬁn QoS Streaming? Bit Streaming-Bitrate 2
per DHCP keine
Rate
IP-Adresse
Zugewiesen wurde. Streaming Status Streaming-Status
Connected Mit einem Streaming Format Streaming-
Netzwerk Formatinformationen
verbunden. Streaming Type Art der gegenwirtig

Modem1- und Modem2-Einstellungen

Setting- Status- Beschreibung

Anzeige Anzeige

Off - Modem-/
Smartphone-
Einstellung ist
deaktiviert.
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ausgewihlten Streaming-
Einstellung

Streaming Destination

Address

Streaming-Zieladresse

Streaming Audio
Channel

Der Streaming-Ausgabe zu
iiberlagernder Audiokanal

¢ CHI1/CH2 (fest eingestellt)
wihrend RTMP/RTMPS-
Streaming.




Network Mode Status-Einstellungen
Anzeige fiir Netzwerk-Client-Modus und RTMP/
RTMPS-Streaming

Status-Anzeige
Off

Beschreibung

Netzwerk-Client-Modus und
RTMP/RTMPS-Streaming
sind deaktiviert.

CCM: Connected Netzwerk-Client-Modus ist
aktiviert, CCM ist verbunden
und Steuerung von CCM aus

ist aktiviert.

Verbindungsaufbau mit CCM
wird versucht.

Falls der Status nicht von
,,CCM: Connecting*
wechselt, ist ggf. die CCM-
Adresseinstellung
fehlerhaft. Stellen Sie
sicher, dass die Adresse
korrekt angegeben wurde.

CCM: Connecting

CCM: Dest-Addr. Error Host-Name oder IP-Adresse
des zu verbindenden CCM ist

ggf. fehlerhaft.

CCM: Auth. Failed Der zum Verbinden mit dem
CCM verwendete
Benutzername oder das

Passwort ist ggf. fehlerhaft.

CCM: No Network
Access

Verbindung mit einem
Netzwerk kann nicht im
Netzwerk-Client-Modus
hergestellt werden.

Priifen Sie den
Netzwerkverbindungsstatus
und die Einstellungen.

Das CCM-Zertifikat ist
ungiiltig.

Die Datum- und
Zeiteinstellungen des
Netzwerks sind ggf.
fehlerhaft.

CCM: Cert. has Expired Der Giiltigkeitszeitraum des
CCM-Zertifikats ist
abgelaufen.

Die Datum- und
Zeiteinstellungen des
Netzwerks sind ggf.
fehlerhaft.

CCM: Cert. Not Valid
Yet

Status-Anzeige

Beschreibung

CCM: Root Cert. Error

Das CCM-Stammzertifikatist
ungiiltig.

Falls diese Fehlermeldung
angezeigt wird, wenden Sie
sich an den Sony-
Kundendienst.

CCM: Inter. Cert. Error

Das CCM-Zwischenzertifikat
ist ungiiltig.

Falls diese Fehlermeldung
angezeigt wird, wenden Sie
sich an den Sony-
Kundendienst.

CCM: Server Cert.
Error

Das CCM-Serverzertifikat ist
ungiiltig.

Falls diese Fehlermeldung
angezeigt wird, wenden Sie
sich an den Sony-
Kundendienst.

RTMP: Connected

Verbunden mit RTMP-Server
und RTMP/RTMPS-
Streaming aktiviert.

RTMP: Connecting

Verbindungsaufbau zu einem
RTMP-Server wird versucht.

Falls der Status nicht von
,RTMP: Connecting*
wechselt, ist ggf. die
Adresseinstellung fiir den
RTMP-Server fehlerhaft.
Stellen Sie sicher, dass die
Adresse korrekt angegeben
wurde.

RTMP: Dest. Addr.
Error

Host-Name oder IP-Adresse
des zu verbindenden RTMP-
Servers ist ggf. fehlerhaft.

RTMP: No Network
Access

Verbindung mit einem
Netzwerk kann nicht mittels
RTMP-Streaming hergestellt
werden.

Priifen Sie den
Netzwerkverbindungsstatus
und die Einstellungen.

RTMP: Server Cert.
Error

Das Serverzertifikat fiir die
RTMP-Streaming-
Verbindung ist ungiiltig.
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Streaming Status-Anzeige

Status-Anzeige

Beschreibung

Off

Streaming ist deaktiviert.

Distributing

Streaming wird durchgefiihrt.

Preparing

Vorbereitung auf Streaming.

Destination Address
Error

Host-Name oder IP-Adresse
des Streaming-Ziels ist ggf.
fehlerhaft.

No Network Access

Verbindung mit einem
Netzwerk kann nicht
hergestellt werden.

Priifen Sie den
Netzwerkverbindungsstatus
und die Einstellungen.

Bildschirm ,File Transfer Status“
Hier werden Informationen zur Dateiiibertragung

angezeigt.

Auto Upload

On/Off-Status der Auto
Upload-Funktion

Auto Upload (Proxy)

On/Off/Chunk-Status der
Auto Upload (Proxy)-
Funktion

Total Transfer Progress

Fortschritt aller
Ubertragungen

Default Upload Server

Name des Zielservers fiir das
automatische Hochladen von
Dateien und das Hochladen
von Dateien iiber die
Miniaturansicht

Job Status(Remain/
Total)

Anzahl verbleibender
Ubertragungen und
Gesamtanzahl Ubertragungen

Current File Transfer
Progress

Ubertragungsfortschritt der
Datei, die gegenwiirtig
hochgeladen wird.

Current Transferring
File Name

Name der Datei, die
gegenwirtig hochgeladen
wird.

Server Address

Adresse des
Dateiiibertragungsservers

Destination Directory

Zielverzeichnis des
Dateilibertragungsservers
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Vorbereitung

Stromversorgung

Der Camcorder kann mit einem Akku oder mit
einem Netzteil iiber das Stromnetz versorgt
werden.

Wenn ein Netzteil angeschlossen ist, erfolgt die
Stromversorgung dariiber, selbst wenn ein Akku
angebracht ist.

Verwenden Sie zur Sicherheit nur Akkus und
Netzteile von Sony, die unten aufgelistet sind.

Lithium-lonen-Akkusétze

Serie BP-U*

* Mit diesem Gerit wird der BP-U35 mitgeliefert.
Netzteile/Ladegerdte

BC-U1A (mitgeliefert)

BC-U2A

Akkus diirfen keinesfalls iibermiBiger
Wirmeeinwirkung ausgesetzt werden, wie z. B.
Sonneneinstrahlung, Feuer o. &.

* Bei Betrieb iiber das Stromnetz ist das mitgelieferte
Netzteil zu verwenden.

Verwenden eines Akkus

So setzen Sie den Akku ein: Schieben Sie den
Akku bis zum Anschlag in den Einschub

(Seite 10), und schieben Sie ihn dann nach unten,
bis er einrastet.

Halten Sie zum Entnehmen des Akkus die Taste
BATT RELEASE (Seite 10) gedriickt, schieben
Sie den Akku nach oben, und nehmen Sie ihn
dann aus dem Einschub.

Laden Sie den Akku vor der Verwendung mit dem
Ladegeriit BC-U1A (mitgeliefert) oder dem Ladegerit
BC-U2A.

¢ Ein erwiarmter Akku (direkt nach dem Gebrauch) ldsst
sich moglicherweise nicht vollstiandig aufladen.

Der BP-U35 kann nicht gleichzeitig mit einem
Modem/Smartphone verwendet werden. Zur
Stromversorgung beim Einsatz eines Modems/
Smartphones verwenden Sie den Akku BP-U60,
BP-U60T oder BP-U90.

Der Akku BP-U90 mit hoher Kapazitit ist gro und
ragt aus dem Camcorder heraus, wenn er angebracht
ist. Der BP-U90 eignet sich besonders bei
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Verwendung des Camcorders fiir lingere
Aufnahmezeiten auf einem Stativ.

Uberpriifen der Restkapazitit

Wenn die Aufnahme oder Wiedergabe iiber den
Akku erfolgt, werden ein Symbol fiir die aktuelle
Akkuladung und die restliche Nutzungsdauer auf
dem LCD-/Sucherbildschirm angezeigt

Verbleibende Kapazitit
100% bis 91%

90% bis 71%

70% bis 51%

50% bis 31%

30% bis 11%

10% bis 0%

Die vom Camcorder in Minuten angezeigte
Restnutzungsdauer ist ein errechneter Wert und
basiert auf der Annahme, dass der Akkubetrieb
mit der aktuellen Leistungsaufnahme fortgesetzt
wird.

Wenn die Akkuladung abnimmt

Wenn die Akkuladung wihrend des Betriebs
unter einen bestimmten Grenzwert fillt (Low
Battery-Zustand), wird eine Meldung angezeigt,
die Aufnahme-/Tally-Anzeige beginnt zu
blinken, und es ertont ein Warnton.

Wenn die Akkuladung auf einen Wert fillt, bei
dem der Betrieb nicht fortgesetzt werden kann
(Battery Empty-Zustand), wird eine
entsprechende Meldung angezeigt.

Der Akku muss dann durch einen aufgeladenen
Akku ersetzt werden.

Andern der Grenzwerte fiir Warnmeldungen

Der Wert fiir Low Battery liegt standardmiaBig bei
10% der vollen Akkuladung, und der Wert fiir
Battery Empty liegt bei 3%. Diese
Warneinstellungen konnen mit Battery Alarm
(Seite 152) im System-Menii gedndert werden.



Verwendung von Wechselstrom

Beim Anschluss des Camcorders an das
Stromnetz brauchen Sie sich keine Gedanken
dariiber zu machen, den Akku aufzuladen.
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Anschluss
DCIN

é Netzteilstecker

1 SchlieBen Sie das Netzkabel an das Netzteil an.

2 SchlieBen Sie das Netzteil an den Anschluss DC IN
am Camcorder an.

3 SchlieBen Sie das Netzkabel an eine Netzsteckdose
an.

Netzteile

« Netzteile diirfen nicht auf engem Raum
angeschlossen werden, etwa zwischen einer
Wand und einem Maobelstiick.

» Falls wihrend des Betriebs ein Problem auftritt,
das Netzkabel sofort aus der Steckdose ziehen.

 Schlieen Sie den Stecker des Netzteils nicht
mit einem Metallgegenstand kurz, da es sonst
zu einer Fehlfunktion kommt.

* Sie konnen den Camcorder nicht laden, indem
Sie ihn an das Netzteil anschlieBen.
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Ein-/Ausschalten des Camcorders

Stellen Sie den Schalter ON/STANDBY

(Seite 10) zum Einschalten in die Position ON (I).
Stellen Sie den Schalter ON/STANDBY zum
Ausschalten in die Position STANDBY (().

* Auch wenn sich der Schalter ON/STANDBY in der
Position STANDBY befindet, nimmt das Gerét
weiterhin Strom auf. Entfernen Sie den Akku, wenn
Sie den Camcorder lidngere Zeit nicht verwenden.

* Entfernen Sie den Akku oder trennen Sie die
Spannungsversorgung iiber DC IN, nachdem die Ein-/
Aus-Anzeige erloschen ist, wenn der Netzschalter in
die Position STANDBY gestellt wurde. Wenn die
Stromversorgung getrennt wird, wihrend sich der
Schalter in der Stellung ON befindet, kénnen
Fehlfunktionen des Camcorders oder der
Speicherkarten auftreten.



Einstellen der Uhr

Wenn Sie den Camcorder zum ersten Mal
einschalten, nachdem Sie ihn neu gekauft haben,
oder sich die Pufferbatterie vollig entladen hat,
erscheint die Anzeige mit Anfangseinstellungen
auf dem Sucher- und dem LCD-Bildschirm.

In diesem Bildschirm konnen das Datum und die
Uhrzeit der internen Uhr eingestellt werden.

Time Zone

Der Wert gibt den Zeitunterschied zur UTC
(Coordinated Universal Time) an. Wihlen Sie
hier die gewiinschte Einstellung.

Einstellen von Datum und Uhrzeit

Bewegen Sie den Cursor mithilfe der Tasten #/%/
«/% (Seite 10) oder dem Regler SEL/SET

(Seite 11), und driicken Sie die Taste SET oder
den Regler SEL/SET, um das jeweilige Element
festzulegen.

Bewegen Sie den Cursor dann auf [Finish], und
driicken Sie die Taste SET oder den Regler SEL/
SET, um den Einstellungsbildschirm zu schlieen
und die Einstellung der Uhr abzuschlieBen.

Sobald der Einstellungsbildschirm geschlossen
ist, konnen Sie mit Clock Set (Seite 152) im
System-Menii die Einstellungen fiir Datum,
Uhrzeit und Zeitzone éndern.

* Wenn die Uhrzeit verloren geht, weil sich die
Pufferbatterie nach lingerer Trennung vom Stromnetz
(kein Akku und keine Stromversorgung iiber DC IN)
nach komplett entladen hat, wird der Bildschirm
,Initial Settings* beim néchsten Einschalten des
Camcorders angezeigt.

Wihrend der Bildschirm ,Initial Settings* angezeigt
wird, kann aufler dem Ausschalten des Camcorders
kein anderer Vorgang ausgefiihrt werden, bis die
Einstellungen in diesem Bildschirm abgeschlossen
sind.

Falls Sie den Camcorder etwa drei Monate lang nicht
verwenden, entlddt sich der eingebaute Akku.
Daraufhin gehen die Datums- und Zeiteinstellungen
aus dem Speicher verloren. Laden Sie in diesem Fall
den Akku auf, und stellen Sie dann Datum und Uhrzeit
wieder ein (Seite 162).
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AnschlieBen von
Geraten

Anbringen der Gegenlichtblende

Taste PUSH (Entriegelung der Gegenlichtblende)

Richten Sie die Markierungen an der
Gegenlichtblende und am Camcorder
aneinander aus und drehen Sie die
Gegenlichtblende in Pfeilrichtung (@, bis sie
einrastet.

Entfernen der Gegenlichtblende

Halten Sie die Taste PUSH (Entriegelung der
Gegenlichtblende) gedriickt und drehen Sie die
Gegenlichtblende entgegen der in der Abbildung
gezeigten Pfeilrichtung.

¢ Nehmen Sie die Gegenlichtblende zum Anbringen/
Abnehmen eines Polarisationsfilters oder Schutzfilters
mit ¢77 mm ab.

Anbringen der groBen
Augenmuschel

Dehnen Sie die grole Augenmuschel leicht und
passen Sie sie iiber die Nut am Sucher ein.

GroBBe Augenmuschel
(mitgeliefert)



Einstellen der
Bildschirme

Einstellen des LCD-Bildschirms

Klappen Sie den LCD-Bildschirm um 180 Grad
auf () und drehen Sie ihn in den fiir die
Aufnahme oder Wiedergabe optimalen Winkel

@).

@ Um 180 Grad
aufklappen /
/

@ 90 Grad
(max.)

D

® 180 Grad
(max.) =2

Der Winkel kann so angepasst werden, dass der
Sucher auf das Motiv ausgerichtet ist. Das Bild
wird auf dem LCD-Bildschirm spiegelverkehrt

angezeigt, jedoch normal aufgenommen.

Einstellen der Hintergrundbeleuchtung

Schalten Sie die Helligkeit der
Hintergrundbeleuchtung mithilfe der Taste LCD
BRIGHT (Seite 12).

Anpassen der Helligkeit

Passen Sie die Helligkeit mithilfe von LCD
Setting >Brightness (Seite 126) im LCD/VF-
Menii an. Anderungen der Helligkeit wirken sich
nicht auf aufgezeichnete Bilder aus.

Einstellen des Suchers

Bei Verwendung des Suchers schauen Sie bei
geschlossenem LCD-Bildschirm durch den
Sucher.

Wenn die Anzeige auf dem Sucherbildschirm
nicht scharf ist, passen Sie diese mit dem
Dioptrienausgleichsregler unter dem Sucher an.
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Regler fur Dioptrien-
Einstellung

Verschieben Sie den
Regler, bis das Bild scharf

Anpassen der Helligkeit

Passen Sie die Helligkeit mithilfe von VF Setting
>Brightness (Seite 126) im LCD/VF-Menii an.

¢ Wenn Sie Ihre Augen vom Sucher entfernen, wechselt
der Bildschirm unter Umsténden voriibergehend zu
Negativfarben, um ein Einbrennen des Bildschirms zu
verhindern. Dies ist keine Fehlfunktion.

Anpassen der Helligkeit von LCD-/
Sucherbildschirm mit frei
belegbharer Taste

Zum Einstellen der Helligkeit des LCD-/
Sucherbildschirms konnen Sie einen Pegelbalken
einblenden, indem Sie zuvor die Funktion LCD/
VF Adjust einer frei belegbaren Taste zuweisen
(Seite 47) und dann diese Taste driicken.

1 Driicken Sie die mit LCD/VF Adjust
belegte Taste, um einen Pegelbalken
zum Einstellen der Helligkeit
einzublenden.

Bei jeder Betitigung der Taste wechselt die
Anzeige zwischen Pegelbalken fiir den LCD-
Bildschirm — Pegelbalken fiir den Sucher
— keine Anzeige.

2 Passen Sie den Pegel mithilfe der Tasten
4/%/«/% oder dem Regler SEL/SET an
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Der Pegelbalken wird ausgeblendet.
Um den Pegelbalken auszublenden, driicken



Sie die mit LCD/VF Adjust belegte Taste
oder nehmen drei Sekunden lang keine
Bedienung vor.
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Verwendung von SxS-
Speicherkarten

Bei diesem Camcorder konnen Audio- und
Videosignale auf in die Karteneinschiibe
eingesetzte SxS-Speicherkarten (gesondert
erhiltlich) aufgezeichnet werden.

Informationen zu SxS-
Speicherkarten

Unterstiitzte Speicherkarten

Verwenden Sie die folgenden SxS-
Speicherkarten von Sony.

Bei anderen Speicherkarten ist der
ordnungsgemifle Betrieb nicht gewihrleistet.

Modellreihe SxS PRO+
Modellreihe SxS PRO
Modellreihe SxS-1

Diese Karten entsprechen dem ExpressCard-
Standard.

Einzelheiten zur Verwendung von SxS-
Speicherkarten und Sicherheitshinweise zur
Verwendung finden Sie in der Bedienungsanleitung
der jeweiligen SxS-Speicherkarte.

Einzelheiten zu Aufnahmemedien und kompatiblen
Formaten siehe Seite 166.

* Verwenden Sie zum Aufzeichnen von XAVC-I
3840x2160P SxS PRO+-Speicherkarten.

* Wenn auf SxS PRO- oder SxS-1-Speicherkarten im
Format XAVC-I oder mit Zeitlupe und Zeitraffer
aufgezeichnet wird, kann auf dem Bildschirm ein
Fehler angezeigt werden, der besagt, dass das Medium
nicht unterstiitzt wird und normale Aufnahme nicht
moglich ist. Die Verwendung von SxS PRO+-
Speicherkarten wird empfohlen.

Einsetzen von SxS-Speicherkarten

1 Offnen Sie die Abdeckung des
Karteneinschubblocks.



2 Schieben Sie die SxS-Speicherkarte mit
der Beschriftung SxS nach rechts
weisend hinein.

Die Zugriffsanzeige (Seite 11) leuchtet
zunéchst rot und wechselt zu griin, sobald die
Speicherkarte betriebsbereit ist.

3 SchlieBen Sie die Abdeckung.

« Die Speicherkarte, der Speicherkartenbereich und die
Bilddaten auf der Speicherkarte konnen beschidigt
werden, wenn die Karte falsch herum eingesetzt wird.

Entnehmen einer SxS-
Speicherkarte

1 Offnen Sie die Abdeckung des
Karteneinschubblocks und driicken Sie
die Taste EJECT.

Die Taste EJECT springt heraus.
Wiihrend der Aufzeichnung wird diese
dadurch gestoppt.

2 Driicken Sie die Taste EJECT erneut,
um die Karte herauszunehmen.

Die Integritit der Daten auf der Karte kann nicht
garantiert werden, wenn withrend des Zugriffs auf die
Speicherkarte der Camcorder ausgeschaltet oder die
Karte entnommen wird. Moglicherweise gehen alle
Daten auf der Karte verloren. Stellen Sie stets sicher,
dass die Zugriffsanzeige entweder griin leuchtet oder
erloschen ist, bevor Sie den Camcorder ausschalten
oder die Speicherkarte entfernen.

Eine nach dem Aufnehmen aus dem Camcorder
herausgenommene SxS-Speicherkarte kann heif3 sein.
Dies ist keine Fehlfunktion.

Wechseln zwischen SxS-
Speicherkarten

Wenn sich sowohl in Einschub A als auch in
Einschub B eine SxS-Speicherkarte befindet,
konnen Sie durch Driicken der Taste SLOT
SELECT (Seite 11) die zum Aufzeichnen
verwendete Karte auswihlen.

Ist die Speicherkapazitit einer Karte wihrend der
Aufnahme erschopft, wechselt der Camcorder
automatisch zur anderen Karte.
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Die Taste SLOT SELECT ist wihrend der Wiedergabe
deaktiviert. Die Speicherkarten werden in dem Fall
auch durch Driicken der Taste nicht gewechselt. Die
Taste ist aktiviert, wihrend die Miniaturbildanzeige
(Seite 92) angezeigt wird.

Formatieren (Initialisieren) einer
SxS-Speicherkarte

Bei einer nicht oder mit einem anderen Format
formatierten SxS-Speicherkarte erscheint die
Meldung ,,Unsupported File System* auf dem
LCD-/Sucherbildschirm.

Formatieren Sie die Karte wie folgt:

Wi hlen Sie iiber Format Media (Seite 134)
im Media-Menii die Option Media(A)
(Einschub A) oder Media(B) (Einschub B)
und dann Execute aus. Wihlen Sie beim
Anzeigen einer Bestitigungsmeldung
erneut Execute.

Wihrend der Formatierung wird eine Meldung
angezeigt, und die Zugriffsanzeige leuchtet rot.
Nach Abschluss der Formatierung wird eine
Abschlussmeldung angezeigt. Driicken Sie den
Regler SEL/SET, um die Meldung auszublenden.

Die Formatierung schlégt fehl

Eine mit Schreibschutz versehene SxS-
Speicherkarte oder eine Speicherkarte, die fiir
diesen Camcorder nicht geeignet ist, wird nicht
formatiert.

Wenn eine Warnmeldung angezeigt wird,
tauschen Sie die Karte gemiB den Anweisungen
in der Meldung gegen eine geeignete SxS-
Speicherkarte aus.

* Beim Formatieren einer Speicherkarte gehen alle
Daten verloren, einschlieBlich aufgezeichnete
Videodaten und Einstellungsdateien.

Uberpriifen der verbleibenden
Aufzeichnungszeit

Wihrend der Aufnahme (oder im
Aufnahmebereitschaftsmodus) wird der restliche
Speicherplatz auf den in die Karteneinschiibe
eingesetzten SxS-Speicherkarten als Status/
restlicher Speicherplatz des Mediums in
Einschub A/B auf dem LCD-/Sucherbildschirm
angezeigt (Seite 13).



Die verbleibende Aufnahmezeit errechnet sich
aus der Restkapazitit auf den Medien in den
beiden Einschiiben und dem aktuellen
Videoformat (Aufzeichnungs-Bitrate) und wird
in Minuten angezeigt.

Bei einer schreibgeschiitzten Speicherkarte wird das
Symbol @ angezeigt. Falls der Schreibschutzschalter
betitigt wird, wihrend die Speicherkarte eingesetzt ist,
wird das Schloss-Symbol nicht angezeigt. Schalten Sie
den Schreibschutzschalter nur bei entnommenen
Speicherkarten um.

Austauschen einer SxS-Speicherkarte

* Wenn die verfiigbare Aufnahmedauer auf
beiden Karten zusammen auf unter 5 Minuten
sinkt, wird die Warnmeldung ,,Media Near
Full* angezeigt, die Aufnahme-/Tally-Anzeige
blinkt und ein Signalton wird an die Kopfhorer
ausgegeben.

Ersetzen Sie die Medien durch Speicherkarten
mit ausreichend freiem Speicherplatz.

Wenn Sie die Aufnahme fortsetzen, bis die
restliche Aufnahmedauer auf null sinkt, wird
stattdessen die Meldung ,,Media Full*
angezeigt und die Aufnahme stoppt.

« Auf einer SxS-Speicherkarte konnen bis zu ca. 600
Clips gespeichert werden.
Falls die Anzahl aufgezeichneter Clips den Grenzwert
erreicht, wird eine Anzeige eingeblendet, die dariiber
informiert, dass die Hochstanzahl Clips erreicht
wurde.

Wiederherstellen einer SxS-
Speicherkarte

Falls an einer Speicherkarte ein Fehler auftritt,
muss sie vor erneutem Gebrauch
wiederhergestellt werden.

Wenn Sie eine SxS-Speicherkarte laden, die
wiederhergestellt werden muss, wird auf dem
LCD-/Sucherbildschirm eine Abfrage angezeigt,
ob Sie sie wiederherstellen mochten.

* Im FAT-Modus beschriebene SxS-Speicherkarten
konnen nicht wiederhergestellt werden.
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Wiederherstellen einer Karte

Wiihlen Sie Execute mithilfe der Tasten 4/
¥/«/» oder dem Regler SEL/SET aus und
driicken Sie die Taste SET oder den Regler
SEL/SET.

Wiihrend der Formatierung werden eine Meldung
und ein Fortschrittsstatus (%) angezeigt, und die
Zugriffsanzeige leuchtet rot.

Wenn die Wiederherstellung beendet ist, wird
eine Abschlussmeldung angezeigt.

Wenn die Wiederherstellung fehlschlagt

* Mit Schreibschutz versehene SxS-

Speicherkarten und Speicherkarten, an denen

ein Speicherfehler aufgetreten ist, konnen nicht

wiederhergestellt werden. Bei derartigen

Karten wird eine Warnmeldung angezeigt.

Gehen Sie nach den Anweisungen der Meldung

vor und entfernen Sie den Schreibschutz der

Karte oder tauschen Sie sie gegen eine andere

aus.

SxS-Speicherkarten, an denen Speicherfehler

aufgetreten sind, konnen durch wiederholte

Formatierung ggf. wieder funktionsfihig

werden.

In einigen Fillen konnen einige Clips

wiederhergestellt werden, andere ggf. jedoch

nicht. Die wiederhergestellten Clips konnen
normal wiedergegeben werden.

Falls auch nach wiederholten

Wiederherstellungsversuchen die Meldung

,,Could not Restore Some Clips* angezeigt

wird, kann die SxS-Speicherkarte ggf. wie

nachfolgend beschrieben wiederhergestellt
werden.

1 Verwenden Sie die Kopierfunktion (Seite 96) des
Camcorders, um die erforderlichen Clips auf eine
andere SxS-Speicherkarte zu kopieren.

2 Formatieren Sie die unbrauchbare SxS-
Speicherkarte im Camcorder.

3 Kopieren Sie die Clips zuriick auf die soeben
formatierte SxS-Speicherkarte.

* Verwenden Sie zur Wiederherstellung von Medien,
die mit diesem Camcorder aufgezeichnet wurden, auf
jeden Fall diesen Camcorder.

Medien, die mit einem anderen als diesem Camcorder
oder mit einem Camcorder mit einer anderen Version
aufgezeichnet wurden (auch wenn es das gleiche
Modell ist), konnen mit diesem Camcorder nicht
wiederhergestellt werden.

Clips, die kiirzer als zwei Sekunden sind, konnen nicht
wiederhergestellt werden.



Verwendung anderer
Medien

XQD-Speicherkarten

Mithilfe eines optionalen Medienadapters QDA-
EX1 konnen Sie anstelle der SxS-Speicherkarte
eine XQD-Speicherkarte in den Einschub fiir
SxS-Speicherkarten einsetzen und zur Aufnahme
bzw. Wiedergabe verwenden.

Kompatible XQD-Karten
XQD-Speicherkarten der Serie G
XQD-Speicherkarten der Serie S (EB Stream)

Einzelheiten zum Verwenden eines Medienadapters
QODA-EX] finden Sie in der dazu mitgelieferten
Bedienungsanleitung.

Einzelheiten zu Aufnahmemedien und kompatiblen
Formaten siehe Seite 166.

Mit einer XQD-Speicherkarte ist eine einwandfreie
Hochgeschwindigkeitswiedergabe (Seite 93) eventuell
nicht moglich.

Wenn in Formaten hoher Bildfrequenz wie z. B.
XAVC-I oder 3840x2160P aufgezeichnet wird, kann
auf dem Bildschirm ein Fehler angezeigt werden, der
besagt, dass das Medium nicht unterstiitzt wird und
normale Aufnahme nicht moglich ist. Die
Verwendung von SxS PRO+-Speicherkarten wird
empfohlen.

Der einwandfreie Betrieb dieses Camcorders kann
nicht fiir alle XQD-Speicherkarten garantiert werden.
Wenden Sie sich fiir Informationen iiber kompatible
Speicherkarten an Ihren Héndler.

Formatieren (Initialisieren)

XQD-Speicherkarten miissen bei der ersten
Verwendung im Camcorder zunédchst formatiert
werden.

XQD-Speicherkarten, die in diesem Camcorder
verwendet werden, miissen mit der
Formatierungsfunktion des Camcorders
formatiert werden. AuBlerdem muss eine XQD-
Speicherkarte dann formatiert werden, wenn
beim Einsetzen der XQD-Speicherkarte eine
entsprechende Meldung erscheint.

Falls eine XQD-Speicherkarte eingesetzt wird,
die mit einem anderen, von diesem Camcorder
nicht unterstiitzten Format formatiert wurde,
erscheint die Meldung ,,Unsupported File
System* auf dem LCD-/Sucherbildschirm.
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Formatieren Sie das Medium wie nachfolgend
beschrieben.

Formatieren

Wiihlen Sie iiber Format Media (Seite 134)
im Media-Menii die Option Media(A)
(Einschub A) oder Media(B) (Einschub B)
und dann Execute aus.

Wihrend der Formatierung wird eine Meldung
angezeigt, und die Zugriffsanzeige leuchtet rot.
Wenn die Formatierung beendet ist, wird eine
Abschlussmeldung angezeigt.

* Beim Formatieren einer XQD-Speicherkarte gehen
alle Daten auf der Karte verloren, einschlieBlich
geschiitzter Videos. Die Daten konnen nicht
wiederhergestellt werden.

Verwenden eines im Camcorder formatierten

Mediums im Einschub eines anderen Geréts

Erstellen Sie ein Backup des Mediums und

formatieren Sie es dann mit dem anderen Geriit.

SD-Karten

Mithilfe eines optionalen Medienadapters
MEAD-SDO02 konnen Sie anstelle der SxS-
Speicherkarte eine SD-Karte in den Einschub fiir
SxS-Speicherkarten einsetzen und zur Aufnahme
bzw. Wiedergabe verwenden.

Einzelheiten zum Verwenden eines Medienadapters
MEAD-SDO2 finden Sie in der dazu mitgelieferten
Bedienungsanleitung.

Einzelheiten zu Aufnahmemedien und kompatiblen
Formaten siehe Seite 166.

* Mit einer SD-Karte ist eine einwandfreie
Hochgeschwindigkeitswiedergabe (Seite 93) eventuell
nicht moglich.

SDXC-Karten (nur exFAT)
(Geschwindigkeitsklasse: Klasse 10)

* Nicht unterstiitzt in anderen Modi als dem exFAT-
Modus.

Verwenden Sie SDXC-Karten nicht gleichzeitig
zusammen mit anderen Speicherkarten. Falls
gleichzeitig unterschiedliche Medien verwendet
werden, kann der Camcorder nicht zwischen den
Karten wechseln, wenn ein Medium voll wird.
Wenn im Format XAVC-I oder mit Zeitlupe und
Zeitraffer (Seite 51) aufgezeichnet wird, kann je nach
verwendeten SDXC-Karten auf dem Bildschirm eine
Warnung angezeigt werden, die besagt, dass das



Medium nicht unterstiitzt wird und normale Aufnahme
nicht méglich ist. Die Verwendung von SxS PRO+-
Speicherkarten wird empfohlen.

Mit Camcordern der Serien PMW und PXW
aufgenommene SDXC-Karten werden je nach dem
Camcorder-Modell moglicherweise nicht unterstiitzt.
Einzelheiten dazu erhalten Sie bei Ihrem Sony-
Hindler oder einem Sony-Kundendienstmitarbeiter.

SDHC-Karten (nur FAT)
(Geschwindigkeitsklasse: Klasse 10)

¢ Nicht in den Modi exFAT und UDF unterstiitzt.

Formatieren (Initialisieren)

SD-Karten miissen bei der ersten Verwendung im
Camcorder zunidchst formatiert werden.
SD-Karten, die im Camcorder verwendet werden
sollen, sind mit der Formatierfunktion des
Camcorders zu formatieren.

Wenn beim Einsetzen einer SD-Karte in den
Camcorder eine Meldung angezeigt wird, muss
die SD-Karte formatiert werden.

Falls eine SD-Speicherkarte eingesetzt wird, die
mit einem anderen, von diesem Camcorder nicht
unterstiitzten Format formatiert wurde, erscheint
die Meldung ,,Unsupported File System* auf dem
LCD-/Sucherbildschirm.

Formatieren Sie das Medium wie nachfolgend
beschrieben.

Formatieren

Wiihlen Sie iiber Format Media (Seite 134)
im Media-Menii die Option Media(A)
(Einschub A) oder Media(B) (Einschub B)
und dann Execute aus.

Wiihrend der Formatierung wird eine Meldung
angezeigt, und die Zugriffsanzeige leuchtet rot.
Wenn die Formatierung beendet ist, wird eine
Abschlussmeldung angezeigt.

¢ Beim Formatieren einer SD-Karte gehen alle Daten auf
der Karte verloren, einschlieBlich geschiitzter Videos.
Die Daten konnen nicht wiederhergestellt werden.
Verwenden eines im Camcorder formatierten
Mediums im Einschub eines anderen Geréts
Erstellen Sie ein Backup des Mediums und
formatieren Sie es dann mit dem anderen Gerit.
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Wiederherstellen einer SD-Karte

Falls an einer SD-Karte ein Fehler auftritt, muss
sie vor erneutem Gebrauch wiederhergestellt
werden.

Wenn Sie eine SD-Karte laden, die
wiederhergestellt werden muss, wird auf dem
LCD-/Sucherbildschirm eine Abfrage angezeigt,
ob Sie sie wiederherstellen mochten.

« SD-Karten, die in den folgenden Formaten und Codecs
beschrieben wurden, konnen nicht wiederhergestellt
werden.

— Dateisystem exFAT und Codec XAVC-1
— Dateisystem exFAT und Codec DVCAM
— Dateisystem FAT und Codec MPEG HD420

Wiederherstellen einer Karte

Wiihlen Sie Execute mithilfe der Tasten 4/
¥/«/» oder dem Regler SEL/SET aus und
driicken Sie die Taste SET oder den Regler
SEL/SET.

Wihrend der Formatierung werden eine Meldung
und ein Fortschrittsstatus (%) angezeigt, und die
Zugriffsanzeige leuchtet rot.

Wenn die Wiederherstellung beendet ist, wird
eine Abschlussmeldung angezeigt.

Wenn die Wiederherstellung fehlschlagt

* Mit Schreibschutz versehene SD-Karten und
SD-Karten, an denen ein Speicherfehler
aufgetreten ist, konnen nicht wiederhergestellt
werden. Bei derartigen SD-Karten wird eine
Warnmeldung angezeigt. Gehen Sie nach den
Anweisungen der Meldung vor und entfernen
Sie den Schreibschutz der Karte oder tauschen
Sie sie gegen eine andere aus.

SD-Karten, an denen Speicherfehler
aufgetreten sind, konnen durch wiederholte
Formatierung ggf. wieder funktionsfihig
werden.

In einigen Fillen konnen einige Clips
wiederhergestellt werden, andere ggf. jedoch
nicht. Die wiederhergestellten Clips konnen
normal wiedergegeben werden.

Falls auch nach wiederholten
Wiederherstellungsversuchen die Meldung
,,Could not Restore Some Clips* angezeigt
wird, kann die Speicherkarte ggf. wie
nachfolgend beschrieben wiederhergestellt
werden.



1) Verwenden Sie die Kopierfunktion (Seite 96) des
Camcorders, um die erforderlichen Clips auf eine
andere Speicherkarte zu kopieren.

2) Formatieren Sie die unbrauchbare Speicherkarte
im Camcorder.

3) Kopieren Sie die Clips zuriick auf die soeben
formatierte Speicherkarte.

« Verwenden Sie zur Wiederherstellung von Medien,
die mit diesem Camcorder aufgezeichnet wurden, auf
jeden Fall diesen Camcorder.

Medien, die mit einem anderen als diesem Camcorder
oder mit einem Camcorder mit einer anderen Version
aufgezeichnet wurden (auch wenn es das gleiche
Modell ist), konnen mit diesem Camcorder nicht
wiederhergestellt werden.

Clips mit einer Dauer von unter einer Minute sind
moglicherweise nicht wiederherstellbar.

Festlegen des Passworts
zur Authentifizierung des
Netzwerkzugriffs

Legen Sie zur Authentifizierung des
Netzwerkzugriffs fiir die Netzwerkfunktionen
des Camcorders stets ein Passwort fest. Wenn
kein Passwort festgelegt wird, konnen Sie die
Netzwerkfunktionen nicht verwenden.

Legen Sie das Passwort mithilfe von Access
Authentication >Password im Network-Menti
fest.

Das Feld Password ist leer, wenn die
Netzwerkfunktionen erstmals verwendet werden.

 Aus Sicherheitsgriinden wird empfohlen, ein Passwort
mit einer ausreichend langen, fiir andere schwer zu
erratenden Zeichenkette zu setzen und sicher
aufzubewahren.
Um die folgenden Einstellmentioptionen festlegen
bzw. ausfiihren zu kénnen, miissen Sie ein Passwort
festlegen. Falls Sie kein Passwort festlegen, werden
die Mentioptionen als deaktiviert angezeigt. Falls Sie
eine deaktivierte Mentioption auswihlen, wird drei
Sekunden lang die Meldung ,,Set the "Password" of
"Access Authentication".* angezeigt.
— Thumbnail-Menii — Transfer Clip
— Thumbnail-Menii — Transfer Clip (Proxy)
— File-Menii — All File — Load Network Data
— Network-Menii — Wireless LAN
* AuBerdem: System-Menii — Assignable Button
— NFC
— Network-Menii — AP Mode Settings
— Network-Menii — ST Mode Settings
— Network-Menii — Wired LAN
— Network-Menii — Modem
— Network-Menii — RTMP/RTMPS
* AuBlerdem: System-Menii — Assignable Button
— RTMP/RTMPS
— Network-Menii — Network Client Mode
* AuBlerdem: System-Menii — Assignable Button
— Network Client Mode
— System-Menii — Assignable Button — Intercom
Level
* Wenn Sie kein Passwort festlegen, konnen Sie die
Intercom-Funktion nicht verwenden.



Aufzeichnung

Basis-Funktionen

Aufzeichnung

Der grundlegende Aufnahmebetrieb lduft
folgendermaflen ab.

1 Vergewissern Sie sich, dass die
benétigten Gerite am Camcorder
angebracht sind und mit Strom
versorgt werden.

2 Setzen Sie die Speicherkarte(n) ein.
Wenn Sie zwei SxS-Speicherkarten in die
Einschiibe A und B einsetzen, wird die
Aufnahme automatisch auf der zweiten Karte
fortgesetzt, wenn die Speicherkapazitit der
ersten Karte erschopft ist.

3 Stellen Sie den Schalter ON/STANDBY
auf ON.

Der Aufnahmebildschirm wird auf dem
LCD-/Sucherbildschirm angezeigt.

4 Driicken Sie die Aufnahmetaste am

seitlichen Griff oder am Griff (Seite 10).

Die Aufnahme-/Tally-Anzeige leuchtet und
die Aufnahme beginnt.

9 Umdie Aufzeichnung anzuhalten,

driicken Sie wieder die Aufnahmetaste.

Die Aufnahme wird angehalten, und der
Camcorder wechselt in den
Bereitschaftsmodus (STBY).

Aufzeichnung (Full Auto-Modus)

Driicken Sie die Taste FULL AUTO. Die
Tastenanzeige leuchtet auf.

Der Full Auto-Modus und Auto Exposure

(Seite 114) werden aktiviert, und Auto ND Filter,
Auto Iris, AGC (Auto Gain Control), Auto
Shutter und ATW (Auto Tracing White Balance)
werden auf On gesetzt. Anschlieend werden die
Helligkeit und der WeiBabgleich automatisch
eingestellt.

Wenn Sie diese Einstellungen manuell
vornehmen wollen, schalten Sie die
Vollautomatik aus.
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Deaktivieren der Ein/Aus-Schaltfunktion
der Taste FULL AUTO
(Tastenhaltefunktion)

Diese Funktion verhindert das Ein- bzw.
Ausschalten des Vollautomatikmodus auch bei
Betitigung der Taste FULL AUTO. Auf diese
Weise konnen Sie das versehentliche Ein- bzw.
Ausschalten des Modus vermeiden.

1 Wiihlen Sie im Menii ,,System* die
Option Switch Hold Setting >FULL
AUTO Button.

2  Setzen Sie FULL AUTO Button auf
Hold(On).
Die Ein/Aus-Schaltfunktion der Taste FULL
AUTO wird deaktiviert. Wenn in diesem
Zustand die Taste FULL AUTO gedriickt
wird, erscheint die Meldung ,.Key Held* auf
dem Bildschirm und der
Vollautomatikmodus wird nicht ein- bzw.
ausgeschaltet.
Um diese Funktion aufzuheben, setzen Sie
die Option FULL AUTO Button auf Off.

Kontinuierliches Aufzeichnen auf den
Speicherkarten (Relay Rec)

Wenn sich sowohl in Einschub A als auch in
Einschub B eine Speicherkarte befindet, wechselt
die Aufzeichnung, kurz bevor die erste Karte
komplett voll ist, automatisch zur zweiten Karte.
Sie konnen die kontinuierliche Aufzeichnung
fortsetzen, indem Sie zwischen den
Speicherkarten umschalten und eine volle durch
eine neue Speicherkarte ersetzen.

* Speicherkarten nicht wihrend der Aufzeichnung
auswerfen. Nehmen Sie nur die Speicherkarte aus dem
Einschub heraus, dessen Zugriffsanzeige wihrend der
Aufnahme nicht leuchtet.

* Wenn die Restdauer der Speicherkarte, auf die
aufgezeichnet wird, weniger als 1 Minute betréigt und
eine bespielbare Speicherkarte in den anderen
Einschub eingesetzt ist, wird die Meldung ,,Will
Switch Slots Soon‘ angezeigt. Sobald der
Speicherkarteneinschub gewechselt wurde, wird die
Nachricht ausgeblendet.



Die automatische Aufnahmefortsetzung funktioniert
moglicherweise nicht, wenn die Restdauer der
Speicherkarte beim Aufnahmestart weniger als 1
Minute betridgt. Damit die automatische
Aufnahmefortsetzung einwandfrei funktioniert, stellen
Sie sicher, dass die Restdauer der Speicherkarte mehr
als 1 Minute betrigt.

Videos, bei denen wihrend der Aufzeichnung ein
Speicherkartenwechsel stattgefunden hat, konnen

nicht nahtlos vom Camcorder wiedergegeben werden.

Zum Verbinden von Videos, die auf mehrere
Speicherkarten verteilt aufgenommen wurden, kann
das Anwendungsprogramm ,,Content Browser*
verwendet werden. Uberpriifen Sie vor der
Verwendung die Betriebsumgebung fiir Content
Browser.

Verwenden Sie fiir die automatische
Aufzeichnungsfortsetzung mit SD-Karten desselben

Typs.

Informationen zu Clips

Clip (Aufnahmedaten)

Wenn Sie die Aufzeichnung anhalten, werden
die Video-, Audio- und Zusatzdaten vom
Anfang bis zum Ende der Aufzeichnung als
einzelner Clip auf der SxS-Speicherkarte
gespeichert.

Clipnamen

Jedem mit dem Camcorder aufgenommenen
Clip wird gemifl dem Benennungsmodus, der
mit Clip Naming (Seite 135) im Media-Menii
festgelegt wurde, ein Clipname zugewiesen.

Maximale Clipldnge

Die maximale Dauer eines Clips variiert je
nach Aufnahmeformat.

Die maximale Dauer einer kontinuierlichen
Aufnahme ist gleich der maximalen Dauer
eines Clips. Falls die Aufnahmedauer die
maximale Dauer eines Clips tiberschreitet, wird
automatisch ein neuer Clip erstellt und die
Aufnahme wird fortgesetzt. Der neue Clip wird
in der Miniaturbildanzeige als separater Clip
angezeigt.

Einzelheiten zur maximalen Aufnahmedauer
eines Clips beim jeweiligen Aufnahmeformat
finden Sie unter ,, Maximale Aufnahmedauer
fiir einen Clip“ (Seite 167).

Ldschen eines Clips

Sie konnen den zuletzt aufgenommenen Clip
mithilfe der Funktion Last Clip Delete 16schen
(Seite 150). Um alle oder bestimmte Clips zu
16schen, fiihren Sie den Vorgang in de
Miniaturbildanzeige (Seite 97) durch.

Einstellen des Zooms

be

Verwenden des Motorzoomhebels

1. Stellen Sie den Schalter ZOOM [D] in die
Position SERVO.

2. Driicken Sie zum Zoomen den
Motorzoomhebel [C].
Driicken Sie den Motorzoomhebel fiir
einen langsamen Zoom nur leicht. Fiir einen
schnelleren Zoom driicken Sie den Hebel
ganz durch.

Totale: Weitwinkel
Il
Wr—mT ‘§
O

Nahaufnahme: Tele

¥

G

* Der fiir die Fokussierung erforderliche
Mindestabstand zwischen Camcorder und
Motiv liegt im Weitwinkelbereich bei etwa
5 cm und im Telebereich bei etwa 80 cm.

* Bei bestimmten Zoompositionen ist eine
Fokussierung eventuell nicht moglich, wenn
sich das Motiv innerhalb von 80 cm Abstand
vom Camcorder befindet.

* Lassen Sie den Finger auf dem
Motorzoomhebel [C]. Wenn Sie den Finger
vom Motorzoomhebel nehmen, wird das
Betriebsgeriusch des Motorzoomhebels
moglicherweise mit aufgezeichnet.



Verwenden des Zoom am Griff

1. Stellen Sie fiir die Bedienung des Zoom-
Bedienelements am Griff ,,Low®, ,,High*
oder ,,Variable*“ unter Handle Zoom
(Seite 116) >Setting im Camera-Menii ein.
« Bei Einstellung von ,,Variable* konnen Sie

mit je nach Stérke des Drucks auf den
Schalter variabler Geschwindigkeit ein-
und auszoomen.

« Bei Einstellung von ,,Low* oder ,,High*
konnen Sie unabhingig von der Stirke des
Drucks auf den Schalter mit fester
Geschwindigkeit ein- und auszoomen. Sie
konnen mithilfe von Handle Zoom im
Camera-Menii die Geschwindigkeit auf
,,Low* oder ,,High* einstellen.

 Indem Sie einer frei belegbaren Taste
(Seite 47) die Funktion Handle Zoom
>Setting zuweisen, konnen Sie die
Funktion des Zoom-Bedienelements am
Griff durch Driicken dieser Taste
umschalten.

2. Driicken Sie zum Ein- und Auszoomen den
Zoomhebel am Griff [A].

 Sie kénnen den Zoomhebel am Griff |A| nicht
verwenden, wenn die Zoom-Bedienung am Griff auf
OFF gestellt ist.

* Wenn die Zoomgeschwindigkeit auf einen niedrigen
Wert eingestellt wird, tritt ggf. ungleichméfiges
Zoomen auf.

Verwenden des Zoomrings

1. Stellen Sie den Schalter ZOOM [D] in die
Position MANUAL.

2. Drehen Sie zum Zoomen den Zoomring Bl.
Sie konnen mit der gewiinschten
Geschwindigkeit zoomen, indem Sie den
Zoomring |B] drehen. Auch eine
Feineinstellung ist moglich.

Einstellen des Fokus

Tipps zum Fokussieren

* Verschieben Sie den Motorzoomhebel zum
Einstellen des Fokus in Richtung T
(Telebereich) und dann zum Einstellen des
Zooms fiir die Aufnahme in Richtung W
(Weitwinkelbereich).
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¢ Verschieben Sie bei Nahaufnahmen den
Motorzoomhebel ganz in Richtung W
(Weitwinkelbereich) und stellen dann den
Fokus ein.

AF/MF-
Modus

PE-

>

Full MF-Modus

Sy

H§

Einstellung im Full MF-Modus

Ziehen Sie den Fokussierring |A] zuriick (in
Richtung des Camcorders), um den Full MF-
Modus mit vollstidndig manueller Fokussteuerung
zu aktivieren.

Drehen Sie zum Einstellen des Fokus den
Fokussierring. Priifen Sie dabei das Bild auf dem
LCD-/Sucherbildschirm.

Im Full MF-Modus koénnen Sie sich beim
Einstellen des Fokus an den
Entfernungsmarkierungen auf dem Fokussierring
orientieren. Die Entfernungen der
Bildschirfenebene entsprechen den Positionen
der Entfernungsmarkierungen.

+ Uben Sie beim Drehen des Fokussierrings am Ende
des Drehbereichs keine iibermiBige Kraft aus.

* Im Full MF-Modus funktionieren der Autofokus und
der Autofokus auf Knopfdruck nicht.

* Die Makrofunktion ist unabhéngig von der Stellung
des Schalters MACRO am Objektiv auf OFF gesetzt.

Einstellung im MF-Modus

Im MF-Modus (manueller Fokus) konnen Sie bei
Bedarf auch den Autofokusbetrieb zuschalten.
Schieben Sie den Fokussierring nach vorn (in
Richtung der Gegenlichtblende) und stellen Sie
den Schalter FOCUS auf MANUAL.



Voriibergehende Verwendung des Autofokus
(Autofokus auf Knopfdruck)

Im MF-Modus wird der Autofokus aktiviert,
solange die Taste FOCUS PUSH AUTO [D] am
Objektiv gedriickt wird oder eine mit Push AF/
Push MF belegte belegbare Taste (Seite 47)
gedriickt wird.

Wenn Sie die Taste loslassen, kehrt der Fokus zur
manuellen Fokussierung zuriick.

Diese Funktion ist niitzlich, um den Fokus
wihrend des manuellen Fokusmodus von einem
Motiv auf ein anderes zu verlagern.

Einstellung im AF-Modus

Im AF-Modus (Autofokus) wird der Fokus
automatisch eingestellt.

Schieben Sie den Fokussierring |A| nach vorn und
stellen Sie den Schalter FOCUS auf AUTO.

Voriibergehende Verwendung des manuellen
Fokus (Manueller Fokus auf Knopfdruck)

Im AF-Modus wird der manuelle Fokus aktiviert,
solange die Taste FOCUS PUSH AUTO am
Objektiv gedriickt wird oder eine mit Push AF/
Push MF belegte belegbare Taste (Seite 47)
gedriickt wird.

‘Wenn Sie die Taste loslassen, kehrt der Fokus zur
automatischen Fokussierung zuriick.

* Im Modus Slow & Quick Motion mit einer Bildrate
von 100 oder 120 fps sind die Funktionen Autofokus
und Autofokus auf Knopfdruck nicht verfiigbar.

Verwenden des Makro-Modus

Stellen Sie im MF- oder AF-Modus den Schalter
MACRO auf die Position ON, um den Makro-
Modus zu aktivieren und die Fokussierung in
einem Bereich zu ermdglichen, der den Makro-
Bereich umfasst.

Der Makro-Modus ist im Full MF-Modus
deaktiviert.

Fokussierung mit vergriBerter Ansicht
(Focus Magnifier)

Wenn eine mit Focus Magnifier belegte belegbare
Taste (Seite 47) gedriickt wird, erscheint der
Fokuslupenbildschirm, in dem ein Teil des Bilds
vergrofert dargestellt wird.

Wenn das Aufzeichnungsformat QFHD ist,
wechselt die VergroBSerung bei jedem
Tastendruck zwischen 4x und 8x. Sie konnen die
vergroferte Position mithilfe der Taste 4/¥/«/®
bewegen.

Die Mitte des Bildschirms wird in anderen
Formaten als QFHD mit fester 2x-Vergro3erung
angezeigt.

Driicken Sie die Taste erneut, um zur normalen
Anzeige zuriickzukehren.

Diese Funktion ist hilfreich, um die
Scharfstellung zu tiberpriifen.

¢ Das Bild wird auf dem Bildschirm vergrofBert
angezeigt, aber normal aufgenommen.

Priifen von Audiosignalen
wéahrend der Aufnahme

SchlieBen Sie zum Uberwachen der
aufgezeichneten Audiosignale einen Kopfhorer
an die Kopfhorerbuchse (Stereominibuchse)
(Seite 11) an.

¢ Wihrend der Aufnahme (Aufnahme oder
Aufnahmebereitschaft) ist der eingebaute
Lautsprecher deaktiviert.

Lautstarke zur Priifung von Audiosignalen

einstellen

Verwenden Sie die VOLUME-Tasten (Seite 12).

Kanal zur Priifung von Audiosignalen einstellen
Wiihlen Sie den Kanal mithilfe von Audio Output
(Seite 125) im Audio-Menii aus.



]
Andern von

Grundeinstellungen

Die Grundeinstellungen kénnen anhand der
Videoanwendung oder der
Aufnahmebedingungen geindert werden.

Videoformat

Die zur Auswahl stehenden Formate variieren je
nach exFAT/UDF/FAT-Dateisystem,
Systemfrequenz und Codec-Einstellungen.

Wechseln des exFAT/UDF/FAT-
Dateisystems

Wechseln Sie mithilfe von Rec Format
(Seite 147) >File System im System-Menii.
Nach dem Wechsel startet der Camcorder
automatisch neu.

* Wihrend der Aufnahme oder Wiedergabe ist das
Wechseln zwischen exFAT/UDF/FAT nicht moglich.

Wechseln der Systemfrequenz

Wechseln Sie mithilfe von Rec Format
(Seite 147) >Frequency im System-Menii.
Nach dem Wechsel startet der Camcorder
automatisch neu.

« Wihrend der Aufnahme oder Wiedergabe ist das
Wechseln der Systemfrequenz nicht moglich.

Wechseln des Codecs

Wechseln Sie mithilfe von Rec Format
(Seite 147) >Codec im System-Menti.

* Wihrend der Aufnahme oder Wiedergabe ist das
Wechseln des Codecs nicht moglich.

Format d@ndern

Wechseln Sie mithilfe von Rec Format

(Seite 147) >Video Format im System-Menii.
Die Signale von den Anschliissen SDI OUT und
HDMI OUT werden ebenfalls in dem mit diesem
Menii ausgewihlten Format ausgegeben.
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* Wihrend der Aufnahme oder Wiedergabe ist das
Wechseln des Formats nicht moglich.

Anpassen der Helligkeit

ifcom|

1§68y

Die Helligkeit kann iiber die Wahl der Blende,
Verstirkung, Belichtungszeit sowie iiber das
Anpassen des Lichtpegels iiber ND-Filter
eingestellt werden.

Aufzeichnen mit automatischer Blende

Wenn die Vollautomatik (Seite 33) aktiviert ist
Die Blende wird zwangsldufig auf Automatik
eingestellt.

Wenn die Vollautomatik deaktiviert ist

Stellen Sie den Schalter IRIS in die Position
AUTO. Die Automatik ist eingestellt.

Wenn der Schalter IRIS auf AUTO gestellt ist,
kann die beim Umschalten des Schalters IRIS
AUTO/MANUAL auf MANUAL angewandte
Einstellung im Direktmenii (Seite 44)
konfiguriert werden.

Aufzeichnen mit manueller Blende

Wenn die Vollautomatik deaktiviert ist, stellen
Sie den Schalter IRIS auf MANUAL. Der
manuelle Modus ist eingestellt. Drehen Sie zum
Einstellen der Blende den Blendenring [A].



Voriibergehendes Umschalten zur
Blendenautomatik

Driicken Sie im manuellen Blendenmodus eine
mit Push Auto Iris belegte belegbare Taste, um
die Funktion ,,Blendenautomatik auf
Knopfdruck* zu aktivieren.

Die automatische Blende ist aktiviert, solange die
Taste gedriickt gehalten wird. Lassen Sie die
Taste los, um in den manuellen Blendenmodus zu
wechseln.

Aufzeichnen mit automatischer
Verstarkung (AGC)

Wenn die Vollautomatik (Seite 33) aktiviert ist
Der AGC-Modus (automatische
Verstirkungsregelung) wird zwangsldufig
aktiviert.

Wenn die Vollautomatik deaktiviert ist

Stellen Sie Auto Exposure >AGC (Seite 114) im
Camera-Menii auf On, um den AGC-Modus zu
aktivieren.

Sie konnen AGC auch iiber das Direktmenii
(Seite 44) aktivieren/deaktivieren.

Aufnehmen mit fester Verstarkung

1. Deaktivieren Sie die Vollautomatik.

2. Wenn der Gain-Wert automatisch eingestellt
wird, setzen Sie Auto Exposure >AGC
(Seite 114) im Camera-Menii auf Off.
AGC* wird ausgeblendet.

3. Stellen Sie den Schalter GAIN auf H M
oder L.
Der fiir die ausgewihlte Position des
Schalters GAIN eingestellte
Verstirkungswert erscheint auf dem
Bildschirm.
Sie konnen den Verstirkungswert fiir H/M/L
mithilfe von Gain (Seite 113) im Camera-
Menii einstellen.
Sie konnen den Wert fiir H/M/L auch tiber
das Direktmenii (Seite 44) festlegen.

Aufnehmen mit Verschlussautomatik

Wenn die Vollautomatik (Seite 33) aktiviert ist
Der Verschluss wird zwangsldufig auf Automatik
eingestellt.

Wenn die Vollautomatik deaktiviert ist

Stellen Sie Auto Exposure >Auto Shutter
(Seite 115) im Camera-Menii auf On, um den
Automatikmodus fiir die
Verschlussgeschwindigkeit zu aktivieren.

Sie konnen die Verschlussautomatik aktivieren,
indem Sie im Direktmenii Auto Shutter
auswihlen und auf On setzen.

Aufnehmen mit festem Verschluss

Wenn die Vollautomatik deaktiviert ist und Auto

Exposure >Auto Shutter (Seite 115) im Camera-

Menii auf Off gesetzt ist, stellen Sie den Schalter

SHUTTER in die Position ON, um einen
festen Verschluss mit Modus und

Geschwindigkeit wie unter Shutter (Seite 114)im

Camera-Menii konfiguriert festzulegen.
Wenn der Schalter SHUTTER auf OFF gestellt

ist, entspricht die Verschlusszeit der Bildrate der

Aufnahme.

Einstellen im Camera-Menii

Wiihlen Sie Shutter (Seite 114) im Camera-Menii

aus, und legen Sie den Blendenmodus und die
Belichtungszeit fest.

Einstellung mithilfe des Direktmeniis
Sie konnen den ECS-Modus (Seite 114) und die
Verschlussgeschwindigkeit auch iiber das
Direktmenti (Seite 44) einstellen.

Anpassen des Lichtpegels (ND-Filter)

Wenn die Umgebung zu hell ist, konnen Sie ein
Motiv durch Verwendung des Schalters ND
FILTER [C| mit der geeigneten Helligkeit
aufnehmen.

Der Camcorder verfiigt iiber zwei ND-
Filtermodi. Sie konnen den Modus mit dem
ND FILTER-Modusschalter [D] wechseln.

Voreinstellungsmodus

Stellen Sie den ND FILTER-Modusschalter [D]
auf PRESET und stellen Sie den Schalter ND
FILTER [C] dann folgendermaBen ein.
CLEAR: ND-Filter wird nicht verwendet.

1: Filterdichte wie mit ND Filter >Preset] im
Camera-Menii festgelegt. Die
Standardeinstellung ist 1/4.

2: Filterdichte wie mit ND Filter >Preset2 im
Camera-Menii festgelegt. Die
Standardeinstellung ist 1/16.

38



3: Filterdichte wie mit ND Filter >Preset3 im
Camera-Menii festgelegt. Die
Standardeinstellung ist 1/64.

Sie konnen den Filter auf gleiche Weise wie den
Schalter ND FILTER mithilfe des Direktmeniis
(Seite 44) einstellen.

Variabler Modus

Stellen Sie den ND FILTER-Modusschalter [D]
auf VARIABLE und stellen Sie den Schalter ND
FILTER [C] dann folgendermaBen ein.

CLEAR: ND-Filter wird nicht verwendet.

1, 2, 3: Sie konnen die Filterdichte mit dem ND-
Steuerregler [E] auf einen Wert im
durchgehenden Bereich von 1/4 bis 1/128
einstellen.

Die Position (1/2/3) des Schalters ND FILTER
beeinflusst die Einstellung der Filterdichte
nicht.

Auto ND-Filter

Wenn der ND FILTER-Modusschalter auf
VARIABLE und der Schalter ND FILTER in
Position 1 bis 3 gestellt ist, kann die Dichte des
ND-Filters automatisch angepasst werden, indem
Auto Exposure >Auto ND Filter (Seite 114) im
Camera-Menii auf On gestellt wird.

Sie konnen auch iiber das Direktmenii (Seite 44)
Auto ND Filter aktivieren/deaktivieren und ND
CLEAR einstellen.

Wenn Auto ND Filter deaktiviert ist, konnen Sie
die Dichte des ND-Filters auch im Direktmenti
auswihlen.

Einstellen der automatischen Belichtung

Die automatische Belichtung regelt iiberméBige
Helligkeit mithilfe des automatischen ND-Filters
sowie der Blenden-, Verstarkungs- und
Verschlussfunktionen auf einen geeigneten
Pegel.

Legen Sie mithilfe von Auto Exposure

(Seite 114) >Mode im Camera-Menii den
Steuerungsmodus und mithilfe von Level die
Stufe fest.

Sie konnen den Steuerungsmodus und die
Korrekturstufe auch iiber das Direktmenii
(Seite 44) festlegen.

Flimmer-Reduzierung

Stellen Sie Flicker Reduce (Seite 115) >Mode im
Camera-Menii auf Auto oder On und stellen Sie
unter Frequency die Netzfrequenz (50 Hz oder
60 Hz) ein.
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Wenn die Bildfrequenz fiir die Aufzeichnung dhnlich
der Netzfrequenz ist, wird das Flimmern
moglicherweise nicht vollstindig reduziert, wenn die
Flimmer-Reduzierung aktiviert ist. Verwenden Sie in
diesem Fall den elektronischen Verschluss.

Anpassung fiir natiirliche Farben
(WeiBabgleich)

SEL/SET CANCEL/
MENU ACK

ot 0R
Bl

Sie konnen den Anpassungsmodus an die
jeweiligen Aufnahmebedingungen anpassen.

Voreinstellungsmodus

In diesem Modus wird die Farbtemperatur auf
einen voreingestellten Wert gesetzt
(Standardwert ist 3200K). Diese Einstellung ist
vorteilhaft, wenn Sie keine Zeit dazu haben, den
WeiBabgleich anzupassen oder wenn Sie den
WeiBabgleich auf die mit White (Seite 117)
>Preset White im Paint-Menii festgelegte
Voreinstellung festlegen mochten.

Memory A-Modus, Memory B-Modus

In diesem Modus wird der Weilabgleich auf die
auf Speichermedium A bzw. B gespeicherten
Einstellungen gesetzt.

Driicken Sie die Taste WB SET [A], um den
automatischen WeiBabgleich durchzufiihren und
speichern Sie den eingestellten Wert in Speicher
A oder B.

ATW-Modus (Auto Tracing White Balance,
automatische WeiBwertanpassung)

In diesem Modus passt der Camcorder den
WeiBlwert automatisch an die jeweiligen
Bedingungen an.



Wenn sich die Farbtemperatur der Lichtquelle
dndert, wird der Weillabgleich automatisch
angepasst.

Die Anpassungsgeschwindigkeit kann (in fiinf
Stufen) iiber White Setting >ATW Speed
(Seite 118) im Paint-Menii gedndert werden.
Sie konnen die aktuelle Einstellung fiir den
WeiBabgleich festhalten, indem Sie einer
belegbaren Taste (Seite 47) die Funktion ATW
Hold zuweisen und diese Taste driicken, um den
ATW-Modus voriibergehend zu unterbrechen.

« Abhingig von den Lichtverhiltnissen und dem Motiv
konnen die Farben moglicherweise nicht per ATW
angepasst werden.

Beispiele:

— Das Motiv wird von einer Farbe dominiert, z. B.
Himmel, Meer, Erdboden oder Blumen.

— Die Farbtemperatur ist extrem hoch oder extrem
niedrig.
Wenn die Nachfiihrgeschwindigkeit des ATW zu
langsam ist und der gewiinschte Effekt aus diesem
oder anderen Griinden nicht erzielbar ist,
verwenden Sie den automatischen Weiabgleich.

Verwenden des Schalters

Wiihlen Sie den Modus mit dem Schalter WHT
BAL aus.

B: ATW-Modus oder Memory B-Modus

A: Memory A-Modus

PRESET: Voreinstellungsmodus

Werkseitig ist der ATW-Modus der Position B
des Schalters WHT BAL zugewiesen. Sie konnen
die Einstellung @ndern, sodass der Memory B-
Modus mithilfe von White Setting >White
Switch<B> (Seite 118) im Paint-Menii
ausgewaihlt wird.

Durch Einstellen des Camcorders auf
Vollautomatikmodus (Seite 33) wird der ATW-
Modus zwangsweise aktiviert.

Indem das Ein-/Ausschalten von ATW einer frei
belegbaren Funktionstaste (Seite 47) zugewiesen
wird, kann ATW getrennt aktiviert bzw.
deaktiviert werden, wenn der
Vollautomatikmodus ausgeschaltet ist.

Mit dem Direktmenii

Driicken Sie die Taste DISPLAY (Seite 12), um
den gewiihlten Modus und die Farbtemperatur auf
dem Bildschirm anzuzeigen (Seite 13).

ATW: ATW-Modus

W:A: Memory A-Modus

W:B: Memory B-Modus
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W:P: Voreinstellungsmodus

Sie konnen den Einstellmodus wie folgt im
Direktmenti (Seite 44) dndern.

Wenn der Schalter WHT BAL in Position B
gestellt ist, konnen ATW-Modus und Memory B-
Modus festgelegt werden.

Wenn der Schalter WHT BAL in Position A
gestellt ist, konnen ATW-Modus und Memory A-
Modus festgelegt werden.

Wenn der Schalter WHT BAL in Position
PRESET gestellt ist, konnen ATW-Modus und
Voreinstellungsmodus festgelegt werden.
Wenn nicht der ATW-Modus eingestellt ist,
konnen Sie die Farbtemperatur im Direktmenti
einstellen.

Sie konnen die Farbtemperatur im Direktmenii
andern, indem Sie die Anzeige der
Farbtemperatur auswéhlen. Im
Voreinstellungsmodus wird durch Driicken der
Taste WB SET die Farbtemperatur ebenfalls
eingestellt.

Umschalten des Voreinstellungsmodus
mit belegbarer Taste

Weisen Sie die Funktion Preset White Select
einer belegbaren Taste zu (Seite 47). Sie konnen
dann mit jedem Driicken auf die Taste die
Voreinstellungswerte in der Reihenfolge 3200K,
4300K, 5600K und 6300K wechseln.

Durchfiihren des automatischen
WeiBabgleichs

1 Wenn Sie einen Anpassungswert im
Speicher festhalten mochten, wiihlen
Sie Memory A-Modus oder Memory B-
Modus.

2  Platzieren Sie einen Bogen weilles
Papier (oder ein anderes Objekt) an
einen Ort mit derselben Lichtquelle und
denselben Lichtbedingungen wie das
Motiv, und zoomen Sie dann das Papier
heran, um den weiflen Bereich auf dem
Bildschirm anzuzeigen.

3 Passen Sie die Helligkeit an.

Passen Sie die Blende wie unter
, Aufzeichnen mit manueller Blende
(Seite 37) beschrieben an.



4 Driicken Sie die Taste WB SET [A].

Wenn Sie den Abgleich in einem
Speichermodus ausfiihren, wird der
eingestellte Wert in dem in Schritt 1
ausgewdihlten Speicher (A oder B) abgelegt.
Wenn der automatische Weillabgleich im
ATW-Modus durchgefiihrt wird, kehrt der
angepasste WeiBabgleich nach der
Anpassung in den ATW-Modus zuriick.

¢ Im Voreinstellungsmodus ist kein automatischer
WeiBabgleich moglich.

* Wenn die Anpassung nicht erfolgreich ist, wird eine
Fehlermeldung auf dem Bildschirm angezeigt. Kehrt
die Fehlermeldung auch nach wiederholten Versuchen
zum Anpassen des WeiBBabgleichs zuriick, wenden Sie
sich an die zustindige Sony Kundendienstvertretung.

Festlegen der aufzunehmenden
Audiosignale

Mithilfe der folgenden Anschliisse, Schalter und
Regler konnen Sie den Ton fiir die Aufnahme
einstellen.
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Externe Audioeing@nge und Wahlschalter
Anschluss AUDIO INPUT1
Anschluss AUDIO INPUT2

Schalter INPUT1

Schalter INPUT2

Schalter fiir Tonquelle
Schalter CH1 (INT/EXT/MI SHOE) [D]
Schalter CH2 (INT/EXT/MI SHOE) [1]

Schalter zum Festlegen des Audiopegels
Regler AUDIO LEVEL (CH1) [E]
Regler AUDIO LEVEL (CH2) [H]
Regler AUDIO LEVEL (CH3)
Regler AUDIO LEVEL (CH4)

Siehe Blockdiagramme (Seite 196).

Verwenden des eingebauten Mikrofons

Sie konnen Ton mithilfe des eingebauten
Mikrofons aufnehmen.

Aufnehmen auf CH1, CH2

Stellen Sie die Schalter CH1 (INT/EXT/MI
SHOE) [D] und CH2 (INT/EXT/MI SHOE)
[1] auf INT.

Aufnehmen auf CH3, CH4

Wiihlen Sie Internal MIC mithilfe von
Audio Input (Seite 124) >CH3 Input Select
und CH4 Input Select im Audio-Menii aus.

Verwenden eines externen Audiogerats

Mischpulte und andere externe Audiogerite
werden unterstiitzt.

Aufnehmen auf CH1, CH2

1 Stellen Sie die Schalter CH1 (INT/EXT/
MI SHOE) @ und CH2 (INT/EXT/MI
SHOE) [1] auf EXT.

Wenn Audio Input >CH2 EXT Input Select
im Audio-Menii auf INPUT2 gesetzt ist, wird
der Ton vom Anschluss AUDIO INPUT1 auf
CHI1 und der Ton vom Anschluss AUDIO
INPUT?2 auf CH2 aufgenommen.

Wenn CH2 EXT Input Select auf INPUT1
gesetzt ist, wird der Ton vom Anschluss
AUDIO INPUT1 auf CH1 und CH2
aufgenommen.

2 Stellen Sie die Schalter INPUT1/
INPUT?2 ([C)/[J]) auf LINE.

3 SchlieBen Sie ein externes Audiogeriit
an die Anschliisse AUDIO INPUT1/
AUDIO INPUT2 ([A)/[B]) an.



Aufnehmen auf CH3, CH4

1 Wihlen Sie INPUT1 mithilfe von Audio
Input (Seite 124) >CH3 Input Select
und INPUT2 mithilfe von CH4 Input
Select im Audio-Menii aus.

Wenn INPUT1 mithilfe von CH4 Input
Select ausgewihlt ist, wird der Ton vom
Anschluss AUDIO INPUT1 auf CH3 und
CH4 aufgenommen.

2 Fiihren Sie die Schritte 2 und 3 wie
unter ,,Aufnehmen auf CH1, CH2¢
beschrieben durch.

Verwenden eines externen Mikrofons

Ein Elektret-Kondensatormikrofon oder andere
Gerite konnen fiir die Aufnahme angeschlossen
werden.

Aufnehmen auf CH1, CH2

1 Stellen Sie die Schalter CH1 (INT/EXT/
MI SHOE) [D] und CH2 (INT/EXT/MI
SHOE) [1] auf EXT.

Wenn Audio Input >CH2 EXT Input Select
im Audio-Menii auf INPUT?2 gesetzt ist, wird
der Ton vom Anschluss AUDIO INPUT1 auf
CHI und der Ton vom Anschluss AUDIO
INPUT?2 auf CH2 aufgenommen.

Wenn CH2 EXT Input Select auf INPUT1
gesetzt ist, wird der Ton vom Anschluss
AUDIO INPUT!1 auf CH1 und CH2
aufgenommen.

2 Stellen Sie die Schalter INPUT1/
INPUT2 ([Cl/[J]) ein.
MIC: Fiir Mikrofone, die keine
Phantomspeisung erfordern.
MIC+48V: Fiir Mikrofone, die eine
Phantomspeisung mit +48 V erfordern.

Wenn Sie MIC+48V auswiihlen und ein
Mikrofon anschlielen, das nicht mit einer +48-V-
Quelle kompatibel ist, kann es zu Schiaden am
angeschlossenen Geriit kommen. Uberpriifen Sie
dies, bevor Sie das Gerit anschlieBen.

Wenn Rauschen von unbelegten Anschliissen ein
Problem darstellt, stellen Sie die zugehorigen
Schalter INPUT1/INPUT?2 auf LINE.
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3 Offnen Sie die Abdeckung, indem Sie
den Griff des Mikrofonhalters aufwérts
ziehen.

4 Bringen Sie ein Mikrofon an. SchlieSen
Sie dann den Mikrofonhalter, um das
Mikrofon zu sichern.

5 SchlieBen Sie das Mikrofonkabel an die
Anschliisse AUDIO INPUT1/AUDIO
INPUT?2 ([A)/[B)) an.

Wenn Sie ein Stereomikrofon (zwei XLR-
Stecker) verwenden wollen, schliefen Sie
den Stecker fiir den linken Kanal (L) an den
Anschluss AUDIO INPUT1 und den Stecker
fiir den rechten Kanal (R) an den Anschluss
AUDIO INPUT?2 an.

Aufnehmen auf CH3, CH4

1 Wihlen Sie INPUT1 mithilfe von Audio
Input (Seite 124) >CH3 Input Select
und INPUT2 mithilfe von CH4 Input
Select im Audio-Menii aus.

Wenn INPUT1 mithilfe von CH4 Input
Select ausgewihlt ist, wird der Ton vom
Anschluss AUDIO INPUT1 auf CH3 und
CH4 aufgenommen.

2 Fiihren Sie die Schritte 2 bis 5 wie unter
,,Aufnehmen auf CH1, CH2¢
beschrieben durch.

Verwenden eines mit dem Multi-
Interface-Schuh kompatiblen Mikrofons

Aufnehmen auf CH1, CH2

1 Stellen Sie die Schalter CH1 (INT/EXT/
MI SHOE) D] und CH2 (INT/EXT/MI
SHOE) [1] auf MI SHOE.

2 Bringen Sie ein Mikrofon am Multi-
Interface-Schuh an.

Aufnehmen auf CH3, CH4

1 Wihlen Sie Shoe CH1 mithilfe von
Audio Input (Seite 124) >CH3 Input
Select und Shoe CH2 mithilfe von CH4
Input Select im Audio-Menii aus.



2 Bringen Sie ein Mikrofon am Multi-
Interface-Schuh an.

Es konnen nicht zwei Mikrofone gleichzeitig am
vorderen und hinteren Multi-Interface-Schuh
angeschlossen werden. Das zuerst angeschlossene
Mikrofon ist das aktive Mikrofon.

Einstellen des Audio-Aufnahmepegels

Automatische Anpassung (AGC)

Stellen Sie die Regler AUDIO LEVEL
(CH1/CH2/CH3/CH4) ([E)/[HI/[F)/[G]) auf
AUTO.

Sie konnen mithilfe von Audio Input (Seite 124)
>CH1&2 AGC Mode im Audio-Menii festlegen,
ob die Pegel auf CH1 und CH2 automatisch
separat (Mono) oder zusammen (Stereo)
angepasst werden.

Sie konnen mithilfe von CH3&4 AGC Mode
ebenso festlegen, ob die Pegel auf CH3 und CH4
automatisch separat (Mono) oder zusammen
(Stereo) angepasst werden.

Manuelle Anpassung

Stellen Sie wiihrend der Aufzeichnung bzw.
im Bereitschaftsmodus die Regler AUDIO
LEVEL (CHI/CH2/CH3/CH4) ([El/HI/[F)/
) der entsprechenden Kanéle im Bereich
zwischen 0 bis 10 ein, um den
Aufnahmepegel anzupassen.

Zum Verringern von Windgerduschen setzen Sie
Audio Input >CH Wind Filter im Audio-Menii
auf On (Seite 124).

* Wenn sowohl fiir CHI als auch fiir CH2 das interne
Mikrofon ausgewihlt ist, werden die Audio-
Aufnahmepegel von CH1 und CH2 verkniipft und mit
dem Regler AUDIO LEVEL (CH1) eingestellt.

* Wenn sowohl fiir CH3 als auch fiir CH4 das interne
Mikrofon ausgewihlt ist, werden die Audio-
Aufnahmepegel von CH3 und CH4 verkniipft und mit
dem Regler AUDIO LEVEL (CH3) eingestellt.

Audio-Aufnahmen in speziellen
Aufzeichnungsmodi

Im Intervall-Aufzeichnungsmodus und
Zeitlupen-/Zeitraffer-Modus wird kein Ton
aufgezeichnet.
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Bildstabilisierung

Durch die Aktivierung der Funktion zur
Bildstabilisierung (SteadyShot) wird das
Wackeln des Bilds unterdriickt, was durch die
Bewegung der Kamera wihrend der Aufnahme
verursacht wird.

Driicken Sie die Taste STEADY SHOT am
Objektiv.

Der SteadyShot-Modus wird mit jedem
Tastendruck ein- bzw. ausgeschaltet.

Die Einstellung wird auf dem LCD-/
Sucherbildschirm angezeigt.

* Wenn Sie mithilfe eines Stativs zur Stabilisierung
arbeiten, stellen Sie SteadyShot auf Off.

Zeitdaten

Einstellen des Timecodes

Legen Sie den Timecode fiir die Aufzeichnung
iiber die Einstellung Timecode (Seite 130) im TC/
UB-Menii fest.

Festlegen von User-Bits

Sie konnen den aufgezeichneten Bildern eine
achtstellige Hexadezimalzahl als User-Bits
hinzufiigen. Sie konnen die User-Bits auch auf
die aktuelle Zeit setzen.

Nehmen Sie die Einstellung mithilfe von Users
Bit (Seite 130) im TC/UB-Menii vor.

Anzeigen von Zeitdaten

Driicken Sie zum Anzeigen der Zeitdaten auf dem
Bildschirm (Seite 13) die Taste DISPLAY.

Die Anzeige wechselt mit jedem Driicken der
Taste DURATION/TC/U-BIT (Seite 12)
zwischen Timecode, Benutzerbits und

Aufzeichnungsdauer.

Anzeige Beschreibung

TCG *k i pr sk Timecode

CLK s ek skeox Timecode (Clock-Modus)
UBG #3* #% %k &k User-Bits

DUR ¥k skdor Dauer seit Aufnahmestart




Niitzliche Funktionen

Verwenden des Direktmeniis

Einige Optionen werden direkt auf dem LCD-/
Sucherbildschirm angezeigt. Sie konnen deren
Status iiberpriifen und deren Einstellungen
andern.

Sie konnen die Direct Menu-Funktion
verwenden, indem Sie die Funktion einer
belegbaren Taste zuweisen.

Die folgenden Optionen konnen konfiguriert
werden.

* Autofokusmodus

« ATW

* Preset White

¢ Color Temp <A>/Color Temp <B>
 Scene File

* ND Filter Position

¢ Auto ND Filter

« ND Filter-Wert

¢ Auto Iris

« Iris-Wert

*« AGC

¢ Gain-Wert (H/M/L/Turbo)

« ECS

¢ Auto Shutter

 Shutter Speed-Wert

 Shutter Angle-Wert

* Auto Exposure Mode

* Auto Exposure Level

* S&Q Frame Rate

* Das Direktmenii ist nicht verfiigbar, wenn die
Vollautomatik (Seite 33) aktiviert ist (Tastenanzeige
FULL AUTO leuchtet).

1 Driicken Sie die mit Direct Menu
belegte belegbare Taste.

Wenn die Informationen mithilfe der Taste
DISPLAY auf dem LCD-/Sucherbildschirm
angezeigt werden, sind nur jene Optionen mit
dem Cursor auswihlbar, die mit dem
Direktmenii konfiguriert werden konnen.
Wenn die Informationen nicht auf dem LCD-
/Sucherbildschirm angezeigt werden, werden
nur jene Optionen angezeigt und sind mit
dem Cursor auswihlbar, die mit dem
Direktmenii konfiguriert werden konnen.
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2 Bewegen Sie den Cursor mithilfe der
Tasten 4/¥%/«/% oder dem Regler SEL/
SET auf die gewiinschte Option und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Das Direktmenii fiir die gewihlte Option
wird angezeigt.

3 Wihlen Sie mithilfe der Tasten #/%
oder dem Regler SEL/SET eine
Einstellung aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Das Menii wird ausgeblendet und die neue
Einstellung wird angezeigt.

Driicken Sie die mit Direct Menu belegte
belegbare Taste erneut oder nehmen Sie drei
Sekunden lang keine Einstellung vor, um das
Direktmenii zu schliefen und zum
Aufnahmebildschirm zuriickzukehren.

Sie konnen das Direktmenii 6ffnen, indem Sie
Menu Settings >Direct Menu with <SET>

(Seite 153) im System-Menii auf On setzen und
die Taste SET oder den Regler SEL/SET driicken.
Die Gesichtserkennung-AF-Funktion fiir
registrierte Gesichter ist jedoch nicht mehr
verfligbar.

Gesichtserkennung-AF

Der Camcorder kann die Gesichter von Personen
erkennen und den Fokus dann auf die Gesichter
anpassen.

Diese Funktion ist nur verfiigbar, wenn die
Fokussierung im AF-Modus oder durch
Autofokus auf Knopfdruck erfolgt.

Sobald Gesichter erkannt werden, werden graue
Gesichtserkennungsrahmen angezeigt. Die Farbe
der Rahmen wechselt zu Weil}, nachdem
Autofokus aktiviert wurde. Wenn mehrere
Personen erkannt werden, wird das Hauptmotiv
automatisch bestimmt.

Legen Sie die Gesichtserkennung-AF
mithilfe von Focus (Seite 113) im Camera-
Menii fest.

Face Only AF: Die Kamera erkennt die
Gesichter von Motiven (Personen) und
fokussiert nur auf ihre Gesichter. Solange ein
Gesicht nicht erkannt wird, wird AF
voriibergehend gestoppt (MF) und das



Symbol ,,Face Only AF Autofokus
angehalten” [1] (Seite 13) wird angezeigt.
angezeigt, wodurch signalisiert wird, dass
kein Gesicht erkannt wurde. Dieser Modus
ist hilfreich, wenn sich die
Gesichtserkennung nicht stabilisiert hat.

Face Priority AF: Die Kamera erkennt die
Gesichter von Motiven (Personen) und
gewihrt der Fokussierung auf die Gesichter
Vorrang. Falls kein Gesicht erkannt wird,
erfolgt die Fokussierung im AF-Modus
(Standardeinstellung).

Off: Die Funktion Gesichtserkennung-AF ist
deaktiviert.

« Wihrend des Autofokus auf Knopfdruck wird Face
Priority AF aktiviert, auch wenn gegenwirtig Face
Only AF ausgewihlt ist.

* Gesichtserkennung-AF ist in den folgenden Fillen
nicht verfiigbar.

— Im Full MF-Modus

— Wenn der Schalter FOCUS auf MANUAL gestellt
ist (ausgenommen wihrend Autofokus auf
Knopfdruck)

— Wenn das Aufzeichnungsformat DVCAM ist

* Wenn Sie den Camcorder ausschalten, wihrend Face
Only AF ausgewihlt ist, wechselt der Modus beim
nichsten Einschalten des Camcorders automatisch zu
Face Priority AF.

Aushlenden von
Gesichtserkennungsrahmen

Sie konnen Gesichtserkennungsrahmen mithilfe
von Display On/Off >Face Detection Frame
(Seite 128) im LCD/VF-Menii ein-/ausblenden.

Fokussieren auf ein registriertes Gesicht

Wiihrend des Betriebs mit Gesichtserkennung-

AF konnen Sie ein Gesicht eines Motivs (Person)

zum Fokussieren darauf registrieren.

Es kann nur ein Gesicht registriert werden. Das

Registrieren eines Gesichts iiberschreibt die

vorhandene Registrierung.

Wenn ein Gesicht registriert wird, wechselt der

Erkennungsrahmen zu einem Doppelrahmen, und

das Symbol ,,Registriertes Gesicht* g2 (Seite 13)

wird angezeigt.

Bei Gesichtserkennung-AF ergeben sich je nach

Kombination von registriertem Gesicht und

Betriebsmodus der Gesichtserkennung-AF

folgende Szenarien.

Face Priority AF (mit registriertem
Gesicht): Falls die Kamera das registrierte
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Gesicht erkennt, fokussiert sie darauf. Falls
das registrierte Gesicht nicht erkannt wird,
wird das normale Face Priority AF aktiviert.

Face Only AF (mit registriertem Gesicht):
Falls die Kamera das registrierte Gesicht
erkennt, fokussiert sie darauf. Falls das
registrierte Gesicht nicht erkannt wird, so
wird AF voriibergehend angehalten (MF)
und das Symbol ,,Face Only AF Autofokus
angehalten® [T] (Seite 13) wird angezeigt.
Dieser Modus ist hilfreich, wenn Sie
automatisch auf die registrierte Person
fokussieren mochten.

Festlegen des registrierten Gesichts

Bewegen Sie den Gesichtsauswahl-Cursor
(orange unterstrichen) mithilfe der Tasten
4/¥%/«/» auf das zu registrierende Gesicht
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Rahmen um das

registrierte Gesicht
(weiBer Doppelrahmen)

Andere Gesichter
(grau)

Gesichtsauswahl-Cursor (orange)

Verwerfen des registrierten Gesichts

Bewegen Sie den Auswahl-Cursor mithilfe der
Tasten 4/¥/«/ auf das registrierte Gesicht und
driicken Sie die Taste SET oder den Regler SEL/
SET.

Das registrierte Gesicht wird verworfen, der
Gesichtsrahmen wechselt zu einem einfachen
Rahmen, und das Symbol ,,Registriertes Gesicht*
wird ausgeblendet.

Wenn Gesichter ohne angezeigten Rahmen eines
registrierten Gesichts erkannt werden und der
Gesichtsauswahl-Cursor (orange) angezeigt wird,
konnen Sie das registrierte Gesicht verwerfen,
indem Sie zwei Mal die Taste SET oder den
Regler SEL/SET driicken.

* Je nach Aufnahmeumgebung, Zustand des Motivs
oder Einstellungen werden Gesichter moglicherweise
nicht registriert.

* Ineinigen Aufnahmeumgebungen konnen Sie ggf. den
Effekt nicht richtig nutzen, oder es werden andere



Motive anstelle von Gesichtern als Gesicht erkannt.
Stellen Sie in diesen Fillen die AF-Funktion der
Gesichtserkennung auf Off.

Es wird empfohlen, das Gesicht der gewiinschten
Person vor der Aufnahme zum Fokussieren zu
registrieren.

Die Gesichtsregistrierung schligt ggf. je nach Frisur,
Gesichtsausgestaltung oder fehlender Ausrichtung auf
die Kamera fehl. In diesem Fall wechselt der
Gesichtsrahmen ggf. zu einem Doppelrahmen, jedoch
wird das Symbol ,,Registriertes Gesicht* nicht
angezeigt und das Gesicht wird nicht registriert.

Falls ein Gesicht bereits registriert wurde, wird
empfohlen, das registrierte Gesicht zu verwerfen und
dann das neue zu registrieren.

Die Funktion zum Registrieren von Gesichtern ist
nicht verfiigbar, wenn Menu Settings >Direct Menu
with <SET> (Seite 153) im System-Menii auf On
gesetzt ist.

Gesichtserkennung-AF mithilfe einer
belegharen Taste umschalten

Weisen Sie die Funktion Face Detection AF einer
belegbaren Taste zu (Seite 47). Sie konnen dann
die Funktionsweise des Gesichtserkennung-AF in
der Reihenfolge Face Priority AF, Face Only AF
und Off per Tastendruck durchschalten.

Einstellung mithilfe des Direktmeniis

Sie konnen die Funktionsweise des
Gesichtserkennung-AF auch iiber das
Direktmenii (Seite 44) festlegen.

Farbbalken/Referenzton

Sie konnen Farbbalken anstelle des Kamerabilds
ausgeben lassen, indem Sie Color Bars

(Seite 115) >Setting im Camera-Menii auf On
setzen. Sobald die Einstellung auf Off gesetzt
wird, erfolgt wieder die Bildausgabe.

Sie konnen zu den Farbbalken auch einen 1-kHz-
Referenzton ausgeben lassen, indem Sie Audio
Input (Seite 124) >1kHz Tone on Color Bars im
Audio-Menii auf On setzen.

Die Farbbalken- und Referenzton-Signale
werden an den Anschliissen SDI OUT, HDMI
OUT und VIDEO OUT (hier nur Farbbalken)
ausgegeben.

Die Art der Farbbalken koénnen Sie mithilfe von
Color Bars >Type im Camera-Menii festlegen.

* Wenn sich der Camcorder im Zeitlupen- &
Zeitraffermodus befindet, konnen keine Farbbalken
ausgegeben werden.
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« Sie konnen wihrend der Aufnahme nicht zu
Farbbalken umschalten (Umschalten von Farbbalken
zum Kamerabild ist moglich).

Szenenmarkierungen

Wenn Sie Szenenmarkierungen fiir wichtige
Video- und Audioszenen eines im exFAT- oder
UDF-Modus aufgezeichneten Clips festhalten,
werden die markierten Szenen in der
Miniaturbildanzeige mit Inhaltsmarkierung
(Seite 98) aufgefiihrt, in der nur Szenen mit
Markierungen angezeigt werden. Dadurch wird
das Ansteuern und Bearbeiten effizienter
gestaltet.

Dieser Camcorder unterstiitzt zwei Arten von
Szenenmarkierungen (Szenenmarkierung 1 und
2).

Szenenmarkierungen konnen nach Bedarf
wihrend der Aufzeichnung gesetzt oder spiter
wiihrend der Uberpriifung der Wiedergabebilder
hinzugefiigt werden.

Szenenmarkierungen wéahrend der
Aufzeichnung setzen

Weisen Sie die Funktion Shot Mark1 oder Shot
Mark?2 einer frei belegbaren Taste zu (Seite 47),
und driicken Sie dann die Taste bei der Szene, in
der eine Szenenmarkierung eingefiigt werden
soll.

Einzelheiten zum Hinzufiigen von
Szenenmarkierungen nach der Aufzeichnung siehe
., Hinzufiigen von Szenenmarkierungen wéhrend der
Wiedergabe (exFAT, UDF)*“ (Seite 93).

Einzelheiten zum Benennen von
Szenenmarkierungen mithilfe von
Planungsmetadaten siehe ,, Definieren von
Szenenmarkierungsnamen in Planungsmetadaten
(Seite 59).

OK/NG/KEEP-Merker (exFAT, UDF)

Im exFAT- oder UDF-Modus aufgezeichnete
Clips konnen mit einem OK/NG/KEEP-Merker
versehen werden.

Indem Sie Merker hinzufiigen, konnen Sie die
Clips dahingehend filtern, dass nur die
gewiinschten in der gefilterten
Miniaturbildanzeige (Seite 98) aufgefiihrt
werden.



« Mit der Einstellung Lock/Unlock Clip (Seite 96)
konnen die Clips geschiitzt werden.

Einen Merker hinzufiigen

Wihrend der Aufzeichnung oder Wiedergabe
konnen Sie Clips mit OK/NG/KEEP-Merkern
versehen.

Driicken Sie wihrend der Aufnahme oder

Wiedergabe die mit Clip Flag OK/Clip Flag
NG/Clip Flag Keep belegte belegbare Taste.

Einen Merker loschen

Sie konnen OK/NG/KEEP-Merker von einem
Clip l6schen.

Driicken Sie die mit Clip Flag OK/Clip Flag
NG/Clip Flag Keep belegte belegbare Taste
zwei Mal.

OK/NG/KEEP-Merker kénnen auch iiber die
Miniaturbildanzeige hinzugefiigt und geléscht
werden. Ndheres dazu finden Sie unter ,, Hinzufiigen/
Loschen von Clip-Merkern (exFAT, UDF)*“

(Seite 97).

Priifen der Aufnahme (Rec
Review)

Den zuletzt aufgezeichneten Clip kénnen Sie im
Bildschirm anschauen (Rec Review).

Wenn die Aufnahme angehalten wurde,
driicken Sie die mit Rec Review belegte
belegbare Taste.

Je nach Einstellung der Option Rec Review
(Seite 132) im Recording-Menii werden die
letzten 3 Sekunden, 10 Sekunden oder der
gesamte Clip wiedergegeben.

Am Ende des Clips schaltet sich die
Aufnahmeriickschau-Wiedergabe aus, und der
Camcorder kehrt in den Bereitschaftsmodus
(STBY) zuriick.

Beenden von ,Rec Review*

Driicken Sie die Taste STOP oder eine
belegbare Taste, der Rec Review
zugewiesen wurde.
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Die Aufnahmeriickschau wird nicht unterstiitzt, wenn
nach der Aufzeichnung des Clips das Videoformat
gedndert wird.

Die Einstellmeniis konnen wihrend der
Aufnahmertickschau nicht bedient werden.
Aufnahmeriickschau ist nicht verfiigbar, wenn die
Miniaturbildanzeige das gefilterte Clip-
Miniaturbildmenti enthlt.

Frei belegbare Tasten

Am Camcorder gibt es zehn belegbare Tasten
(Seite 8), denen Funktionen zugewiesen werden
konnen.

Zuweisen anderer Funktionen

Verwenden Sie Assignable Button (Seite 150) im
System-Menii.

Die zugewiesenen Funktionen werden im
Bildschirm ,,Assignable Button Status* (Seite 18)
angezeigt.

StandardmiBig zugewiesene Funktionen

Taste 1 Zebra

Taste 2 Peaking

Taste 3 Video Signal Monitor
Taste 4 Network Client Mode
Taste 5 Off

Taste 6 Off

Taste 7 Direct Menu

Taste 8 Focus Magnifier
Taste 9 Off

Taste 10 Push Auto Iris

Zuweishare Funktionen
Nihere Informationen zu den Funktionen
erhalten Sie unter Seite 150.
* Off

¢ Push AF/Push MF

* Face Detection AF

¢ ND Filter Position

¢ Auto ND Filter

¢ Push Auto ND

* Push Auto Iris

¢ Turbo Gain

* AGC

* Shutter

* Auto Exposure Level

* Spotlight

* Backlight

 Flash Band Reduce

* Digital Extender x2



¢ Handle Zoom

* Color Bars

* Preset White Select

« ATW

*« ATW Hold

¢ Audio Monitor CH

¢ Audio Mon. CH Switch
e Marker

e Zebra

¢ Peaking

* Video Signal Monitor
* Focus Magnifier

¢ Lens Info

* LCD/VF Adjust

* VF Mode

* Gamma Display Assist
« Display

* Rec

* S&Q Motion

« Clip Continuous Rec
* Picture Cache Rec

* Proxy Rec Start/Stop
* Rec Review

« Last Clip Delete

¢ Thumbnail

* Shot Mark1

¢ Shot Mark2

* Clip Flag OK

 Clip Flag NG

« Clip Flag Keep

« NFC

* Network Client Mode
* Intercom Level

* Streaming

* RTMP/RTMPS

¢ Auto Upload (Proxy)
¢ Direct Menu

¢ User Menu

¢ Menu

Intervallaufzeichnung (Interval
Rec)

Sie konnen Bilder in bestimmten Intervallen
automatisch aufzeichnen und hierzu die Anzahl
Einzelbilder pro Einstellung (Number of Frames)
und das Aufzeichnungsintervall (Interval Time)
festlegen.

Diese Funktion ist besonders gut zur Aufnahme

von sich langsam bewegenden Motiven geeignet.
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Aufzeichnungsintervall (Interval Time)

—

Anzahl der Einzelbilder in einer Einstellung
(Number of Frames)

Es wird empfohlen, den Camcorder auf einem
Stativ 0. A. zu montieren und die Aufzeichnung
mit der Web-Fernbedienung anstatt mit der
Aufnahmetaste am Camcorder zu steuern.

Im Intervall-Aufzeichnungsmodus wird kein Ton
aufgezeichnet.

Interval Rec kann nicht gleichzeitig mit S&Q Motion,
Picture Cache Rec, Clip Continuous Rec, 2-slot Simul
Rec, 4K & HD (Sub) Rec oder Proxy Rec auf On
eingestellt werden. Wenn Interval Rec auf On gesetzt
wird, werden diese anderen Aufzeichnungsmodi auf
Off gesetzt.

Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion Interval Rec (Seite 131) im Recording-
Menii.

Wenn Setting auf On gesetzt wird, ist der
Intervall-Aufzeichnungsmodus aktiviert und auf
dem Bildschirm wird ,,Int Stby** angezeigt.

Wenn eine mit dem Multi-Interface-Schuh
kompatible Videoleuchte angebracht ist, konnen
Sie Interval Rec> Pre-Lighting im Recording-
Menii auf On setzen, sodass sich die Leuchte
automatisch 2, 5 oder 10 Sekunden vor der
Aufnahme einschaltet.

* Wenn Pre-Lighting auf On gesetzt wird, bleibt die
Videoleuchte eingeschaltet, falls die Ausschaltdauer
gemif der Einstellung fiir Interval Time kiirzer als
5 Sekunden wiire. Dies ist auch dann der Fall, wenn
Video Light Set im Camera-Menii auf Rec Link oder
Rec Link + Stby gesetzt wurde.



Aufnehmen im Intervall-
Aufzeichnungsmodus

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Sobald Sie die Aufnahme starten, dndert sich die
Anzeige ,.Int Stby* und wechselt zwischen ,,Int
@Rec* und ,.Int @Stby*.

Wihrend der Aufnahme im Intervall-
Aufzeichnungsmodus kénnen die Einstellungen
Interval Time und Number of Frames nicht geéndert
werden. Um die Einstellungen zu @ndern stoppen Sie
zunichst die Aufnahme.

Nach Beginn der Aufnahme im Intervall-
Aufzeichnungsmodus ist die Aufnahmeriickschau-
Funktion deaktiviert. Dies gilt auch wihrend der
Intervallzeit.

Wihrend der Aufzeichnung im Intervall-
Aufzeichnungsmodus (Seite 130) wird der Timecode
im Rec Run-Modus aufgezeichnet.

Wihrend einer Pause im Intervall-
Aufzeichnungsmodus werden einige zusitzliche
Bilder aufgezeichnet, wenn Sie die Aufzeichnung
anhalten oder den Speicherkarteneinschub wechseln.
Interval Rec >Setting wird automatisch auf Off
gesetzt, wenn der Schalter ON/STANDBY in die
Position STANDBY gebracht wird. Die Einstellungen
Interval Time und Number of Frames werden jedoch
beibehalten.

Kontinuierliche Aufnahme (Clip
Continuous Rec) (exFAT, UDF)

Normalerweise wird mit jedem Starten und
Stoppen der Aufnahme ein Clip als unabhingige
Datei erstellt. Mit dieser Funktion kénnen Sie
jedoch die Aufnahme starten und stoppen und
dabei kontinuierlich fiir denselben Clip

aufnehmen, solange die Funktion aktiviert bleibt.

Dies ist niitzlich, wenn Sie keine grofle Anzahl
kurzer Clips generieren und sich bei der
Aufnahme keine Gedanken um das Uberschreiten
der Hochstzahl an Clips machen wollen. Die
Aufnahmestartpunkte lassen sich dennoch
problemlos finden, da bei jedem Starten der
Aufnahme eine Aufnahmestartmarkierung
aufgezeichnet wird.

Einzelheiten zu den Aufnahmeformaten, die mit
der kontinuierlichen Clipaufnahme kompatibel
sind, finden Sie unter (Seite 167).
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Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion Clip Continuous Rec (Seite 131) im
Recording-Menii.

Wenn Setting auf On gesetzt wird, ist der Modus
zur kontinuierlichen Clipaufnahme aktiviert und
auf dem Bildschirm wird ,,Cont Stby* angezeigt
(Seite 13).

Konfigurieren mithilfe belegharer Tasten

Sie konnen Clip Continuous Rec auch einer frei
belegbaren Funktionstaste (Seite 47) zuweisen
und durch Driicken dieser Taste auf On/Off
setzen.

* Clip Continuous Rec kann nicht gleichzeitig mit S&Q
Motion, Interval Rec, Picture Cache Rec, 2-slot Simul
Rec oder 4K & HD (Sub) Rec auf On eingestellt
werden. Wenn Clip Continuous Rec auf On gesetzt
wird, werden diese anderen Aufzeichnungsmodi auf
Off gesetzt.

Wihrend der Aufzeichnung kann der Modus fiir die
kontinuierliche Clipaufnahme nicht verwendet
werden.

Aufnehmen im Modus fiir die
kontinuierliche Clipaufnahme

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Wenn Sie mit der Aufnahme beginnen, wechselt
die Anzeige ,,Cont Stby* zu ,,Cont @Rec*
(@ wird rot).

* Wenn Sie wihrend der Aufnahme oder im
Aufnahmebereitschaftsmodus (,,Cont Stby* wird
angezeigt) die SxS-Speicherkarte oder den Akku
herausnehmen bzw. die Stromquelle vom Gerit
trennen, muss die SxS-Speicherkarte wiederhergestellt
werden. Beenden Sie die kontinuierliche
Clipaufnahme und nehmen Sie dann die SxS-
Speicherkarte heraus. Wenn ,,Cont Stby* blinkt (ein
Mal pro Sekunde), kénnen Sie die SxS-Speicherkarte
entnehmen.

« Stoppen Sie die Aufnahme frithestens nach zwei
Sekunden ab Aufnahmestart.

Stoppen Sie zum Beenden die Aufnahme.

So beenden Sie den Modus fiir die
kontinuierliche Clipaufnahme

Setzen Sie wihrend der Aufnahmebereitschaft
Clip Continuous Rec (Seite 131) >Setting



entweder im Recording-Menti auf Off oder
driicken Sie die belegbare Taste, der die Funktion
Clip Continuous Rec zugewiesen ist.

Einschrankungen

Ein einziger kontinuierlicher Clip kann nicht

erstellt werden, wenn Sie eine der folgenden

Funktionen ausfiihren, wihrend sich der

Camcorder im Aufnahme- oder

Aufnahmebereitschaftsmodus befindet. Beim

néchsten Starten der Aufnahme wird ein neuer

Clip erstellt.

« Einen Clip bearbeiten (Sperren, Loschen oder
Umbenennen eines Clips)

* Den Speicherkarteneinschub wechseln

¢ Das Aufnahmeformat wechseln

¢ Den Schalter ON/STANDBY auf STANDBY
stellen

 Die Miniaturbildanzeige aufrufen

* Einen Clip wiedergeben

* Den Modus fiir die kontinuierliche
Clipaufnahme beenden

Aufzeichnung im Bildpuffermodus
(Picture Cache Rec)

Der Camcorder behélt wihrend der Aufnahme
stets fiir ein bestimmtes Intervall einen Puffer mit
Video- und Audiodaten (maximal 28 Sekunden)
im internen Speicher, sodass Sie einige Sekunden
Material bereits vor dem Beginn der eigentlichen
Aufzeichnung aufnehmen.

Die Aufzeichnung im Bildpuffermodus kann
verwendet werden, wenn das Aufnahmeformat
(Seite 147) auf eines der nachfolgend
aufgefiihrten Formate eingestellt ist.

* XAVC-1

« XAVC-L

*« MPEG HD 422

* MPEG HD 420

Picture Cache Rec kann nicht gleichzeitig mit S&Q
Motion, Interval Rec, Clip Continuous Rec, 2-slot
Simul Rec, 4K & HD (Sub) Rec oder Proxy Rec auf On
eingestellt werden. Wenn Picture Cache Rec auf On
gesetzt wird, werden diese anderen
Aufzeichnungsmodi auf Off gesetzt.

Wihrend der Aufzeichnung oder der
Aufnahmeriickschau kann der Bildpuffermodus nicht
gewihlt werden.

Wenn Picture Cache Rec auf On gesetzt ist, wird der
Timecode unabhiingig von der Einstellung im TC/UB-
Menii im Modus Free Run aufgezeichnet (Seite 130).
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Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion Picture Cache Rec (Seite 131) im
Recording-Meni.

Wenn Setting auf On gesetzt wird, ist die
Aufzeichnung im Bildpuffermodus aktiviert und
auf dem Bildschirm wird ,,Cache* angezeigt.

Konfigurieren mithilfe belegbarer Tasten
Weisen Sie Picture Cache Rec einer frei
belegbaren Funktionstaste (Seite 47) zu und
setzen Sie sie durch Driicken dieser Taste auf On/
Off.

Aufnehmen im Bildpuffermodus

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Wenn Sie mit der Aufnahme beginnen, wechselt
die Anzeige ,,Cache* zu ,,@Rec*.

Stoppen Sie zum Beenden die Aufnahme.

Abbrechen von ,,Picture Cache Rec”

Setzen Sie Picture Cache Rec >Setting entweder
im Recording-Menii auf Off oder driicken Sie die
belegbare Taste, der die Funktion Picture Cache
Rec zugewiesen ist.

Bei einer Anderung des Aufzeichnungsformat wird
das bis zu diesem Zeitpunkt aufgezeichnete Video im
Pufferspeicher geloscht, und es wird ein neues Video
gepuffert. In dem Fall konnen Bilder, die vor der
Formatidnderung im Puffer gespeichert wurden, nicht
aufgezeichnet werden, wenn Sie die Aufzeichnung
direkt nach der Formatinderung starten.

Wenn die Aufzeichnung im Bildpuffermodus
unmittelbar nach dem Einlegen einer SxS-
Speicherkarte gestartet oder gestoppt wird, werden
Pufferdaten moglicherweise nicht auf der Karte
gespeichert.

Videoaufnahmen werden im Pufferspeicher
gespeichert, wenn die Funktion Picture Cache Rec auf
On gesetzt ist. Video, das vor Setzen der Funktion auf
On aufgezeichnet wurde, wird nicht gepuffert.
Wihrend des Zugriffs auf eine SxS-Speicherkarte, z.
B. wihrend der Wiedergabe, Uberpriifung der
Aufnahme oder Miniaturbildanzeige, werden keine
Videoaufnahmen im Pufferspeicher gespeichert.
Wihrend dieser Zeit ist die Bildpuffer-Aufzeichnung
von Videoaufnahmen nicht moglich.

¢ Wenn eine mit dem Multi-Interface-Schuh kompatible
Videoleuchte angebracht ist, dann ist keine
Pufferaufnahme vor dem Beginn der Aufzeichnung
moglich, selbst wenn Video Light Set im Camera-
Menti auf Rec Link oder Rec Link + Stby gesetzt ist.



Die Leuchte wird ein-/ausgeschaltet, wenn Sie die
Aufnahmetaste driicken.

Zeitlupe und Zeitraffer

Wenn das Dateisystem exFAT ist und das
Aufnahmeformat (Seite 147) auf eines der unten
aufgefiihrten Formate eingestellt ist, konnen Sie
eine Aufzeichnungsbildfrequenz festlegen, die
sich von der Wiedergabebildfrequenz
unterscheidet.

Aufzeich- Systemfre-  Bildfrequenz
nungsformat quenz fiir Zeitlupe/
Zeitraffer
XAVC-I 1080P 59.94/29.97/ 1 bis 60 fps
"XAVC-L 1080P 23.98/50/25 (in Schritten zu
1 fps), 100 fps,
120 fps
XAVC-12160P 59.94/29.97/ 1 bis 60 fps
"XAVC-L2160P 23.98/50/25 (in Schritten zu
1 fps)
MPEG HD422/ 29.97/23.98 1 bis 30 fps
MPEG HD420 (in Schritten zu
1080P 1 fps)
25 1 bis 25 fps
(in Schritten zu
1 fps)
MPEG HD422 59.94/29.97/ 1 bis 60 fps
720P 23.98 (in Schritten zu
1 fps)
50/25 1 bis 50 fps
(in Schritten zu
1 fps)

Zeitlupe & Zeitraffer konnen nicht wihrend der
Aufzeichnung, Wiedergabe oder Miniaturbildanzeige
festgelegt werden.

S&Q Motion kann nicht gleichzeitig mit Interval Rec,
Picture Cache Rec, Clip Continuous Rec, 2-slot Simul
Rec, 4K & HD (Sub) Rec oder Proxy Rec auf On
eingestellt werden. Wenn S&Q Motion auf On gesetzt
wird, werden diese anderen Aufzeichnungsmodi auf
Off gesetzt.

Im Zeitlupen- & Zeitraffermodus ist keine
Audioaufnahme moglich.

Die Autofokusfunktion ist im Modus Slow & Quick
Motion deaktiviert, wenn die Bildrate auf 100 fps oder
120 fps eingestellt ist.

Je nach dem verwendeten Modus kann das Rauschen
in Abhingigkeit von der Aufnahmeumgebung
auffillig werden.
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Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion S&Q Motion (Seite 130) im Recording-
Mentii.

Wenn Setting auf On gesetzt wird, ist der
Zeitlupen- & Zeitraffermodus aktiviert und auf
dem Bildschirm wird ,,S&Q Stby** angezeigt.

Aufzeichnungsbildfrequenz mithilfe des
Direktmeniis einstellen

Sie konnen die Aufzeichnungsbildfrequenz im
Zeitlupen- & Zeitraffermodus mithilfe des
Direktmeniis festlegen (Seite 44).

Konfigurieren mithilfe belegbarer Tasten

Sie konnen S&Q Motion einer frei belegbaren
Funktionstaste (Seite 47) zaweisen und durch
Driicken dieser Taste auf On/Off den Zeitlupen-
& Zeitratffermodus wechseln.

Sie konnen die Bildfrequenz fiir die Aufnahme
festlegen, indem Sie eine belegbare Taste
gedriickt halten, um den Einstellungsbildschirm
fiir die Aufzeichnungsbildfrequenz aufzurufen.

Aufzeichnung mit dem Zeitlupen- &
Zeitraffermodus

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Wenn Sie mit der Aufnahme beginnen, wechselt
die Anzeige ,,S&Q Stby*“ zu ,,S&Q @Rec*.

Wihrend der Aufzeichnung mit Zeitlupe/Zeitraffer
konnen Sie die Einstellung Frame Rate nicht éndern.
Um die Einstellungen zu dndern stoppen Sie zunichst
die Aufnahme.

Die Aufnahmeriickschau wird nicht wihrend der
Aufzeichnung mit Zeitlupe/Zeitraffer unterstiitzt.
Wiihrend der Aufzeichnung mit Zeitlupe/Zeitraffer
(Seite 130) wird der Timecode im Rec Run-Modus
aufgezeichnet.

Wenn Sie mit einer geringen Bildfrequenz aufnehmen,
setzt der Camcorder die Aufnahme ggf. noch einige
Sekunden fort, nachdem Sie die Aufnahmetaste
gedriickt haben, um die Aufnahme anzuhalten.

Stoppen Sie zum Beenden die Aufnahme.

Aufheben von Zeitlupe/Zeitraffer

Setzen Sie wihrend der Aufnahmebereitschaft
S&Q Motion >Setting entweder im Recording-
Menti auf Off oder driicken Sie die belegbare
Taste, der die Funktion S&Q Motion zugewiesen
18t.



Simultanaufzeichnung in zwei
Einschiiben (Simul Rec)

Es ist moglich, auf Speicherkarte A und B
gleichzeitig aufzuzeichnen.

Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion Simul Rec (Seite 131) im Recording-
Menii.

2-slot Simul Rec kann nicht gleichzeitig mit S&Q
Motion, Interval Rec, Picture Cache Rec, Clip
Continuous Rec, 4K & HD (Sub) Rec oder Proxy Rec
auf On eingestellt werden. Wenn 2-slot Simul Rec auf
On gesetzt wird, werden diese anderen
Aufzeichnungsmodi auf Off gesetzt.
Simultanaufzeichnung in 2 Einschiiben wird nicht
unterstiitzt, wenn das Aufzeichnungsformat QFHD-
Modus (3840x2160P) ist. Wenn das
Aufzeichnungsformat auf QFHD-Modus gesetzt wird,
wihrend 2-slot Simul Rec auf On gesetzt ist, wird 2-
slot Simul Rec zwangsliufig auf Off gesetzt.

Aufnehmen im Modus fiir
Simultanaufzeichnung in 2 Einschiiben

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Verwenden Sie fiir die Simultanaufzeichnung in 2
Einschiiben Speicherkarten gleichen Typs und
gleicher GroBe.

SxS-Speicherkarten werden empfohlen.
SDHC-Karten werden im Modus fiir
Simultanaufzeichnung in 2 Einschiiben nicht
unterstiitzt.

2-slot Simul Rec kann nicht wihrend der
Aufzeichnung, Wiedergabe oder Miniaturbildanzeige
festgelegt werden.

Wenn der Speicherplatz auf einer Speicherkarte in
einem Einschub zur Neige geht und der andere
Einschub eine beschreibbare Speicherkarte enthilt,
wird die Aufzeichnung normal fortgesetzt. Wenn Sie
die Speicherkarten bei normaler kontinuierlicher
Aufzeichnung wechseln, stehen die
Simultanaufzeichnung und die automatische
Aufzeichnungsfortsetzung nicht zur Verfiigung.
Wenn Simultanaufzeichnung in 2 Einschiiben starten
und nur in einem Einschub ein Medium eingesetzt ist
oder das Medium in einem Einschub voll ist, wird nur
auf dem aufnahmebereiten Medium Video
aufgenommen.

Stoppen Sie zum Beenden die Aufnahme.
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Aufheben der Simultanaufzeichnung in 2
Einschiiben

Stellen Sie im Aufzeichnungsbereitschaftsmodus
Simul Rec >Setting im Recording-Menii auf Off.

Andern der Einstellung fiir die
Aufnahmetaste und die Aufnahmetaste
am Griff

Sie konnen mit den Aufnahmetasten am Griff
oder am seitlichen Griff die Aufnahme auf die
Speicherkarten in den beiden Einschiiben
unabhiéngig voneinander starten bzw. stoppen.
StandardméBig wird durch Driicken einer der
Tasten die Aufnahme auf Speicherkarte A und
auf Speicherkarte B gleichzeitig gestartet bzw.
gestoppt.
* Rec Button:[ A »| [ B » Handle Rec
Button:[ A » [ B »

Andern der Einstellung

Wiihlen Sie Simul Rec >Rec Button Set im
Recording-Menii aus.

Rec Button Set Tasten und
Speicherkarten

Durch Driicken einer dieser
Tasten wird die simultane
Auszeichnung auf
Speicherkarte A und
Speicherkarte B gestartet
bzw. angehalten.

Rec Button:| A »
Handle Rec
Button: B

Die Aufnahme auf
Speicherkarte A wird mit der
Aufnahmetaste, die
Aufnahme auf Speicherkarte
B wird mit der
Aufnahmetaste am Griff
gestartet bzw. gestoppt.

Die Aufnahme auf
Speicherkarte B wird mit der
Aufnahmetaste, die
Aufnahme auf Speicherkarte
A wird mit der
Aufnahmetaste am Griff
gestartet bzw. gestoppt.

Rec Button:

Handle Rec

Button:| B »

Rec Button:| B »

Handle Rec

Button:

4K- und HD (Sub)-Aufzeichnung

Mithilfe dieser Funktion konnen Sie ein 4K
(QFHD)-Video (Hauptclip) und ein MPEG
HD422-Video (Subclip) fiir die Vorbearbeitung
auf einer einzigen SxS-Speicherkarte
aufzeichnen.



Von der 4K- und HD (Sub)-Aufzeichnung
werden die folgenden Aufnahmeformate fiir SxS-
Speicherkarten unterstiitzt.

Das Aufnahmeformat des Subclips wird von der
Systemfrequenz des Hauptclips bestimmt.

Aufnahmeformat Systemfre- Aufnahmefor-

des Hauptclips  quenz mat des Sub-
clips

XAVC-1 29.97/25/ MPEG HD422

3840x2160P 23.98 1920x1080P

XAVC-L 59.94/50 MPEG HD422

3840x2160P 1920x1080i

* SD-Karten konnen nicht fiir 4K- und HD (Sub)-
Aufzeichnung verwendet werden.

Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion 4K & HD (Sub) Rec (Seite 132) im
Recording-Menii.

4K & HD (Sub) Rec kann nicht gleichzeitig mit S&Q
Motion, Interval Rec, Picture Cache Rec, Clip
Continuous Rec, 2-slot Simul Rec oder Proxy Rec auf
On eingestellt werden. Wenn 4K & HD (Sub) Rec auf
On gesetzt wird, werden diese anderen
Aufzeichnungsmodi auf Off gesetzt.

4K & HD (Sub) Rec kann nicht wihrend der
Aufzeichnung, Wiedergabe oder Miniaturbildanzeige
festgelegt werden.

Aufzeichnung im 4K- und HD (Sub)-
Aufnahmemodus

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.
Wiihrend der Aufnahme wird ,,XAVC-I/Sub*
oder ,,XAVC-L/Sub* rechts von der Anzeige des

Aufzeichnungsformats (Codec) auf dem
Bildschirm angezeigt.

Stoppen Sie zum Beenden die Aufnahme.

Aufheben des 4K- und HD (Sub)-
Aufnahmemodus

Stellen Sie im Aufzeichnungsbereitschaftsmodus
4K & HD (Sub) Rec >Setting im Recording-
Menii auf Off.
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High Dynamic Range (HDR)-
Aufnahme

Sie konnen vom herkommlichen
Aufnahmemodus Standard Dynamic Range
(SDR) in den Modus High Dynamic Range
(HDR) wechseln.

Sie konnen fiir die Bildgebung den Modus mit
groBem Dynamikbereich (High Dynamic Range,
HDR) festlegen, um Bilder mit einem zu BT.2020
dquivalenten Farbraum und erweitertem
Dynamikbereich aufzunehmen und auszugeben.
Diese Funktion ist aktiviert, wenn Verfiigung,
wenn File System auf exFAT eingestellt ist.

* Wird nicht fiir DVCAM-Dateiformate unterstiitzt.

Diese Funktion ist in den folgenden Fillen nicht

verfiigbar.

— Wiihrend der Aufnahme, Wiedergabe oder wenn
die Miniaturbildanzeige angezeigt wird

— Wenn File System nicht auf exFAT eingestellt ist

— Wiihrend QoS-Streaming

— Wihrend RTMP/RTMPS-Streaming

Festlegen des HDR-Modus

1 Setzen Sie Base Setting >Shooting Mode
im System-Menii auf HDR.

2 Wiihlen Sie Aufnahme im HDR-Modus
und die Gammakurve des
Ausgangssignals mithilfe von HDR
Setting >Rec/Out im System-Menii aus.
Sie konnen HDR(HLG) oder HDR(S-Log3)
auswihlen.

3 Wenn Sie HDR(HLG) in Schritt 2
gewihlt haben, wihlen Sie den Look fiir
HLG mithilfe von HDR Paint Setting
>HLG Look im Paint-Menii aus.

Einzelheiten zu den auswihlbaren Looks
siehe ,,HLG Look* (Seite 117).

Festlegen der Gamma-
Anzeigeassistentenfunktion

Der LCD-Bildschirm und der Sucherbildschirm
des Camcorders sind nicht HDR-kompatibel und
nicht zur Anzeige von HDR geeignet. Wenn als
Aufnahmemodus der HDR-Modus eingestellt ist,
kann die Erkennbarkeit der Anzeige zum



leichteren Aufnehmen mithilfe der Gamma-
Anzeigeassistentenfunktion verbessert werden.
Gehen Sie wie folgt vor, um die Gamma-
Anzeigeassistentenfunktion zu aktivieren.

Setzen Sie Gamma Display Assist im LCD/
VF-Menii auf On.

Der Gamma-Anzeigeassistent wird nur fiir den LCD-
Bildschirm/Sucher verwendet. Die Einstellungen
wirken sich nicht auf das aufgezeichnete oder
ausgegebene Bild aus.

Auswédhlen des LCD-Bildschirms/
Suchers, wenn der Gamma-
Anzeigeassistent aktiviert ist

Wenn der Gamma-Anzeigeassistent aktiviert ist,
konnen Sie fiir die Anzeige von HDR-Bildern auf
dem LCD-Bildschirm/im Sucher zwischen den
folgenden beiden Methoden wihlen.

@ Anzeigemethode, die den Kontrast dunkler
und heller Bereiche des HDR-Bilds hewahrt
Diese Methode nutzt die Ausdrucksstidrke von
HDR und zeigt bei starker oder geringer
Belichtung das Bild auf dem LCD-Bildschirm
an, ohne Verlust von Schwarzdetails oder
iiberbelichtete Spitzlichter zu verursachen.
Der Kontrast wird jedoch leicht reduziert.
Nehmen Sie die Konfiguration wie folgt vor.

Setzen Sie HDR Setting >LCD/VF SDR
Preview im System-Menii auf Off.

(@ Anzeigemethode mit einfacher Umwandlung
von HDR in SDR
Mithilfe dieser Methode konnen Sie die
Kamera wie vom herkommlichen SDR
gewohnt bedienen.
Sie konnen die Helligkeit des HDR-Bilds
anpassen, indem Sie den
Verstarkungsunterschied zwischen HDR und
SDR mithilfe von SDR Gain einstellen.
Nehmen Sie die Konfiguration wie folgt vor.

1 Setzen Sie HDR Setting >LCD/VF
SDR Preview im System-Menii auf
Off.

2 Passen Sie die SDR-Verstirkung
mithilfe von HDR Setting >SDR
Gain im System-Menii an.
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Der Einstellbereich betrigt 0dB bis
—15dB. Der Wert kann in Schritten von
1dB eingestellt werden.

Wenn sowohl der Gamma-Anzeigeassistent als
auch LCD/VF SDR Preview aktiviert sind, wird
Zebra als SDR-Ausgabepegel angezeigt.

Um die Anzeige nach der Aufnahme mithilfe von
SR Live Metadata von HDR in SDR zu
konvertieren, wird SDR Gain zur Wandlung in
ein SDR-Bild mit der auf dem LCD-Bildschirm/
Sucher bei der Aufnahme beobachteten
Belichtung verwendet.

Automatisches Einstellen des
AuflagemaBes

Der Abstand zwischen der Kante des
Objektivgewindes und der Bildsensorebene
(Auflagemal oder Flanschbrennweite) kann
automatisch eingestellt werden.

Fiihren Sie diese Einstellung durch, wenn mit
dem Objektivzoom in Weitwinkel- und
Teleposition keine Fokussierung erreicht werden
kann.

Bei korrekter Einstellung sollte die Fokussierung
beim Wechsel der Zoomposition beibehalten
werden.

‘Wenn Sie ein Motiv ohne ausreichenden Kontrast
verwenden oder den Camcorder oder das Motiv
wihrend der Einstellung bewegen, ist keine
einwandfreie Einstellung moglich. Sobald die
Einstellung beginnt, diirfen bis zu ihrem Ende weder
Camcorder noch Objektiv beriihrt werden.

Die automatische Einstellung des AuflagemalBes ist
nicht bei Ausnahme im Zeitlupen- & Zeitraffermodus
moglich.

Stellen Sie sicher, dass sich wihrend der
Auflagemalfeinstellung keine Lichtquelle wie z. B.
eine Lampe, die Sonne oder ein helles Fenster im
Bildrahmen befindet.

* Wenden Sie sich an Ihren Hindler, wenn Sie ein
Testbild zur Einstellung des Auflagemalles bendtigen.

1 Stellen Sie den Schalter ON/STANDBY
auf ON.

2 Entfernen Sie Zubehor wie Konverter.

3 Legt den normalen Aufnahmemodus
fest.



4 Setzen Sie Marker (Seite 127) >Setting
auf On oder Center Marker im LCD/
VF-Menii auf eine andere Einstellung
als Off, um die Mittenmarkierung auf
dem Bildschirm einzublenden.

9 Positionieren Sie das Testbild zur
Einstellung des AuflagemaBes oder ein
anderes Objekt mit hohem Kontrast
etwa 3 m vom Camcorder entfernt.
Passen Sie die Beleuchtung so an, dass
eine zufriedenstellende Videoausgabe
erfolgt.

Platzieren Sie das Motiv so, dass es in Tele-
Endeinstellung in der Mitte des Bildschirms
erscheint. Stellen Sie auBerdem sicher, dass
in der Weitwinkel-Endeinstellung kein der
Kamera niheres Objekt als das Testbild auf
dem Bildschirm erscheint.

6 Bringen Sie den Zoom in die Tele-
Endeinstellung und richten Sie die
Mitte des Testbilds zur Einstellung des
AuflagemafBes oder eines anderen
Motivs an der Mittenmarkierung auf
dem Bildschirm aus.

7 Setzen Sie Rec Format (Seite 147)
>Video Format auf 3840x2160P und
Frequency im System-Menii auf 59.94
oder 50.

8 Bringen Sie den Zoom in die
Weitwinkel-Endeinstellung,
deaktivieren Sie den
Vollautomatikmodus und stellen Sie
folgende Werte fiir
Verschlussgeschwindigkeit,
Verstirkung und Blende ein (Seite 37).
Verschlussgeschwindigkeit:

Automatischer Verschluss
Verstéarkung: 0dB
Blende: F1.9 (geoffnet)

9 Passen Sie die Beleuchtung und den
ND-Filter auf eine geeignete Helligkeit
an.

1 U Stellen Sie den Schalter ZOOM an der
Unterseite des Camcorders auf SERVO
(Motor-Zoom-Modus).
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11 Wiihlen Sie Auto FB Adjust >Execute
im Camera-Menii aus.

Die automatische Einstellung des
AuflagemaBes beginnt.

Auf dem Bildschirm wird wihrend der
Einstellung eine Fortschrittsmeldung
angezeigt.

Wenn die Einstellung erfolgreich
abgeschlossen wurde, wird eine
Abschlussmeldung angezeigt.

* Wechseln Sie den ND-Filter nicht, solange Auto FB
Adjust ausgefiihrt wird.

Wenn Sie wahrend des Einstellvorgangs die

Taste CANCEL driicken

Die automatische Einstellung des Auflagemales

wird abgebrochen und der Zustand vor dem

Beginn der Einstellung wird wiederhergestellt.

Falls die Einstellung des Auflagemalies
fehlschldgt

Eine Fehlermeldung wird angezeigt.

Priifen Sie das Motiv und die
Beleuchtungsbedingungen, und wiederholen Sie
die Einstellung.

Abrufen von
Standortinformationen (GPS)

Standort- und Uhrzeitinformationen des mit
aktivierter Positionierung aufgenommenen
Videos werden auf das in den Karteneinschub des
Camcorders eingesetzte Medium gespeichert und
konnen als SDI ausgegeben werden.

1 Driicken Sie im Bereitschaftsmodus die
Taste MENU.

2 Setzen Sie GPS im System-Menii auf
On.
MO wird angezeigt, wihrend der
Camcorder nach GPS-Satelliten sucht. Wenn
die Position ermittelt wurde, werden bei der
Videoaufzeichnung Standortinformationen
erfasst.

* Das angezeigte Symbol dndert sich je nach
Signalempfang von den GPS-Satelliten.



Positionie- Anzeige Status des GPS-
rungssta- Empfangs
tus
Ausgeschal-  Keine GPS ist auf Off gesetzt,
tet Anzeige  oder es ist ein Fehler
aufgetreten.
Positionsda- NO GPS Es konnten keine
ten nicht ver-  SIGNAL Standortinformationen
fligbar ermittelt werden, weil kein
GPS-Signal empfangen
wurde. Begeben Sie sich
an einen Ort mit
unversperrtem Blick in
den Himmel.
Satelliten \,@ Satelliten werden gesucht.
werden P a4 Dieser Vorgang kann
gesucht mehrere Minuten in
Anspruch nehmen.
Positionie- 0 Der Camcorder empfiangt
rung o‘. ein schwaches GPS-
Signal.
" Der Camc?rd’er empfingt
ol ein GPS-Signal.
Standortinformationen
konnen abgerufen werden.
P Der Camcorder empfiangt
"III ein starkes GPS-Signal.

Standortinformationen
konnen abgerufen werden.

¢ GPS ist standardmiBig auf On gesetzt. Wenn
die Positionierung aktiviert ist, zeichnet der
Camcorder Standort- und Zeitinformationen zu
den Videos auf. Zum Beenden der
Aufzeichnung dieser Informationen setzen Sie
GPS auf Off.

Nach dem Einschalten des Camcorders kann es

eine Weile dauern, bis die Positionierung
gestartet wird.

Falls auch nach mehreren Minuten noch kein
Positionierungssymbol angezeigt wird, liegt
moglicherweise ein Problem beim
Signalempfang vor. Sie konnen die Aufnahme
ohne Standortinformationen starten oder an
einen Ort mit unversperrtem Blick zum Himmel
wechseln. Wenn das Positionierungssymbol

wihrend der Aufnahme nicht angezeigt wird,
werden auch keine Standortinformationen
aufgezeichnet.

Bei Innenaufnahmen oder Aufnahmen in der
Nihe hoher Gebilde kann der Camcorder
moglicherweise kein GPS-Signal empfangen.
Begeben Sie sich an einen Ort mit
unversperrtem Blick in den Himmel.
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¢ Die Aufzeichnung von Standortinformationen
kann abreiflen, wenn die Signalstidrke abnimmt,
selbst wenn ein Positionierungssymbol
angezeigt wird.

Andern der Audiokanile mit
Tastenbefehlen

Uber die Option Audio Output >Monitor CH
(Seite 125) im Audio-Menii konnen Sie mit
belegbaren Tasten die konfigurierte Kombination
der Audiokanile dndern.

Sie konnen den iiber den integrierten
Lautsprecher oder Kopfhorer anzuhdrenden
Audiokanal auswihlen und die auf den einzelnen
Aufnahmekanilen aufgezeichneten Audiodaten
iiberpriifen.

Driicken Sie eine belegbare Taste, der die
Funktion Audio Monitor CH zugewiesen ist, und
wechseln Sie wie unten beschrieben den
Audiokanal.

Aktuelle Monitor CH- Einstellung nach

Einstellung Wechsel mithilfe von
Audio Monitor CH

CHI1/CH2 CHI1

CH3/CH4 CH3

MIX ALL Nicht anwendbar

CHI1 CH2

CH2 CHI1/CH2

CH3 CH4

CH4 CH3/CH4

Driicken Sie eine belegbare Taste, der die
Funktion Audio Mon. CH Switch zugewiesen ist,
und wechseln Sie wie unten beschrieben den
Audiokanal.

Aktuelle Monitor CH- Einstellung nach

Einstellung Wechsel mithilfe von
Audio Mon. CH
Switch

CHI1/CH2 CH3/CH4

CH3/CH4 CHI1/CH2

MIX ALL Nicht anwendbar

CHI CH3

CH2 CH4

CH3 CHI

CH4 CH2




* Wenn eine belegbare Taste gedriickt wird, der die
Funktion Audio Monitor CH oder Audio Mon. CH
Switch zugewiesen ist, wird die aktuelle Monitor CH-
Einstellung in einer Meldung angezeigt.
Um die Monitor CH-Einstellung zu @ndern, driicken
Sie withrend der Anzeige der Monitor CH-
Einstellungsmeldung die belegbare Taste, der Audio
Monitor CH oder Audio Mon. CH Switch zugewiesen
wurde.
* Wenn Monitor CH auf MIX ALL eingestellt ist, wird
der Audiokanal nicht umgeschaltet.

Planungsmetadaten

Planungsmetadaten sind Daten zur
Aufnahmeplanung, die in einer XML-Datei
aufgezeichnet werden.

Sie konnen mit Clipnamen und
Szenenmarkierungsnamen aufnehmen, die zuvor
in einer Planungsmetadatendatei definiert
wurden.

Sie konnen mithilfe der Anwendung ,,Content
Browser Mobile* Planungsmetadaten tiber ein
Netzwerk senden und empfangen.

Mit diesem Camcorder konnen Clipnamen und
Szenenmarkierungsnamen angezeigt werden, die
in den folgenden Sprachen definiert sind:

* Japanisch

* Englisch

* Chinesisch

* Deutsch

* Franzosisch

* Italienisch

* Spanisch

* Niederldndisch

* Portugiesisch

* Schwedisch

* Norwegisch

* Dinisch

* Finnisch

* Wenn Sie Clip- und Szenenmarkierungsnamen in
anderen als den oben aufgelisteten Sprachen
definieren, werden sie auf dem LCD-/
Sucherbildschirm unter Umsténden nicht angezeigt.
Wenn Sie Clip- und Szenenmarkierungsnamen in
Franzosisch, Niederldndisch oder Finnisch definieren,
werden manche Zeichen in einer anderen, aber
dhnlichen Schriftart angezeigt.
Um die angewendete Planungs-Metadatendatei bei der
automatischen Ubertragung der Originaldatei
zusammen mit dieser zu iibertragen, miissen ein
Medium in den UTILITY SD/MS-Einschub eingesetzt
und der Proxy-Aufzeichnungsmodus aktiviert sein.
In den folgenden Fillen werden keine
Planungsmetadaten iibertragen.
— Wenn das Medium wiihrend der Dateiiibertragung
voll wird
— Wenn wihrend der Ubertragung der Originaldatei
Einschiibe gewechselt werden oder die
automatische Aufzeichnungsfortsetzung verwendet
wird



Laden einer
Planungsmetadatendatei

Um Planungsmetadaten zusammen mit Clips
aufzuzeichnen, muss vorab eine
Planungsmetadatendatei in den Speicher des
Camcorders geladen werden.

Bei Verwendung einer SxS-
Speicherkarte

Setzen Sie die SxS-Speicherkarte, auf der die
Planungsmetadatendatei (.xml) im folgenden
Verzeichnis gespeichert ist, in den
Karteneinschub des Camcorders ein. Wihlen Sie
dann die Datei mithilfe von Planning Metadata
(Seite 136) >Load from Media(A) oder Load
from Media(B) im Media-Menii aus und laden
Sie sie.

Es wird ein Bildschirm mit einer Dateiliste
angezeigt.

Es werden bis zu 512 Planungs-Metadatendateien
in der Liste angezeigt.

Die Sortierreihenfolge der Dateiliste kann mit
Planning Metadata >Sort by im Media-Menii
gedndert werden.

,»S0rt by“-
Einstellung

Sortierreihenfolge

Date/Time (0-9) Dateiliste in aufsteigender
Reihenfolge nach Spalte
Date/Time sortieren (éltestes

Erstellungsdatum oben).

Bei Verwendung einer SDXC-Karte

Mit dem optionalen Medienadapter MEAD-
SDO02 konnen Sie eine Planungsmetadatendatei
von einer SDXC-Karte laden (Seite 30).

Legen Sie die SDXC-Karte, auf der die
Planungsmetadatendatei (.xml) im folgenden
Verzeichnis gespeichert ist, in den
Medienadapter ein und setzen Sie den
Medienadapter in den Speicherkartensteckplatz
des Camcorders ein.

Wihlen Sie Planning Metadata (Seite 136) >Load
from Media(A) oder Load from Media(B) im
Media-Menii aus, um die Datei zu laden.

Es wird ein Bildschirm mit einer Dateiliste
angezeigt.

Es werden bis zu 512 Planungs-Metadatendateien
in der Liste angezeigt.

Die Sortierreihenfolge der Dateiliste kann mit
Planning Metadata >Sort by im Media-Menii
gedndert werden.

,»Sort by
Einstellung

Sortierreihenfolge

Date/Time (0-9) Dateiliste in aufsteigender
Reihenfolge nach Spalte
Date/Time sortieren (dltestes

Erstellungsdatum oben).

Date/Time (9-0) Dateiliste in absteigender
Reihenfolge nach Spalte
Date/Time sortieren
(jiingstes Erstellungsdatum

oben).

Date/Time (9-0) Dateiliste in absteigender
Reihenfolge nach Spalte
Date/Time sortieren
(jiingstes Erstellungsdatum

oben).

Speicherverzeichnis fiir Planungs-
Metadatendateien

exFAT: XDROOT/General/Sony/Planning
UDF: General/Sony/Planning

« Bei Verwendung des FAT-Dateisystems konnen keine
Planungsmetadatendateien geladen werden.
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Speicherverzeichnis fiir Planungs-

Metadatendateien

exFAT: PRIVATE/XDROOT/General/Sony/
Planning

* Bei Verwendung des UDF/FAT-Dateisystems konnen
keine Planungsmetadatendateien geladen werden.

* Von einer SDHC/SD-Karte konnen keine Daten
geladen werden.

Anzeigen detaillierter Informationen in
den Planungsmetadaten

Nachdem Sie Planungsmetadaten in den
Camcorder geladen haben, konnen Sie deren
Inhalt wie Dateinamen, Datum und Uhrzeit der
Erstellung und Titel tiberpriifen.

Wiihlen Sie Planning Metadata (Seite 136)
>Properties >Execute im Media-Menii aus.



Entfernen der geladenen
Planungsmetadaten aus dem Speicher

Wenn Sie die in den Speicher des Camcorders
geladenen Planungsdaten daraus 16schen wollen,
gehen Sie folgendermalien vor:

Wiihlen Sie Planning Metadata (Seite 136)
>Clear Memory >Execute im Media-Menii aus.

Definieren eines Clipnamens in
den Planungsmetadaten

Die folgenden beiden Typen von

Clipnamenzeichenfolgen konnen in eine

Planungsmetadatendatei geschrieben werden.

¢ Name im ASCII-Format, der auf dem
Sucherbildschirm angezeigt wird

¢ Ein Name im UTF-8-Format, der tatséchlich als
Clipname registriert ist

Wenn Sie in den Planungsmetadaten einen

Clipnamen angeben, wird der Name unter der

Betriebsstatusanzeige auf dem Sucherbildschirm

angezeigt.

Beispiel fiir Clipnamenzeichenfolgen

Modifizieren Sie mit einem Texteditor die
Beschreibung fiir das Tag <Title> der
Planungsmetadaten.

Die im Beispiel schattierten Felder sind
Clipnamenzeichenfolgen.

. Typhoon* ist im ASCII-Format beschrieben (bis
zu 44 Zeichen). ,,Typhoon_Strikes* ist im UTF-
8-Format beschrieben (bis zu 44 Bytes).

,,Sp“ steht fiir ein Leerzeichen und « fiir einen
Zeilenumbruch.

<Txmlgpversion="1.0"gencoding="
UTF-8"7>¢=
<PlanningMetadatag,xmIns="http://
xmlns.sony.net/pro/metadata/
planningmetadata” gassignld="
P0001" g creationDate="
2011-08-20T17:00:00+09:00",
lastUpdate="
2011-09-28T10:30:00+09:00",
version="1.00">«
<Properties g,propertyld="
assignment" gpupdate="
2011-09-28T10:30:00+09:00",
modifiedBy="Chris">«

<Titleg,usAscii=" Typhoon "sp
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xml:lang="en"> Typhoon_Strikes
</Title>+
</Properties>+
</PlanningMetadata>«

* Geben Sie beim Erstellen einer Datei jede Anweisung
als einzelne Zeile ein und fiigen Sie erst nach dem
letzten Zeichen der Zeile mit CR (Zeilenumbruch)
einen Zeilenumbruch ein. Geben Sie Leerzeichen
ausschlieBlich in Form von ,,sp* ein.

Eine Zeichenfolge aus bis zu 44 Byte (bzw. 44
Zeichen) ist ein giiltiger Clipname.

‘Wenn die Zeichenfolge im UTF-8-Format mehr als 44
Byte umfasst, werden die ersten 44 Byte als Clipname
verwendet.

‘Wenn nur eine Zeichenfolge im ASCII-Format
festgelegt wird, wird der Name im ASCII-Format bis
zum 44. Zeichen als Clipname verwendet.

‘Wenn weder die Namenszeichenfolge im ASCII-
Format noch die im UTF-8-Format giiltig ist, wird ein
Clipname im Standardformat verwendet.

Verwenden eines in den
Planungsmetadaten definierten
Clipnamens

Laden Sie eine Planungsmetadatendatei mit dem
Clipnamen in den Speicher des Camcorders und
wihlen Sie dann Clip Naming (Seite 135) >Auto
Naming >Plan im Media-Menii aus.
Clipnamen werden durch Hinzufiigen eines
Unterstrichs (_) und einer fortlaufenden 5-
stelligen Nummer (00001 bis 99999) generiert.
Beispiel: Typhoon_Strikes_00001,
Typhoon_Strikes_00002, ...

* Wenn die fortlaufende Nummer 99999 erreicht, wird
bei der nichsten Aufnahme wieder mit 00001
begonnen.

* Wenn Sie eine andere Planungsmetadatendatei laden,
wird die fortlaufende 5-stellige Nummer auf 00001
zuriickgesetzt.

Definieren von
Szenenmarkierungsnamen in
Planungsmetadaten

Wenn Sie Szenenmarkierung 1 oder
Szenenmarkierung 2 aufzeichnen, konnen Sie der
Szenenmarkierung mit einer in den
Planungsmetadaten definierten Zeichenfolge
einen Namen zuweisen.



Beispiel fiir Szenenmarkierungsnamen-
Zeichenfolgen

Modifizieren Sie mit einem Texteditor die
Beschreibung fiir das Tag <Meta name> der
Planungsmetadaten.
Die im Beispiel schattierten Felder sind
Szenenmarkierungsnamen-Zeichenfolgen.
Namen konnen im ASCII-Format (bis zu 32
Zeichen) oder im UTF-8-Format (bis zu 16
Zeichen) vorliegen.

*“ steht fiir ein Leerzeichen und « fiir einen

»sp
Zeilenumbruch.

* Wenn eine Namenszeichenfolge ein Nicht-ASCII-
Zeichen enthilt, ist die maximale Linge dieser
Zeichenfolge auf 16 Zeichen begrenzt.

<?xmlgpversion="1.0"gencoding="
UTF-8"7>+

<PlanningMetadata xmlIns="http://
xmlns.sony.net/pro/metadata/
planningmetadata”,assignld="
HO00123" g creationDate="
2011-04-15T08:00:00Z" i, lastUpdate="
2011-04-15T15:00:00Z",version=

"1.00">
<Propertiesg,propertyld=
"assignment",class="original",

update="2011-04-15T15:00:00Z",
modifiedBy="Chris">«
<TitlegpusAscii="Football Game"
spxml:lang="en">
Football Game 15/04/2011
</Title>«
<Metag,name="_ShotMark1"
content=" Goal "/>«
<Metag,name="_ShotMark2"
content=" Shoot "/>«
</Properties>«+
</PlanningMetadata>«

P

P

¢ Geben Sie beim Erstellen einer Datei jede Anweisung

als einzelne Zeile ein und fiigen Sie erst nach dem
letzten Zeichen der Zeile mit CR (Zeilenumbruch)
einen Zeilenumbruch ein. Geben Sie Leerzeichen
ausschlieBlich in der Form ,,o,* auerhalb der
Szenenmarkierungsnamen-Zeichenfolgen ein.

Ubertragen von Planungs-
Metadatendateien

Sie konnen eine Planungs-Metadatendatei
gemeinsam mit Originaldateien oder
Proxydateien iibertragen.
Planungs-Metadatendateien konnen automatisch
iibertragen werden, wenn Auto Upload (Proxy)
auf On eingestellt wurde und eine SD-Karte
eingesetzt ist oder wenn sowohl Auto Upload als
auch Auto Upload (Proxy) auf On eingestellt
wurden und eine SD-Karte eingesetzt ist.
Einzelheiten zur Proxy-Aufzeichnung finden Sie
unter ,, Proxy-Aufzeichnung “ (Seite 61).
Einzelheiten zum Ubertragen von
Originaldateien und Proxy-Dateien finden Sie
unter ,, Hochladen einer Datei* (Seite 74).

« In den folgenden Fillen werden Planungs-

Metadatendateien nicht iibertragen.

— Wenn sich die Datei in ihrem endgiiltigen Zustand
befindet, da die Aufnahme stoppt, weil das Medium
voll wurde

— Wenn das Aufzeichnungsmedium aufgrund von
automatischer Aufzeichnungsfortsetzung oder
Simultanaufzeichnung in 2 Einschiiben wechselt:
Planungsmetadaten fiir die dem Medienwechsel
vorhergehende Datei werden nicht iibertragen. Die
Planungs-Metadatendatei wird fiir die Datei
iibertragen, sobald die Aufzeichnung nach dem
Medienwechsel stoppt.

— Wenn die Datei nach 6 Stunden Aufzeichnung
geteilt wird:

Planungsmetadaten fiir die dem Medienwechsel
vorhergehende Datei werden nicht angehéngt.

— Bei gleichzeitiger Verwendung von
kontinuierlicher Clipaufzeichnung und Proxy-
Aufzeichnung



Proxy-Aufzeichnung

Sie konnen wihrend der Aufzeichnung auf einer
SxS-Speicherkarte gleichzeitig Proxy-Daten auf
einer SD-Karte aufzeichnen.

Unterstiitzte SD-Karten

SDXC-Speicherkarten*
(Geschwindigkeitsklasse: 4 oder hoher)
SDHC-Speicherkarten*
(Geschwindigkeitsklasse: 4 oder hoher,
Kapazitit: bis zu 32 GB)
SD-Speicherkarten*
(Geschwindigkeitsklasse: 4 oder hoher,
Kapazitit: bis zu 2 GB)

* In diesem Handbuch mit dem Begriff ,,SD-Karte*
bezeichnet.

Formatieren (Initialisieren) von
SD-Karten

SD-Karten miissen bei der ersten Verwendung im
Camcorder zunidchst formatiert werden.
SD-Karten, die im Camcorder verwendet werden
sollen, sind mit der Formatierfunktion des
Camcorders zu formatieren. Wenn beim
Einsetzen einer SD-Karte in den Camcorder eine
Meldung angezeigt wird, muss die SD-Karte
formatiert werden.

1 Setzen Sie die SD-Karte mit dem Etikett
nach rechts weisend in den UTILITY
SD/MS-Einschub (Seite 10) ein.

2 Wihlen Sie Format Media (Seite 134)
>Utility SD/MS >Execute im Media-
Menii aus. Wihlen Sie beim Anzeigen
einer Bestiitigungsmeldung erneut
Execute.

Wihrend der Formatierung werden eine
Meldung und ein Fortschrittsstatus
angezeigt, und die Zugriffsanzeige leuchtet
rot.

Nach Abschluss der Formatierung wird eine
Abschlussmeldung angezeigt. Driicken Sie
die Taste SET oder den Regler SEL/SET, um
die Meldung auszublenden.

61

¢ Beim Formatieren einer SD-Karte gehen alle Daten auf
der Karte verloren. Die Karte kann nicht
wiederhergestellt werden.

¢ SDXC-Karten werden in exFAT, SDHC-Karten in
FAT32 formatiert.

Uberpriifen der Restkapazitit

Die Restkapazitit auf einer SD-Karte kann im
Bildschirm ,,Media Status* (Seite 18) tiberpriift
werden.

* Wenn die SD-Karte geschiitzt ist, wird ein @
angezeigt.

Verwenden eines im Camcorder formatierten

Mediums im Einschub eines anderen Gerits

Erstellen Sie zunichst eine Sicherheitskopie der Karte,
und formatieren Sie die Karte dann in dem Geriit, in dem
sie verwendet werden soll.

Proxy-Aufnahme (Proxy Rec)

Konfiguration vor der Aufzeichnung

1 Setzen Sie Proxy Rec >Setting im
Recording-Menii auf On.

2 Setzen Sie die SD-Karte mit dem Etikett
nach rechts weisend in den UTILITY
SD/MS-Einschub (Seite 10) ein.

Proxy Rec kann nicht gleichzeitig mit S&Q Motion,
Interval Rec, Picture Cache Rec, 2-slot Simul Rec oder
4K & HD (Sub) Rec auf On eingestellt werden.
‘Wenn Proxy Rec auf On eingestellt ist, werden andere
Aufzeichnungsfunktionen als S&Q Motion fest auf
Off eingestellt.

‘Wenn Proxy Rec auf On und S&Q Motion auf On
eingestellt sind, ist Proxy Rec voriibergehend auf Off
eingestellt. Wenn S&Q Motion auf Off eingestellt
wird, so wird Proxy Rec wieder auf On eingestellt.

Aufnahmen eines Proxy

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

* Die Integritit der Daten auf der SD-Karte kann nicht
garantiert werden, wenn wihrend des Zugriffs auf die
SD-Karte der Camcorder ausgeschaltet oder die Karte



entnommen wird. Moglicherweise gehen alle Daten
auf der Karte verloren. Stellen Sie stets sicher, dass die
Zugriffsanzeige erloschen ist, bevor Sie den
Camcorder ausschalten oder die SD-Karte entfernen.

 Passen Sie auf, dass die SD-Karte beim Einsetzen und
Auswerfen nicht herausfliegt.

Stoppen Sie zum Beenden die Aufnahme.

Wenn die Aufnahme auf eine SxS-Speicherkarte
gestoppt wird, wird die Proxy-Aufnahme
ebenfalls gestoppt.

Andern der Einstellungen fiir die
Proxy-Aufzeichnung

Einstellen der BildgrdBe

Wiihlen Sie Proxy Rec >Proxy Format im
Recording-Menii aus, und legen Sie die
Bildgrofe fest.

Festlegen des Audiokanals

Wihlen Sie Proxy Rec >Audio Channel im
Recording-Menii aus und legen Sie den
Audiokanal fiir die Proxy-Aufzeichnung fest.

Aufzeichnen und Hochladen einer
Proxy-Datei

Wenn die Einstellung fiir das automatische
Hochladen auf Chunk gesetzt ist und eine Proxy-
Datei entsprechend dem folgenden Verfahren in
Blocken aufgezeichnet wird, kann die Proxy-
Datei wihrend der Hauptaufnahme hochgeladen
werden.

1 Wiihlen Sie im Menii ,,Recording* die
Option Proxy Rec.

2 Wihlen Sie Proxy Rec >Chunk und
wihlen Sie das
Blockaufzeichnungsintervall.
30sec: Proxy-Datei in 30-Sekunden-
Blocken aufzeichnen
(Standardeinstellung).

1min: Proxy-Datei in 1-Minuten-Blocken
aufzeichnen.

2min: Proxy-Datei in 2-Minuten-Blscken
aufzeichnen.
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3 Setzen Sie die Option File Transfer
>Auto Upload (Proxy) im Menii
,,Network‘ auf Chunk.

4 Starten Sie die Proxy-Aufzeichnung.

Die Proxy-Datei wird in Blocken mit dem
angegebenen Intervall aufgezeichnet und die
einzelnen Blocke werden in der Jobliste als
Ubertragungsjobs registriert.

* Wenn Auto Upload (Proxy) nicht auf Chunk
eingestellt ist, erfolgt keine Proxy-Aufzeichnung
in Blocken.

Hinweis zur aufgenommenen
Datei

Die Dateinamenerweiterung lautet ,,.mp4*.
Der Timecode wird ebenfalls gleichzeitig
aufgezeichnet.

Speicherzielort der
aufgenommenen Datei

Die aufgenommene Datei wird im Verzeichnis
/PRIVATE/PXROOT/Clip* gespeichert.

Hinweis zum Dateinamen

Der Dateiname besteht aus dem Namen des auf

den SxS-Speicherkarten aufgezeichneten Clips

und einer fortlaufenden Nummernendung.

¢ Die fortlaufende Nummer wird beibehalten, auch
wenn der Camcorder ausgeschaltet wird. Die
fortlaufende Nummer wird auf 0001 zuriickgesetzt,
wenn All Reset ausgefiihrt wird.

Einzelheiten zu Clipnamen siehe Clip Naming

(Seite 135) im Media-Menii.

Aufnehmen von Proxy-Daten
allein

Sie konnen Proxy-Daten unabhingig auf einer
SD-Karte im UTILITY SD/MS-Einschub
aufzeichnen, ohne auf eine SxS-Speicherkarte
aufzuzeichnen.

Das Aufnahmeformat der Proxy-Daten ist
identisch mit dem fiir gleichzeitige
Aufzeichnung.



Konfiguration vor der Aufzeichnung

1 Weisen Sie die Funktion Proxy Rec
Start/Stop einer belegbaren Taste zu
(Seite 47).

2 Setzen Sie Proxy Rec >Setting im
Recording-Menii auf On.

3 Setzen Sie die SD-Karte mit dem Etikett
nach rechts weisend in den UTILITY
SD/MS-Einschub (Seite 10) ein.

Aufzeichnung lauft

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.
Driicken Sie die mit Proxy Rec Start/Stop
belegte belegbare Taste.

Um die Aufzeichnung anzuhalten, driicken Sie
die belegbare Taste.
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Verbinden mit anderen
Geraten iiber LAN

Der Camcorder kann iiber eine LAN-Verbindung
mit Smartphones, Tablets und anderen Geriten
verbunden werden.

Indem Sie eine LAN-Verbindung zwischen
einem Gerit und dem Camcorder herstellen,
konnen Sie mithilfe der Web-Fernbedienung
(Seite 85) oder der Anwendung ,,Content
Browser Mobile* die im Folgenden aufgefiihrten
Funktionen nutzen.

 Planungsmetadaten (Seite 57)

Senden und empfangen Sie Planungsmetadaten
mithilfe des Gerits und des Camcorders.

Sie konnen zuvor erstellte Planungsmetadaten
an den Camcorder senden, um Clipnamen
anzugeben.

Fernbedienung iiber ein LAN

Sie konnen den Camcorder von einem
Smartphone, Tablet oder Computer aus steuern,
das bzw. der iiber das LAN mit dem Camcorder

verbunden ist.

Dateiiibertragung iiber ein LAN

Sie konnen eine auf einer SD-Karte im
Camcorder aufgezeichnete Proxy-Datei
(niedrige Auflosung) oder eine mit dem
Camcorder aufgezeichnete Originaldatei (hohe
Auflosung) tiber ein LAN an einen Server
iibertragen.

Video-Priifung per LAN

Sie konnen das Kamerasignal oder das
Wiedergabevideo des Camcorders als Stream
(H.264) iibertragen lassen und mithilfe der
Anwendung ,,Content Browser Mobile* auf
einem Geriit iiber ein LAN priifen.

Anwendung ,,Content Browser Mobile*

Sie konnen den Camcorder vom
Geritebildschirm aus wihrend des Streaming
fernsteuern und die Einstellungen des
Camcorders mit der Anwendung ,,Content
Browser Mobile* konfigurieren.

Informationen zur Anwendung ,, Content Browser
Mobile* erhalten Sie beim zustindigen Sony-
Kundendienst oder einer Handelsvertretung.



« Bei Geriten ab Version 3.00 verwenden Sie Content
Browser Mobile ab Version 3.2.0.

Streaming von hoher Qualitét mit QoS-
Technologie von Sony (Seite 79)
Sie konnen Video von hoher Qualitit mithilfe
einer Network RX Station von Sony (separat
erhiltlich) oder C3 Portal* Connection Control
Manager (CCM) per Streaming iibertragen, die
im Netzwerk-Client-Modus mit dem Camcorder
verbunden sind.
* C3 Portal ist ein Cloud-Dienst, der von Sony
bereitgestellt wird.
Wenn Sie diesen Dienst nutzen wollen, ist eine
Registrierung erforderlich.
C3 Portal wird in einigen Regionen nicht bereitgestellt.
Ausfiihrliche Informationen zu den Gebieten, in denen
der Dienst bereitgestellt wird, finden Sie auf der
folgenden Website.
https://www.c3p.sony.net
Einzelheiten zur Datenschutzrichtlinie von C3 Portal
finden Sie auf den folgenden Webseiten.
— Nutzungsbedingungen
https://www.c3p.sony.net/site/tos_eu.html
— C3 Portal-Datenschutzrichtlinie
https://www.c3p.sony.net/site/
c3p_privacy_policy.html
— Professional ID-Datenschutzrichtlinie
https://www.pro-id.sony.net/#/privacyPolicy
Um weitere Informationen zu erhalten, wenden Sie
sich an Vertriebsmitarbeiter von Sony Professional.

Herstellen einer Verhindung im
WLAN-Zugangspunktmodus

Der Camcorder fungiert als Zugangspunkt und
stellt eine Verbindung zu einem Gerit iiber ein
WLAN her.

Smartphone/ Computer

e |j
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Schnelles Herstellen einer Verbindung
mit einem NFC-kompatiblen Gerat

NFC-fahige Gerite konnen mithilfe der
Nahfelderkennung per Beriihrung verbunden
werden.

1

Offnen Sie auf dem Geriit das Menii
[Settings], wihlen Sie [More], und
aktivieren Sie das Kontrollkistchen
neben [NFC].

NFC

v =

Schalten Sie den Camcorder ein.

Aktivieren Sie die NFC-Funkion.

Um den NFC-Verbindungsmodus zu
aktivieren, halten Sie eine mit NFC belegte
belegbare Taste drei Sekunden lang gedriickt
oder wihlen Sie Wireless LAN >NFC im
Network-Menti aus.

Die NFC-Funktion steht nur zur Verfiigung,
solange [N] auf dem Bildschirm erscheint.

Beriihren Sie mit dem Geriit den
Camcorder.

Das Geriit verbindet sich mit dem Camcorder
und ,,Content Browser Mobile* wird
gestartet.

* Deaktivieren Sie vorher den Schlafmodus und die
Bildschirmsperre.



* Beriihren Sie das Gerit, und halten Sie es still, bis die
Anwendung ,,Content Browser Mobile* gestartet wird
(ca. 1 bis 2 Sekunden).

Herstellen der Verbindung mit einem
WPS-kompatiblen Gerat

Gerite, die WPS unterstiitzen, konnen mithilfe
von WPS verbunden werden.

1 Wiihlen Sie Wireless LAN >Setting
>Access Point Mode im Network-Menii
aus.

2 Wiihlen Sie Wireless LAN >WPS
>Execute im Network-Menii aus.

3 Aktivieren Sie in den Netzwerk- oder
WLAN:-Einstellungen des Geriits die
WLAN-Funktion.

4 Wiihlen Sie am zu verbindenden Ger:it
aus der SSID-Liste der WLAN-
Netzwerke die SSID des Camcorders
und dann WPS Push Button in den
Optionen aus.

Das Verfahren hingt vom jeweiligen Gerit ab.
Informationen zu SSID und Passwort des Camcorders
finden Sie unter AP Mode Settings (Seite 139)
>Camera SSID & Password im Network-Menii.

Aus Sicherheitsgriinden wird empfohlen, ein Passwort
mit einer ausreichend langen, fiir andere schwer zu
erratenden Zeichenkette zu setzen und sicher
aufzubewahren.

5 Rufen Sie die Web-Fernbedienung auf
(Seite 86). Alternativ stellen Sie die
Verbindung mithilfe der Anwendung
,,Content Browser Mobile‘ her.

Herstellen der Verbindung durch Eingabe
von SSID und Passwort am anderen
Gerat

Sie konnen die Verbindung zwischen dem
Camcorder und einem Geriit herstellen, indem Sie
an diesem Gerit die SSID und das Passwort
eingeben.

1 Wihlen Sie Wireless LAN >Setting
>Access Point Mode im Network-Menii
aus.

2 Aktivieren Sie in den Netzwerk- oder
WLAN:-Einstellungen des Geriits die
WLAN-Funktion.

3 Verbinden Sie das Gerit mit dem
Camcorder, indem Sie die SSID des
Camcorders aus der SSID-Liste unter
Wi-Fi Network auswiihlen und das
Passwort eingeben.

Informationen zu SSID und Passwort des
Camcorders finden Sie unter AP Mode
Settings (Seite 139) >Camera SSID &
Password im Network-Menii.

Das Verfahren hingt vom jeweiligen Gerit ab.
Informationen zu SSID und Passwort des Camcorders
finden Sie unter AP Mode Settings (Seite 139)
>Camera SSID & Password im Network-Menii.

Aus Sicherheitsgriinden wird empfohlen, ein Passwort
mit einer ausreichend langen, fiir andere schwer zu
erratenden Zeichenkette zu setzen und sicher
aufzubewahren.

4 Rufen Sie die Web-Fernbedienung auf
(Seite 86). Alternativ stellen Sie die
Verbindung mithilfe der Anwendung
,,Content Browser Mobile‘ her.

Herstellen einer Verbindung im
WLAN-Stationsmodus

Der Camcorder stellt eine Verbindung zu einem
vorhandenen Zugangspunkt des WLAN als
Client her. Der Camcorder und das andere Gerit
werden iiber den Zugangspunkt verbunden.

Im Verlauf sind die letzten zehn Zugangspunkte
aufgefiihrt, mit denen eine Verbindung
hergestellt wurde.

Der Verbindungsverlauf wird in einer ALL-Datei
gespeichert, die Kennworter werden jedoch nicht
gespeichert. Beim néchsten Herstellen der
Verbindung nach dem Laden der ALL-Datei
muss das Passwort eingegeben werden.



Smartphone/
Tablet

Computer

Zugangs-
punkt

Verhindung mit einem Zugangspunkt
mittels WPS herstellen

Wenn der Zugangspunkt mit der WPS-Funktion
kompatibel ist, konnen Sie die Verbindung zum
Zugangspunkt mit einfachen Einstellungen
herstellen.

1 Schalten Sie den Zugangspunkt ein.
2 Schalten Sie den Camcorder ein.

3 Wihlen Sie Wireless LAN >Setting
>Station Mode im Network-Menii aus.

4 Wiihlen Sie Wireless LAN >WPS
>Execute im Network-Menii aus.

O Driicken Sie die WPS-Taste am
Zugangspunkt.
Einzelheiten zur Funktion der WPS-Taste
finden Sie in der Bedienungsanleitung zum
Zugangspunkt.
Wenn die Verbindung erfolgreich hergestellt
wurde, signalisiert die Netzwerkstatusanzei-
ge auf dem LCD-/Sucherbildschirm eine
Stirke von 1 oder hoher.

* Wenn die Verbindung fehlschligt, fiihren Sie die
Schritte ab Schritt 1 erneut aus.

6 Verbinden Sie das andere Gerit mit
dem Zugangspunkt.
Einzelheiten zum Herstellen der Verbindung
finden Sie in der Bedienungsanleitung zum
anderen Gerit.

T Rufen Sie die Web-Fernbedienung auf
(Seite 86). Alternativ stellen Sie die
Verbindung mithilfe der Anwendung
,,Content Browser Mobile‘ her.

Verbindung mit einem Zugangspunkt
mittels automatischer
Netzwerkerkennung oder manuell
herstellen

Sie konnen iiber das Einstellmenii die
Verbindung mit einem gewiinschten
Zugangspunkt konfigurieren.

Sie konnen die Verbindung mit einem
gewiinschten Zugangspunkt mittels
automatischer Netzwerkerkennung
konfigurieren.

Verhinden mithilfe der automatischen
Netzwerkerkennung

1 Fiihren Sie die Schritte 1 bis 3 unter
,, Verbindung mit einem Zugangspunkt
mittels WPS herstellen* (Seite 66) durch.

2 Wiihlen Sie ST Mode Settings >Scan
Networks (Seite 141) >Execute im
Network-Menii aus.

Der Camcorder beginnt mit der Erkennung
von Verbindungszielen.

Die erkannten Verbindungsziele werden in
der Liste Scan Networks angezeigt.

3 Wihlen Sie mithilfe der Tasten 4/%/«/»
oder dem Regler SEL/SET eine
Verbindung aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Daraufhin wird ein Bildschirm mit
Einzelheiten zum Netzwerk (Zugangspunkt)
angezeigt. Die ausgewihlte Verbindung wird
unter SSID angezeigt.

4  Wiihlen Sie Password aus und legen Sie
das Passwort auf dem
Passworteingabebildschirm fest.



Wenn Sie im Verbindungsverlauf eine SSID
auswihlen, werden die Einstellungen
einschlieBlich des Passworts automatisch
konfiguriert.

Legen Sie das Passwort fest, um zum
Bildschirm mit Einzelheiten zum Netzwerk
(Zugangspunkt) zuriickzukehren.

Konfigurieren Sie die folgenden
Verbindungseinstellungen.

« DHCP

Legen Sie die DHCP-Einstellung fest.
Wenn Sie die Option auf On setzen, wird
die IP-Adresse dem Camcorder
automatisch zugewiesen.

Wenn Sie die IP-Adresse dem Camcorder
manuell zuweisen wollen, stellen Sie Off
ein.

IP Address

Geben Sie die IP-Adresse des Camcorders
ein. Diese Einstellung steht nur zur
Verfiigung, wenn DHCP auf Off eingestellt
ist.

Subnet Mask

Geben Sie die Subnetzmaske des

Camcorders ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.
Gateway

Geben Sie das Standard-Gateway fiir den
Zugangspunkt ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.

DNS Auto

Mit dieser Einstellung konnen Sie DNS
automatisch abrufen.

Wenn Sie On einstellen, wird die DNS-
Serveradresse automatisch abgerufen.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf On eingestellt ist.
Primary DNS Server

Geben Sie den primédren DNS-Server fiir
den Zugangspunkt ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.
Secondary DNS Server

Geben Sie den sekundidren DNS-Server fiir
den Zugangspunkt ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.
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6 Wiihlen Sie abschlieBend Connect aus,

um die Verbindung mit dem
Zugangspunkt herzustellen.

Manuell verbinden

1

Fiihren Sie die Schritte 1 bis 3 unter
,, Verbindung mit einem Zugangspunkt
mittels WPS herstellen* (Seite 66) durch.

Wiihlen Sie ST Mode Settings >Manual
Register (Seite 141) >Execute im
Network-Menii aus.

Daraufhin wird ein Bildschirm mit
Einzelheiten zum Netzwerk (Zugangspunkt)
angezeigt.

Konfigurieren Sie die folgenden
Verbindungseinstellungen.

* SSID
Geben Sie die SSID fiir den Zugangspunkt
ein.
* Security
Wiihlen Sie die Verschliisselungsmethode
aus.
* Password
Geben Sie das Passwort fiir den
Zugangspunkt ein.
* DHCP
Legen Sie die DHCP-Einstellung fest.
Wenn Sie die Option auf On setzen, wird
die IP-Adresse dem Camcorder
automatisch zugewiesen.
Wenn Sie die IP-Adresse dem Camcorder
manuell zuweisen wollen, stellen Sie Off
ein.
IP Address
Geben Sie die IP-Adresse des Camcorders
ein. Diese Einstellung steht nur zur
Verfiigung, wenn DHCP auf Off eingestellt
ist.
Subnet Mask
Geben Sie die Subnetzmaske des
Camcorders ein.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.
Gateway
Geben Sie die Adresse des Gateway ein.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.
DNS Auto
Mit dieser Einstellung konnen Sie DNS
automatisch abrufen.



Wenn Sie On einstellen, wird die DNS-
Serveradresse automatisch abgerufen.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf On eingestellt ist.
Primary DNS Server

Geben Sie die Adresse des primédren DNS-
Servers ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.
Secondary DNS Server

Geben Sie die Adresse des sekundiren
DNS-Servers ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.

4 Wihlen Sie abschlieBend Connect aus,
um die Verbindung mit dem
Zugangspunkt herzustellen.

Herstellen einer Verbhindung mit
einem Gerat per LAN-Kabel

Sie konnen die Verbindung mit einem Gerit
herstellen, indem Sie den Anschluss fiir
verkabeltes LAN des Camcorders iiber ein LAN-
Kabel mit einem Switch verbinden.

Computer

LAN-Switch
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* Verkabeltes LAN kann nicht gleichzeitig mit einem
Modem/Smartphone verwendet werden.

Verkaheltes LAN und
Videoausgangskombinationen

Verkabeltes LAN kann nicht verwendet werden,
wenn zwei oder mehr der Einstellungen Output
On/Off (Seite 125) >SDI, HDMI und VIDEO im
Video-Menii auf On gesetzt sind.
StandardméBig sind unter Output On/Off alle
Optionen auf On gesetzt. Um verkabeltes LAN
verwenden zu konnen, setzen Sie mindestens
zwei Ausginge unter Output On/Offauf Off.
Um verkabeltes LAN und WLAN gleichzeitig
verwenden zu konnen, setzen Sie alle Ausginge
unter Output On/Off auf Off.

* Wenn verkabeltes LAN und Videoausgabe
gleichzeitig verwendet werden, sinkt die Helligkeit des
LCD-Bildschirms.

Verbhindungen und Einstellungen fiir
verkabeltes LAN

1 Verbinden Sie den Anschluss fiir
verkabeltes LAN des Camcorders iiber
ein LAN-Kabel mit einem Switch.

2 Schalten Sie den Camcorder ein.

3 Setzen Sie Wired LAN (Seite 142)
>Setting im Network-Menii auf On.

4 Konfigurieren Sie die
Verbindungseinstellungen mithilfe von
Detail Settings im Menii.

« DHCP

Legen Sie die DHCP-Einstellung fest.
Wenn Sie die Option auf On setzen, wird
die IP-Adresse dem Camcorder
automatisch zugewiesen.

Wenn Sie die IP-Adresse dem Camcorder
manuell zuweisen wollen, stellen Sie Off
ein.

IP Address

Geben Sie die IP-Adresse des Camcorders
ein. Diese Einstellung steht nur zur
Verfiigung, wenn DHCP auf Off eingestellt
ist.



¢ Subnet Mask

Geben Sie die Subnetzmaske des
Camcorders ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.
Gateway

Geben Sie die Adresse des Gateway ein.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.

DNS Auto

Mit dieser Einstellung konnen Sie DNS
automatisch abrufen.

Wenn Sie On einstellen, wird die DNS-
Serveradresse automatisch abgerufen.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf On eingestellt ist.
Primary DNS Server

Geben Sie die Adresse des primédren DNS-
Servers ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.
Secondary DNS Server

Geben Sie die Adresse des sekundiren
DNS-Servers ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.

5 Wihlen Sie abschlieBend Set aus, um
die Einstellungen zu iibernehmen.

» Wiihlen Sie nach dem Andern der
Verbindungseinstellungen stets Set aus. Falls Sie Set
nicht auswihlen, werden die Einstellungen nicht
ibernommen.
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Herstellen einer
Verbindung mit dem
Internet

Sie konnen den Camcorder iiber ein Modem, ein
Smartphone, iiber verkabeltes LAN oder WLAN
mit dem Internet verbinden.

Herstellen der Verbindung iiber
ein Modem/Smartphone

Sie konnen den Camcorder iiber ein 3G-/4G-
Netzwerk mit dem Internet verbinden, wenn Sie
ein gesondert erhiltliches Modem an das Geriit
anschlielen.

Indem Sie mehr als ein Modem/Smartphone
anschlieBen und zur gleichen Zeit verwenden,
konnen Sie Streaming hoher Qualitit im
Netzwerk-Client-Modus verwenden und dank
zweier Leitungen hohere Qualitit und
Geriteredundanz erzielen.

Einzelheiten zu kompatiblen Modems und
Smartphones erhalten Sie bei Threm Sony-
Hindler oder einem Sony-
Kundendienstmitarbeiter.

* Ein Modem/Smartphone kann nicht gleichzeitig mit
einem verkabelten LAN verwendet werden.

* Ein Modem/Smartphone kann nicht mit dem Akku
BP-35 verwendet werden.

¢ Wenn ein Modem/Smartphone und Videoausgabe
gleichzeitig verwendet werden, sinkt die Helligkeit des
LCD-Bildschirms.

Anbringen eines Modems/Smartphones
am Camcorder

Bringen Sie auf eine der folgenden Methoden ein
Modem/Smartphones am Camcorder an.

Anbringen am USB 2.0 (HOST)- oder USB 3.0
(HOST)-Anschluss

Bringen Sie ein Modem an, das den USB-
Standard des jeweiligen Anschlusses unterstiitzt.
Sie konnen zwei Modems/Smartphones
gleichzeitig verwenden, indem sie diese mit
beiden Anschliissen verbinden.



¢ Schalten Sie den Camcorder aus, wenn Sie das
Modem/Smartphone anbringen bzw. abnehmen
wollen.

« Wenn Sie ein iiber einen eigenen Hub angeschlossenes
Modem/Smartphone verwenden, kann kein mit dem
USB 3.0 (HOST)-Anschluss verbundenes Modem/
Smartphone verwendet werden.

Verhinden eines Modems/Smartphones iiber
einen eigenen, mit dem USB 2.0 (HOST)-
Anschluss verbundenen USB-Hub (CBK-DL1)
Uber einen eigenen, mit dem USB 2.0 (HOST)-
Anschluss verbundenen USB-Hub konnen ein
oder zwei Modems/Smartphones angeschlossen
werden.

¢ Schalten Sie den Camcorder aus, wenn Sie das
Modem/Smartphone und den gesonderten USB-Hub
anbringen bzw. abnehmen méochten.

« Wenn ein eigener Hub angeschlossen ist, kann kein mit
dem USB 3.0 (HOST)-Anschluss verbundenes
Modem/Smartphone verwendet werden.

Konfigurieren der Netzwerkeinstellungen
mit dem Hilfstool fiir die
Netzwerkeinrichtung

Bei einer Verbindung iiber ein Smartphone muss
die Kombination aus gleichzeitig nutzbaren
Netzwerkfunktionen und Videoausgabe
konfiguriert werden. Diese Einstellungen kénnen
einfach mit dem Hilfstool fiir die
Netzwerkeinrichtung konfiguriert werden.
Dariiber hinaus kann das Hilfstool fiir die
Netzwerkeinrichtung einen QR-Code mit den
Informationen erstellen, die fiir den Zugriff auf
den Camcorder erforderlich sind.

Installieren Sie zunéchst die spezielle C3 Portal-
Anwendung auf Threm Smartphone, um diese
Funktion verwenden zu konnen.

1 Schalten Sie den Camcorder ein.

2 Wiihlen Sie im Menii ,,Network* die
Option Setup for Mobile App >Setup.

Ein Bildschirm zur Auswahl der Funktion
wird angezeigt.

p for Mobile App
a function to use simultaneously with the modem
SDI HDMI

VIDEO OUT  Wireless LAN

AP Mode
ST Mode

Cancel Next

3 Wiihlen Sie mithilfe der Tasten #/%/</»
oder des Reglers SEL/SET die zu
verwendende Kombination aus.

4  Wihlen Sie Next.

Setup for Mobile App 01/02
Select a function to use simultaneously with the modem
SDI HDMI VIDEO OUT  Wireless LAN
* On
On

AP Mode
ST Mode

Cancel Next

Ein Konfiguration-Bestitigungsbildschirm
wird angezeigt.

) Uberpriifen Sie die Einstellungen und
wiihlen Sie OK.

Die Konfiguration wird gestartet. Wihrend
der Konfiguration wird die Meldung
,.Changing* angezeigt.

Wenn die Konfiguration abgeschlossen ist,
wird der folgende Bildschirm angezeigt.

Setup for Mobile App
User Name
admin

Password

ac2ac2C5

Serial Number

0000000000

¢ Achten Sie darauf, dass das Passwort nicht
eingesehen und das QR-Code-Bild nicht von
anderen kopiert werden kann.



6 Starten Sie die auf Threm Smartphone
installierte spezielle C3 Portal-
Anwendung und scannen Sie den QR-
Code mithilfe der Kamera des
Smartphones.

Einzelheiten zur Verwendung der speziellen
C3 Portal-Anwendung siehe Hilfe zur
speziellen C3 Portal-Anwendung.

Die zum Zugriff auf den Camcorder
erforderlichen Informationen werden in das
Smartphone geladen.

Einzelheiten zur speziellen Anwendung
erhalten Sie auf der C3 Portal-Website.
https://www.c3p.sony.net

¢ Um das Videoformat oder die WLAN-

Einstellungen zu dndern, setzen Sie zuniichst alle

Einstellungen unter Output On/Off im Video-

Menii auf Off und Modem >Setting im Network-

Menii auf Off.
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Herstellen einer Verbindung im
WLAN-Stationsmodus (WLAN-
Stationsmodus)

Sie konnen den Camcorder iiber einen gesondert
erhiltlichen WLAN-Router im WLAN-
Stationsmodus oder durch Tethering mit einem
anderen Gerit mit dem Internet verbinden.

Smartphone/ Computer

Tablet

WLAN-Router

©

Internet

Smartphone/
Tablet

Internet

Stellen Sie die Verbindung zum WLAN-Router
oder zum Gerit wie unter ,, Herstellen einer
Verbindung im WLAN-Stationsmodus “ (Seite 65)
beschrieben her.


https://www.c3p.sony.net

Verbindung per LAN-Kabel

Sie konnen die Verbindung mit einem Gerit
herstellen, indem Sie den Anschluss fiir
verkabeltes LAN des Camcorders iiber ein LAN-
Kabel mit einem Internet-Router verbinden.

Computer

Router

©

Internet

Stellen Sie die Verbindung zum Internet-Router
wie unter ,, Herstellen einer Verbindung mit
einem Geriit per LAN-Kabel* (Seite 68)
beschrieben her.
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Liste der Funktionen fiir Netzwerkverbindungen

In der folgenden Tabelle wird aufgefiihrt, welche Netzwerkfunktionen in den Netzwerkverbindungsmodi
verfiigbar sind.

Netzwerkfunktion Netzwerkverbindungsmodus

Access Point  Station Modem Wired LAN  Off
Dateilibertragung 3 O @] ob 3
(Seite 74)
Streaming X O @] O X
(Seite 77)
RTMP-Streaming
(Seite 82)
Priifung ob ob X ob X
(Seite 87)
Fernbedienung des ob ob 3 ob 3
Camcorders
(Seite 85)

1) Funktionen eines iiber ein Netzwerk mit dem Camcorder verbundenen Gerits
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Hochladen einer Datei

Sie konnen eine Proxy-Datei oder eine
Originaldatei, die auf dem Camcorder
aufgezeichnet wurde, iiber ein 3G/4G-Netzwerk
oder einen Zugangspunkt auf einen Server im
Internet oder im lokalen Netzwerk hochladen.

» Wihrend des Streaming wird die Ubertragung
unterbrochen. Sie wird fortgesetzt, wenn das
Streaming beendet wurde.

Wenn Sie in XAVC-I 3840x2160P 59.94/50P
aufzeichnen, wird die Ubertragung unterbrochen.
Sie wird fortgesetzt, wenn die Aufzeichnung
beendet wurde.

Bei einer Wiedergabe wihrend der
Dateitibertragung kann das Bild des
Wiedergabebildschirms verzerrt dargestellt
werden.

Vorbereitungen

Mit einem Netzwerk verbinden

Verbinden Sie den Camcorder wie unter

., Herstellen einer Verbindung mit dem Internet
(Seite 69) beschrieben mit dem Internet oder
lokalen Netzwerk.

Erforderliche
Dateiiibertragungseinstellungen
automatisch konfigurieren (Smartphone-
Verbindung)

Sie konnen bei vorhandener Netzwerkverbindung
die zur Dateiiibertragung von einem Smartphone
auf den Camcorder erforderlichen Einstellungen
mithilfe eines Smartphones senden, auf dem die

spezielle C3 Portal-Anwendung installiert ist.

1 Senden Sie die Informationen zur
Dateiiibertragung mithilfe der speziellen
C3 Portal-Anwendung auf einem
Smartphone an den Camcorder.
Einzelheiten zur Verwendung der speziellen
C3 Portal-Anwendung siehe Hilfe zur
speziellen C3 Portal-Anwendung.

Wenn der Camcorder die Informationen zur
Dateiiibertragung erfolgreich empfingt, wird
die folgende Meldung angezeigt.
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Network File received.
Load File?

OK

2 Wiihlen Sie OK aus.

Die Setup-Informationen werden geladen.
Wenn das Setup erfolgreich geladen wurde,
wird die Meldung ,,Network File loaded.*
angezeigt.

Automatisch konfigurierte Elemente
Einzelheiten zu den automatisch konfigurierten
Elementen finden Sie in Schritt 2 des folgenden
Abschnitts ,,Registrieren eines Ziels fiir die
Dateiiibertragung*.

* Das Root Certificate kann nicht automatisch festgelegt
werden. Konfigurieren Sie dieses manuell.

Registrieren eines Ziels fiir die
Dateiiibertragung

Registrieren Sie vorab den Server fiir das
Hochladen.

1 Wiihlen Sie File Transfer >Server
Settings1 (oder Server Settings2, Server
Settings3) im Network-Menii aus.

Der Bildschirm zur Einrichtung des
Ubertragungsziels wird angezeigt.

2 Konfigurieren Sie die Optionen auf dem
Bildschirm zur Einrichtung des
Ubertragungsziels.

Display Name

Geben Sie den in der Liste der
Ubertragungsziele anzuzeigenden Namen
des Servers ein.

Service
Zeigt den Servertyp an.
FTP“: FTP-Server

Host Name
Geben Sie die Adresse des Servers ein.

Port
Geben Sie die Portnummer des Servers ein,
zu dem eine Verbindung hergestellt werden
soll.

User Name
Geben Sie den Benutzernamen ein.



Password
Geben Sie das Passwort ein.

Passive Mode
Zum Ein-/Ausschalten des passiven Modus.

Destination Directory
Geben Sie den Namen des Verzeichnisses
auf dem Zielserver ein.

Beim Bearbeiten werden Zeichen, die nicht
inderbar sind, mit ,,[1* gekennzeichnet. Wenn
Sie einen Verzeichnisnamen bearbeiten, der diese
Zeichen enthilt, wird fehlerfreie Funktion nicht
garantiert. Falls eine Bearbeitung erforderlich ist,
16schen Sie alle Zeichen und geben erneut einen
Wert ein.

Falls in Destination Directory Zeichen
eingegeben werden, die auf dem Zielserver
ungiiltig sind, werden die Dateien in das
Heimverzeichnis des Benutzers iibertragen.
Welche Zeichen ungiiltig sind, hdngt vom Server
ab.

Using Secure Protocol
Stellen Sie ein, ob das sichere FTP-
Hochladen ausgefiihrt werden soll.

Root Certificate

Laden/l6schen Sie ein Zertifikat.

¢ Load
Wiihlen Sie Set in Schritt 3 aus und
importieren Sie ein Zertifikat einer
Zertifizierungsstelle.

* Das zu ladende Zertifikat muss das PEM-Format
besitzen, sich im Stammverzeichnis der SD-
Karte befinden und mit , certification.pem*™ als
Dateiname benannt sein.

¢ Clear
Wiihlen Sie Set in Schritt 3 aus und 16schen
Sie ein Zertifikat einer
Zertifizierungsstelle.

* None
Kein Zertifikat laden oder 16schen.

Stellen Sie die Uhr des Camcorders auf die
korrekte Zeit ein, bevor Sie ein Zertifikat einer
Zertifizierungsstelle importieren.

Bei Aufnahme mit XAVC-I 3840x2160P 59.94/
50P kann Load nicht ausgewihlt werden.

Bei niedriger Spannung kann Load/Clear fiir ein
Zertifikat einer Zertifizierungsstelle nicht
ausgewdhlt werden.

Root Certificate Status
Hier wird der Ladestatus des Zertifikats
angezeigt.
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Reset
Setzen Sie die Einstellungen unter Server
Settings auf die Standardwerte zuriick.

3 Wiihlen Sie abschlieBend Set aus, um
die Einstellungen zu iibernehmen.

Wiihlen Sie nach dem Andern der
Einstellungen stets Set aus. Falls Sie Set
nicht auswihlen, werden die Einstellungen
nicht iibernommen.

Sie konnen einen Server auch mithilfe der Web-
Fernbedienung registrieren ,,Registrieren eines
Zielservers“ (Seite 88).

Auswihlen und Hochladen einer
Datei

Laden Sie eine auf einer SD-Karte aufgezeichnete
Datei oder eine auf einer SxS-Speicherkarte
aufgezeichnete Originaldatei auf einen Server
hoch.

Dateien konnen auch tiber die Web-
Fernbedienung hochgeladen werden. Niheres
dazu finden Sie unter ,, Ubertragen von Dateien
(Slot A, Slot B, Slot SD/MS)* (Seite 89).

Hochladen einer Proxy-Datei auf einer
SD-Karte iiber die Miniaturbildanzeige

1 Wiihlen Sie Transfer Clip (Proxy)
>Select Clip im Thumbnail-Menii aus.
Die Anzeige wechselt vom Einstellmenii zur
Miniaturbildanzeige.

Clips konnen von der Miniaturbildanzeige
oder der gefilterten Clip-Miniaturbildanzeige
iibertragen werden.

2 Wiihlen Sie mithilfe der Tasten 4/%/«/%
oder des Regler SEL/SET die zu
iibertragende Datei (Clip) aus und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Der ausgewihlte Clip wird mit einem
Hikchen versehen.

3 Driicken Sie die Taste MENU.

Ein Bestitigungsbildschirm wird angezeigt.



4 Wihlen Sie Execute aus.

Die Ubertragung der ausgewihlten Datei
wird in der Ubertragungsliste gespeichert
und das Ergebnis der Speicherung wird
angezeigt.

9 Wiihlen Sie OK aus.

Hochladen aller Dateien

Wiihlen Sie in Schritt 1 All Clips anstelle von
Select Clip, um die Proxy-Dateien fiir alle
Dateien zu iibertragen.

» Es konnen bis zu 200 Dateien iibertragen werden.

Hochladen einer Originaldatei auf einer
SxS-Speicherkarte iiber die
Miniaturbildanzeige

1 Wiihlen Sie Transfer Clip >Select Clip
im Thumbnail-Menii aus.
Die Anzeige wechselt vom Einstellmenii zur
Miniaturbildanzeige.
Clips konnen von der Miniaturbildanzeige
oder der gefilterten Clip-Miniaturbildanzeige
iibertragen werden.

2 Wiihlen Sie mithilfe der Tasten 4/%/«/%
oder des Regler SEL/SET die zu
iibertragende Datei aus und driicken
Sie die Taste SET oder den Regler SEL/
SET.

Der ausgewihlte Clip wird mit einem
Hikchen versehen.

3 Driicken Sie die Taste MENU.

Ein Bestitigungsbildschirm wird angezeigt.

4 Wihlen Sie Execute aus.

Die Ubertragung der ausgewihlten Datei
wird in der Ubertragungsliste gespeichert
und das Ergebnis der Speicherung wird
angezeigt.

9 Wiihlen Sie OK aus.

Hochladen aller Dateien
Wiihlen Sie in Schritt 1 All Clips anstelle von
Select Clip, um alle Dateien zu iibertragen.

¢ Es konnen bis zu 200 Dateien iibertragen werden.
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Uberpriifen der Dateiiibertragung

Sie konnen die Dateiiibertragung auf dem
angezeigten Bildschirm iiberpriifen, indem Sie im
Network-Menii die Option File Transfer >View
Job List auswihlen.

Bis zu 200 Ubertragungen konnen registriert werden.
Die Ubertragungsliste wird beibehalten, wenn der
Camcorder ausgeschaltet wird. Es konnen jedoch
aktuelle Fortschrittdaten von bis zu 10 Minuten
verloren gehen, falls der Akku abgenommen wird oder
der Camcorder ausgeschaltet wird, ohne zuvor den
Schalter ON/STANDBY auf STANDBY zu stellen.
Ubertragungen, die nach Eintritt des Zustands geringer
Akkuspannung hinzugefiigt wurden, werden nicht in
der Ubertragungsliste gespeichert.

* Falls wihrend der Dateiiibertragung ein Fehler auftritt,
kann die Ubertragung eines Clips mit dem gleichen
Namen wie der iibertragene ggf. je nach Einstellungen
und Status des Zielservers der Ubertragung nicht
fortgesetzt werden. Priifen Sie in diesem Fall die
Einstellungen und den Status des Zielservers der
Ubertragung.

Dateien automatisch hochladen

Falls File Transfer >Auto Upload (Seite 143) oder
Auto Upload (Proxy) (Seite 143) im Network-
Menii auf On gesetzt ist und eine
Netzwerkverbindung besteht, werden
Originaldateien und Proxy-Dateien automatisch
auf den mithilfe von Default Upload Server
(Seite 143) angegebenen Server oder das C3
Portal hochgeladen, sobald die Aufnahme endet.
Wenn sowohl Original- als auch Proxy-Dateien
fiir das automatische Hochladen konfiguriert
sind, erhélt das automatische Hochladen von
Proxy-Dateien Vorrang.

* Die Reihenfolge der Ubertragungen kann sich je nach
Netzwerkstatus dndern.

* Die Reihenfolge der Ubertragungen kann sich éndern,
wenn ein Clip wihrend einer lingeren Aufzeichnung
automatisch geteilt wird.

Hochladen mithilfe von Secure
FTP

Sie konnen Dateien verschliisselt mithilfe von
FTPS im Explicit-Modus (FTPES) fiir die
Verbindung mit dem Ziel-Dateiserver hochladen.



Festlegen einer sicheren FTP-Ubertragung
Um eine sichere FTP-Ubertragung zu erzielen,
setzen Sie Using Secure Protocol in den
Einstellungen des Ziel-Dateiservers auf On und
importieren Sie ein Zertifikat.

Nihere Informationen zur Konfiguration siehe
. Registrieren eines Ziels fiir die
Dateiiibertragung “ (Seite 74).
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|
Streaming-Ubertragung
von Video- und
Audiodaten

Sie konnen die mit dem Camcorder
aufgenommenen bzw. wiedergegebenen Video-
und Audiodaten iiber das Internet oder ein lokales
Netzwerk iibertragen.

Festlegen von Ziel und Format fiir
das Streaming

Sie konnen als Destination Settings bis zu drei
Ziele fiir das Streaming konfigurieren.

1 Wiihlen Sie Streaming >Destination
Settings1 (oder Destination Settings2,
Destination Settings3) im Network-
Menii aus.

Der Bildschirm zur Einrichtung des
Verbindungsziels fiir das Streaming-
Verbindung wird angezeigt.

2 Konfigurieren Sie die Optionen auf dem
Bildschirm zur Einrichtung des
Verbindungsziels.

Display Name
Legen Sie den Anzeigenamen im Destination
Settings-Menii fest.

Streaming Type

Hier wird der Typ des zu streamenden
Videos angezeigt (festgelegt auf MPEG-2
TS/UDP).

Streaming Format
Legen Sie das Format des zu streamenden
Videos fest.

* 1920x1080 9M
* 1920x1080 6M
* 1920x1080 3M
* 1280x720P OM
* 1280x720P 6M
* 1280x720P 3M
* 1280x720P 2M
* 640x360P 3M

* 640x360P 2M

* 640x360P 1M

* 480x270P IM



* 480x270P 0.5M
* 480x270P 0.3M
* 480x270P 0.2M
* 320x180P 0.2M

Audio Channel

Wiihlen Sie die Audiokanile fiir die
Streaming-Ausgabe aus.

« CH1/CH2

* CH3/CH4

* CHI

* CH2

* CH3

* CH4

¢ Die auswihlbaren Audio Channel-Einstellungen
sind entsprechend der Streaming Format-
Einstellung beschrinkt.

Destination Address

Geben Sie die Adresse des Zielservers fiir die

Streaming-Daten ein.

Destination Port
Geben Sie die Portnummer des Zielservers
fiir die Streaming-Daten ein.

Reset

Setzen Sie die Einstellungen unter
Destination Settings auf die Standardwerte
zuriick.

3 Wiihlen Sie abschlieBend Set aus, um
die Einstellungen zu iibernehmen.
Wihlen Sie nach dem Andern der
Einstellungen stets Set aus. Falls Sie Set
nicht auswihlen, werden die Einstellungen
nicht iibernommen.

4  Wihlen Sie Streaming >Destination
Select im Network-Menii aus und
wiihlen Sie dann die in Schritt 1 bis 3
angegebenen Zieleinstellungen
(Destination Settings1, Destination
Settings2, Destination Settings3) aus.

Starten des Streaming-Vorgangs

1 Verbinden Sie den Camcorder wie
unter ,,Herstellen einer Verbindung mit
dem Internet‘ (Seite 69) oder
,, Verbinden mit anderen Geriiten iiber
LAN¢* (Seite 63) beschrieben mit dem
Internet.
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2 Setzen Sie Streaming >Setting im
Network-Menii auf On.

Der Streaming-Vorgang startet gemél den
Einstellungen.

Sie konnen das Streaming auch starten,
indem Sie die Streaming-Funktion einer
belegbaren Taste zuweisen (Seite 47) und die
Taste driicken.

Das Streaming kann bei folgenden Meniieinstellungen

nicht gestartet werden.

— Wenn Network Client Mode >Setting im Network-
Menii auf On gesetzt ist

— Wenn RTMP/RTMPS im Network-Menii auf On
gesetzt ist

— Wenn Rec Format >Codec im System-Menii auf
DVCAM(MXEF) gesetzt ist

— Wenn S&Q Motion >Setting im Recording-Menii
auf On gesetzt ist

— Wenn Interval Rec >Setting im Recording-Menii
auf On gesetzt ist

— Wenn Simul Rec >Setting im Recording-Menii auf
On gesetzt ist

Es kann einige zehn Sekunden dauern, bis nach dem

Starten des Streaming-Vorgangs die Video- oder

Audiodaten tatsichlich gestreamt werden.

Wenn das Ziel der Streaming-Ubertragung ungiiltig ist

oder der Camcorder keine Netzwerkverbindung

herstellen kann, wird auf dem Bildschirm ,,x* als

Streaming-Statusanzeige angezeigt.

Audio- und Videodaten werden wie vorliegend iiber

das Internet tibertragen. Somit konnen moglicherweise

auch Dritte auf die Daten zugreifen. Priifen Sie, ob die

Streaming-Daten vom Empfangsgerit empfangen

werden. Falls die Adresse oder andere Einstellungen

fehlerhaft konfiguriert sind, konnen Daten

moglicherweise an Dritte iibertragen werden.

« Je nach Netzwerkstatus konnen ggf. nicht alle

Einzelbilder wiedergegeben werden.

Die Bildqualitit kann sich bei Szenen mit starker

Bewegung verschlechtern.

Wenn der Stream auf ein groles Format bei niedriger

Bitrate eingestellt ist, werden ggf. nicht alle

Einzelbilder wiedergegeben. Um diesen Effekt zu

vermeiden, wihlen Sie fiir die Einstellung Streaming

Format ein kleineres Format.

Wenn das Streaming wihrend der Priifung gestartet

wird, stoppt diese.

Dateiiibertragung wird wihrend des Streaming nicht

unterstiitzt. Dateilibertragung wird nach Stoppen des

Streaming unterstiitzt.

Falls wiihrend einer Dateiiibertragung das Streaming

gestartet wird, stoppt diese. Nach Stoppen des

Streaming wird die Dateiiibertragung fortgesetzt.

Wiihrend des Streaming wird die Aktualisierungsrate

des Bildschirms reduziert. Dies wirkt sich jedoch nicht

auf den Betrieb aus.



Streaming stoppen

Setzen Sie Streaming >Setting im Network-
Menii auf Off.

Das Streaming stoppt.

Sie konnen das Streaming auch stoppen, indem
Sie eine belegbare Taste driicken, der die
Funktion Streaming zugewiesen wurde.

Netzwerk-Client-Modus

Streaming mit hoher Qualitit wird unterstiitzt,
indem der Netzwerk-Client-Modus aktiviert und
eine Verbindung mit dem Connection Control
Manager (CCM) von entweder einer Sony
Network RX Station (Option) oder dem C3 Portal
hergestellt wird.

Mithilfe des Netzwerk-Client-Modus kdnnen Sie
auBerdem Intercom-Anrufe zwischen dem
Camcorder und einem Network RX Station- oder
C3 Portal-CCM iiber ein mit dem USB 3.0-
Anschluss (HOST) des Camcorders verbundenes
Headset durchfiihren.

Festlegen der Verbindung fiir den
Netzwerk-Client-Modus

Sie konnen unter NCM Settings bis zu drei
Verbindungen fiir den Netzwerk-Client-Modus
konfigurieren.

1 Wihlen Sie Network Client Mode
>NCM Settings1 (oder NCM Settings2,
NCM Settings3) im Network-Menii aus.
Der Bildschirm zur Einrichtung des
Verbindungsziels des Netzwerk-Client-
Modus wird angezeigt.

2 Konfigurieren Sie die Optionen auf dem
Bildschirm zur Einrichtung des
Verbindungsziels.

Display Name
Legen Sie den Anzeigenamen im NCM
Settings-Menii fest.

CCM Address

Geben Sie den Namen des CCM ein, zu dem
eine Verbindung hergestellt werden soll
(Hostname oder IP-Adresse).
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CCM Port

Geben Sie die Portnummer des CCM ein, zu
dem eine Verbindung hergestellt werden
soll.

User Name
Geben Sie den Benutzernamen ein.

Password
Geben Sie das Passwort ein.

CCM Certificate

Konfigurieren Sie das Zertifikat fiir die

CCM-Verbindung.

e Load
Wiihlen Sie Set in Schritt 3 aus und
importieren Sie ein Zertifikat.

* Das zu ladende Zertifikat muss das PEM-Format
besitzen, sich im Stammverzeichnis der SD-
Karte befinden und mit
,,CCM_certification.pem* als Dateiname
benannt sein.

* Clear
Wiihlen Sie Set in Schritt 3 aus und 16schen
Sie ein Zertifikat.

* None
Kein Zertifikat laden oder 16schen.

Stellen Sie die Uhr des Camcorders auf die
korrekte Zeit ein, bevor Sie CCM-
Verbindungszertifikate laden.

Wenn Sie in XAVC-I 3840x2160P 59.94/50P
aufzeichnen, konnen Sie Load nicht auswéhlen.
Bei niedriger Spannung konnen CCM-
Verbindungszertifikate nicht geladen oder
geloscht werden.

CCM Certificate Status
Hier wird der Ladestatus des Zertifikats
angezeigt.

Camera Control
Aktiviert/deaktiviert die Kamerasteuerung bei
Verbindung mit einem CCM.

Camera Setting
Aktiviert/deaktiviert ALL-Dateivorgidnge
bei Verbindung mit einem CCM.

Reset
Setzen Sie die Einstellungen unter NCM
Settings auf die Standardwerte zuriick.

Wiihlen Sie abschlieBend Set aus, um
die Einstellungen zu iibernehmen.
Wihlen Sie nach dem Andern der
Einstellungen stets Set aus. Falls Sie Set
nicht auswihlen, werden die Einstellungen
nicht iibernommen.



4  Wiihlen Sie Network Client Mode
>NCM Settings Select im Network-
Menii aus und wiihlen Sie dann die in
Schritt 1 bis 3 angegebenen NCM-
Einstellungen (NCM Settings1, NCM
Settings2, NCM Settings3) aus.

Verbinden im Netzwerk-Client-Modus

1 Verbinden Sie den Camcorder wie
unter ,,Herstellen einer Verbindung mit
dem Internet“ (Seite 69) beschrieben mit
dem Internet.

2 Setzen Sie Network Client Mode
>Setting im Network-Menii auf On.
Der Netzwerk-Client-Modus wird aktiviert
und der Camcorder wird mit der Network RX
Station oder C3 Portal verbunden.

Das Live-Streaming startet infolge der
Bedienung der Network RX Station.
Einzelheiten zur Bedienung finden Sie in der
Bedienungsanleitung zur Network RX

Station oder in der Online-Hilfe zu C3 Portal.

Sie konnen auch Setting auf On oder Off
setzen, indem Sie eine belegbare Taste
driicken (Seite 47), der Sie die Funktion
Network Client Mode zugewiesen haben.

¢ Das Streaming kann bei folgenden Meniieinstellungen
nicht gestartet werden.

— Wenn Rec Format >Codec im System-Menii auf
DVCAM(MXEF) gesetzt ist

— Wenn S&Q Motion >Setting im Recording-Menii
auf On gesetzt ist

— Wenn Interval Rec >Setting im Recording-Menii
auf On gesetzt ist

— Wenn Simul Rec >Setting im Recording-Menii auf
On gesetzt ist

* Wechsel zum Netzwerk-Client-Modus

— Withrend des normalen Streaming (Seite 77) oder
RTMP-Streaming (Seite 82) ist es nicht moglich,
zum Netzwerk-Client-Modus zu wechseln.

— Nach dem Wechsel zum Netzwerk-Client-Modus
sind Streaming und Priifen (Seite 87) nicht
verfligbar.

— Wechseln zum Netzwerk-Client-Modus wihrend
der Priifung fiihrt zum Stopp der Priifung.

e Streaming

— Dateiiibertragung wird wihrend des Streaming im
Netzwerk-Client-Modus nicht unterstiitzt.
Dateiiibertragung wird nach Stoppen des Streaming
unterstiitzt.

— Falls wihrend einer Dateiiibertragung das
Streaming im Netzwerk-Client-Modus gestartet
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wird, stoppt diese. Nach Stoppen des Streaming
wird die Dateiiibertragung fortgesetzt.

— Falls Setting wihrend des Streaming im Netzwerk-
Client-Modus auf Off gesetzt wird, stoppt das
Streaming.

— Beim Streaming im Netzwerk-Client-Modus
konnen NCM Settings Select und die mithilfe von
NCM Settings Select ausgewihlten Einstellungen
unter NCM Settings nicht geéndert werden.

— Wihrend des Streaming wird die
Aktualisierungsrate des Bildschirms reduziert. Dies
wirkt sich jedoch nicht auf den Betrieb aus.

— Die Aufnahmeeinstellungen konnen wihrend des
Streaming im Netzwerk-Client-Modus nicht
gedndert werden.

— Die Wired LAN-Einstellungen (verkabeltes LAN)
konnen wihrend des Streaming im Netzwerk-
Client-Modus nicht geidndert werden.

— Das Streaming stoppt, wenn Sie wihrend des QoS-
Streaming zur Miniaturbildanzeige oder zum
Wiedergabebildschirm wechseln.

— Die fiir das Streaming verfiigbaren
Verbreitungsformate variieren je nach Einstellung
des Camcorders fiir Rec Format.

User Name, Password und Zertifikate werden nicht in

einer ALL-Datei gespeichert und miissen somit nach

dem Laden einer ALL-Datei erneut konfiguriert
werden.

Ubertragen von Dateien im Netzwerk-
Client-Modus

Sie konnen Dateien auf einen vom CCM
festgelegten Server iibertragen, indem Sie eine als
CCM fungierende Network RX Station im
Netzwerk-Client-Modus mit dem Camcorder

verbinden.

1 Wihlen Sie die hochzuladende Datei aus.

» Ubertragen einer Proxy-Aufnahme:
Fiihren Sie die Schritte 1 bis 4 unter
,,Hochladen einer Proxy-Datei auf einer
SD-Karte* (Seite 89) durch.

« Ubertragen von Originaldateien:
Fiihren Sie die Schritte 1 bis 4 unter
 Hochladen einer Originaldatei auf einer
SxS-Speicherkarte “ (Seite 90) durch.

2 Tippen Sie auf Transfer.

NCM: RX Server* wird als Ziel angezeigt.
Geben Sie ,,NCM: RX Server* als Ziel an.

3 Tippen Sie auf Transfer.

Die Ubertragung der ausgewiihlten Dateien
auf den am CCM festgelegten Server beginnt.



Das Ziel kann auch auBerhalb des Netzwerk-Client-
Modus auf ,NCM: RX Server” festgelegt werden. In
diesem Fall wird die Ubertragung zum am CCM
festgelegten Server aufgeschoben und begonnen,
nachdem die Verbindung zum CCM im Netzwerk-
Client-Modus hergestellt ist.

Intercom-Anrufe im Netzwerk-Client-
Modus

Mithilfe des Netzwerk-Client-Modus konnen Sie
Intercom-Anrufe zwischen dem Camcorder und
einem Network RX Station- oder C3 Portal-CCM
iiber ein mit dem USB 3.0-Anschluss (HOST)
des Camcorders verbundenes Headset
durchfiihren.

Verbinden Sie das Headset stets mit dem USB 3.0-

Anschluss (HOST) des Camcorders.

Der Verbindungsstandard entspricht USB 2.0.

Bei Verbindung des Headsets iiber einen USB-Hub

wird die einwandfreie Funktion nicht garantiert.

Bei Verbindung von Headsets sowohl mit dem

USB 3.0 (HOST)- als auch dem USB 2.0 (HOST)-

Anschluss wird die einwandfreie Funktion nicht

garantiert.

Sobald ein Headset mit dem USB 2.0 (HOST)-

Anschluss verbunden wird, wird die Intercom-

Anruffunktion ggf. deaktiviert. Trennen Sie zunichst

das Headset vom USB 2.0 (HOST)-Anschluss, stellen

Sie danach den Netzschalter auf STANDBY und dann

wieder zuriick auf ON.

Falls Network Client Mode >Setting wihrend eines

Intercom-Anrufs auf Off gesetzt wird, so wird der

Anruf gestoppt.

Falls NCM Settings Select und die mithilfe von NCM

Settings Select ausgewiéhlten NCM Settings wihrend

eines Intercom-Anrufs geéndert werden, so wird der

Anruf gestoppt.

Das Intercom-Anrufstartsignal kann bei den folgenden

Meniieinstellungen nicht von einem CCM an den

Camcorder gesendet werden.

— Wenn Focus >Face Detection AF im Camera-Menii
auf Face Only AF oder Face Priority AF gesetzt ist

— Wenn Proxy Rec >Setting im Recording-Menii auf
On gesetzt ist

— Wenn 4K & HD (Sub) Rec >Setting im Recording-
Menii auf On gesetzt ist

1 Verbinden Sie den Camcorder wie
unter ,,Herstellen einer Verbindung mit
dem Internet“ (Seite 69) beschrieben mit
dem Internet.

2 Stellen Sie Network Client Mode
>Setting im Network-Menii auf On ein.

Der Netzwerk-Client-Modus wird aktiviert
und der Camcorder wird mit dem CCM der
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Network RX Station oder von C3 Portal
verbunden.

Einzelheiten zur nachfolgenden Bedienung
finden Sie in der Bedienungsanleitung zur
Network RX Station oder in der Online-Hilfe
zu C3 Portal.

3 Senden Sie ein Intercom-
Anrufstartsignal von einem CCM an
den verbundenen Camcorder.

Wenn das Startsignal vom CCM empfangen
wird, erscheint das Intercom-
Verbindungssymbol auf dem
Monitorbildschirm (Seite 16).

4 Senden Sie ein Intercom-
Anrufendsignal von einem CCM an den
verbundenen Camcorder.

Um den Anruf zu beenden, senden Sie das
Endsignal von einem CCM an den
Camcorder.

Anpassen des Intercom-Pegels

Wenn Sie die Lautstéirketaste des Headsets
betitigen, wird der Einstellbalken fiir den
Intercom-Pegel auf dem Monitorbildschirm
angezeigt.

Sie konnen den Einstellbalken fiir den Intercom-
Pegel auch aufrufen, indem Sie Intercom Level
einer belegbaren Taste zuweisen und diese dann
driicken.

186min
B02I60
0ips/80.94P
KAVCAL { Sub.
Praxy

2o B

[ Somin
[ Gonin
(Bosemin
) 55001 Hold

Stellen Sie den Intercom-Pegel ein, wihrend
dessen Einstellbalken angezeigt wird.

Driicken Sie zum Erhthen der Lautstirke die
entsprechende Taste am Headset, drehen Sie den
Regler SEL/SET aufwirts, oder driicken Sie 4
oder # der Tasten #/%/«/%.

Driicken Sie zum Verringern der Lautstirke die
entsprechende Taste am Headset, drehen Sie den
Regler SEL/SET abwiirts, oder driicken Sie ¥
oder « der Tasten #/%/«/%.



¢ Die beim Driicken der Lautstirketasten am Headset
jeweils durchgefiihrte der folgenden Intercom-

Pegelanpassungen hiingt von der Headset-Funktion ab.

— Nur Intercom-Pegel des Headsets anpassen

— Intercom-Pegel sowohl des Headsets als auch des
Camcorders anpassen

— Nur Intercom-Pegel des Camcorders anpassen,
wenn das Headset die Funktion zum Anpassen des
Intercom-Pegels nicht unterstiitzt

Je nach Funktion des Headsets tritt folgendes

Verhalten auf.

— Intercom-Pegel @ndert sich um zwei oder mehr
Stufen, wenn Headset-Lautstirketasten ein Mal
gedriickt werden

— Intercom-Pegel @ndert sich erst, wenn Headset-
Lautstirketasten zwei Mal oder 6fter gedriickt
werden

— Tatséchlicher Lautstirkepegel dndert sich erst,
wenn Intercom-Pegel um zwei oder mehr Stufen
gedndert wird

— Einstellbalken fiir Intercom-Pegel wird auch dann
nicht auf dem Monitorbildschirm angezeigt, wenn
eine Lautstirketaste gedriickt wird

Wenn der Intercom-Pegel nur am Headset angepasst

wird, wird der Einstellbalken fiir den Intercom-Pegel

nicht auf dem Monitorbildschirm angezeigt.

¢ Je nach Kommunikationsstatus und Verarbeitungslast

kann sich die Tonqualitit verschlechtern.
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RTMP/RTMPS-
Streaming-Ubertragung
von Video- und
Audiodaten

Sie konnen vom Camcorder aufgenommene
Video- und Audiosignale mit geringer Latenz
unter Verwendung des von Adobe Systems
Incorporated entwickelten RTMP (Real Time
Messaging Protocol) per Streaming iibertragen.
Auch das mit SSL verschliisselte RTMPS wird
unterstiitzt.

Festlegen von Ziel und Format fiir
das RTMP/RTMPS-Streaming

1 Wiihlen Sie RTMP/RTMPS >RTMP
Settings Select >SRTMP Settings1 (oder
RTMP Settings2, RTMP Settings3) im
Network-Menii aus.

Der Bildschirm zur Einrichtung des
Verbindungsziels fiir das RTMP/RTMPS-
Streaming wird angezeigt.

2 Konfigurieren Sie die Optionen auf dem
Bildschirm zur Einrichtung des
Verbindungsziels.

Display Name
Legen Sie den Anzeigenamen im RTMP
Settings-Menii fest.

Streaming Format

Legen Sie das Format des zu streamenden
Videos fest.

* 1920x1080 OM

* 1920x1080 6M

* 1280x720P 3M

* 640x360P 1M

Destination URL

Legen Sie die URL des zu verbindenden
RTMP-Servers fest.

URLs, die mit ,,rtmps://* beginnen,werden
als RTMPS-Streaming erkannt und die
Streaming-Daten werden verschliisselt.
Dementsprechend ist fiir RTMPS-
Verbindungen ein Zertifikat erforderlich.



Stream Name

Legen Sie den Namen des Streaming-Kanals
fest, der vom Streaming-Server iibertragen
wird.

RTMPS Certificate

Um RTMPS-Streaming verwenden zu
konnen, miissen Sie diese Option
konfigurieren.

Konfigurieren Sie das Zertifikat fiir die
RTMPS-Verbindung.

¢ Load

Zertifikat importieren.

* Das zu ladende Zertifikat muss das PEM-
Format besitzen, sich im Stammverzeichnis der
SD-Karte befinden und mit
.RTMPS_certification.pem* als Dateiname
benannt sein.

¢ Clear
Zertifikat 16schen.
* None
Kein Zertifikat laden oder 16schen.

Wenn hier kein Zertifikat geladen wird,
werden die vorinstallierten
Standardzertifikate verwendet. Die
Standardzertifikate konnen vom Benutzer
durch andere Standardzertifikate ersetzt
werden. Einzelheiten zum Ersetzen von
Standardzertifikaten finden Sie unter

L Ersetzen vorinstallierter
Standardzertifikate durch benutzerdefinierte
Standardzertifikate“ (Seite 83).

Wiihlen Sie abschlieBend Set aus, um
die Einstellungen zu iibernehmen.

Wiihlen Sie nach dem Andern der
Einstellungen stets Set aus. Falls Sie Set
nicht auswihlen, werden die Einstellungen
nicht tibernommen.

Stellen Sie die Uhr des Camcorders auf die
korrekte Zeit ein, bevor Sie ein Zertifikat fiir
RTMPS-Verbindungen importieren.

Wenn Sie in XAVC-I 3840x2160P 59.94/50P
aufzeichnen, konnen Sie Load nicht auswihlen.
Bei niedriger Spannung kann Load/Clear fiir ein
Zertifikat einer RTMPS-Verbindung nicht
ausgewihlt werden.

RTMPS Certificate Status
Hier wird der Ladestatus des Zertifikats der
RTMPS-Verbindung angezeigt.
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Load from Utility SD/MS

Laden der auf dem im UTILITY SD/MS-
Einschub eingesetzten Medium
gespeicherten Informationen Display Name,
Destination URL und Stream Name fiir
RTMP/RTMPS.

* Zum Erstellen einer Datei zum Laden der
Informationen fiir Display Name, Destination
URL und Stream Name ist ein 6ffentlicher
Schliissel erforderlich.

Speichern Sie mithilfe von Network Public Key
>Key Export (Seite 138) im File-Menii den
offentlichen Schliissel auf einer SD-Karte.
Erstellen Sie mithilfe der Anwendungssoftware
Streaming Setting Transfer” und dem
gespeicherten offentlichen Schliissel die zu
ladende Datei.

Reset
Zuriicksetzen der Einstellungen auf die
Standardwerte.

Ersetzen vorinstallierter
Standardzertifikate durch
benutzerdefinierte Standardzertifikate

1 Stecken Sie die SD-Karte, auf der die

benutzerdefinierten
Standardzertifikate gespeichert sind, in
den Steckplatz UTILITY SD/MS.

Wiihlen Sie im Menii ,,Network* die
Option RTMP/RTMPS >Replace
Default Certificates >Execute.

Eine Meldung wird angezeigt, in der Sie
aufgefordert werden, das Laden der
Zertifikatsdatei zu bestitigen.

Wiihlen Sie OK aus.

Die benutzerdefinierten Standardzertifikate

werden in das Gerit geladen.

Zu ladende Datei:
-RTMPS_DefaultCertificates.pem® im
Stammverzeichnis der SD-Karte

Nach dem Abschluss des Ladevorgangs wird
die Meldung ,,Certificate loaded. angezeigt.



Wiederherstellen der vorinstallierten
Standardzertifikate

Wiihlen Sie im Menii ,,Network‘ die Option
RTMP/RTMPS >Reset Default Certificates
>Execute.

Wenn der Vorgang erfolgreich abgeschlossen
wurde, wird die Meldung ,,Certificates have been
reset.” angezeigt.

Die vom Benutzer registrierten
Standardzertifikate werden geldscht und die
vorinstallierten Standardzertifikate werden
aktiviert.

Uberpriifen des Status der
Standardzertifikate

Wiihlen Sie im Menii ,,Network* die Option
RTMP/RTMPS >Default Certificates
Status und iiberpriifen Sie die Anzeige.

Wenn die vorinstallierten Standardzertifikate
verwendet werden, wird die Meldung ,,Preinstall*
angezeigt.

Wenn benutzerdefinierte Standardzertifikate
verwendet werden, werden Datum und Uhrzeit

der Ausfiihrung der Benutzeroperation angezeigt.

Anzeigeformat:

4-stelliges Jahr + 2-stelliger Monat + 2-stelliger
Tag + 2-stellige Stunde (24 Stunden) + 2-stellige
Minute + 2-stellige Sekunde

Anzeigebeispiel:

Fiir den 1. 12. 2021 12:34:56 Uhr —
20211201123456

Starten des RTMP/RTMPS-
Streaming

1 Verbinden Sie den Camcorder wie
unter ,,Herstellen einer Verbindung mit
dem Internet‘ (Seite 69) oder
,, Verbinden mit anderen Geriiten iiber
LAN¢* (Seite 63) beschrieben mit dem
Internet.

2 Setzen Sie RTMP/RTMPS >Setting im
Network-Menii auf On.
Das RTMP/RTMPS-Streaming startet
gemil den Einstellungen.

Sie konnen das Streaming auch starten,
indem Sie die Funktion RTMP/RTMPS einer
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belegbaren Taste zuweisen (Seite 47) und die
Taste driicken.

RTMP/RTMPS-Streaming kann bei folgenden

Meniieinstellungen nicht gestartet werden.

— Wenn Network Client Mode >Setting im Network-
Menii auf On gesetzt ist

— Wenn Streaming >Setting im Network-Menii auf
On gesetzt ist

— Wenn Rec Format >Codec im System-Menii auf
DVCAM(MXEF) gesetzt ist

— Wenn S&Q Motion >Setting im Recording-Menii
auf On gesetzt ist

— Wenn Interval Rec >Setting im Recording-Menii
auf On gesetzt ist

— Wenn Simul Rec >Setting im Recording-Menii auf
On gesetzt ist

Es kann einige zehn Sekunden dauern, bis nach dem

Starten des RTMP/RTMPS-Streaming-Vorgangs die

Video- oder Audiodaten tatsédchlich gestreamt werden.

Wenn das Ziel der RTMP/RTMPS-Streaming-

Ubertragung ungiiltig ist oder der Camcorder keine

Netzwerkverbindung herstellen kann, wird auf dem

Bildschirm ,,x* als RTMP/RTMPS-Streaming-

Statusanzeige angezeigt.

Audio- und Videodaten werden wie vorliegend iiber

das Internet iibertragen. Somit konnen moglicherweise

auch Dritte auf die Daten zugreifen. Priifen Sie, ob die

RTMP/RTMPS-Streaming-Daten vom Empfangsgerit

empfangen werden. Falls die Adresse oder andere

Einstellungen fehlerhaft konfiguriert sind, konnen

Daten moglicherweise an Dritte libertragen werden.

Je nach Netzwerkstatus konnen ggf. nicht alle

Einzelbilder wiedergegeben werden.

Die Bildqualitit kann sich bei Szenen mit starker

Bewegung verschlechtern.

Wenn der RTMP/RTMPS-Stream auf ein grofies

Format bei niedriger Bitrate eingestellt ist, werden ggf.

nicht alle Einzelbilder wiedergegeben. Um diesen

Effekt zu vermeiden, wihlen Sie fiir die Einstellung

Streaming Format ein kleineres Format.

‘Wenn das RTMP/RTMPS-Streaming wihrend der

Priifung gestartet wird, stoppt diese.

Dateiiibertragung wird wihrend des R-TMP/RTMPS-

Streaming nicht unterstiitzt. Dateilibertragung wird

nach Stoppen des RTMP/RTMPS-Streaming

unterstiitzt.

Falls wihrend einer Dateiiibertragung das RTMP/

RTMPS-Streaming gestartet wird, stoppt diese. Die

Dateiiibertragung wird nach Stoppen des RTMP/

RTMPS-Streaming erneut gestartet.

Wiihrend des RTMP/RTMPS-Streaming wird die

Aktualisierungsrate des Bildschirms reduziert. Dies

wirkt sich jedoch nicht auf den Betrieb aus.

Wiihrend des RTMP/RTMPS-Streaming konnen die

Aufnahmeeinstellungen nicht geéndert werden.

Die fiir das Streaming verfiigbaren

Verbreitungsformate variieren je nach Einstellung des

Camcorders fiir Rec Format.



Stoppen des RTMP/RTMPS-
Streaming

Setzen Sie RTMP/RTMPS >Setting im
Network-Menii auf Off.

Das Streaming stoppt.

Sie konnen das Streaming auch stoppen, indem
Sie eine belegbare Taste driicken, der die
Funktion RTMP/RTMPS zugewiesen wurde.

Verwenden der Web-
Fernbedienung

Sie konnen von einem Smartphone/Tablet oder
Computer aus iiber eine Netzwerkverbindung auf
die im Camcorder integrierte Web-
Fernbedienung zugreifen.

Mithilfe der Web-Fernbedienung konnen Sie den
Camcorder fernbedienen. Sie konnen mit einem
verbundenen Gerit die Aufnahme starten/stoppen
und Aufnahmeeinstellungen vornehmen. Diese
Funktion ist niitzlich, wenn der Camcorder an
einem entfernten Ort wie z. B. oben auf einem
Kran usw. platziert wird.

Bildschirm ,Camera Control“
Bildschirm ,,Main*
=/ Camara Cotiel
00:00:00.00 Lt

Assign M Playback ~ Cursor

ND V4. B W16,

of

Auto Iris Auto ND Filter
off

Auto White

* Status

* Taste zum Starten/Stoppen der Aufzeichnung

* ND-Regler

« Iris-Regler

» Focus-Regler

e Zoom-Regler

* Aufnahmeeinstellungen
S&Q FPS, Shutter, White, Gamma, Auto Iris, Auto
Shutter, AGC, Auto ND Filter, ATW, Gain, Color
Bars, Auto White
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Bildschirm ,,Playback‘

= Camera Control

00: 0.00

1

Main Cursor

Assign

Playback

- /n >
Frev | Pay/pavse | Frua
e | | >
prev stop Next

* Status
¢ Schaltflichen zur Wiedergabesteuerung:
F Rev, Play/Pause, F Fwd, Prev, Stop, Next

Bildschirm ,,Cursor

= Camera Control
00:00:00.00

Assign Main  Playback _ Cursor

Menu

Thumbnail

* Status

¢ Schaltflichen zur Cursorbedienung, Menii/
Statusanzeige:
Up, Left, Set, Right, Down, Cancel/Back, Menu,
Status, Thumbnail

Bildschirm ,,Assign*

= Camera Control
1p000_0001

00:00:00.00 Size 38

XA\ (b 9%9min

Assign Main Cursor

Playback

@ reaking s

tor @n
Qo @oiectvens @F

* Status
« Belegbare Tasten:
Belegbare Tasten 1 bis 10

Aufrufen der Web-Fernbedienung

1 Stellen Sie eine Netzwerkverbindung
(Seite 63) zwischen Camcorder und
Gerit her.
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2

Starten Sie auf dem Geriit einen
Browser und rufen Sie die Seite ,,http://
IP-Adresse des Camcorders/rm.html*
auf.,

Beispiel: Wenn die IP-Adresse
192.198.122.1 lautet, geben Sie http://
192.168.1.1/rm.html in die Adressleiste ein.
Sie konnen die IP-Adresse des Camcorders
auf dem Network Status-Bildschirm
iiberpriifen (Seite 19).

Geben Sie den Benutzernamen und das
Passwort (Network-Menii — Access
Authentication — User Name und
Password) im Browser ein.

Bei erfolgreicher Verbindung wird der
Bildschirm der Web-Fernbedienung auf dem
Gerit angezeigt.

Sie konnen den Camcorder dann iiber den
Bildschirm der Web-Fernbedienung
bedienen.

Die Tastenfunktion kann deaktiviert werden,
indem der Schalter Lock nach rechts
geschoben wird.

In den unten aufgefiihrten Fillen stimmt der

Bildschirm der Web-Fernbedienung moglicherweise

nicht mit den Camcorder-Einstellungen iiberein.

Aktualisieren Sie in diesem Fall das Browserfenster.

— Der Camcorder wird bei bestehender Verbindung
neu gestartet.

— Der Camcorder wird bei bestehender Verbindung
direkt bedient.

— Das Gerit wurde erneut verbunden.

— Die Browser-Schaltflichen ,,Vorwirts* oder
,Zuriick” wurden verwendet.

Wenn das WLAN-Signal zu schwach ist, funktioniert

die Web-Fernbedienung moglicherweise nicht.

Aus Sicherheitsgriinden wird empfohlen, ein Passwort

mit einer ausreichend langen, fiir andere schwer zu

erratenden Zeichenkette zu setzen und sicher

aufzubewahren.

Geréate, die mit der Web-Fernbedienung
kompatibel sind

In der folgenden Tabelle sind die Geriite,

B

etriebssysteme und Browser aufgefiihrt, welche

die Web-Fernbedienung unterstiitzen.

Gerit

Betriebssy- Browser

stem

Tablet

Android 8/9/10 Chrome

iOS 12/13.3/
14/15

Safari




Gerit Betriebssy- Browser

stem

Computer Windows 8.1/ Chrome
10
macOS 10.14/  Safari
10.15

Informationen zu Geriten, die von der
Anwendung ,,Content Browser Mobile*
unterstiitzt werden, erhalten Sie vom Sony-
Kundendienst oder einer Handelsvertretung.
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Menii der Web-
Fernbedienung

Indem Sie oben links auf dem Bildschirm auf
tippen, offnen Sie das
Bildschirmauswahlmenii. Wihlen Sie
Monitoring Settings aus, um den Monitoring
Settings-Bildschirm anzuzeigen.
Indem Sie oben links auf dem Monitoring
Settings-Bildschirm auf E tippen, 6ffnen Sie
das Einstellmenii fiir Aufgaben wie die
Dateiiibertragung.

Meniioptionen
* Remote Control
Camera Control
* Monitoring
Monitoring Settings
¢ File Transfer
Slot A
Slot B
Slot SD/MS
Job List
Upload Settings

Einstellungen fiir die Priifung von
Video (Monitoring Settings)

Sie konnen das Format einstellen, wenn Sie die
Priifung auf einem Gerét vornehmen.

Size

Legt die BildgroB8e und Bitrate des Videos fiir die
Priifung fest.

* 480x270(1Mbps)

* 480x270(0.5Mbps)

Frame Rate
Zeigt die Bildfrequenz des Videos fiir die Priifung
an.



Einstellungen fiir das Hochladen
(Upload Settings)

Sie konnen die Servereinstellungen fiir das
Hochladen einer Proxy-Datei oder einer
Originaldatei éndern, die auf dem Camcorder
aufgenommen wurde.

Registrieren eines Zielservers

Wiihlen Sie einen Server in der Liste Upload
Server, und tippen Sie auf Edit, um den
Bildschirm zur Servereinrichtung anzuzeigen.
Konfigurieren Sie dann die Optionen, um einen
Server zu registrieren.

Sie konnen einen Server auch mithilfe von File
Transfer (Seite 74) im Network-Menii festlegen.
Ein an dieser Stelle konfigurierter Server wird in
der Dateitibertragungsliste auf den Bildschirmen
Slot A, Slot B und Slot SD/MS beim Hochladen
einer Datei angezeigt.

Tippen Sie auf OK, um die Einstellungen zu
iibernehmen. Tippen Sie auf Cancel, um die
Einstellungen zu verwerfen.

Service
Zeigt den Servertyp an.
., FTP*“: FTP-Server

Display Name
Geben Sie den in der Liste anzuzeigenden Namen
des Servers ein.
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Host Name
Geben Sie die Adresse des Servers ein.

Port
Geben Sie die Portnummer des Servers ein, zu
dem eine Verbindung hergestellt werden soll.

User Name
Geben Sie den Benutzernamen ein.

Password
Geben Sie das Passwort ein.

* Das Passwort wird aus Sicherheitsgriinden geloscht,
wenn der Bildschirm Edit gedffnet wird. Geben Sie das
Passwort erneut ein, wenn sich die Servereinstellungen
geindert haben.

Display Password

Zeigt das Passwort an bzw. blendet es aus.

Wenn die Option auf Off gesetzt ist, wird das

konfigurierte Passwort nicht angezeigt. Beim

Eingeben eines Passworts werden alle Zeichen als

Sternchen angezeigt.

Wenn die Option auf On gesetzt ist, wird das

konfigurierte Passwort angezeigt. Beim Eingeben

eines Passworts werden alle Zeichen angezeigt.

Passive Mode
Zum Ein-/Ausschalten des passiven Modus.

Destination Directory
Geben Sie den Namen des Verzeichnisses auf
dem Zielserver ein.

Falls in Destination Directory Zeichen eingegeben
werden, die auf dem Zielserver ungiiltig sind, werden
die Dateien in das Heimverzeichnis des Benutzers
iibertragen. Welche Zeichen ungiiltig sind, hingt vom
Server ab.

Using Secure Protocol

Stellen Sie ein, ob das sichere FTP-Hochladen

ausgefiihrt werden soll. Bei Einstellung auf ON

wird der Zertifikatstatus angezeigt.

Um ein Zertifikat zu importieren oder zu 16schen,

tippen Sie auf Select Function und wihlen Sie

eine Option im angezeigten Menii aus.

* Load
Zertifikat einer Zertifizierungsstelle
importieren.

* Das zu ladende Zertifikat muss das PEM-Format
besitzen, sich im Stammverzeichnis der SD-Karte
befinden und mit ,certification.pem* als Dateiname
benannt sein.

* Clear
Zertifikat einer Zertifizierungsstelle 16schen.

* None
Kein Zertifikat laden oder 16schen.



« Stellen Sie die Uhr des Camcorders auf die korrekte
Zeit ein, bevor Sie ein Zertifikat einer
Zertifizierungsstelle importieren.

Andern von registrierten Servereinstellungen

Wiihlen Sie auf dem Bildschirm Upload Settings

den Server aus, dessen Einstellungen Sie dndern

mochten, und tippen Sie auf Edit. Andern Sie die

Einstellungen auf dem Bildschirm zum Andern

der Einstellungen.

Sie konnen einen Server auch mithilfe von File

Transfer (Seite 143) im Network-Menii festlegen.

Wenn Auto Upload (Proxy) auf Chunk gesetzt ist
Wenn Auto Upload auf Chunk gesetzt ist, 14dt der
Camcorder jeweils nach dem in Proxy Rec
>Chunk eingestellten Intervall automatisch eine
Proxy-Datei auf das mithilfe von Default Upload
Server festgelegte Ubertragungsziel hoch.

Default Upload Server
Wiihlen Sie den Standardserver fiir
Dateilibertragung aus.

Verwaltung der Dateiiibertragung
(File Transfer)

Sie konnen auf einer SxS-Speicherkarte
aufgezeichnete Originaldateien oder auf einer
SD-Karte aufgezeichnete Proxy-Dateien
tibertragen, die Ubertragung verwalten und deren
Ziel konfigurieren.

Ubertragen von Dateien (Slot A, Slot B,
Slot SD/MS)

Sie konnen eine Liste von Clips anzeigen, die auf
den Medien in Einschub A/Einschub B
gespeichert sind bzw. eine Liste von Proxy-
Dateien anzeigen, die auf dem Medium im
UTILITY SD/MS-Einschub gespeichert sind.

Sie konnen eine angezeigte Datei auswéhlen, um
sie auf einen Server im Internet hochzuladen.

Hochladen einer Proxy-Datei auf einer SD-Karte

1 Stellen Sie eine LAN-Verbindung
(Seite 63) zwischen Camcorder und
Geriit her.

2 Starten Sie auf dem Geriit einen
Browser und rufen Sie die Web-
Fernbedienung auf (Seite 86).

3 Rufen Sie zum Auswihlen einer Datei
den Dateilistenbildschirm auf.

Tippen Sie auf E >File Transfer >Slot SD/
MS.

Eine Liste mit auf dem im UTILITY SD/MS-
Einschub eingesetzten Medium
gespeicherten Dateien wird angezeigt.

4 Wiihlen Sie die hochzuladende Datei
aus.

Tippen Sie auf die Datei, um sie
auszuwéhlen. Zum Aufheben der Auswahl
tippen Sie erneut auf die Datei.

Sie kénnen doppelt auf eine Datei tippen, um
sie wiederzugeben und ihren Inhalt zu
priifen. (nur SD-Karten)

) Tippen Sie auf Transfer.

Der mithilfe von Default Upload Server in
., Registrieren eines Zielservers“ (Seite 88)
festgelegte Server wird angezeigt.

Zum Wechseln des Servers tippen Sie auf
den Server, um die Serverliste aufzurufen.
Wihlen Sie dann einen Server aus.

Geben Sie in Directory bei Bedarf den
Namen des Verzeichnisses auf dem Server
ein.
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6 Tippen Sie auf Transfer.
Der Camcorder beginnt, die ausgewihlte
Datei hochzuladen.
Wenn Sie das Hochladen abbrechen wollen,
tippen Sie auf Cancel.

Hochladen einer Originaldatei auf einer SxS-
Speicherkarte

1 Stellen Sie eine LAN-Verbindung
(Seite 63) zwischen Camcorder und
Geriit her.

2 Starten Sie auf dem Geriit einen
Browser und rufen Sie die Web-
Fernbedienung auf (Seite 86).

3 Rufen Sie zum Auswiihlen einer Datei
den Dateilistenbildschirm auf.
Tippen Sie aufE >File Transfer >Slot A
oder Slot B.
Eine Liste mit auf dem im Einschub A oder B
eingesetzten Medium gespeicherten Dateien
wird angezeigt.

Beispiel: Bildschirm ,,Slot A*

4 Wihlen Sie die hochzuladende Datei
aus.
Tippen Sie auf die Datei, um sie
auszuwihlen. Zum Aufheben der Auswahl
tippen Sie erneut auf die Datei.
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) Tippen Sie auf Transfer.

Der mithilfe von Default Upload Server in
., Registrieren eines Zielservers“ (Seite 88)
festgelegte Server wird angezeigt.

Zum Wechseln des Servers tippen Sie auf
den Server, um die Serverliste aufzurufen.
Wihlen Sie dann einen Server aus.

Geben Sie in Directory bei Bedarf den
Namen des Verzeichnisses auf dem Server
ein.

6 Tippen Sie auf Transfer.
Der Camcorder beginnt, die ausgewihlte
Datei hochzuladen.
Wenn Sie das Hochladen abbrechen wollen,
tippen Sie auf Cancel.

Uberpriifen der Dateiiibertragung (Job
List)

Sie konnen die Liste der hochzuladenden Dateien
und die Datei, die gerade hochgeladen wird,
priifen, das Hochladen einer Datei abbrechen
oder starten und eine Datei aus der Dateiliste
16schen.

Der Camcorder ist mit der FTP-
Fortsetzungsfunktion kompatibel (Funktion zum
Fortsetzen des Hochladevorgangs einer Datei,
deren Ubertragung abgebrochen wurde).

* Total: Fortschritt aller hochzuladenden Dateien.

« Status: Fortschritt der Datei, die gerade hochgeladen
wird.

* Remain Time: Geschitzte Restdauer fiir das
Hochladen. )

* Transfer data rate: Anzeige der Ubertragungsrate.

So brechen Sie das Hochladen ab oder starten es

oder ldschen eine Datei aus der Dateiliste

1 Wiihlen Sie eine Datei aus.

2 Tippen Sie oben rechts auf dem
Bildschirm auf und wiihlen Sie eine
Option aus.



Abort selected: Hochladen der ausgewihlten
Datei abbrechen.

Delete from list: Ausgewihlte Datei aus der Liste
16schen.

Start selected: Hochladen der ausgewihlten Datei
starten.

Select All: Alle Dateien in der Liste auswihlen.
Clear completed: Liste hochgeladener Dateien
16schen.

Wenn ein Block-Job eines Clips wihrend der
Blockaufzeichnung geloscht wird, werden die
nachfolgenden Clip-Blocke nicht hochgeladen.

Bei Verwendung der Web-Fernbedienung wird eine in
Blocken aufgezeichnete Proxy-Datei als einzelne
Clips angezeigt. Diese Clips konnen nicht geldscht
werden. Wenn diese Clips mit der Web-
Fernbedienung tibertragen werden, konnen die Clips
auf dem Server nicht automatisch zusammengefiihrt
werden.
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Konfiguration der Miniaturbildanzeige

Wenn Sie die Taste THUMBNAIL (Seite 12) driicken, werden auf der SxS-Speicherkarte aufgezeichnete
Clips als Miniaturbilder auf dem Bildschirm angezeigt.

Sie konnen einen Clip in der Miniaturbildanzeige wihlen und die Wiedergabe des Clips starten. Das
Wiedergabebild kann auf dem LCD-/Sucherbildschirm und externen Monitoren angezeigt werden.
Durch erneutes Driicken der Taste THUMBNAIL wird die Miniaturbildanzeige geschlossen und das
Kamerabild wieder angezeigt.

« In der Miniaturbildanzeige werden nur Clips angezeigt, die im derzeit gewihlten Aufzeichnungsformat aufgenommen
wurden. Falls ein aufgezeichneter Clip wider Erwarten nicht angezeigt wird, iiberpriifen Sie das Aufzeichnungsformat.
Beachten Sie diesen Aspekt vor dem Formatieren (Initialisieren) von Speichermedien.

Informationen zum Clip an der Cursorposition werden unten im Bildschirm angezeigt.

Anzeige der derzeit gewéhlten SxS-Speicherkarte
(Gesperrte Karten sind durch ein Schlosssymbol gekennzeichnet.)

| Clip-Nummer/Gesamtzahl der Clips
|
D (110 )z

o nsw] | Y

(gelb) — Al f
LN TCR00:00:00:12 TCR00:00:00:15

[—_
TCR 00:00

2

1 -
TCR 00:00:04:57

2 —{(EIINE) 27 Jun 2014 1220 AV

1. Miniaturbild (Indexbild) 4. Spezielle Aufzeichnungsinformationen
Hier wird das Indexbild eines Clips angezeigt. Der Aufzeichnungsmodus wird nur angezeigt,
Wenn ein Clip aufgezeichnet wird, wird sein wenn der Clip in einem speziellen
erstes Einzelbild automatisch als Indexbild Aufzeichnungsmodus aufgenommen wurde.
gesetzt. Bei Zeitlupen- & Zeitrafferclips wird rechts die
Unter dem Miniaturbild werden Informationen Bildrate angezeigt.

zum Clip/Bild angezeigt. Sie konnen die
Anzeige der Informationen mithilfe von
Customize View (Seite 99) >Thumbnail 6. Erstellungsdatum
Caption im Thumbnail-Menii dndern.

2. Name des Clips
Zeigt den Namen des ausgewdhlten Clips an.

5. Cliplinge

3. Videoaufzeichnungsformat
Zeigt das Dateiformat des ausgewdhlten Clips
an.
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Wiedergeben von Clips

Abspielen der aufgezeichneten
Clips

Aufgezeichnete Clips konnen wiedergegeben
werden, wenn sich der Camcorder im
Bereitschaftsmodus (Stby) befindet.

1 Setzen Sie eine SxS-Speicherkarte fiir
die Wiedergabe ein.

2 Driicken Sie die
Wiedergabefunktionstaste PLAY/
PAUSE.

3 Driicken Sie die Taste PREV oder
NEXT, um den gewiinschten Clip
anzusteuern.

4 Driicken Sie die Taste PLAY/PAUSE.
Das Wiedergabebild erscheint im Sucher.

Die Wiedergabe kann durch Driicken der

folgenden Tasten gesteuert werden:

Taste PLAY/PAUSE: Die Wiedergabe wird
angehalten. Driicken Sie die Taste erneut, um
die Wiedergabe fortzusetzen.

Taste F FWD/Taste F REV: Schnelle
Wiedergabe. Driicken Sie die Taste PLAY/
PAUSE, um zur normalen Wiedergabe
zuriickzuschalten.

Taste STOP: Die Wiedergabe oder Aufnahme
wird gestoppt.

Auswiéhlen des ersten Miniaturbilds
Halten Sie die Taste FREV gedriickt und driicken
Sie die Taste PREV.

Auswdhlen des letzten Miniaturbilds
Halten Sie die Taste F FWD gedriickt und
driicken Sie die Taste NEXT.

Wiedergeben des ausgewéahlten
und der folgenden Clips
nacheinander

1 Driicken Sie die Tasten 4/%/4/+ oder
drehen Sie den Regler SEL/SET, um
den Cursor auf das Miniaturbild des
gewiinschten Clips zu verschieben.
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2 Driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Wiedergabe beginnt am Anfang des
ausgewdhlten Clips.

An den Ubergiingen zwischen verschiedenen Clips
kann es temporir zu einem Bildabbruch oder zur
Anzeige von Standbildern kommen. Der Camcorder
kann wihrenddessen nicht gesteuert werden.

Wenn Sie einen Clip in der Miniaturbildanzeige
wihlen und die Wiedergabe starten, kann es zu einem
kurzzeitigen Bildabbruch am Anfang des Clips
kommen. Ohne Verzerrung konnen Sie die
Wiedergabe starten, indem Sie zunichst die
Wiedergabe starten und in die Pause schalten, mit der
Wiedergabefunktionstaste PREV den Anfang des
Clips ansteuern und dann die Wiedergabe fortsetzen.

Hinzufiigen von
Szenenmarkierungen wahrend der
Wiedergabe (exFAT, UDF)

Sie konnen Szenenmarkierungen wéhrend der
Wiedergabe zu Clips hinzufiigen, indem Sie die
gleichen Tasten wie wihrend der Aufnahme dazu
bedienen.

Driicken Sie in einem Bereich, dem Sie
Szenenmarkierungen hinzufiigen méchten,
die belegbaren Tasten, denen Sie Shot
Mark1 oder Shot Mark2 zugewiesen haben.

» Das Aufzeichnen von Szenenmarkierungen ist nicht
moglich, wenn die SxS-Speicherkarte
schreibgeschiitzt ist.

* Szenenmarkierungen kdnnen nicht am Beginn oder
Ende eines Clips aufgezeichnet werden.

Priifung von Audiosignalen
wahrend der Wiedergabe

Im normalen Wiedergabemodus kénnen Sie die
aufgezeichneten Audiosignale tiber den
integrierten Lautsprecher oder den
angeschlossenen Kopfhorer priifen.

Wenn Sie einen Kopfhorer an die
Kopthorerbuchse anschlieBen (Seite 11), wird der
integrierte Lautsprecher stummgeschaltet.
Passen Sie die Lautstirke mithilfe der VOLUME-
Tasten an (Seite 12).

Sie konnen den zu priifenden Kanal mithilfe von
Audio Output (Seite 125) im Audio-Menii
auswihlen.



Clipfunktionen

Mithilfe des Thumbnail-Meniis konnen Sie Clips
schiitzen/loschen, Eigenschaften priifen, Merker
in einem Clip hinzufiigen/I6schen und andere
Vorginge durchfiihren.

Bedienung des Thumbnail-Meniis

Das Thumbnail-Menii kann nur verwendet
werden, wenn eine Miniaturbildanzeige
angezeigt wird.

1 Driicken Sie die Taste THUMBNAIL.

Die Miniaturbildanzeige erscheint.

2 Driicken Sie die Taste MENU.

Die Meniianzeige erscheint.

3 Wiihlen Sie Thumbnail mithilfe der
Tasten 4/%/«/#» oder dem Regler SEL/
SET aus und driicken Sie die Taste SET
oder den Regler SEL/SET.

Um das Thumbnail-Menii auszublenden, driicken
Sie die Taste MENU erneut.

Wiihlen Sie die Mentioptionen und Unteroptionen
wie nachfolgend beschrieben aus.

Wiihlen Sie mithilfe der Tasten 4/¥/«/»
oder dem Regler SEL/SET eine
Meniioption oder Unteroption aus und
driicken Sie die Taste SET oder den Regler
SEL/SET.

Durch Driicken der Taste CANCEL/BACK
(Seite 11) gelangen Sie zum vorherigen
Bildschirm.

* Wenn die SxS-Speicherkarte schreibgeschiitzt ist, sind
einige Bedienvorginge nicht moglich.

 Einige Punkte konnen nicht gewihlt werden, abhingig
vom Zustand des Camcorders wihrend der
Meniianzeige.
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Wiihlen Sie Display Clip Properties im Thumbnail-Menii aus.

45 6 7

Clip Properties

C|Ip0001
1———==="

TG Index  00:05:00:02)| Video codec  XAVC-L50

2 Start 00:05:00:00| Size 1920x1080
End 00:08:19:23||| FPS 59.94P 8
(Duration  00:03:19:23)|| Audio Codec  LPCM
Created ||| chBit 4ch 24bit
3 Aug-23-201410:58:42 ||| pec Mode  Interval Rec

Modified

Aug-23-2014 10:58:42 ||| REC Device PXW- 2280V(SN00001 014)

1. Bild des aktuellen Clips

2. Timecode-Anzeige
TC Index: Timecode des angezeigten Vollbilds
Start: Timecode am Startpunkt der Aufnahme
End: Timecode am Endpunkt der Aufnahme
Duration: Dauer des Clips

3. Datum von Erstellung und Anderung
4. Zurzeit ausgewiihlte Speicherkarte
5. Symbeol fiir geschiitztes Medium

6. Clip-Nummer/Gesamtzahl der Clips
7. Akkusymbol

8. Informationen zum Clip
Name des Clips
Aufzeichnungsformat
Spezielle Aufzeichnungsinformationen
Name des Aufnahmegeriits
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Schiitzen von Clips (exFAT, UDF)

Sie konnen einen bestimmten Clip oder alle Clips
vor dem Loschen schiitzen.

Den Miniaturbildern geschiitzter Clips wird (3)
hinzugefiigt.

Clips konnen in der Miniaturbildanzeige oder der
gefilterten Miniaturbildanzeige (Seite 98)
geschiitzt werden.

Schiitzen eines bestimmten Clips

1 Wiihlen Sie Lock/Unlock Clip >Select
Clip >Execute im Thumbnail-Menii
aus.

Der Bildschirm zur Auswahl von Clips wird
angezeigt.

2 Wihlen Sie den zu schiitzenden Clip
aus.

Der ausgewiihlte Clip wird mit einem
Hikchen versehen.

3 Driicken Sie die Taste MENU.

Ein Bestitigungsbildschirm wird angezeigt.

4 Wihlen Sie Execute aus.

Der Clip wird geschiitzt und eine
Abschlussmeldung wird angezeigt.

5 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Schiitzen aller Clips

1 Wihlen Sie Lock/Unlock Clip >Lock
All Clips >Execute im Thumbnail-
Menii aus.

Ein Bestitigungsbildschirm wird angezeigt.

2 Wiihlen Sie Execute aus.

Alle Clips werden geschiitzt und eine
Abschlussmeldung wird angezeigt.

3 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.
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Entsperren aller Clips

1 Wiihlen Sie Lock/Unlock Clip >Unlock
All Clips >Execute im Thumbnail-
Menii aus.

Ein Bestitigungsbildschirm wird angezeigt.

2 Wiihlen Sie Execute aus.

Alle Clips werden entsperrt und eine
Abschlussmeldung wird angezeigt.

3 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Clips kopieren

Sie konnen Clips auf eine andere Speicherkarte
kopieren.

Clips werden unter den gleichen Namen wie die
Originalclips auf Zielspeicherkarten kopiert.

« Falls auf der Zielspeicherkarte bereits ein Clip
gleichen Namens vorhanden ist, wird dem
Originalnamen eine Ziffer in Klammern hinzugefiigt.
Die Zahl in Klammern ist die kleinste, die am
Speicherort noch nicht vorhanden ist.

Beispiele: ABCD0002 — ABCDO0002(1)
ABCDO0002(1) — ABCD0002(2)
ABCDO0005(3) — ABCDO0005(4)

Falls beim FAT-Dateisystem die Ziffern (1) bis (9) am

Kopierziel bereits vorhanden sind, konnen Sie unter

diesem Namen keine weiteren Clips kopieren.

Falls bei den Dateisystemen exFAT und UDF die

Zahlen von (1) bis (999) am Kopierziel bereits

vorhanden sind, weil ein Clip mehr als 1000 Mal

kopiert wurde, konnen Sie unter diesem Namen keine
weiteren Clips kopieren.

Eine Meldung wird angezeigt, wenn nicht gentigend

Speicherplatz auf der Zielspeicherkarte vorhanden ist.

Tauschen Sie die Karte gegen eine mit mehr freiem

Speicherplatz aus.

Bei einer Speicherkarte mit mehreren aufgezeichneten

Clipsist es je nach Speichercharakteristik und Nutzung

der Speicherkarten ggf. nicht moglich, alle Clips zu

kopieren, selbst wenn die Speicherkarten die gleiche

Kapazitit besitzen.

Einen bestimmten Clip kopieren

1 Wihlen Sie Copy Clip >Select Clip
>Execute im Thumbnail-Menii aus.

Der Bildschirm zur Auswahl von Clips wird
angezeigt.



2 Wihlen Sie den zu kopierenden Clip
aus.

Der ausgewiihlte Clip wird mit einem
Hikchen versehen.

3 Driicken Sie die Taste MENU.
Ein Bestitigungsbildschirm wird angezeigt.

4 Wiihlen Sie Execute aus.

Der Clip wird kopiert und eine
Abschlussmeldung wird angezeigt.

9 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Alle Clips kopieren

Sie konnen alle auf einer Speicherkarte
vorhandenen Clips gleichzeitig auf eine andere
Speicherkarte kopieren.

1 Wiihlen Sie Copy Clip >All Clips
>Execute im Thumbnail-Menii aus.

Ein Bestitigungsbildschirm wird angezeigt.

2 Wiihlen Sie Execute aus.

Alle Clips werden kopiert und eine
Abschlussmeldung wird angezeigt.

3 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Loschen von Clips

Sie konnen Clips von Speicherkarten 16schen.

¢ Geschiitzte Clips konnen nicht geloscht werden.
Entsperren Sie zum Loschen zunichst den Clip.

Einen bestimmten Clip I6schen

1 Wiihlen Sie Delete Clip >Select Clip
>Execute im Thumbnail-Menii aus.

Der Bildschirm zur Auswahl von Clips wird
angezeigt.

2 Wiihlen Sie den zu léschenden Clip aus.

Der ausgewiihlte Clip wird mit einem
Hikchen versehen.

3 Driicken Sie die Taste MENU.

Ein Bestitigungsbildschirm wird angezeigt.

4  Wihlen Sie Execute aus.

Der Clip wird geloscht und eine
Abschlussmeldung wird angezeigt.

5 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Alle Clips loschen

1 Wihlen Sie Delete Clip >All Clips
>Execute im Thumbnail-Menii aus.

Ein Bestitigungsbildschirm wird angezeigt.

2 Waihlen Sie Execute aus.

Alle Clips werden geloscht und eine
Abschlussmeldung wird angezeigt.

3 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Hinzufiigen/Ldschen von Clip-
Merkern (exFAT, UDF)

Sie konnen Merker (OK-, NG-, KEEP-
Markierungen) zu Clips hinzufiigen, um sie
dementsprechend in der gefilterten
Miniaturbildanzeige anzeigen zu lassen
(Seite 98).

Einen Clip-Merker hinzufiigen

1 Wiihlen Sie das Miniaturbild des Clips
aus, dem Sie einen Clip-Merker
hinzufiigen mochten.

2 Wiihlen Sie je nach hinzufiigendem
Clip-Merker Set Clip Flag >Add OK,
Add NG oder Add KEEP im
Thumbnail-Menii aus.

Der Clip-Merker wird dem Miniaturbild des
ausgewihlten Clips hinzugefiigt.

Um einen Clip-Merker hinzuzufiigen, konnen Sie
auch belegbaren Tasten die Funktionen Clip Flag



OK, Clip Flag NG und Clip Flag Keep zuweisen
(Seite 47) und die jeweilige Taste driicken.

Einen Clip-Merker léschen

1 Wihlen Sie das Miniaturbild des Clips
aus, dessen Clip-Merker Sie loschen
mochten.

2 Wihlen Sie Set Clip Flag >Delete Clip
Flag im Thumbnail-Menii aus.

Der Merker des ausgewihlten Clips wird
geloscht.

Selektives Anzeigen von Clips
mithilfe der gefilterten
Miniaturbildanzeige (exFAT, UDF)

Um Clips nach Merkern zu filtern, wihlen
Sie Filter Clips >OK, NG oder KEEP
>Execute im Thumbnail-Menii aus.

Auf dem Bildschirm mit den Clips werden die
nach dem ausgewihlten Merker gefilterten Clips
angezeigt. Dieser Bildschirm wird als gefilterte
Miniaturbildanzeige bezeichnet.

Wenn Sie Filter Clips >All auf dem Thumbnail-
Bildschirm auswihlen, wird der Filter
aufgehoben und es erscheint die normale
Miniaturbildanzeige.

Sie konnen dies auch mithilfe der Taste
DISPLAY umschalten.

Szenenmarkierungen ldschen
(exFAT, UDF)

Sie konnen einem Clip hinzugefiigte
Szenenmarkierungen 16schen.
Szenenmarkierungen 16schen Sie in der
Miniaturbildanzeige mit Inhaltsmarkierung.

1 Wiihlen Sie Thumbnail View >Essence
Mark Thumbnail im Thumbnail-Menii
aus und wihlen Sie dann den Typ der zu
loschenden Szenenmarkierung aus
(Shot Mark1 oder Shot Mark2).

Die Miniaturbildanzeige mit
Inhaltsmarkierung erscheint.
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2 Wihlen Sie das Miniaturbild des
Einzelbilds mit der zu loschenden
Szenenmarkierung aus.

3 Wiihlen Sie Set Shot Mark >Delete Shot
Mark1 oder Delete Shot Mark2 im
Thumbnail-Menii aus.

Die Szenenmarkierung wird vom
ausgewihlten Einzelbild geloscht.

Selektives Anzeigen von Clips
(Einzelbildern) mithilfe der
Miniaturbildanzeige mit
Inhaltsmarkierung (exFAT, UDF)

Wenn in einem Clip mehr als eine
Inhaltsmarkierung (Szenenmarkierung,
Aufnahmestartmarkierung) aufgezeichnet wurde,
konnen Sie Miniaturbilder fiir nur jene
Einzelbilder anzeigen lassen, denen eine
Inhaltsmarkierung hinzugefiigt wurde.

Dieser Bildschirm wird als Miniaturbildanzeige
mit Inhaltsmarkierung bezeichnet.

Waihlen Sie Thumbnail View >Essence
Mark Thumbnail im Thumbnail-Menii aus
und wiihlen Sie dann den Typ der
Inhaltsmarkierung aus, nach der gefiltert
werden soll.

All: Alle Einzelbilder mit Inhaltsmarkierungen

Rec Start: Einzelbilder mit einer
Aufnahmestartmarkierung und das erste
Einzelbild von Clips, die keine
Aufnahmestartmarkierung besitzen

Shot MarkO0 bis Shot Mark9: Einzelbilder mit
der jeweiligen Szenenmarkierung

Die Miniaturbildanzeige mit Inhaltsmarkierung
wird gefiltert nach der ausgewihlten
Inhaltsmarkierung angezeigt.

Falls ein Clip unter Verwendung von
Planungsmetadaten aufgezeichnet wurde, in
denen Namen fiir die Szenenmarkierungen 0 bis 9
definiert sind, werden die Auswahloptionen in
der Liste mit den definierten Namen angezeigt.



Hochladen von Clips von der
Miniaturbildanzeige oder der
gefilterten Clip-
Miniaturbildanzeige (exFAT, UDF,
FAT)

Sie konnen einen Clip auf einer SxS-
Speicherkarte auswihlen und auf einen Server
iibertragen.

Niheres dazu finden Sie unter ,,Auswdihlen und
Hochladen einer Datei“ (Seite 75).

Andern der in der
Miniaturbildanzeige
erscheinenden Informationen

Sie konnen indern, welche Informationen zum
Clip bzw. Bild unter einem Miniaturbild
angezeigt werden.

Wiihlen Sie Customize View >Thumbnail

Caption im Thumbnail-Menii aus und dann

die anzuzeigenden Informationen.

Date Time: Datum und Uhrzeit der Clip-
Erstellung und seiner letzten Anderung.

Time Code: Timecode

Duration: Dauer

Sequential Number: Miniaturbildnummer

Andern des Indexbilds eines Clips

Sie konnen das in der Miniaturbildanzeige mit
Inhaltsmarkierung ausgewihlte Einzelbild als
Indexbild fiir den Clip festlegen.

1 Wihlen Sie in der Miniaturbildanzeige
mit Inhaltsmarkierung das
Miniaturbild des Einzelbilds aus, das
Sie als Indexbild festlegen mochten.

2 Wiihlen Sie Set Index Picture im
Thumbnail-Menii aus.

Das ausgewihlte Einzelbild wird als
Indexbild des Clips festgelegt.
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AnschlieBen externer Monitore und Aufnahmegerate

Zum Anzeigen von Aufzeichnungs-/
Wiedergabebildern auf einem externen Monitor
wihlen Sie das Ausgangssignal des Camcorders
und schliefen den Monitor mit einem geeigneten
Kabel an.

Sie konnen auch Aufnahmegerite wie einen
Videorekorder anschliefen und das
Ausgangssignal vom Camcorder aufzeichnen.
Auf einem externen Monitor konnen dieselben
Informationen angezeigt werden, die auch im
Sucher erscheinen, z. B. Statusinformationen und
Meniis. Setzen Sie Output Display (Seite 125) im
Video-Menii fiir den entsprechenden Signaltyp
auf On, um das Signal an den Monitor
auszugeben.

Anschluss SDI QUT (BNC-Ausfiihrung)

Stellen Sie im Video-Menii ein, ob der Ausgang
ein- bzw. ausgeschaltet ist, und legen Sie das
Ausgabeformat fest (Seite 125).

Verwenden Sie fiir den Anschluss ein
handelsiibliches 75- Q-Koaxialkabel.

Stellen Sie vor dem Einschalten unbedingt eine
Erdungsverbindung zwischen Camcorder und
externem Gerit her.

(Wir empfehlen, vor dem Einschalten des Camcorders
und des externen Geriits erst ein 75- Q-Koaxialkabel
anzuschlieen.)

Wenn Sie ein externes Gerit an den Camcorder
anschlielen, withrend der Camcorder eingeschaltet ist,
schlieBen Sie das 75- Q-Koaxialkabel erst an das
externe Gerit an und dann an den Camcorder.

Synchronisierte Aufnahme auf dem Camcorder
und einem externen Gerét starten

Wenn der SDI-Signalausgang ausgewihlt wurde,
setzen Sie SDI/HDMI Rec Control (Seite 125)
>Setting im Video-Menii auf On, um an das
externe Gerdt am Anschluss SDI OUT ein REC-
Auslosersignal zu leiten. Dadurch wird die
Aufzeichnung auf dem externen Gerit mit dem
Camcorder synchronisiert.

« Wenn ein angeschlossenes externes Gerit nicht auf das
REC Auslosesignal anspricht, kann das Gerit nicht
bedient werden.
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Anschluss HDMI OUT (Typ A)

Stellen Sie im Video-Menii ein, ob der Ausgang
ein- bzw. ausgeschaltet ist, und legen Sie das
Ausgabeformat fest (Seite 125).

Verwenden Sie fiir den Anschluss ein
handelsiibliches HDMI-Kabel.

Synchronisierte Aufnahme auf dem Camcorder
und einem externen Gerét starten

Wenn der HDMI-Signalausgang ausgewihlt
wurde, setzen Sie HDMI TC Out (Seite 130)
>Setting im TC/UB-Menii auf On und SDI/
HDMI Rec Control (Seite 125) >Setting im
Video-Menii auf On, um an das externe Gerit am
Anschluss HDMI OUT ein REC-Auslosersignal
zu leiten. Dadurch wird die Aufzeichnung auf
dem externen Gerit mit dem Camcorder
synchronisiert.

Anschluss GENLOCK IN/VIDEO OUT
(BNC-Ausfiihrung)

Uber den Anschluss kénnen HD-Y-Signale, HD-
Synchronisationssignale oder
herunterkonvertierte analoge SD-Composite-
Signale an den Monitor ausgegeben werden,
indem die Einstellung fiir Output Format im
Video-Menii entsprechend gedndert wird.
Verwenden Sie zum Anschliefen ein
handelsiibliches BNC-Kabel.

Niheres dazu finden Sie unter ,, Videoformate
und Ausgangssignale (Seite 168).

Multi/Micro USB-Anschluss

2-Kanal-Audiosignale konnen mithilfe des AV-
Kabels VMC-15MR2 (separat erhéltlich)
ausgegeben werden.

Anschluss REMOTE

Uber eine hier angeschlossene Fernbedienung
RM-30BP konnen verschiedene
Kamerafunktionen fernbedient werden.

Um die Fokus-, Blenden- und Zoom-Funktionen
zu verwenden, sind folgende Schritte
erforderlich.




Fokus

« Stellen Sie den AF-Ring des Objektivs in die
Position AF.

« Stellen Sie den Schalter FOCUS des Objektivs
in die Position MANUAL und stellen Sie
sicher, dass auf dem Bildschirm ,, MF*
angezeigt wird.

Blende

Stellen Sie den Schalter IRIS des Objektivs in die
Position AUTO. Stellen Sie sicher, dass auf dem
Bildschirm nicht ,,AE* angezeigt wird. Wird
LAE® angezeigt, driicken Sie die Taste IRIS der
RM-30BP, sodass es ausgeblendet wird.

Zoom
Stellen Sie den Zoom-Schalter des Objektivs in
die Position SERVO.

Synchronisation mit
externen Geraten

Wenn mehrere Camcorder dieses Modells am
selben Aufnahmeort eingesetzt werden, lisst sich
die Aufnahme mithilfe eines bestimmten
Referenzsignals synchronisieren und die
Timecodes der Geriite konnen aufeinander
abgestimmt werden.

Synchronisieren der Videosignalphase
(Genlock)

Genlock-Betrieb ist moglich, wenn ein
Referenzsignal am Anschluss GENLOCK IN/
VIDEO OUT (Seite 10) des Camcorders
eingespeist wird.

Die verfiigbaren Referenzsignale hingen von der
Systemfrequenz des gewihlten
Aufzeichnungsformats ab.

Systemfrequenz des Giiltige

Aufzeichnungsformats Referenzsignale

59.94P 1920x1080 59.94i
720x486 59.94i
1280x720 59.94P

29.97p 1920x1080 59.94i
720x486 59.94i

23.98P 1920x1080 47.951
(23.98PsF)

59.94i 1920x1080 59.94i
720x486 59.94i

50P 1920x1080 50i
720x576 50i
1280720 S0P

25p 1920x1080 501
720x576 50i

50i 1920x1080 50i
720x576 50i

Es miissen Video- und Timecode-Signale eingespeist
werden, wenn als Aufnahmeformat 1280x720 60P
ausgewihlt wurde.

Wenn das Referenzsignal nicht stabil ist, ist Genlock
nicht anwendbar.

Der Subtriger wird nicht synchronisiert.



Synchronisation mit dem Timecode
anderer Gerdte

Versetzen Sie das Gerit, das den Timecode
liefert, in einen Modus, in dem der Timecode
weiterlduft (z. B. Free Run oder Clock).

1 Setzen Sie Timecode im TC/UB-Menii
auf folgende Einstellungen:

Mode: Preset
Run: Free Run

2 Driicken Sie die Taste DURATION/TC/
U-BIT (Seite 12), um den Timecode am
Bildschirm anzuzeigen.

3 Vergewissern Sie sich, dass der Schalter
IN/OUT (Seite 10) auf IN gestellt ist,
und speisen Sie dann ein HD- oder SD-
Referenzvideosignal am Anschluss
GENLOCK IN/VIDEO OUT und den
Referenz-Timecode am Anschluss TC
ein.

Der integrierte Timecode-Generator des
Camcorders synchronisiert sich mit dem
Referenz-Timecode und die Meldung ,,Ext LK*
wird am Bildschirm angezeigt.

Etwa zehn Sekunden nach Herstellung der
Verbindung bleibt die externe Verbindung auch
dann bestehen, wenn der Referenz-Timecode
vom externen Gerit wegfillt, weil dieses vom
Camcorder getrennt wird.

Stellen Sie sicher, dass sich der Referenz-Timecode
und das Referenzvideosignal in einem
Phasenverhiltnis befinden, das dem SMPTE-
Timecode-Standard entspricht.

Nach Herstellung der externen Synchronisierung wird
der Timecode sofort mit dem externen Timecode
synchronisiert, und im Datenanzeigebereich wird der
Wert des externen Timecodes angezeigt. Beginnen Sie
jedoch nicht gleich mit der Aufnahme. Warten Sie
einige Sekunden mit dem Start der Aufzeichnung, bis
sich der Timecode-Generator stabilisiert hat.

Wenn die Frequenz des Referenzvideosignals und die
Bildfrequenz auf dem Camcorder nicht gleich sind,
kann keine Verbindung erreicht werden, und es ist
keine einwandfreie Funktion des Camcorders moglich.
In diesem Fall erfolgt keine korrekte Verbindung des
Timecodes mit dem externen Timecode.

Wenn die Verbindung getrennt wird, kann sich der
Timecode im Verhiltnis zum Referenz-Timecode um
ein Einzelbild pro Stunde verschieben.

Aufheben der externen Timecode-
Synchronisation

Andern Sie die Einstellung fiir Timecode im TC/
UB-Menii oder schalten Sie den Camcorder in
STANDBY.

Die externe Synchronisation wird auch
aufgehoben, wenn Sie die Systemfrequenz
dndern und wenn Sie in einem speziellen
Aufnahmemodus aufzeichnen (Zeitlupe und
Zeitraffer oder Intervallaufzeichnung).

Synchronisieren des Timecodes eines
anderen Gerats mit dem des Camcorders

1 Legen Sie den Timecode des
Camcorders iiber die Einstellung
Timecode (Seite 43) im TC/UB-Menii
fest.

2 Stellen Sie sicher, dass der Schalter TC
IN/OUT (Seite 10) auf OUT steht, und
leiten Sie den Anschliissen TC und
GENLOCK IN/VIDEO OUT (Seite 10)
jeweils das Timecode-Eingangssignal
bzw. das Referenzsignal des Geriits zu,
mit dem die Synchronisierung erfolgen
soll.



Verwalten/Bearbeiten
von Clips auf einem
Computer

Verbindung per USB-Kabel

Verbinden Sie den Camcorder iiber ein USB-
Kabel mit einem Computer und setzen Sie eine
Speicherkarte in den Einschub ein. Die
Speicherkarte wird als externes
Computerlaufwerk erkannt.

Wenn zwei Speicherkarten in den Camcorder
eingesetzt sind, werden sie vom Computer als
zwei unabhingige externe Laufwerke erkannt.

* Der Camcorder kann nicht per USB vom Computer
mit Strom versorgt werden. Halten Sie eine separate
Stromquelle bereit.

In den folgenden Fillen wird der Camcorder nicht als

Laufwerk erkannt.

— Wiihrend der Aufnahme (einschlieBlich
Spezialaufnahmemodi)

— Wiihrend der Wiedergabe (einschlieSlich
Hochgeschwindigkeitswiedergabe und im
angehaltenen Zustand)

— Wiihrend der Miniaturbildanzeige

— Wihrend Medien formatiert (initialisiert) werden

— Wenn Speicherkarten wiederhergestellt oder
Verwaltungsdateien aktualisiert werden
(einschlieBlich wihrend der Bestitigung vor der
Ausfiihrung)

— Wiihrend des Streaming

— Wiihrend der Verbindung im Netzwerk-Client-
Modus

Wenn dieses Gerit tiber USB mit einem Computer

verbunden ist, wird die USB-Verbindung eventuell

getrennt und wiederhergestellt, wenn eine SD-Karte
aus dem Medienadapter entfernt oder eingesetzt wird
oder wenn andere Medientypen gewechselt werden.

1 Verbinden Sie den Multi/Micro USB-
Anschluss des Camcorders iiber ein
USB-Kabel mit dem Computer.

Stellen Sie den Schalter ON/STANDBY
auf ON.

Auf dem LCD-/Sucherbildschirm wird eine
Meldung mit der Frage angezeigt, ob Sie die
USB-Verbindung aktivieren mochten.

* Wenn die Bestitigungsmeldung ausgeblendet
wird, trennen Sie das USB-Kabel und schlieSen
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es erneut an. Die Bestitigungsmeldung wird nicht
wiihrend der Aufnahme/Wiedergabe und der
Miniaturbildanzeige angezeigt.

3 Wiihlen Sie Execute mithilfe der Tasten
4/¥%/«/» oder des Reglers SEL/SET aus.
4  Auf einem Windows-Computer muss
gepriift werden, ob die Speicherkarte
im Fenster ,,Dieser PC* oder
,Computer* als Wechseldatentriger
angezeigt wird.
Auf einem Macintosh-Computer ist zu
priifen, ob der Ordner ,,NO NAME*
oder ,,Untitled* auf dem Desktop
erstellt wurde.

Die folgenden Vorginge sollten nicht ausgefiihrt

werden, wenn die ACCESS-Leuchte rot leuchtet.

— Ausschalten des Geriits oder Trennen des
Netzkabels

— Entnehmen der SxS-Speicherkarte

— Abziehen des USB-Kabels

Wiihlen Sie beim Herausnehmen einer SxS-

Speicherkarte an einem Macintosh nicht die Option

,.Card Power Off* iiber das SxS-

Speicherkartensymbol auf der Meniileiste.

Der ordnungsgemifie Betrieb ist nicht bei allen

Computern gewihrleistet.

Anwendungssoftware

Um Clips auf die lokale Festplatte Ihres
Computers zu kopieren, muss die dafiir
vorgesehene Anwendungssoftware
heruntergeladen und auf Threm Computer
installiert werden. Einzelheiten zum
Herunterladen von Software siehe ,, Software-
Downloads* (Seite 202).

Die Daten zu den Aufnahmen werden zwar auf
mehrere Dateien und Ordner verteilt gespeichert,
aber mit der dedizierten Anwendungssoftware
konnen Sie die Clips problemlos handhaben,
ohne die Daten- und Verzeichnisstruktur zu
berticksichtigen.

* Wenn Sie Funktionen wie das Kopieren von Clips auf
einer SxS-Speicherkarte mit dem Explorer (Windows)
oder Finder (Macintosh) ausfiihren, gehen die in den
Clips enthaltenen ergidnzenden Daten moglicherweise
verloren.



Verwenden eines nichtlinearen
Schnittsystems

Ein nonlineares Bearbeitungssystem erfordert ein
optionales Bearbeitungsprogramm, das mit den
Aufnahmeformaten des Camcorders kompatibel
ist.

Speichern Sie zuerst die Clips, die bearbeitet
werden sollen, mithilfe der dedizierten
Anwendungssoftware auf der Festplatte Ihres
Computers.

AnschlieBen einer externen
Festplatte/eines USB-Mediums

Wenn eine externe Festplatte oder ein USB-
Medium mit dem USB 3.0 (HOST)-Anschluss
des Camcorders verbunden ist, konnen Sie Clips
von dem in einen SxS-Speicherkarteneinschub
eingesetzten Aufnahmemedium auf die externe
Festplatte oder das USB-Medium kopieren.

Kopieren von Clips auf ein USB-Medium

1 Wihlen Sie USB >Select Folder
(Seite 134) im Media-Menii aus.

Wiihlen Sie in der Ordnerliste den
Zielordner fiir das Kopieren aus und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Sie konnen auch New auf dem Bildschirm
auswihlen, um einen neuen Ordner zu
erstellen.

Falls kein Ordner angegeben wird, so wird
automatisch ein neuer erstellt und mit dem
Erstellungsdatum des ersten zu kopierenden Clips
benannt. Die Clips werden in diesen Ordner
kopiert.

Wiihlen Sie USB >Copy to USB

(Seite 134) im Media-Menii aus, setzen

Sie das zu kopierende

Aufnahmemedium ein und wiihlen Sie

den SxS-Speicherkarteneinschub aus.

Media(A) to USB: Alle Clips vom in den
Einschub A eingesetzten
Aufnahmemedium kopieren.
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Media(B) to USB: Alle Clips vom in den
Einschub B eingesetzten
Aufnahmemedium kopieren.

Media(A)(B) to USB: Alle Clips von den
in die Einschiibe A und B eingesetzten
Aufnahmemedien kopieren.

* Wenn ein Kopierzielordner in Schritt 2 und
Media(A)(B) to USB angegeben wurde, werden
die Clips von Einschub A in den angegebenen
Zielordner kopiert. Clips von Einschub B werden
in einen automatisch erstellten Ordner kopiert,
der mit dem Erstellungsdatum des ersten Clips
benannt wird.

Wiihlen Sie Execute mithilfe der Tasten
4/¥%/«/» oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Alle Clips vom Aufnahmemedium werden
auf das USB-Medium kopiert.

« Falls im Zielordner bereits ein Clip mit dem
gleichen Namen wie der zu kopierende Clip
vorhanden ist, wird der Clip nicht kopiert.

Anzeigen einer Liste der Clips auf einer
externen Festplatte/einem USB-Medium

Mithilfe von USB >View Clip List (Seite 134) im
Media-Menii konnen Sie eine Liste der auf einer
externen Festplatte/einem USB-Medium
gespeicherten Clips anzeigen.

Umbenennen eines Ordners auf einer
externen Festplatte/einem USB-Medium

1 Wiihlen Sie USB >Rename Folder
(Seite 134) im Media-Menii aus.

2

Waihlen Sie in der Ordnerliste den
umzubenennenden Ordner aus und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Es wird ein Bildschirm zum Eingeben von
Dateinamen angezeigt.

Geben Sie einen Ordnernamen ein und
wiihlen Sie Done aus.

Der Ordner wird umbenannt.



Priifen auf Lesefehler heim Kopieren

Sie konnen Clips nach dem Schreiben auf
Lesefehler priifen lassen, indem Sie USB >Error
Check (Seite 134) im Media-Menii auf On setzen.

Formatieren (Initialisieren) einer
externen Festplatte/eines USB-Mediums

1 Wihlen Sie USB >Format USB
(Seite 134) im Media-Menii aus.

2 Wiihlen Sie Execute mithilfe der Tasten
4/%/«/» oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Initialisierung (Formatierung) beginnt.

3 Sobald die Formatierung abgeschlossen
ist, wird eine Meldung angezeigt.
Wiihlen Sie OK aus.

Priifen der verbleibenden Kapazitat einer
externen Festplatte/eines USB-Mediums

Der freie Speicherplatz auf einer externen
Festplatte/einem USB-Medium wird in der Zeile
Media Remain auf dem Bildschirm angezeigt,
wenn USB im Media-Menii ausgewihlt wird.

Hinweise zur Stromversorgung einer
externen Festplatte/eines USB-Mediums

Externe Festplatten/USB-Medien werden bei
Verwendung von USB-Meniioptionen im Media-
Menii automatisch iiber den USB 3.0 (HOST)-
Anschluss mit Strom versorgt.

Unter den nachfolgend aufgefiihrten
Bedingungen jedoch wird selbst bei Verwendung
von USB-Meniioptionen im Media-Menii die
Stromversorgung nicht aufgenommen. Um die
Stromversorgung einzuschalten, gehen Sie nach
der in der Tabelle aufgefiihrten Losung vor.

Zustand Losung

Bei Aufnahme/Wiedergabe Beenden Sie den
von Clips, vorhergehenden
Miniaturbildanzeige, Proxy- Vorgang.
Aufnahme, Formatieren/

Wiederherstellen von

Medien, Aktualisieren von
Verwaltungsdateien und

Software, Zuriicksetzen des

Camcorders oder des

Netzwerks, AnschlieBen

eines Computers, Anzeige

von

Bestitigungsbildschirmen,

Streaming

Unzureichende Wechseln Sie den Akku

Versorgungsspannung oder verwenden Sie eine
andere
Stromversorgung.

Rec Format >File System ist Setzen Sie die
nicht auf exFAT gesetzt Einstellung auf exFAT.

Network Client Mode ist auf Setzen Sie Network
On gesetzt Client Mode auf Off.

* Clips auf einer externen Festplatte/einem USB-
Medium konnen nicht auf in einen SxS-
Speicherkarteneinschub eingesetzte Aufnahmemedien
kopiert werden.

* Clips kénnen nicht aufgenommen werden, solange der
USB 3.0 (HOST)-Anschluss mit Strom versorgt wird.
Um Clips aufzunehmen, beenden Sie die Verwendung
von USB-Meniioptionen im Media-Menii.



Meniianzeige und Einstellungen

Konfiguration und Hierarchie des Einstellmeniis

Driicken Sie die Taste MENU, um das

Einstellmenii auf dem LCD-Bildschirm/Sucher

anzuzeigen und verschiedene Einstellungen fiir

die Aufnahme, Aufzeichnung und Wiedergabe
festzulegen (das Menii kann auch auf einem
externen Monitor angezeigt werden). Das

Einstellmentii ist in folgende Meniis gegliedert.

User Menu: Menii mit
benutzerkonfigurierbaren Optionen (mithilfe
von Edit User Menu zu bearbeiten).

Edit User Menu-Menii: Menii zum Bearbeiten
der User-Meniioptionen.

Camera-Men(i: Enthilt Einstellungen fiir die
Aufnahme.

Paint-Meni: Enthilt Einstellungen fiir die
Bildqualitit.

Audio-Menii: Enthilt Einstellungen fiir die
Audiosteuerung.

Video-Menii: Enthilt Einstellungen fiir die
Videoausgabe.

LCD/VF-Menii: Enthilt Einstellungen fiir die
Anzeige auf LCD-Bildschirm und im
Sucher.

TC/UB-Menii: Enthilt Einstellungen zu
Timecode und User-Bits.

Recording-Menii: Enthilt Einstellungen fiir
die Aufzeichnung.

Thumbnail-Menii: Enthilt Einstellungen fiir
die Miniaturbildanzeige.

Media-Menii: Enthilt Einstellungen fiir die
Speichermedien.

File-Menii: Enthilt Einstellungen fiir die
Dateien.

Network-Menii: Enthilt Einstellungen fiir
Netzwerke.

System-Menii: Enthilt Einstellungen fiir das
System.

Hierarchie des Einstellmeniis

MENU
User Base Setting
HDR Setting
Rec Format
S&Q Motion

Picture Cache Rec

 Edit User Menu

- Camera

 Paint

- Simul Rec

4K & HD (Sub) Rec
- Proxy Rec

— Output Format

- Assignable Button
- Delete Clip

— Wireless LAN

— Wired LAN

— Modem

- Format Media

— Menu Settings

L Edit User Menu

Add ltem
Customize Reset

— Focus

 ND Filter

— Gain

— Shutter

I Auto Exposure

- Color Bars

- Flicker Reduce

- Flash Band Reduce
- Handle Zoom

- Auto Black Balance
— Auto FB Adjust

L Video Light Set

—— HDR Paint Setting
- White

— White Setting

— Offset White

- Black

— Gamma

— Black Gamma

— Low Key Saturation
- Saturation Mode

— Noise Suppression
- Knee

— White Clip

I Detail(QFHD)

- Detail(HD)

- Detail(SD)

- Skin Detail

— Aperture

— Matrix




- Audio

 Video

— LCD/VF

—TC/UB

- Recording

— Thumbnail

- Media

Multi Matrix
Maintenance

—I: Audio Input

Audio Output

— Output On/Off

- Output Format

- Output Display

- SDI/HDMI Rec Control
L Down Converter

— LCD Setting

- VF Setting

- Peaking

— Marker

- Zebra

— Gamma Display Assist
L Display On/Off

— Timecode
- Users Bit
L HDMI TC Out

— S&Q Motion

- Interval Rec

- Picture Cache Rec
- Clip Continuous Rec
- Simul Rec

- 4K & HD (Sub) Rec
I Proxy Rec

- Rec Review

— Display Clip Properties
- Set Shot Mark

- Set Clip Flag

- Lock/Unlock Clip

- Delete Clip

I Copy Clip

- Copy Sub Clip

- Transfer Clip

- Transfer Clip (Proxy)
I Set Index Picture
 Thumbnail View

- Filter Clips

L Customize View

— Update Media
- Format Media
- USB

- Clip Naming

L Planning Metadata

+ File

— Network

L System
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— User File

— All File

- Scene File

L Network Public Key

— Setup for Mobile App
I Access Authentication
I Wireless LAN

— AP Mode Settings

- ST Mode Settings

— Wired LAN

— Modem

- Network Client Mode
+ File Transfer

I Streaming

- RTMP/RTMPS

L Network Reset

— Base Setting

— HDR Setting

- Rec Format

- Assignable Button
— Switch Hold Setting
— Tally

- Language

I Clock Set

- Hours Meter

— GPS

I Battery Alarm

- DC Voltage Alarm
— Menu Settings

— Fan Control

— All Reset

L Version



Funktionen im
Einstellmenii

Driicken Sie die Taste MENU, um das
Einstellmenii auf dem LCD-Bildschirm/Sucher
anzuzeigen und verschiedene Einstellungen fiir
die Aufnahme, Aufzeichnung und Wiedergabe
festzulegen (das Menii kann auch auf einem
externen Monitor angezeigt werden).

Meniisteuerung

Taste MENU (Seite 11)
Aktiviert bzw. deaktiviert den Meniimodus fiir
die Bedienung des Einstellmeniis.

Regler SEL/SET (Seite 11)

Durch Drehen lidsst sich der Cursor zur Auswahl
von Optionen oder Einstellungen nach oben und
unten bewegen.

Driicken Sie den Regler SEL/SET, um das
gewihlte Element zu iibernehmen.

Taste CANCEL/BACK (Seite 11)

Driicken Sie diese Taste, um zum
vorhergehenden Menii zu wechseln. Nicht
bestitigte Anderungen werden verworfen.

Tasten #/¥/«/»/SET

Driicken Sie die Tasten 4/%/<«/%, um den Cursor
nach oben/unten/links/rechts zu bewegen und
Meniioptionen oder Einstellungen auszuwihlen.
Driicken Sie den Taste SET, um die gewihlte
Option zu iibernehmen.

¢ Im Fokuslupenbildschirm (Seite 36) kann das
Einstellmenii nicht verwendet werden.

Festlegen von Meniielementen

Bewegen Sie den Cursor mithilfe der Tasten #/%/
«/% oder dem Regler SEL/SET auf die
gewiinschte Option und driicken Sie die Taste
SET oder den Regler SEL/SET, um die
Einstellung zu tibernehmen.

* Im Auswahlbereich der Meniioption werden
maximal 9 Zeilen angezeigt. Falls nicht alle
verfiigbaren Optionen fiir ein Element
gleichzeitig angezeigt werden konnen, blittern
Sie durch die Liste, indem Sie den Cursor nach
oben bzw. nach unten bewegen.
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* Bei Unteroptionen mit einem grofien
Einstellbereich (z. B. —99 bis +99) wird der
Einstellbereich nicht angezeigt. Die aktuelle
Einstellung ist hervorgehoben, um den
dnderbaren Wert zu kennzeichnen.

* Durch die Wahl von Execute wird die
entsprechende Funktion ausgefiihrt.

¢ Bei Auswabhl eines Elements, das vor der
Ausfiihrung bestitigt werden muss, wird das
Menii voriibergehend durch eine
Bestitigungsmeldung iiberlagert. Uberpriifen
Sie die Meldung, und wihlen Sie dann, ob die
Funktion ausgefiihrt oder abgebrochen werden
soll.

Eingeben einer Zeichenfolge

Wenn Sie ein Element wihlen, fiir das eine
Zeichenfolge eingegeben werden muss (z. B. ein
Dateiname), wird ein Bildschirm zur
Zeicheneingabe eingeblendet.

Edit File Name

Kurokawa_Scene_ 001 a

Bbcdefgh.i

n opgqgr st

u v wixy z

2 3

1 Wihlen Sie durch Drehen des Reglers
SEL/SET die Art der Zeichen und
driicken Sie dann auf den Regler.
ABC: GroBbuchstaben
abc: Kleinbuchstaben
123: Numerische Zeichen
1#$: Sonderzeichen

Wiihlen Sie ein Zeichen aus dem
gewihlten Zeichentyp aus, und driicken
Sie auf den Regler.

Der Cursor bewegt sich zum néchsten Feld.
Space: Fiigt an der Cursorposition ein
Leerzeichen ein.

«/*: Andert die Position des Cursors.

BS: Loscht das Zeichen links vom Cursor
(Riicktaste).



Wenn Sie fertig sind, wiihlen Sie Done
und driicken auf den Regler.

Die Zeichenfolge wird iibernommen, und der
Bildschirm zur Zeicheneingabe wird
ausgeblendet.

Sperren und Entsperren des Meniis

Sie konnen das Einstellmenii sperren, sodass nur
das User-Menii angezeigt wird.

Sperren des Meniis

1

Halten Sie den Regler SEL/SET

User-Menii zu registrieren, konnen diese Funktionen
keinen belegbaren Tasten zugewiesen werden.

« Falls diese Funktionen bereits belegbaren Tasten
zugewiesen wurden, wird die zugewiesene Einstellung
ab dem Zeitpunkt deaktiviert, zu dem das Menii

gesperrt wird.

Einstellmeniioption

Auswahloptionen
fiir belegbare
Tasten

Camera >Focus >Face
Detection AF

Face Detection AF

Camera >Gain >Gain
<Turbo>

Turbo Gain

Camera >Auto Exposure
>Level

Auto Exposure Level

gedriickt und driicken Sie die Taste Camera >Auto Exposure  Spotlight
MENU >Mode
Camera >Auto Exposure Backlight
2 Wiihlen Sie Menu Settings >User Menu >Mode
with Lock im System-Menii aus Camera >Auto Exposure Auto ND Filter
: >Auto ND Filter
m Camera >Auto Exposure AGC
* Wenn Sie nur die Taste MENU driicken, um das >AGC
normale Einstellmenii anzuzeigen, wird User Camera >Auto Exposure Shutter
Menu Only unter Menu Settings im System- >Auto Shutter
Menii angezeigt. Halten Sie den Regler SEL/SET Camera >Color Bars Color Bars
gedriickt und driicken Sie die Taste MENU, um >Settin
User Menu with Lock anzuzeigen. £
Camera >Flash Band Reduce Flash Band Reduce

3 Setzen Sie die Einstellung auf On und >Setting

Camera >Handle Zoom Handle Zoom

>Setting

driicken Sie die Taste SET oder den

Regler SEL/SET.

Paint >White >Preset White Preset White Select

Die Anzeige des LCD-/Sucherbildschirms

Audio >Audio Output Audio Monitor CH

wechselt zu einem Bildschirm fiir die >Monitor CH Audio Mon. CH Switch
Eingabe eines Codes. LCD/VF >VF Setting >Color VE Mode
Mode
4 Geben Sie eine beliebige Zahl ein. LCD/VF >Peaking >Setting _ Peaking
Geben Sie eine vierstellige Zahl von 0000 bis LCD/VF >Marker >Setting ~ Marker
9999 ein. Der Standardwert ist 0000. LCD/VF >Zebra >Setting Zebra
Geben Sie eine Ziffer ein und driicken Sie die LCD/VF >Gamma Display ~ Gamma Display Assist
Taste SET oder den Regler SEL/SET, um zur Assist >Setting
niichsten Ziffer zu wechseln. LCD/VF >Display On/Off  Lens Info
>Lens Info

Wenn alle Ziffern eingegeben wurden,

LCD/VF >Display On/Off
>Video Signal Monitor

bewegen Sie den Cursor auf SET. Video Signal Monitor

9 Driicken Sie die Taste SET oder den
Regler SEL/SET.

Recording >S&Q Motion
>Setting

S&Q Motion

Recording >Picture Cache Picture Cache Rec

Die Eingabe wird iibernommen. Rec >Setting

Eine Bestitigungsmeldung erscheint und der

. . . Recording >Clip Continuous
Bildschirm wechselt zur Anzeige des User-

Rec >Setting

Clip Continuous Rec

Mentiis.

Recording >Rec Review Rec Review
Thumbnail >Set Shot Mark ~ Shot Mark1

« Falls das Menii gesperrt wird, ohne

Einstellmeniioptionen aus den folgenden Tabellen im >Add Shot Markl
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Einstellmeniioption Auswahloptionen
fiir belegbare
Tasten

Thumbnail >Set Shot Mark ~ Shot Mark2

>Add Shot Mark2

Thumbnail >Set Clip Flag Clip Flag OK

>Add OK

Thumbnail >Set Clip Flag Clip Flag NG

>Add NG

Thumbnail >Set Clip Flag Clip Flag Keep

>Add KEEP

Network >Wireless LAN NFC

>NFC

Network >Network Client
Mode >Setting

Network Client Mode

Network >File Transfer
>Auto Upload (Proxy)

Auto Upload (Proxy)

Network >Streaming Streaming
>Setting

Network >SRTMP/RTMPS ~ RTMP/RTMPS
>Setting

User User Menu

Entsperren des Meniis

1 Halten Sie den Regler SEL/SET
gedriickt und driicken Sie die Taste

MENU.

2 Wihlen Sie Menu Settings >User Menu
with Lock im System-Menii aus.

* Wenn Sie nur die Taste MENU driicken, um das
normale Einstellmenii anzuzeigen, wird User
Menu Only unter Menu Settings im System-
Menii angezeigt. Halten Sie den Regler SEL/SET
gedriickt und driicken Sie die Taste MENU, um
User Menu with Lock anzuzeigen.

3 Setzen Sie die Einstellung auf Off und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Anzeige des LCD-/Sucherbildschirms
wechselt zu einem Bildschirm fiir die
Eingabe eines Codes.

4 Geben Sie den zum Sperren des Meniis
verwendeten Code ein.
Geben Sie eine Ziffer ein und driicken Sie die
Taste SET oder den Regler SEL/SET, um zur
nichsten Ziffer zu wechseln.
Wenn alle Ziffern eingegeben wurden,
bewegen Sie den Cursor auf Set.
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5 Driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Eingabe wird iibernommen.

Falls der eingegebene Code jenem fiir die
Sperrung des Meniis entspricht, wird das
Menti entsperrt und angezeigt.

« Falls der eingegebene Code jenem fiir die Sperrung des
Mentiis nicht entspricht, wird das Menii nicht entsperrt.

* Es wird empfohlen, den Code so aufzubewahren, dass
Sie ihn nachschlagen konnen, falls Sie ihn vergessen.
Falls Sie den Code vergessen haben sollten, wenden
Sie sich an den Sony-Kundendienst.

Bearbeiten des User-Meniis

Sie konnen das User-Menii mithilfe von Edit User
Menu bearbeiten, z. B. Optionen hinzufiigen,
16schen oder anders anordnen, um das User-
Menii an Thre Bediirfnisse anzupassen.

Hinzufiigen von Optionen und
Unteroptionen

1 Wiihlen Sie Edit User Menu >Add Item
im User-Menii aus.
Die hinzufiigbaren Optionen werden
angezeigt.

2 Wiihlen Sie eine hinzuzufiigende
Option aus.
Ein Bildschirm zur Auswahl
hinzuzufiigender Unteroptionen wird
angezeigt.

3 Wiihlen Sie eine hinzuzufiigende
Unteroption aus.
Aktivieren Sie das Kontrollkistchen All, um
alle Unteroptionen hinzuzufiigen.
Aktivieren Sie Kontrollkdstchen individuell,
um die hinzuzufiigenden Unteroptionen
festzulegen.

4 Wihlen Sie OK aus und driicken Sie die
Taste SET oder den Regler SEL/SET.
Die Optionen/Unteroptionen werden
hinzugefiigt.

* Ein und dieselbe Option oder Unteroption kann nicht
zwei Mal registriert werden.



Auferdem kann der Name der Option oder
Unteroption nicht gedndert werden.

Bearbeiten von Unteroptionen

Sie konnen die anzuzeigenden Unteroptionen
angeben.

1

Waihlen Sie Edit User Menu im User-
Menii aus und dann die zu bearbeitende
Option.

Die Liste zur Bearbeitung der Funktionen
wird angezeigt.

Wiihlen Sie Edit Sub Item aus.

Der Bildschirm Edit Sub Item erscheint.
Alle Unteroptionen werden gepriift, sobald
der Bildschirm erstmals geoffnet wird
(Funktion zur Anzeige aller Unteroptionen).
Deaktivieren Sie die Hikchen der
Unteroptionen, die nicht im User-Menii
angezeigt werden sollen.

Wiihlen Sie OK aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Die Bearbeitung ist abgeschlossen.

Loschen einer Option

1

Waihlen Sie Edit User Menu im User-
Menii aus und dann die zu loschende
Option.

Die Liste zur Bearbeitung der Funktionen
wird angezeigt.

Wahlen Sie Delete aus.

Die Option wird geloscht.

Verschieben einer Option

1

Wiihlen Sie Edit User Menu im User-
Menii aus und dann die zu
verschiebende Option.

Die Liste zur Bearbeitung der Funktionen
wird angezeigt.

Waihlen Sie Move aus.

Die zu verschiebende Option wird
hervorgehoben. Eine Dreiecksmarkierung
und eine Linie kennzeichnen die
Zielposition.
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3 Bewegen Sie Dreiecksmarkierung und

Linie ans Ziel der Option und driicken
Sie die Taste SET oder den Regler SEL/
SET.

Die Option wird verschoben.

Wiederherstellen des werkseitigen
Zustands vom User-Menii

1 Wiihlen Sie Edit User Menu

>Customize Reset im User-Menii aus.
Der Bildschirm Customize Reset erscheint.

Wiihlen Sie Reset aus und driicken Sie
die Taste SET oder den Regler SEL/
SET.

Ein Bestitigungsbildschirm wird angezeigt.

Wiihlen Sie Execute aus und driicken
Sie die Taste SET oder den Regler SEL/
SET.

Der werkseitige Zustand des User-Meniis
wird wiederhergestellt.



Liste der Elemente im Einstellmenii

In diesem Abschnitt werden die Funktionen und Einstellungen der Elemente in den einzelnen Meniis
erldutert.
Standardeinstellungen sind fett gedruckt (z. B. 18dB).

User-Menii

User

Werkseitig registrierte Optionen Beschreibung

Base Setting Option System >Base Setting

HDR Setting Option System >HDR Setting

Rec Format Option System >Rec Format

S&Q Motion Option Recording >S&Q Motion
Picture Cache Rec Option Recording >Picture Cache Rec
Simul Rec Option Recording >Simul Rec

4K & HD (Sub) Rec Option Recording >4K & HD (Sub) Rec
Proxy Rec Option Recording >Proxy Rec

Output Format Option Video >Output Format
Assignable Button Option System >Assignable Button
Delete Clip Option Thumbnail >Delete Clip
Wireless LAN Option Network >Wireless LAN
Wired LAN Option Network >Wired LAN

Modem Option Network >Modem

Format Media Option Media >Format Media

Menu Settings Option System >Menu Settings

Edit User Menu Ruft den Bildschirm Edit User Menu auf.

Edit User Menu-Menii

Edit User
Menu

Option Unteroptionen und Beschreibung
Einstellungen

Add Item - Fiigt Optionen und Unteroptionen hinzu.
Customize Reset Stellt den werkseitigen Zustand des User-Meniis wieder her.
Reset
Bei Auswahl der  Delete Loscht eine Option.
registrierten Move Verschiebt eine Option.
Option angezeigte - - - -
Opti Edit Sub Item Bearbeitet eine Unteroption.

ptionen
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Camera-Menii

Camera

Option Unteroptionen und Beschreibung

Einstellungen
Focus Face Detection AF Aktiviert/deaktiviert Gesichtserkennung-AF.
Gesichtserkennung- ~ Face Only AF/

AF-Einstellungen

Face Priority AF / Off

ND Filter Presetl Zum Einstellen des Voreinstellwerts 1 fiir den ND-Filter.
ND- 1/128/1/64 /1 1/32/1/16 /
Filtereinstellungen ~ 1/8/1/4
Preset2 Zum Einstellen des Voreinstellwerts 2 fiir den ND-Filter.
1/128 /1/64 /1/32 /116 /
1/8/71/4
Preset3 Zum Einstellen des Voreinstellwerts 3 fiir den ND-Filter.
1/128 /1/64 / 1/32/ 1/16 /
1/8 /7 1/4
Gain Gain<L> Legt die Verstirkung fiir die Position L des Schalters GAIN
Verstirkungsein- 18dB/15dB/12dB /9dB/6dB fest.
stellungen /3dB/0dB /-3dB

Gain<M>
18dB / 15dB / 12dB / 9dB /
6dB /3dB /0dB /-3dB

Legt die Verstirkung fiir die Position M des Schalters GAIN
fest.

Gain<H>
18dB / 15dB / 12dB / 9dB /
6dB /3dB / 0dB / -3dB

Legt die Verstdrkung fiir die Position H des Schalters GAIN
fest.

Gain <Turbo>
42dB / 18dB / 15dB /
12dB /9dB / 6dB / 3dB / 0dB /
-3dB

Legt den Verstirkungswert fiir den Fall fest, dass eine
belegbare Taste gedriickt wird, der die Funktion Turbo Gain
zugewiesen wurde.

High Sensitivity Mode
On / Off

Schaltet den Hochempfindlichkeitsmodus ein bzw. aus.

Shockless Gain
On / Off

Schaltet die nahtlose Verstiarkungsumschaltung ein bzw. aus.
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Camera

Option Unteroptionen und Beschreibung

Einstellungen
Shutter Mode Legt den Betriebsmodus der elektronischen Blende fest.
Einstellungen fiir Speed / Angle Wird verwendet, um bewegliche Motive deutlich
die Betriebsbedin- aufzuzeichnen. Wihlt den Modus zum Einstellen der
gungen der elek- Belichtungszeit in Sekunden (Speed) oder als
tronischen Blende Verschlusswinkel (Angle) aus.

Shutter Speed Legt die Verschlusszeit fest, wenn der Speed-Modus

64F, 32F, 16F, 8F, 7F, 6F, 5F,
4F, 3F, 2F, 1/24, 1/25, 1/30,
1/32, 1/33, 1/40, 1/48, 1/50,
1/60, 1/96, 1/100, 1/120, 1/125,
1/250, 1/500, 1/1000, 1/2000,
174000, 1/8000

ausgewihlt ist. Die verfiigbaren Einstellungen héngen von der
Bildfrequenz des gewihlten Videoformats ab.

Shutter Angle
64F / 32F / 16F / 8F / TF /
6F / 5F / 4F | 3F / 2F /
360.0° /300.0° / 270.0° /
240.0°/216.0°/210.0°/
180.0°/172.8°/150.0° /
144.0°/120.0° /90.0° / 86.4° /

Legt den Verschlusswinkel fest, wenn der Angle-Modus
ausgewahlt ist.

72.0°/45.0°/30.0°/22.5°/
11.25°/5.6°
ECS Schaltet den ECS-Modus ein bzw. aus.
On / Off Wird fiir das Aufzeichnen ohne rollende horizontale Balken

auf dem LCD-/Sucherbildschirm verwendet.

ECS Frequency
8000 bis 23.99
(NTSC-Bereich: 60.00, PAL-
Bereich: 50.00)

Legt die ECS-Frequenz fest, wenn der ECS-Modus
ausgewihlt ist. Die verfiigbaren Einstellungen héngen von der
Bildfrequenz des gewihlten Videoformats ab.

Auto Exposure
Helligkeitseinstel-
lungen der auto-
matischen
Belichtung

Level
+3.0/42.75/+42.5/+2.25/
+2.0/+1.75/+1.5/+1.25/
+1.0/40.75/+0.5/+0.25/
+0/-0.25/-0.5/-0.75/
-1.0/-1.25/-1.5/-1.75/
-2.0/-2.25/-25/-2.75/
-3.0

Legt den Korrekturpegel fest.

Mode Legt den Steuerungsmodus fest.
Backlight / Standard / Backlight: Gegenlichtmodus (Modus zum Verringern der
Spotlight Verdunkelung des Hauptmotivs, die bei Gegenlicht
entsteht)
Standard: Standardmodus
Spotlight: Punktlicht-Modus (Modus zum Verringern der
iiberstrahlten Spitzlichter des Hauptmotivs, die im
Scheinwerferlicht entstehen)
Speed Legt die Regelungsgeschwindigkeit fest.
—99 bis +99 (x0)
Auto ND Filter Schaltet die automatische Einstellung der ND-Filterdichte ein
On / Off bzw. aus.
AGC Schaltet die AGC-Funktion (automatische
On / Off Verstirkungssteuerung) ein bzw. aus.
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Camera

Option Unteroptionen und Beschreibung
Einstellungen
Auto Exposure AGC Limit Legt die maximale Verstirkung der AGC-Funktion fest.
Helligkeitseinstel- 0dB /3dB/6dB /9dB / 12dB /
lungen der auto- 15dB / 18dB
g:l?f}cl?:r?g AGC Point Legt den F-Stoppwert der Blende fest, bei der die AGC-
F2.8/F4/F5.6 Funktion einsetzt, sofern auf On gesetzt.
Auto Shutter Schaltet die automatische Verschlussfunktion ein bzw. aus.
On/ Off
A.SHT Limit Legt die kiirzeste Belichtungszeit der automatischen
1/100/ 1/150/ 1/200 / Verschlussfunktion fest.
1/250/1/2000
A.SHT Point Legt den F-Stoppwert der Blende fest, bei dem die

F5.6/F8/F11/F16

automatische Verschlussfunktion einsetzt.

1/2/3/4/5/6/Custom

Clip High light Schaltet die Funktion ein bzw. aus, die Uberbelichtungen
On / Off ignoriert, um eine flachere Reaktion bei extremer Helligkeit
zu erzielen.
Detect Window Legt den Belichtungsmessbereich fest, um die Belichtung

automatisch an die Helligkeit des Motivs anzupassen. (Bei
manueller Belichtung ist diese Einstellung nicht verfiigbar.)

Detect Window Indication

On / Off

Zum Ein-/Ausschalten der Detect Window-Funktion (Auto
Gain Control).

Average Peak Level Ratio

Legt das Verhiltnis zwischen Durchschnitts- und Spitzenwert

-99 bis +99 (x0) des zur Auto Exposure-Erkennung verwendeten Videosignals
fest.
Custom Width Legt die Breite des Detect Window fest.
40 bis 999 (500)

Custom Height

70 bis 999 (500)

Legt die Hohe des Detect Window fest.

Custom H Position

—479 bis +479 (x0)

Legt die horizontale Position des Detect Window fest.

Custom V Position

—464 bis +464 (x0)

Legt die vertikale Position des Detect Window fest.

Color Bars Setting Schaltet die Farbbalken ein bzw. aus.
Einstellungen fiir On / Off
die Farbbalken Type Wihlt den Farbbalkentyp aus.

ARIB /100% / 75% / SMPTE

Flicker Reduce Mode

Legt den Flimmerkorrekturmodus fest.

Einstellungen fiir Auto / On / Off
die Frequency Legt die Frequenz der Stromquelle fest, von der das Licht
Flimmerkorrektur 50Hz / 60Hz stammt, welches das Flimmern verursacht.

(NTSC-Bereich: 60.00, PAL-

Bereich: 50.00)
Flash Band Setting Schaltet die Flash Band-Korrektur ein bzw. aus. Dadurch
Reduce On / Off werden iiberstrahlte Spitzlichter an den oberen oder unteren
Einstellungen fiir Rindern des Bilds reduziert, die bei Verwendung eines Blitzes
die Flash Band- fiir Standbildkameras entstehen.
Korrektur
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Camera

Option Unteroptionen und Beschreibung
Einstellungen
Handle Zoom  Setting Legt die Geschwindigkeit des Zoomhebels fest.

Geschwindigkeits-
einstellungen fiir

Off / Low / High / Variable

(Aktiviert, wenn der Schalter fiir den Zoom am Griff in
Stellung FIX steht.)

den Zoom am

" High Legt die Zoomgeschwindigkeit des Zooms am Griff fest,
Griff 1 bis 8 (8) wenn die Geschwindigkeit High ausgewahlt ist.
Low Legt die Zoomgeschwindigkeit des Zooms am Griff fest,
1 bis 8 (3) wenn die Geschwindigkeit Low ausgewihlt ist.
* Wenn die Zoomgeschwindigkeit auf einen niedrigen Wert
eingestellt wird, tritt ggf. ungleichmiBiges Zoomen auf.
Auto Black Auto Black Balance Fiihrt den automatischen Schwarzabgleich durch.
Balance Execute / Cancel

Einstellungen fiir
den automatischen

» Kann nicht wihrend der Aufzeichnung oder der

Schwarzabgleich Farbbalkenanzeige festgelegt werden.
¢ Kann nicht in den Modi fiir Intervallaufzeichnung,
Einzelbildaufzeichnung oder lange Verschlusszeit festgelegt
werden.
Auto FB Auto FB Adjust Fiihrt die automatische Einstellung des AuflagemaBes (der
Adjust Execute / Cancel Flanschbrennweite) durch. Der Camcorder stellt die
Einstellungen fiir Flanschbrennweite automatisch ein, damit die Motive von der
die Auflagemal3- Weitwinkel- bis hin zur Tele-Position des Objektivzooms im
Automatik Fokus gehalten werden.
(Flanschbrenn-
weite)
Video Light Video Light Set Legt die Beleuchtungskontrollmethode der am Multi-
Set Power Link / Rec Link / Rec  Interface-Schuh angeschlossenen Videoleuchte fest.

Einstellungen fiir
die Videoleuchte

Link + Stby

Power Link: Videoleuchte wird zusammen mit der
Stromversorgung des Camcorders ein- bzw. ausgeschaltet.

Rec Link: Videoleuchte wird beim Aufzeichnungsbeginn bzw.
-ende ein- bzw. ausgeschaltet.

Rec Link + Stby: Videoleuchte wird beim
Aufzeichnungsbeginn eingeschaltet und beim Ende in
Bereitschaft geschaltet.
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Paint-Menii

Option Unteroptionen und
Einstellungen

Beschreibung

HDR Paint HLG Look

Setting Natural / Live / HLG2 / HLG1
Moduseinstellun-

gen fiir den Dyna-

mikbereich

Legt den Look fiir HLG fest, wenn Shooting Mode auf HDR

gesetzt ist.

Natural: Charakteristik geméf ITU-R BT.2100(HLG).

Live: Charakteristik gemdfl ITU-R BT.2100(HLG), die eine
verbesserte HDR-Darstellung liefert.

HLG2: Einstellung mit Gleichgewicht zwischen
Dynamikbereich und Rauschunterdriickung.

HLG1: Einstellung mit stérkerer Rauschunterdriickung als
HLG2. Der Dynamikbereich fiir die Aufnahme ist jedoch
kleiner.

HLG1 und HLG2 verwenden die gleiche Look-Charakteristik

wie Live, jedoch mit unterschiedlichem Dynamikbereich und

anderer Rauschbalance.

HDR Black Offset
-95 bis +103 (x0)

Legt den HDR-Schwarzabweichwert relativ zur SDR-
Einstellung (Master Black) fest, wenn Shooting Mode auf
HDR gesetzt ist.

HDR Knee Schaltet die Kniekorrekturfunktion fiir das HDR-Signal ein
On / Off oder aus, wenn Shooting Mode auf HDR gesetzt ist.

HDR Knee Point Legt den Kniepunkt fiir HDR-Signale fest, wenn HDR Knee
—99 bis +99 (x0) auf On gesetzt ist.

HDR Knee Slope
99 bis +99 (x0)

Legt die Kompressionsrate fiir HDR-Signale fest, wenn HDR
Knee auf On gesetzt ist.

White Preset White
WeiBwerteinstel- 10000K bis 2100K (3200K)
lungen

Passt die voreingestellte Farbtemperatur an, wenn eine
Voreinstellung fiir den Weiabgleich-Modus ausgewéhlt ist.

Eine Anderung der Einstellung ist auch bei Anderung der
Einstellung fiir Preset White auf dem Bildschirm nicht zu
sehen, wenn fiir den WeiBabgleich-Modus keine
Voreinstellung ausgewihlt ist.

Color Temp <A>
50000K bis 1500K (3200K)

Zeigt die in Speicher A gespeicherte Farbtemperatur des
Weiabgleichs.

Color Temp Balance <A>

Legt die in Speicher A gespeicherten Verstirkungswerte des

-99.0 bis +99.0 (+0.0) Weilabgleichs (an die Verstarkung der R- und B-Signale
gekoppelt) fest.
R Gain <A> Legt den in Speicher A gespeicherten R-Verstarkungswert fiir
—-99.0 bis +99.0 (+0.0) den Weilabgleich fest.
B Gain <A> Legt den in Speicher A gespeicherten B-Verstirkungswert fiir
—-99.0 bis +99.0 (+0.0) den WeiBabgleich fest.

Color Temp <B>
50000K bis 1500K (3200K)

Zeigt die in Speicher B gespeicherte Farbtemperatur des
Weiabgleichs an.

Color Temp Balance <B>
—-99.0 bis +99.0 (x0.0)

Legt die in Speicher B gespeicherten Verstiarkungswerte fiir
den Weiflabgleich (an die Verstirkung der R- und B-Signale
gekoppelt) fest.
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Option Unteroptionen und Beschreibung
Einstellungen
White R Gain <B> Legt den in Speicher B gespeicherten R-Verstiarkungswert fiir
WeiBwerteinstel- —-99.0 bis +99.0 (+0.0) den WeiBabgleich fest.
lungen B Gain <B> Legt den in Speicher B gespeicherten B-Verstirkungswert fiir
-99.0 bis +99.0 (+0.0) den Weilabgleich fest.
White Setting Shockless White Legt die Reaktionsgeschwindigkeit des WeiBabgleichs beim
Einstellungen fiir Off/1/2/3 Wechsel in den WeiBabgleich-Modus fest.
die Anpassung des Off: Sofortiger Wechsel.
WeilBabgleichs 1 bis 3: Mit zunehmender Zahl verlangsamt sich die

Geschwindigkeit.

ATW Speed Legt die Reaktionsgeschwindigkeit im Modus ATW fest.
1/2/3/4/5 1: Kiirzeste Reaktionszeit

ATW Mode Legt den ATW-Modus fest (automatische
Natural / Pure WeiBwertanpassung).

Natural: ATW wird automatisch so angepasst, dass ein
natiirliches Ambiente gemil der Beleuchtung der Szene
erzielt wird.

Pure: ATW wird automatisch so angepasst, dass ein niher an
den Primirfarben liegendes Ergebnis ohne blduliche oder
rotliche Restanteile erzielt wird.

White Switch<B> ‘Wiihlt den Einstellungsmodus fiir den WeiBabgleich, wenn der
Memory / ATW Schalter WHT BAL auf B gestellt wird.
Filter White Memory Schaltet die Funktion, die den WeiBabgleich-Speicherbereich
On / Off fiir die einzelnen ND-Filter festlegt, ein bzw. aus.
Offset White  Offset White <A> Legt fest, ob dem WeiBabgleich in Speicher A ein
Einstellungen fiir On / Off Abweichwert hinzugefiigt werden soll (On) oder nicht (Off).
die Weilwert- Warm Cool <A> Wenn Offset White <A> auf On gesetzt ist, wird hierdurch der
Abweichung —-99.0 bis +99.0 (+0.0) Abweichwert (als Farbtemperatur) angegeben, welcher dem

Weillabgleich in Speicher A hinzugefiigt werden soll.
(Beachten Sie, dass der Fehler mit hoheren Abweichwert-
Farbtemperaturen zunimmt. Beobachten Sie das tatséchliche
Bild wihrend der Anpassung.)

Warm Cool Balance <A>

Legt eine prizisere Farbtemperatur fiir den Fall fest, dass mit

-99.0 bis +99.0 (+0.0) der Einstellung Warm Cool <A> kein zufriedenstellendes Bild
erzielt wird.
Offset White <B> Legt fest, ob dem WeiBabgleich in Speicher B ein
On / Off Abweichwert hinzugefiigt werden soll (On) oder nicht (Off).
Warm Cool <B> ‘Wenn Offset White <B> auf On gesetzt ist, wird hierdurch der
—-99.0 bis +99.0 (+0.0) Abweichwert (als Farbtemperatur) angegeben, welcher dem

Weillabgleich in Speicher B hinzugefiigt werden soll.
(Beachten Sie, dass der Fehler mit hoheren Abweichwert-
Farbtemperaturen zunimmt. Beobachten Sie das tatséchliche
Bild wihrend der Anpassung.)

Warm Cool Balance <B>

Legt eine prizisere Farbtemperatur fiir den Fall fest, dass mit

—-99.0 bis +99.0 (+0.0) der Einstellung Warm Cool <B> kein zufriedenstellendes Bild
erzielt wird.
Offset White<ATW> Legt fest, ob dem ATW-Weillabgleich ein Abweichwert
On / Off hinzugefiigt werden soll (On) oder nicht (Off).
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Option Unteroptionen und Beschreibung

Einstellungen
Offset White ~ Warm Cool<ATW> Legt den zum ATW-WeiBabgleich hinzugefiigten
Einstellungen fiir —-99.0 bis +99.0 (+0.0) Abweichwert als Farbtemperatur fest, wenn Offset

die Weilwert-

White<ATW> auf On gesetzt ist.

Abweichung Warm Cool Balance<ATW> Legt eine prizisere Farbtemperatur fiir den Fall fest, dass mit
—-99.0 bis +99.0 (+0.0) der Einstellung Warm Cool<ATW> kein zufriedenstellendes
Bild erzielt wird.
Black Setting Schaltet die Schwarzwertkorrektur ein bzw. aus.
Schwarzwertein- On/ Off
stellungen Master Black Legt den Master-Schwarzpegel fest.
-99.0 bis +99.0 (£0.0)
Gamma Setting Schaltet die Gammakorrektur ein bzw. aus.
Einstellungen fiir On/ Off
die Master Gamma Legt den Master-Gammapegel fest.
Gammakorrektur ~99 bis +99 (+0)
Gamma Category Wihlt Standard-Gamma (STD) oder HG aus.
STD /HG

Gamma Select

Wenn Gamma Category auf STD

gesetzt ist:
STD1 DVW /STD2 x4.5 /
STD3 x3.5/ STD4 240M /
STD5 R709 / STD6 x5.0

Wenn Gamma Category auf HG

gesetzt ist:
HGI 3250G36/

Wiihlt die Gammatabelle fiir die Gammakorrektur.

HG2 4600G30 /

HG3 3259G40 /

HG4 4609G33
Black Gamma Setting Zum Ein-/Ausschalten der Schwarzgammakorrektur.
Einstellungen fiir On / Off
die Anpassung des m
Schwarzgammape- * Die Funktionen Black Gamma und Knee >Knee Saturation
gels konnen nicht zur selben Zeit verwendet werden.

Range Hier wird der effektive Messbereich der

Low / L.Mid / HMid

Schwarzgammakorrektur gewihlt.

Master Black Gamma

Legt den Master-Schwarzgammapegel fest.

—99 bis +99 (x0)
Low Key Setting Schaltet die Low Key-Sittigungskorrektur ein bzw. aus.
Saturation On / Off
Einstellungen fiir m
die Low Key-Siitti- ¢ Um die Low Key-Sittigungsfunktion zu aktivieren, setzen
gungskorrektur Sie Saturation Mode auf Low Key.
* Die Funktionen Low Key Saturation und Knee Saturation
konnen nicht zur selben Zeit verwendet werden.
Level Legt die Farbsittigung in Bereichen geringer Luminanz fest.
—99 bis +99 (x0)
Range Wihlt den Luminanzpegel aus, bei dem die Low Key-

Low / L.Mid / HMid

Sattigung aktiviert wird.
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Einstellungen
Saturation Saturation Mode Wihlt aus, ob die Sittigungsfunktion bei hohen Pegeln (Knee)
Mode Knee / Low Key oder niedrigen Pegeln (Low Key) aktiviert wird.

Einstellungen fiir
die Sittigungskor-

Knee Saturation
On / Off

Schaltet die Kniesittigungsfunktion ein bzw. aus.

rektur

Black Gamma
On / Off

Schaltet die Schwarzgammakorrektur ein bzw. aus.

Low Key Saturation
On / Off

Schaltet die Low Key-Sittigungsfunktion ein bzw. aus.

Noise Setting Schaltet die Rauschunterdriickungsfunktion ein bzw. aus.
Suppression On / Off
Einstellungen fiir [ evel ‘Wiihlt den Grad der Rauschunterdriickung aus.
die Rauschunter- Low / Mid / High
driickungsfunktion
Knee Setting Schaltet die Kniekorrektur ein bzw. aus.
Einstellungen fiir On / Off (Diese Option ist aktiviert, wenn Gamma >Gamma Category
die Kniekorrektur auf STD gesetzt ist.)
Auto Knee Zum Ein-/Ausschalten der automatischen Kniefunktion.
On/ Off
Point Legt den Kniepunkt fest.
75% bis 109% (90%)
Slope Legt die Kompressionsrate fest.
99 bis +99 (x0)

Knee Saturation
On / Off

Aktiviert bzw. deaktiviert die Knieséttigungseinstellung
(regelt die Farbgebung iiber dem Kniepunkt).

¢ Die Funktionen Black Gamma und Knee >Knee Saturation
konnen nicht zur selben Zeit verwendet werden.

* Die Funktionen Low Key Saturation und Knee Saturation
konnen nicht zur selben Zeit verwendet werden.

Knee Saturation Level

Legt den Pegel fiir die Farbgebung iiber dem Kniepunkt

—-99 bis +99 (x0) (Kniesittigung) fest.
White Clip Setting Schaltet die Funktion zur WeiB-Amplitudenbegrenzung ein
Einstellungen fiir On/ Off bzw. aus.
die Weil-Amplitu- 1 eve] Legt den WeiB-Amplitudenbegrenzungspegel fest.

denkorrektur

90.0% bis 109.0%
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Einstellungen
Detail(QFHD) Manual Setting Schaltet die Detailanpassung ein bzw. aus.
Einstellungen fiir On / Off
die Level Legt die Detailstufe fest.
Detailanpassung ~99 bis +99 (+0)
H/V Ratio Legt das Mischungsverhiltnis zwischen dem H-Detailpegel
-99 bis +99 (+0) und dem V-Detailpegel fest.
Crispening Legt den Kantenkorrekturpegel fest.
99 bis +99 (x0)
Frequency Stellt die Mittelfrequenz fiir Details ein. (Eine hohere
-99 bis +99 (+0) Einstellung der Mittelfrequenz verringert die Details.)
Knee Aperture Schaltet die Kniedffnungskorrektur ein bzw. aus.
On / Off
Knee Aperture Level Legt den Kniedffnungspegel fest.
99 bis +99 (x0)
White Limit Passt den Weifidetail-Begrenzer an.
—99 bis +99 (x0)
Black Limit Passt den Schwarzdetail-Begrenzer an.
99 bis +99 (x0)
V Detail Creation Legt die (aus dem R-Signal oder aus dem G-Signal oder aus
NAM/Y/G/G+R dem B-Signal) Signalquelle des V-Signals auf NAM, Y, G,
oder G+R fest, je nachdem welches Signal den hochsten Pegel
hat.
Detail(HD) Manual Setting Schaltet die Detailanpassung ein bzw. aus.

On / Off
Level Legt die Detailstufe fest.
—99 bis +99 (x0)
H/V Ratio Legt das Mischungsverhiltnis zwischen dem H-Detailpegel
-99 bis +99 (+0) und dem V-Detailpegel fest.
Crispening Legt den Kantenkorrekturpegel fest.
99 bis +99 (x0)
Frequency Stellt die Mittelfrequenz fiir Details ein.
-99 bis +99 (+0) (Eine hohere Einstellung der Mittelfrequenz verringert die

Details.)

Knee Aperture

Schaltet die Kniedffnungskorrektur ein bzw. aus.

On / Off
Knee Aperture Level Legt den Kniedffnungspegel fest.
99 bis +99 (x0)
White Limit Passt den Weifidetail-Begrenzer an.
—99 bis +99 (x0)
Black Limit Passt den Schwarzdetail-Begrenzer an.
—99 bis +99 (x0)
V Detail Creation Legt die (aus dem R-Signal oder aus dem G-Signal oder aus
NAM/Y/G/G+R dem B-Signal) Signalquelle des V-Signals auf NAM, Y, G,

oder G+R fest, je nachdem welches Signal den hochsten Pegel
hat.
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Einstellungen
Detail(SD) Manual Setting Schaltet die Detailanpassung ein bzw. aus.
On / Off
Level Legt die Detailstufe fest.
99 bis +99 (x0)
H/V Ratio Legt das Mischungsverhiltnis zwischen dem H-Detailpegel
-99 bis +99 (+0) und dem V-Detailpegel fest.
Crispening Legt den Kantenkorrekturpegel fest.
99 bis +99 (x0)
Frequency Stellt die Mittelfrequenz fiir Details ein.
-99 bis +99 (+0) Eine hohere Einstellung der Mittelfrequenz verringert die
Details.
Knee Aperture Schaltet die Kniedffnungskorrektur ein bzw. aus.
On / Off
Knee Aperture Level Legt den Kniedffnungspegel fest.
—99 bis +99 (x0)
White Limit Passt den Weildetail-Begrenzer an.
-99 bis +99 (x0)
Black Limit Passt den Schwarzdetail-Begrenzer an.
—-99 bis +99 (x0)
V Detail Creation Legt die (aus dem R-Signal oder aus dem G-Signal oder aus
NAM/Y/G/G+R dem B-Signal) Signalquelle des V-Signals auf NAM, Y, G,
oder G+R fest, je nachdem welches Signal den hochsten Pegel
hat.
Skin Detail Setting Schaltet die Oberflichenfarbdetailkorrektur ein bzw. aus.
Einstellungen fiir On / Off
die Obe‘_ﬂﬁ"he“' Area Detection Ermittelt die fiir die Oberflichenfarbdetailkorrektur
farbdetailkorrektur  Execute / Cancel verwendete Farbe.
Execute: Funktion ausfiihren.
Area Indication Schaltet die Zebramusteranzeige in dem Farbbereich ein bzw.
On / Off aus, in dem die Detailkorrektur fiir Hautténe vorgenommen
werden soll.
Level Legt den Oberflichenfarbdetailpegel fest.
—99 bis +99 (x0)
Saturation Legt die Sittigung der Farbe fest, die von der
-99 bis +99 (x0) Oberflachenfarbdetailkorrektur anvisiert wird.
Hue Legt den Farbton der Farbe fest, die von der
0 bis 359 Oberflichenfarbdetailkorrektur anvisiert wird.
Width Legt den Farbtonbereich der Farbe fest, die von der
0 bis 90 (40) Oberflichenfarbdetailkorrektur anvisiert wird.
Aperture Setting Aktiviert bzw. deaktiviert die Offnungskorrektur (verbessert
Einstellungen fiir On/ Off die Auflésung durch Hinzufiigen von Hochfrequenz-
die Offnungssignalen zum Videosignal, um Verschlechterungen
Offnungskorrektur auszugleichen, die durch die Hochfrequenzeigenschaften
entstehen).
Level Legt den Blendenoffnungspegel fest.
99 bis +99 (x0)
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Einstellungen
Matrix Setting Schaltet die Matrixkorrektur ein bzw. aus.
Einstellungen fiir On/ Off
die Adaptive Matrix Schaltet die adaptive Matrixkorrektur ein bzw. aus.
Matrixkorrektur On / Off
Preset Matrix Schaltet die voreingestellte Matrixkorrektur ein bzw. aus.
On/ Off
Preset Select Wihlt eine voreingestellte Matrix aus.
1:SMPTE 240M /
2:ITU-709 / 3:SMPTE Wide /
4:NTSC /5:EBU / 6:PAL
User Matrix Schaltet die benutzerdefinierte Matrixkorrektur ein bzw. aus.
On / Off
User Matrix Level Zum Einstellen der Farbsittigung des gesamten Bildbereichs.
99 bis +99 (x0)
User Matrix Phase Zum Einstellen der Farbphase fiir den gesamten Bildbereich.
—99 bis +99 (x0)
User Matrix R-G Legt eine benutzerdefinierbare R-G-Benutzermatrix fest.
—99 bis +99 (x0)
User Matrix R-B Legt eine benutzerdefinierbare R-B-Benutzermatrix fest.
99 bis +99 (x0)
User Matrix G-R Legt eine benutzerdefinierbare G-R-Benutzermatrix fest.
—99 bis +99 (x0)
User Matrix G-B Legt eine benutzerdefinierbare G-B-Benutzermatrix fest.
99 bis +99 (x0)
User Matrix B-R Legt eine benutzerdefinierbare B-R-Benutzermatrix fest.
—99 bis +99 (x0)
User Matrix B-G Legt eine benutzerdefinierbare B-G-Benutzermatrix fest.
—99 bis +99 (x0)
Multi Matrix Setting Schaltet die Multimatrixkorrektur ein bzw. aus.
Einstellungen fiir On / Off
die Multimatrix-  Area Indication Schaltet die Bereichsanzeige ein bzw. aus.
Korrekturfunktion On / Off

Color Detection
Execute / Cancel

Ermittelt die fiir die Multimatrixkorrektur verwendete Farbe.

Reset Setzt alle Farbton- und Sittigungswerte auf der jeweiligen
Execute / Cancel Achse auf Standardwerte.
Axis Wihlt die Achse.

B/B+/MG-/MG/MG+/R/
R+/YL-/YL/YL+/G-/G/

G+/CY/CY+/B-
Hue Legt den Farbton der fiir die Multimatixkorrektur verwendeten
-99 bis +99 (x0) Farbe fest.
Saturation Legt die Séttigung der fiir die Multimatixkorrektur
—99 bis +99 (x0) verwendeten Farbe fest.
Maintenance  Test Saw Schaltet das Test-Saw-Signal ein bzw. aus.
Wartungseinstel- On/ Off
lungen
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Audio-Menii

Option

Unteroptionen und
Einstellungen

Beschreibung

Audio Input
Einstellungen fiir
die Einspeisung
der Audiosignale

CH2 EXT Input Select
INPUT1 / INPUT2

Wiihlt die Eingabe fiir die Aufzeichnung auf Kanal 2 aus. Ist
nur aktiviert, wenn die Audioquelle EXT ausgewdhlt ist.

CH3 Input Select
Off / INPUT1 / Internal MIC /
Shoe CHI

Wiihlt die Eingabe fiir die Aufzeichnung auf Kanal 3 aus.

CH4 Input Select
Off / INPUT1 / INPUT2 /
Internal MIC / Shoe CH2

Wiihlt die Eingabe fiir die Aufzeichnung auf Kanal 4 aus.

INPUT1 MIC Reference
—80dB / -70dB / -60dB /
—50dB / —40dB /-30dB

Zum Auswihlen des bei Einstellung des Schalters INPUT1
auf MIC verwendeten Referenzeingangspegels.

INPUT2 MIC Reference
—80dB / -70dB / -60dB /
—50dB / —40dB /-30dB

Zum Auswihlen des bei Einstellung des Schalters INPUT2
auf MIC verwendeten Referenzeingangspegels.

Internal MIC Level
—-12dB / -6dB / 0dB / +6dB /
+12dB

Zum Auswihlen des Pegels des eingebauten Mikrofons. Sie
konnen den Pegel unabhéngig von der Stellung des Reglers
AUDIO LEVEL auswihlen.

Line Input Reference
+4dB /0dB / -3dB / EBUL

Zum Auswihlen des bei Einstellung des Schalters INPUT1/
INPUT?2 auf LINE verwendeten Referenzeingangspegels.

Reference Level
—20dB /-18dB / -16dB /

Wiihlt den Aufnahmepegel des 1-kHz-Referenztons aus.

—12dB / EBUL

CH1 Wind Filter Schaltet den Windgeréuschfilter fiir die Aufnahme auf
On / Off Kanal 1 ein/aus.

CH2 Wind Filter Schaltet den Windgerduschfilter fiir die Aufnahme auf
On/ Off Kanal 2 ein/aus.

CH3 Wind Filter Schaltet den Windgerauschfilter fiir die Aufnahme auf
On / Off Kanal 3 ein/aus.

CH4 Wind Filter Schaltet den Windgerduschfilter fiir die Aufnahme auf
On/ Off Kanal 4 ein/aus.

Limiter Mode
Off / —6dB / -9dB / -12dB /
—-15dB /-17dB

Wihlt die Begrenzercharakteristik (Sittigungspegel) fiir den
Fall aus, dass bei manueller Einstellung des
Audioeingangspegels laute Signale eingespeist werden.

CH1&2 AGC Mode
Mono / Stereo

Wihlt den Modus fiir die automatische Pegelanpassung fiir
Aufzeichnung auf Kanal 1 und Kanal 2 aus. Wenn Stereo
ausgewihlt wird, ist die AGC beider Kanile verkniipft.

CH3&4 AGC Mode Wihlt den Modus fiir die automatische Pegelanpassung fiir
Mono / Stereo Aufzeichnung auf Kanal 3 und Kanal 4 aus. Wenn Stereo
ausgewihlt wird, ist die AGC beider Kanile verkniipft.
AGC Spec Wihlt die AGC-Charakteristik (Sattigungspegel) fiir den Fall
-6dB /-9dB /-12dB / aus, dass bei automatischer Einstellung des
—15dB /-17dB Audioeingangspegels laute Signale eingespeist werden.

1kHz Tone on Color Bars
On / Off

Schaltet das 1-kHz-Referenzsignal beim Anzeigen von
Farbbalken ein bzw. aus.
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Option Unteroptionen und
Einstellungen

Beschreibung

Audio Output  Monitor CH
Einstellungen fiir
die Audioausgabe

CH1/CH2 / CH3/CH4 / MIX
ALL/CHI1/CH2/CH3/CH4

Wiihlt die an die Kopfhorerbuchse und den integrierten
Lautsprecher auszugebenden Audiokanile aus.

Headphone Out
Mono / Stereo

Legt fiir den Kopfhorerausgang Mono oder Stereo fest.

Alarm Level

Zum Einstellen der Alarmlautstirke.

0bis 7 (4)
HDMI Output CH ‘Wiihlt die Kombination der Audiokanile am HDMI-Ausgang
CH1/CH2/ CH3/CH4 aus.
Analog Output CH Wihlt die Kombination der Audiokanile am analogen Audio-
CH1/CH2 / CH3/CH4 Ausgang fest.
Video-Menii
Option Unteroptionen und Beschreibung
Einstellungen

Output On/Off SDI
Einstellungen fiir On / Off

Schaltet die SDI-Ausgabe ein bzw. aus.

die Videoausgabe Hpm
On/Off

Schaltet die HDMI-Ausgabe ein bzw. aus.

VIDEO
On/ Off

Schaltet die VIDEO-Ausgabe ein bzw. aus.

Output Format SDI
Einstellungen fiir

Zum Einstellen der Auflosung des SDI-Ausgangs.
SET: Funktion festlegen.

das HDMI Zum Einstellen der Auflosung des HDMI-Ausgangs.
Ausgabeformat SET: Funktion festlegen.
: Nghere . VIDEO Zeigt die Auflosung und das Abtastverfahren an (nur
Informationen zu Anzeige).
den Einstellungen
erhalten Sie unter
,, Videoformate
und
Ausgangssignale

“ (Seite 168).

Output Display SDI/HDMI/ VIDEO
Einstellungen fiir On / Off

Zum Auswiihlen der Einblendung von Menii oder Status in
das SDI/HDMI/VIDEO-Ausgangssignal.

das

Ausgangssignal

SDI/HDMI Rec  Setting Schaltet den Aufzeichnungsstart und -stopp eines extern
Control On / Off angeschlossenen Geriits per SDI-/HDMI-Ausgangssignal ein

Einstellungen zur
Steuerung extern
angeschlossener
Geriite

bzw. aus.

* Setzen Sie zur Steuerung iiber das HDMI-Ausgangssignal
HDMI TC Out >Setting im TC/UB-Menii auf On.
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Option Unteroptionen und Beschreibung

Einstellungen
Down Edge Crop / Letter Box / Stellt den Ausgabemodus (Bildformat) fiir SD-Signale ein.
Converter Squeeze Edge Crop: Beschneidet ein 16:9-Bild an den Seiten zur
Betriebsmodus des Ausgabe als 4:3-Bild.
Abwirtskonverters Letter Box: Deckt den oberen und unteren Bereich des 4:3-

Bildes ab und zeigt ein 16:9-Bild in der Mitte des
Bildschirms an.

Squeeze: Staucht das 16:9-Bild horizontal zur Ausgabe als
4:3-Bild.

LCD/VF-Menii

LCD/VF

Option Unteroptionen und Beschreibung
Einstellungen
LCD Setting  Brightness Zum Einstellen der Helligkeit des LCD-Bildschirms.
Einstellungen fiir -99 bis +99 (+0)
den LCD-
Bildschirm
VF Setting Brightness Stellt die der Helligkeit des Sucherbilds ein.
Einstellungen fiir —-99 bis +99 (x0)
den Sucher Color Mode Wihlt den Anzeigemodus des Suchers bei der E-E-Anzeige/
Color / B&W Aufnahme aus.
Peaking Setting Zum Ein-/Ausschalten der Konturverstirkung.
Einstellung der On / Off
Konturverstirkung Type Wihlt den Typ der Konturverstirkung aus.
Normal / Color Normal: Normale Konturverstirkung

Color: Konturverstirkung in Farbe

Normal Peaking Frequency

Normal / High

Wihlt die normale (Normal) oder die hohe
Konturverstiarkungsfrequenz (High) aus.

Normal Peaking Level
0 bis 99 (50)

Stellt den normalen Konturverstidrkungswert ein.

Color

B&W /Red / Yellow / Blue

Wiihlt die Farbe des Farb-Konturverstarkungssignals aus.

Color Peaking Level
0 bis 99 (50)

Stellt den Farb-Konturverstirkungswert ein.
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LCD/VF

Option Unteroptionen und Beschreibung
Einstellungen
Marker Setting Schaltet simtliche Markierungsanzeigen ein bzw. aus.
Einstellung fiir die ~ On/ Off
Mjarkierungsan- Color Wihlt die Farbe der Markierungsanzeige aus.
zeige White / Yellow / Cyan / Green

/ Magenta / Red / Blue
Center Marker Schaltet die Mittenmarkierung ein bzw. aus.
1/2/3/4/0ff
Safety Zone Schaltet die Sicherheitszonenmarkierung ein bzw. aus.
On / Off
Safety Area Wihlt die GroBe (Prozentsatz des gesamten Bildschirms) der
80% / 90% / 92.5% / 95% Sicherheitszonenmarkierung.
Aspect Marker Zum Auswihlen der Bildformatmarkierung.
Line / Mask / Off Line: Anzeige als weie Linien.
Mask: Anzeige von Bereichen auferhalb des
Markierungsbereichs erfolgt mit abgesenktem
Videosignalpegel.
Off: Keine Anzeige
Aspect Mask Wiihlt die Helligkeit des Bilds auerhalb der

0bis 15 (12)

Bildformatmarkierung aus, wenn Aspect Marker auf Mask
gesetzt ist.

Aspect Safety Zone
On/ Off

Schaltet die Bildformat-Sicherheitszonenmarkierung ein bzw.
aus.

Aspect Safety Area
80% / 90% / 92.5% / 95%

Wihlt die GroBe (Prozentsatz des gesamten Bildschirms) der
Bildformat-Sicherheitszonenmarkierung aus.

Aspect Select
4:3/13:9/14:9/15:9/
16:9/17:9/1.66:1/1.85:1/
2.35:1/2.4:1

Zum Auswihlen des Seitenverhéltnisses
Bildformatmarkierung.

Guide Frame

Schaltet die Rastermarkierung ein bzw. aus.

On / Off

100% Marker Schaltet die 100%-Sicherheitszonenmarkierung ein bzw. aus.
On / Off

User Box Schaltet die Anzeige des Kasten-Cursors ein bzw. aus.
On / Off

User Box Width Legt wird die Breite des Kasten-Cursors (Abstand von der
40 bis 999 (500) Mitte bis zur linken oder rechten Ecke) fest.

User Box Height Legt die Hohe des Kasten-Cursors (Abstand von der Mitte bis
70 bis 999 (500) zur oberen oder unteren Ecke) fest.

User Box H Position
—479 bis +479 (+0)

Legt die horizontale Position der Mitte des Kasten-Cursors
fest.

User Box V Position
—464 bis +464 (+0)

Legt die vertikale Position der Mitte des Kasten-Cursors fest.
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LCD/VF

Option Unteroptionen und Beschreibung
Einstellungen

Zebra Setting Zum Ein-/Ausschalten der Zebrafunktion.
Einstellung des On / Off

Streifenmusters Zebra Select Wihlt den Typ des Zebramusters aus (Zebral, Zebra2, Both).
1/2/Both

Zebral Level Legt den Zebral-Anzeigepegel fest.
0% bis 107% (70%)

Zebral Aperture Level Legt den Zebral-Blendeno6ffnungspegel fest.
1% bis 20% (10%)

Zebra2 Level Legt den Zebra2-Anzeigepegel fest.
0% bis 109% (100%)

Gamma Setting Zum Ein-/Ausschalten der Gamma-
Display Assist On / Off Anzeigeassistentenfunktion.
Einstellungen des

Gamma-

Anzeigeassistenten

Display On/Off Network Status Zum Auswihlen der Optionen, die auf dem LCD-/
Einstellungen fiir On / Off Sucherbildschirm angezeigt werden sollen.
die anzuzeigenden - Fjje Transfer Status
Elemente On / Off
Rec/Play Status
On / Off
Tally
On / Off
NCM/Streaming Status
On / Off

Battery Remain
On / Off

Focus Mode
On / Off
Focus Position
Meter / Feet / Off
Focus Macro
On / Off

Face Detection Frame
On / Off

Lens Info
Meter / Feet / Off

Rec Format
On / Off

Frame Rate
On / Off

Zoom Position
Number / Bar / Off

Digital Extender
On / Off

UWP RF Level
On / Off
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LCD/VF

Option Unteroptionen und Beschreibung
Einstellungen

Display On/Off GPS
Einstellungen fiir On/Off
die anzuzeigenden  SteadyShot
Elemente On/ Off

Gamma
On / Off

SDI/HDMI Rec Control
On / Off

Gamma Display Assist
On / Off

Proxy Status
On / Off

Focus Assist Indicator
On/ Off

Focus Assist Area
On / Off

Media Status
On / Off

Video Signal Monitor
Off / Waveform / Vector /
Histogram

Clip Name
On / Off

White Balance
On / Off

Scene File
On / Off

Auto Exposure Mode
On/ Off

Auto Exposure Level
On / Off

Timecode

On / Off
ND Filter

On / Off
Iris

On / Off
Gain

On / Off
Shutter

On / Off
Audio Level Meter

On / Off

Video Level Warning
On/ Off

Clip Number
On / Off

Notice Message
On / Off
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TC/UB-Menii

TC/UB

Option Unteroptionen und Beschreibung
Einstellungen
Timecode Mode Legt den Ausfithrungsmodus fiir den Timecode fest.
Einstellungen fiir Preset / Regen / Clock Preset: Der Timecode beginnt ab einem vorgegebenen Wert.
den Timecode Regen (Regeneration): Der Timecode wird ab dem Timecode
des vorhergehenden Clips fortgesetzt.
Clock: Als Timecode wird die interne Uhr verwendet.
Run Rec Run: Der Timecode lduft nur wihrend der Aufzeichnung.
Rec Run/ Free Run Free Run: Der Timecode lauft immer, und zwar unabhingig
vom Aufnahmestatus.
Setting Stellt den Timecode auf einen beliebigen Wert ein.
SET: Stellt den Wert ein.
Reset Setzt den Timecode auf 00:00:00:00 zuriick.
Execute / Cancel Execute: Funktion ausfiihren.
TC Format Wiihlt das Timecode-Format.
DF / NDF DF: Drop Frame
NDF: Non-Drop Frame
Users Bit Mode Legt den Anwenderdatenmodus fest.
Einstellungen zu Fix / Time Fix: In den Anwenderdaten wird ein beliebiger fester Wert
Anwenderdaten verwendet.
Time: Verwendet das aktuelle Datum und die aktuelle Uhrzeit
in den Anwenderdaten.
Setting Legt die Anwenderdaten auf einen beliebigen Wert fest.
HDMI TC Out  Setting Legt fest, ob der Timecode zu anderen Zwecken per HDMI an
On / Off Geriite weitergegeben werden soll.
Recording-Menii
Option Unteroptionen und Beschreibung
Einstellungen

S&Q Motion Setting
Einstellungen fiir On / Off

Zum Ein-/Ausschalten von Zeitlupe und Zeitraffer.

den Zeitlupen- &  Frame Rate
Zeitraffermodus 1ps bis 120fps

Zum Einstellen der Bildfrequenz bei der Aufnahme mit
Zeitlupe und Zeitraffer, wenn die Einstellung fiir Zeitlupe und
Zeitraffer auf On gesetzt ist.

Die verfiigbaren Einstellungen hiingen von der ausgewihltem
Systemfrequenz, dem Codec und dem Videoformat ab.
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Option Unteroptionen und Beschreibung

Einstellungen
Interval Rec Setting Schaltet den Intervall-Aufzeichnungsmodus ein bzw. aus.
Einstellungen fiir On / Off

den Intervall-Auf-
zeichnungsmodus

Interval Time
1sec/2sec/3sec/4sec/ 5sec/
6sec / Tsec / 8sec / 9sec / 10sec
/ 15sec / 20sec / 30sec / 40sec /
50sec / 1min / 2min / 3min /
4min / Smin / 6min / 7min /
8min /9min/ 10min / 15min /
20min / 30min / 40min / 50min
/ 1hour / 2hour / 3hour / 4hour /
6hour / 12hour / 24hour

Legt das Intervall zwischen Aufzeichnungen im Intervall-
Aufzeichnungsmodus fest (wenn Interval Rec auf On gesetzt
ist).

Number of Frames
Die Einstellungen variieren in
Abhiingigkeit zur Einstellung
fiir die Systemfrequenz.

2frames / 6frames / 12frames

1frame / 3frames / 6frames /
9frames

Legt die aufzuzeichnende Anzahl der Einzelbilder pro
Einstellung im Intervall-Aufzeichnungsmodus fest (wenn
Interval Rec auf On gesetzt ist).

Wenn die Bildfrequenz des Aufnahmeformats S0P oder
59.94P lautet.

‘Wenn die Bildfrequenz des Aufnahmeformats nicht 50P oder
59.94P lautet.

Pre-Lighting
Off / 2sec / 5sec / 10sec

Zum Einstellen der Zeit in Sekunden, welche die Videoleuchte
vor Beginn der Intervallaufzeichnung eingeschaltet wird. Um
die Videoleuchte nicht einzuschalten, wihlen Sie Off aus.

Picture Cache
Rec

Setting
On / Off

Schaltet den Bildpuffer-Aufzeichnungsmodus ein bzw. aus.

Einstellungen fiir

Cache Rec Time

Legt die Zeit zum Sammeln von Bildmaterial im Bildpuffer

den Bildpuffer- Die Einstellungen variieren in  fest (Zeit fiir Aufzeichnung mit Bildpufferfunktion).
Aufzeichnungsmo-  Abhiingigkeit zur Einstellung

dus fiir das Aufnahmeformat.

Clip Setting Zum Ein-/Ausschalten des Modus fiir kontinuierliche
Continuous On / Off Clipaufzeichnung.

Rec Find Mode Wihlt die durch Driicken der Tasten NEXT/PREV ausgeldste
Einstellungen fiir Clip / Rec Start Funktion aus.

den Modus der

kontinuierlichen

Clipaufzeichnung

Simul Rec Setting Zum Ein-/Ausschalten des Modus fiir gleichzeitige Aufnahme
Einstellungen fiir On/ Off und zum Festlegen der Zielmedien.

den Modus fiir Rec Button Set Weist die Aufnahmetasten zur Steuerung der einzelnen
gleichzeitige . Aufzeichnungsmedien zu.

Aufnahme Rec Button:| A B

Handle Rec Button:[ A |
/ Rec Button:
Handle Rec Button: /
Rec Button: Handle Rec
Button: m
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Option Unteroptionen und Beschreibung
Einstellungen

4K & HD (Sub) Setting Zum Ein-/Ausschalten des 4K- und HD (Sub)-

Rec On / Off Aufnahmemodus.

Einstellungen fiir

den 4K- und HD

(Sub)-

Aufnahmemodus

Proxy Rec Setting Zum Ein-/Ausschalten des Proxy-Aufnahmemodus.

Einstellungen fiir On/ Off

den Proxy- m

Aufnahmemodus * Der Proxy-Aufzeichnungsmodus kann nicht auf On gesetzt
werden, wenn S&Q Motion >Setting (Seite 130) im
Recording-Menii auf On gesetzt ist.

Proxy Format Zum Einstellen der BildgréBe fiir die Proxy-Datei.
1920x1080(9Mbps) / Bei Einstellung auf 1920x1080(9Mbps) und einer
1280x720(9Mbps) / Systemfrequenz von 23.98 wird zur Aufnahme Progressive-
1280x720(6Mbps) / Abtastung verwendet. Bei anderen Systemfrequenzen als
640x360(3Mbps) / 23.98 wird zur Aufnahme Interlaced-Abtastung verwendet.
480x270(1Mbps) / Bei anderen Einstellungen als 1920x1080(9Mbps) wird
480x270(0.5Mbps) unabhingig von der Systemfrequenz zur Aufnahme stets

Progressive-Abtastung verwendet.

Audio Channel Zum Auswihlen des Audiokanals, der als Proxy-Daten
CH1/CH2 / CH3/CH4 aufgenommen werden soll.

Chunk Legt das Blockaufzeichnungsintervall fiir Proxydateien fest.
30sec / Imin / 2min

Rec Review Setting Zum Auswiihlen der Wiedergabedauer von soeben
Einstellungen fiir 3sec / 10sec / Clip aufgenommenen Clips zur Priifung.

die Priifung der

Aufnahme

Thumbnail-Menii

Thumbnail

Option

Unteroptionen und
Einstellungen

Beschreibung

Display Clip
Properties
Anzeigen des
Bildschirms
,Display Clip
Properties*

Zeigt den Bildschirm ,,Display Clip Properties* an.

Set Shot Mark

Delete Shot Mark1

Loscht Shot Mark1.

Einstellungen fiir
Szenenmarkierun-
gen

Delete Shot Mark2

Loscht Shot Mark?2.

Set Clip Flag

Clip-Merker

bearbeiten

Add OK Fiigt eine OK-Kennzeichnung hinzu.
Add NG Fiigt eine NG-Kennzeichnung hinzu.
Add KEEP Fiigt eine Keep-Kennzeichnung hinzu.
Delete Clip Flag Alle Kennzeichnungen werden geloscht.
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Thumbnail

Option Unteroptionen und Beschreibung

Einstellungen
Lock/Unlock  Select Clip Hieriiber wird ein Clip ausgewiihlt und ge- bzw. entsperrt.
Clip Lock All Clips Alle Clips werden gesperrt.

Einstellungen fiir

X Unlock All Clips
den Clip-Schutz

Alle Clips werden entsperrt.

Delete Clip Select Clip

Loscht den ausgewihlten Clip.

Loschen von Clips Aq) Clips

Loscht alle Clips.

Copy Clip Select Clip Kopiert ausgewihlte Clips.
Clips kopieren A7} Clips Kopiert alle Clips.
Copy Sub Clip All Clips Kopiert alle im 4K- und HD (Sub)-Aufzeichnungsmodus
Sub-Clips aufgenommenen Sub-Clips als Hauptclips auf ein anderes
kopieren Medium.
Transfer Clip  Select Clip Ubertriigt ausgewihlte Clips.
Clip-Ubertra- All Clips Ubertriigt alle Clips.
gungseinstellun-
gen [ Hinweis
* Bis zu 200 Clips konnen iibertragen werden.
Transfer Clip  Select Clip Ubertrigt die Proxy-Clips fiir die ausgewihlten Clips.
(Proxy) ) All Clips Ubertrigt die Proxy-Clips fiir alle Clips.
Proxy-Clip-Uber-
tragungseinstel- m
lungen * Bis zu 200 Clips konnen iibertragen werden.
Set Index Legt das Indexbild eines Clips fest.
Picture
Einstellungen fiir
das Indexbild eines
Clips
Thumbnail Essence Mark Thumbnail Zeigt mit Inhaltsmarkierungen markierte Einzelbilder an.
View All / Rec Start / Shot Mark1 /
Einstellungen fiir Shot Mark?2 / Shot Mark3 /
die Miniaturbil- Shot Mark4 / Shot Mark5 /
danzeige Shot Mark6 / Shot Mark7 /
Shot Mark8 / Shot Mark9 /
Shot Mark0
Clip Thumbnail Zeigt Miniaturbilder aufgezeichneter Clips an.
Filter Clips OK Zeigt nur Clips mit OK-Kennzeichnung an.
Anzeigeeinstellun- NG Zeigt nur Clips mit NG-Kennzeichnung an.
fiir gefil
g?psur gefilterte KEEP Zeigt nur Clips mit Keep-Kennzeichnung an.
None Zeigt nur Clips ohne Kennzeichnung an.
All Zeigt unabhingig von Kennzeichnungen alle Clips an.
Customize Thumbnail Caption Andert die Informationen, die unter den Miniaturbildern
View Date Time / Time Code / angezeigt werden.

Einstellungen fiir Duration / Sequential Number
Miniaturbildan-
zeige von Stand-

bildern
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Media-Menii

Das Media-Menii ist nur verfiigbar, wenn ein Medium eingesetzt ist.

Option Unteroptionen und Beschreibung
Einstellungen
Update Media Media(A) Die Verwaltungsdatei auf der SxS-Speicherkarte in Einschub
Aktualisieren von Execute / Cancel A wird aktualisiert.
Medien Media(B) Die Verwaltungsdatei auf der SxS-Speicherkarte in Einschub

Execute / Cancel

B wird aktualisiert.

Format Media Media(A)

Zum Formatieren der SxS-Speicherkarte in Einschub A.

Formatieren von Execute / Cancel Execute: Funktion ausfiihren.
Medien Media(B) Zum Formatieren der SxS-Speicherkarte in Einschub B.
Execute / Cancel Execute: Funktion ausfiihren.
Utility SD/MS Zum Formatieren des Mediums im UTILITY SD/MS-

Execute / Cancel

Einschub.
Execute: Funktion ausfiihren.

UsSB Select Folder Wiihlt einen Ordner auf dem USB-Medium aus.
Einstellungen zum Erstellt einen neuen Ordner auf dem USB-Medium.
Kopieren von View Clip List Zeigt eine Liste der auf dem USB-Medium befindlichen Clips

Clips von einem in

an.

einen SxS-Spei- Rename Folder

Benennt einen Ordner auf dem USB-Medium um.

cherkartenein-

schub eingesetzten Error Check Wiihlt aus, ob beim Kopieren von Clips auf ein USB-Medium
Aufnahmeme- On / Off auf Fehler gepriift werden soll.

dium auf USB- Format USB Formatiert (initialisiert) das USB-Medium.

Medien Execute / Cancel Execute: Funktion ausfiihren.

Copy to USB
Media(A) to USB / Media(B)
to USB / Media(A)(B) to USB

Wiihlt den Zieleinschub fiir das Kopieren von Clips von einer
SxS-Speicherkarte in einen Ordner auf einem USB-Medium
aus.

Media Remain

Zeigt den verbleibenden freien Speicherplatz auf dem USB-
Medium an (nur Anzeige).
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Option Unteroptionen und
Einstellungen

Beschreibung

Clip Naming  Auto Naming
Einstellungen zum Title / Plan
Benennen und

Loschen von Clips

‘Wiihlt das Benennungsformat fiir Clips aus.

Title: Legt die Benennung gemif Title Prefix fest.

Plan: Zum Benennen wird ein in den Planungsmetadaten
festgelegter Name verwendet, sofern vorhanden. Wenn in
den Planungsmetadaten kein Name angegeben ist, wird der
mit Title Prefix festgelegte Name verwendet.

Title Prefix
nnn_ (nnn=die letzten drei
Ziffern der Seriennummer)
(max. 7-Stellen-Anzeige)

Zeigt den Bildschirm Edit File Name zum Einstellen des
Titelteils (4 bis 46 Zeichen) der Clipnamen an.

Struktur des Bildschirms Edit File Name
Zeichenauswahlbereich (3 Zeilen):
Wihlen Sie hier die Zeichen, die im Title Prefix-Bereich an
der Cursorposition eingefiigt werden sollen.
1#$%()+.-.;=@[ 1"_~0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
Cursorfunktionsbereich (1 Zeile):
Space: An der Cursorposition wird ein Leerzeichen
eingefiigt.
<«—: Der Cursor wird nach links verschoben.
—: Der Cursor wird nach rechts verschoben.
BS: Loscht das Zeichen links vom Cursor.
Title Prefix-Bereich (1 Zeile):
Bereich zum Eingeben des Titels.

So legen Sie den Titel fest

Wihlen Sie das an der Cursorposition im Title Prefix-

Bereich einzufiigende Zeichen mithilfe der Tasten #/%/4a/%

im aus dem Zeichenauswahlbereich aus und driicken Sie den

Regler SEL/SET. (Das ausgewihlte Zeichen wird eingefiigt

und der Cursor nach rechts bewegt.)

2 Wiederholen Sie Schritt 1, um den Titel festzulegen.
(Verwenden Sie bei Bedarf BS.)

3 Nachdem Sie den Titel festgelegt haben, wihlen Sie Done
aus, um den Bildschirm Edit File Name zu schliefen.

-

Number Set
Wenn Auto Naming auf Title
gesetzt ist:
0001 bis 9999
Wenn Auto Naming auf Plan
gesetzt ist:
00001 bis 99999

Legt die vierstellige numerische Endung des Clipnamens fest.
Legt bei Verwendung einer Planungsmetadatendatei eine
fiinfstellige Zahl fest.
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Option Unteroptionen und Beschreibung

Einstellungen
Planning Load from Media(A) Ladt Planungsmetadaten von der Speicherkarte in Einschub A
Metadata oder oder B.
Einstellungen fiir ~Load from Media(B) Wiihlen Sie Execute aus, um eine Liste der auf der
Vorginge mit Pla- Execute / Cancel Speicherkarte in Einschub A oder B gespeicherten
nungsmetadaten Planungsmetadatendateien anzuzeigen. Wihlen Sie eine Datei

aus, dann Load und Execute, um diese zu laden.

¢ In der Dateiliste werden bis zu 512 Dateien angezeigt. Auch
wenn die Gesamtzahl der Planungsmetadatendateien
hochstens 512 betrégt, kann es vorkommen, dass nicht alle
davon erscheinen, wenn das Verzeichnis, in dem sie sich auf
der Speicherkarte befinden (XDROOT/General/Sony/
Planning), 513 Dateien oder mehr enthilt.

¢ Nach dem Beginn des Ladevorgangs darf die Speicherkarte
erst wieder entfernt werden, wenn die Abschlussmeldung
angezeigt wird.

Properties Wiihlen Sie Execute aus, um die Eigenschaften der
Execute / Cancel Planungsmetadaten aufzurufen, die in den Speicher des

Camcorders geladen wurden.

File Name: Dateiname

Assign ID: Zuweisungs-ID

Created: Uhrzeit und Datum der Erstellung

Modified: Uhrzeit und Datum der letzten Anderung

Modified by: Name der Person, welche die Datei geéndert hat

Titlel: Titlel in der Datei (Clipname im ASCII-Format)

Title2: Title2 in der Datei (Clipname im UTF-8-Format)

Material Group: Anzahl der Materialgruppen (Gruppen von
Clips, die mit denselben Planungsmetadaten aufgezeichnet
wurden)

Shot Mark0 Bis Shot Mark9: Fiir Szenenmarkierungen 0 bis 9
festgelegte Namen.

Clear Memory Wiihlen Sie Execute aus, um die in den Speicher des
Execute / Cancel Camcorders geladenen Planungsmetadaten zu 16schen.

Clip Name Display Legt den Anzeigemodus fiir den in den Planungsmetadaten
Title1(ASCII) / Title2(UTF-8) festgelegten Clipnamen fest.

Sort by Date/Time (0-9): Dateiliste in aufsteigender Reihenfolge nach
Date/Time (0-9) / Date/Time Spalte Date/Time sortieren (dltestes Erstellungsdatum
(9-0) oben).

Date/Time (9-0): Dateiliste in absteigender Reihenfolge nach
Spalte Date/Time sortieren (jiingstes Erstellungsdatum
oben).
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File-Menii

Option Unteroptionen und Beschreibung
Einstellungen
User File Load from Utility SD/MS Lidt Benutzerdatei-Einstellungen von einer SD-Karte oder

Einstellungen fiir
Vorginge mit

Execute / Cancel

einem ,,Memory Stick“-Medium.
Execute: Funktion ausfiihren.

Benutzerdateien  gyve 1o Utility SD/MS Speichert Benutzerdatei-Einstellungen auf einer SD-Karte
Execute / Cancel oder einem ,,Memory Stick“-Medium.
Execute: Funktion ausfiihren.
File ID Zeigt einen Bildschirm zum Anzeigen/Bearbeiten der ID von
Benutzerdateien an.
Load Customize Data Legt fest, ob bei Ausfiihren von Load from Utility SD/MS
On / Off benutzerdefinierte Daten fiir das User-Menii geladen werden
sollen.
Load White Data Legt fest, ob bei Ausfiihren von Load from Utility SD/MS
On / Off WeiBabgleichdaten geladen werden sollen.
All File Load from Utility SD/MS Ladt eine ALL-Datei von einer SD-Karte oder einem

Einstellungen fiir
ALL-Dateien

Execute / Cancel

,,Memory Stick*“-Medium.
Execute: Funktion ausfiihren.

Load from Cloud(Private)
Execute / Cancel

Lidt eine im C3 Portal-Cloud-Dienst (privat) gespeicherte,
hochgeladene ALL-Datei.
Execute: Funktion ausfiihren.

Load from Cloud(Share)
Execute / Cancel

Ladt eine im C3 Portal-Cloud-Dienst (geteilt) gespeicherte,
hochgeladene ALL-Datei.
Execute: Funktion ausfiihren.

Save to Utility SD/MS
Execute / Cancel

Speichert eine ALL-Datei auf einer SD-Karte oder einem
,.Memory Stick*“-Medium.
Execute: Funktion ausfiihren.

Save to Cloud(Private)
Execute / Cancel

Speichert eine ALL-Datei im C3 Portal-Cloud-Dienst (privat).
Execute: Funktion ausfiihren.

Save to Cloud(Share)
Execute / Cancel

Speichert eine ALL-Datei im C3 Portal-Cloud-Dienst
(geteilt).
Execute: Funktion ausfiihren.

File ID

Versieht die Datei mit einem Namen.

Load Network Data
On / Off

Legt fest, ob bei Ausfiihren von Load from Utility SD/MS,
Load from Cloud(Private) oder Load from Cloud(Share)
Einstellungsdaten fiir das Network-Menii geladen werden
sollen.
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Option Unteroptionen und Beschreibung
Einstellungen
Scene File Recall Internal Memory Ladt eine Szene-Datei aus dem internen Speicher.

Einstellungen fiir Execute / Cancel

Execute: Funktion ausfiihren.

Szene-Dateien Store Internal Memory

Execute / Cancel

Speichert eine Szene-Datei im internen Speicher.
Execute: Funktion ausfiihren.

Load from Utility SD/MS

Execute / Cancel

Liadt eine Szene-Datei auf einer SD-Karte.

Save to Utility SD/MS
Execute / Cancel

Wihlen Sie Execute zum Speichern auf einer SD-Karte aus.
Die Setup-Datei wird im folgenden Verzeichnis gespeichert.
/PRIVATE/SONY/PRO/CAMERA/PXW-Z280V/

(oder PXW-Z280T)

File ID Versieht die Datei mit einem Namen.
Scene White Data Es wird festgelegt, ob beim Laden von Szene-Dateien die
On / Off WeiBabgleichdaten angewendet werden sollen.
Network Key Export Speichert einen 6ffentlichen Schliissel auf dem im
Public Key Execute / Cancel UTILITY SD/MS-Einschub eingesetzten Medium.
Einstellungen fiir Execute: Funktion ausfiihren.
den offentlichen
Schliissel m
« Falls Key Export wiederholt fehlschligt, ist der 6ffentliche
Schliissel moglicherweise beschidigt. Loschen Sie in diesem
Fall den offentlichen Schliissel mithilfe von Key Clear und
fiihren Sie dann Key Export aus.
Key Clear Loscht den im Camcorder gespeicherten &ffentlichen
Execute / Cancel Schliissel.
Execute: Funktion ausfiihren.
Create Key Date Zeigt das Erstellungsdatum des 6ffentlichen Schliissels im
folgenden Format an (nur Anzeige).
4-stelliges Jahr + 2-stelliger Monat + 2-stelliger Tag +
2-stellige Stunde (24 Stunden) + 2-stellige Minute +
2-stellige Sekunde
Anzeigebeispiel fiir 2020/12/1 12:34:56
— 20201201123456
Network-Menii
Option Unteroptionen und Beschreibung
Einstellungen
Setup for Setup Startet das Hilfstool fiir die Netzwerkeinrichtung.
Mobile App
Hilfstool fiir die
Netzwerkeinrich-
tung
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Option Unteroptionen und Beschreibung

Einstellungen
Access User Name Legt den Benutzernamen fiir die Zugriffsauthentifizierung
Authentication fest.
Authentifizie- Input Password Legt das Passwort fiir die Zugriffsauthentifizierung fest.
rungseinstellungen

* Aus Sicherheitsgriinden wird empfohlen, ein Passwort mit
einer ausreichend langen, fiir andere schwer zu erratenden
Zeichenkette zu setzen und sicher aufzubewahren.

Generate Password Erzeugt automatisch ein Passwort fiir die
Execute / Cancel Zugriffsauthentifizierung.
Execute: Funktion ausfiihren.
Show Settings Zeigt den Benutzernamen, das Passwort und die
Seriennummer fiir die Zugangsauthentifizierung als Text und
QR-Code an.

¢ Achten Sie darauf, dass das Passwort nicht eingesehen und
das QR-Code-Bild nicht von anderen kopiert werden kann.

Wireless LAN  Setting Wihlt den Betriebsmodus der WLAN-Verbindung aus.
Einstellungen fiir Access Point Mode / Station
die Wi-Fi- Mode / Off
Verbindung WPS Stellt eine Verbindung mithilfe von WPS (Wi-Fi Protected
Execute / Cancel Setup) her.
Execute: Funktion ausfiihren.
NFC Stellt eine Verbindung mithilfe von NFC (Near Field
Execute / Cancel Communication) her.
Execute: Funktion ausfiihren.
MAC Address Zum Anzeigen der MAC-Adresse der WLAN-Schnittstelle
des Camcorders (nur Anzeige).
AP Mode Channel Zum Einstellen des WLAN-Kanals.
Settings Auto(5GHz) / Auto / CH1 / Auto(5GHz) Ist nur beim PXW-Z280V verfiigbar.

Einstellungen fiir CH2/CH3/CH4 / CH5 / CH6
Verbindungen im /CH7/CH8/CH9/CHI10/
Zugangspunktmo- CHI11

dus Camera SSID & Password Zeigt die SSID und das Passwort des Camcorders an.
Regenerate Password Erstellt ein neues Passwort.
Execute / Cancel Execute: Funktion ausfiihren.
IP Address Zeigt die IP-Adresse des Camcorders im Zugangspunktmodus
an.
Subnet Mask Zeigt die Subnetzmaske des Camcorders im

Zugangspunktmodus an.
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Einstellungen

ST Mode Camera Remote Control

Settings Enable / Disable

Einstellungen fiir

Legt fest, ob die Fernbedienung von einem per WLAN im
Stationsmodus mit dem Camcorder verbundenen Gerit aus
aktiviert werden soll.

Verbindungen im  Connected Network

Zeigt das verbundene WLAN an (Zugangspunkt).

Stationsmodus SSID

Zeigt die SSID des Zugangspunkts an, zu dem die Verbindung
hergestellt werden soll.

Security

Zeigt die Verschliisselungsart des Zugangspunkts an, zu dem
die Verbindung hergestellt werden soll.

Password

Zeigt das Passwort des Zugangspunkts an, zu dem die
Verbindung hergestellt werden soll.

Wenn Security auf WEP oder WPA gesetzt ist: * ¥4k
Wenn Security auf None gesetzt ist: (leer)

DHCP

Zeigt an, ob DHCP aktiviert/deaktiviert ist.

IP Address

Zeigt die IP-Adresse des Camcorders an, wenn DHCP auf Off
gesetzt ist.

Subnet Mask

Zeigt die Subnetzmaske des Camcorders an, wenn DHCP auf
Off gesetzt ist.

Gateway

Zeigt das Standard-Gateway des Camcorders an, wenn DHCP
auf Off gesetzt ist.

DNS Auto

Zeigt an, ob der Bezug der DNS-Daten aktiviert/deaktiviert
ist.

Primary DNS Server

Zeigt den primdren DNS-Server des Camcorders an, wenn
DNS Auto auf Off gesetzt ist.

Secondary DNS Server

Zeigt den sekundiren DNS-Server des Camcorders an, wenn
DNS Auto auf Off gesetzt ist.
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Einstellungen
ST Mode Scan Networks Erkennt WLAN-Netzwerke (Zugangspunkte) und zeigt eine
Settings Liste an.

Einstellungen fiir
Verbindungen im
Stationsmodus

Wiihlen Sie aus der Liste ein Ziel aus, zu dem die Verbindung
hergestellt werden soll.

SSID Zeigt die SSID des Zugangspunkts an, zu dem die Verbindung
hergestellt werden soll.
Security Zeigt die Verschliisselungsart des Zugangspunkts an, zu dem
die Verbindung hergestellt werden soll.
Password Geben Sie das Passwort fiir den Zugangspunkt ein, zu dem die
Verbindung hergestellt werden soll.
DHCP Aktiviert/deaktiviert DHCP.
On / Off
IP Address Geben Sie die IP-Adresse des Camcorders ein, wenn DHCP
auf Off gesetzt ist.
Subnet Mask Geben Sie die Subnetzmaske des Camcorders ein, wenn
DHCP auf Off gesetzt ist.
Gateway Geben Sie das Standard-Gateway des Camcorders ein, wenn
DHCP auf Off gesetzt ist.
DNS Auto Schaltet automatischen Bezug der DNS-Daten ein/aus.
On / Off

Primary DNS Server

Geben Sie den primédren DNS-Server des Camcorders ein,
wenn DNS Auto auf Off gesetzt ist.

Secondary DNS Server

Geben Sie den sekundidren DNS-Server des Camcorders an,
wenn DNS Auto auf Off gesetzt ist.

Manual Register

Registriert Einstellungen zur manuellen Verbindung mit
einem Zugangspunkt.

SSID Geben Sie die SSID des Zugangspunkts ein, zu dem die
Verbindung hergestellt werden soll.
Security Geben Sie die Verschliisselungsart des Zugangspunkts ein, zu
None / WEP / WPA dem die Verbindung hergestellt werden soll. Wihlen Sie WPA
aus, falls die Verschliisselungsart des Ziel-Zugangspunkts
WPA oder WPA2 ist.
Password Geben Sie das Passwort fiir den Zugangspunkt ein, zu dem die
Verbindung hergestellt werden soll.
DHCP Schaltet DHCP ein bzw. aus.
On/ Off
IP Address Geben Sie die IP-Adresse des Camcorders ein, wenn DHCP
auf Off gesetzt ist.
Subnet Mask Geben Sie die Subnetzmaske des Camcorders ein, wenn
DHCP auf Off gesetzt ist.
Gateway Geben Sie das Standard-Gateway des Camcorders ein, wenn
DHCP auf Off gesetzt ist.
DNS Auto Schaltet automatischen Bezug der DNS-Daten ein/aus.
On/ Off

Primary DNS Server

Zeigt den primdren DNS-Server des Camcorders an, wenn
DNS Auto auf Off gesetzt ist.

Secondary DNS Server

Zeigt den sekundéiren DNS-Server des Camcorders an, wenn
DNS Auto auf Off gesetzt ist.

141



Option Unteroptionen und
Einstellungen

Beschreibung

Wired LAN Setting
Einstellungen fiir On / Off

Schaltet die LAN-Funktion ein bzw. aus.

die Verbindung mit Cymera Remote Control

einem verkabelten Enable / Disable
LAN

Legt fest, ob die Fernbedienung von einem per verkabeltem
LAN mit dem Camcorder verbundenen Gerit aus aktiviert
werden soll.

Detail Settings

Konfiguriert Eigenschaften der Verbindung mit einem
verkabelten LAN.

DHCP
On/ Off

Schaltet DHCP ein bzw. aus.

IP Address

Geben Sie die IP-Adresse des Camcorders ein, wenn DHCP
auf Off gesetzt ist.

Subnet Mask

Geben Sie die Subnetzmaske des Camcorders ein, wenn
DHCP auf Off gesetzt ist.

Gateway

Geben Sie das Standard-Gateway des Camcorders ein, wenn
DHCP auf Off gesetzt ist.

DNS Auto
On / Off

Schaltet automatischen Bezug der DNS-Daten ein/aus.

Primary DNS Server

Zeigt den primdren DNS-Server des Camcorders an, wenn
DNS Auto auf Off gesetzt ist.

Secondary DNS Server

Zeigt den sekundéiren DNS-Server des Camcorders an, wenn
DNS Auto auf Off gesetzt ist.

Zum Ein-/Ausschalten der Modem/Smartphone-Verbindung.

Modem Setting
Modem/ On / Off
Smartphone- Camera Remote Control

Einstellungen Enable / Disable

Legt fest, ob die Fernbedienung von einem Gerit aus moglich
sein soll, das per WLAN iiber ein Modem/Smartphone mit
dem Camcorder verbunden ist.

Modem1 IP Address

Zeigt die IP-Adresse von Modem1 an.

Modem1 Subnet Mask

Zeigt die Subnetzmaske von Modem1 an.

Modem?2 IP Address

Zeigt die IP-Adresse von Modem?2 an.

Modem?2 Subnet Mask

Zeigt die Subnetzmaske von Modem2 an.
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Network Client Setting
Mode On/ Off

Startet (On) oder stoppt (Off) den Netzwerk-Client-Modus.

Einstellungen fir  NCM Settings Select
den Netzwerk-

Client-Modus

Wihlt Voreinstellungen (NCM Settings1/NCM Settings2/
NCM Settings3) mit zuvor konfigurierten
Verbindungseinstellungen fiir den Netzwerk-Client-Modus
aus.

NCM Settingsl
Display Name Legt den Anzeigenamen im NCM Settings-Menii fest.
CCM Address Legt die Adresse des CCM als Ziel fiir die Verbindung fest.

(Host-Name oder IP-Adresse)

CCM Port (1 bis 65535 (8443))

Legt die Portnummer des CCM als Ziel fiir die Verbindung
fest.

User Name Legt den Benutzernamen fiir die Authentifizierung der CCM-
Verbindung fest.
Password Legt das Passwort fiir die Authentifizierung der CCM-
Verbindung fest.
CCM Certificate Ladt beim Verbinden mit dem CCM ein Zertifikat und 16scht
Load / Clear / None die Einstellungen.

CCM Certificate Status
Loaded / Default

Zeigt den Ladestatus des Zertifikats beim Verbinden mit dem
CCM an.

Camera Control
Enable / Disable

Aktiviert/deaktiviert die Kamerasteuerung von einem CCM
aus, sofern dieser verbunden ist.

Camera Setting
Always / Onetime / Off

Aktiviert/deaktiviert All File-Vorginge von einem CCM aus,

sofern dieser verbunden ist.

Always: All File-Vorginge von einem CCM aus stets
aktivieren.

Onetime: All File-Vorginge (Load) von einem CCM aus nur
einmalig aktivieren.

Off: All File-Vorginge von einem CCM aus deaktivieren.

Reset
Execute / Cancel

Setzt die Einstellungen unter NCM Settings auf die
Standardwerte zuriick.
Execute: Funktion ausfiihren.

NCM Settings2 Wie NCM Settings]1.
NCM Settings3 Wie NCM Settings]1.
File Transfer  Auto Upload Zum Ein-/Ausschalten des automatischen Hochladens von
Dateiiibertra- On / Off Originaldateien.
gungseinstellun-
gen  Hinweis |

* Wenn Simul Rec >Setting (Seite 131) im Recording-Menii
auf On gesetzt ist, werden die auf das Medium im Einschub
B aufgezeichneten Clips nicht automatisch hochgeladen.

Auto Upload (Proxy)
On / Off / Chunk

On: Aktiviert die automatische Ubertragung von Proxy-
Dateien.

Off: Deaktiviert die automatische Ubertragung von Proxy-
Dateien.

Chunk: Ladt eine in Blocken aufgezeichnete Proxy-Datei
hoch.
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Einstellungen
File Transfer  Default Upload Server Wiihlt den Upload-Server fiir Dateien aus. Der hier
Dateiiibertra- ausgewihlte Server wird zum Ziel fiir das automatische
gungseinstellun- Hochladen von Dateien und zum Upload-Ziel fiir Dateien in
gen der Miniaturbildanzeige.
Zeigt den in Server Settings(NCM) und Server Settings1 bis
Server Settings3 konfigurierten Anzeigenamen an.
Clear Completed Jobs Loscht abgeschlossene Ubertragungen aus der Liste.

Execute / Cancel

Execute: Funktion ausfiihren.

Clear All Jobs
Execute / Cancel

Loscht alle Ubertragungen aus der Liste.
Execute: Funktion ausfiihren.

View Job List

Zeigt die Ubertragungsliste an.

Server Settings(NCM)

Zeigt den Anzeigenamen des NCM-Servers und den Dienst an
(CCM) (nur Anzeige).

Display Name

Zeigt den Anzeigenamen des NCM-Servers an (nur Anzeige).

Service

Zeigt den Dienst an (nur Anzeige).

Server Settings1

Display Name

Legt den Anzeigenamen im Einstellmenii fiir das
Ubertragungsziel fest.

Service Zeigt den Typ des Servers an (nur Anzeige).
FTP
Host Name Legt den Hostnamen des Servers fest, der das Ziel fiir die

Ubertragung ist.

Port (1 bis 65535 (21))

Legt die Portnummer des Servers fest, der das Ziel fiir die
Ubertragung ist.

User Name Legt den Benutzernamen fiir die Authentifizierung der
Verbindung zum Server fest, der das Ziel fiir die Ubertragung
ist.

Password Legt das Passwort fiir die Authentifizierung der Verbindung

zum Server fest, der das Ziel fiir die Ubertragung ist.

Passive Mode
On/ Off

Zum Ein-/Ausschalten des PASV-Modus.

Destination Directory

Geben Sie das Verzeichnis auf dem Zielserver fiir die
Ubertragung ein.

Using Secure Protocol

Legt fest, ob sichere FTP-Ubertragung verwendet werden soll

On / Off (On) oder nicht (Off) (FTPS Explicit-Modus: FTPES).
Root Certificate Lidt ein Stammzertifikat fiir sichere FTP-Ubertragung und
Load / Clear / None 1oscht Einstellungen.

Root Certificate Status

Loaded / No Certificate

Zeigt den Ladestatus des Stammzertifikats fiir sichere FTP-
Ubertragung an.

Reset
Execute / Cancel

Setzt die Einstellungen unter Server Settings auf die
Standardwerte zuriick.
Execute: Funktion ausfiihren.

Server Settings2

Wie Server Settings1.

Server Settings3

Wie Server Settings1.
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Einstellungen
Streaming Setting Startet (On) oder stoppt (Off) das Streaming.
Einstellungen fiir On / Off

Video-/Audio-
Streaming

Destination Select

Wihlt Voreinstellungen (Destination Settings1/Destination
Settings2/Destination Settings3) mit zuvor konfigurierten
Einstellungen fiir das Streaming-Ziel aus.

Destination Settings1

Display Name Geben Sie den Anzeigenamen im Einstellmenii fiir das
Streaming-Ziel ein.
Streaming Type Zeigt die Streaming-Methode des Streaming-Ziels an (nur

Anzeige).

Streaming Format
1920%x1080 9M /
1920x1080 6M /
1920%x1080 3M /
1280x720P OM /
1280x720P 6M /
1280x720P 3M /
1280x720P 2M /
640x360P 3M /
640x360P 2M /
640x360P 1M /
480x270P 1M /
480x270P 0.5M /
480x270P 0.3M /
480x270P 0.2M /
320x180P 0.2M

Legt das Format des zu streamenden Videos fest.

Audio Channel
CHI1/CH2/CH3/CH4 /CHI
/CH2/CH3 / CH4

Zum Auswihlen des zu streamenden Audiokanals.

Destination Address

Legt die Adresse des Servers fest, der das Ziel fiir das
Streaming ist.
(Host-Name oder IP-Adresse)

CCM Port (1 bis 65535 (1234))

Legt die Portnummer des Servers fest, der das Ziel fiir das
Streaming ist.

Reset
Execute / Cancel

Setzt die Einstellungen unter Destination Settings auf die
Standardwerte zuriick.
Execute: Funktion ausfiihren.

Destination Settings2

Wie Destination Settings1.

Destination Settings3

Wie Destination Settings1.
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Einstellungen
RTMP/RTMPS  Setting Startet (On) oder stoppt (Off) das RTMP/RTMPS-Streaming.
Einstellungen fiir On / Off
RTMP/RTMPS-  rTMP Settings Select Wihlt Voreinstellungen (RTMP Settings1/RTMP Settings2/
Video-/Audio- RTMP Settings3) mit zuvor konfigurierten Einstellungen fiir
Streaming das RTMP/RTMPS-Streaming-Ziel aus.

RTMP Settings1

Display Name

Legt den Anzeigenamen im RTMP Settings-Menii fest.

Streaming Format

Legt das Format des zu streamenden Videos fest.

Destination URL

Legt die URL des zu verbindenden RTMP-Servers fest.

Stream Name

Legt den Namen des Streaming-Kanals fest, der vom
Streaming-Server iibertragen wird.

RTMPS Certificate
Load / Clear / None

Legt das Zertifikat fiir die RTMPS-Verbindung fest.

RTMPS Certificate Status
Loaded / Default

Hier wird der Ladestatus des Zertifikats der RTMPS-

Verbindung angezeigt.

Loaded: Ein Zertifikat wurde geladen. Das geladene Zertifikat
wird verwendet.

Default: Es wurde kein Zertifikat geladen. Das integrierte
Zertifikat des Camcorders wird verwendet.

Load from Utility SD/MS

Lédt die auf dem im UTILITY SD/MS-Einschub eingesetzten

Load / None Medium gespeicherten Informationen Display Name,
Destination URL und Stream Name fiir RTMP/RTMPS.
Reset Zuriicksetzen der Einstellungen auf die Standardwerte.
Execute / Cancel Execute: Funktion ausfiihren.
RTMP Settings2 Wie RTMP Settings1.
RTMP Settings3 Wie RTMP Settings1.

Replace Default Certificates
Execute / Cancel

Laden der Standardzertifikate von der SD-Speicherkarte.
Execute: Funktion ausfiihren.

Reset Default Certificates
Execute / Cancel

Wiederherstellen der vorinstallierten Standardzertifikate.
Execute: Funktion ausfiihren.

Default Certificates Status

Zeigt den Status der Standardzertifikate an.

Network Reset

Reset
Execute / Cancel

Zum Zuriicksetzen der Netzwerkeinstellungen.
Execute: Funktion ausfiihren.

System-Men

Option Unteroptionen und Beschreibung
Einstellungen
Base Setting  Shooting Mode ‘Wiihlt den Dynamikbereichmodus aus.
Einstellungen des SDR/HDR
Aufnahmemodus
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Einstellungen
HDR Setting  Rec/Out Wihlt die Aufzeichnung im HDR-Modus und die
Einstellungen fiir HDR(HLG) / HDR(S-Log3)  Gammakurve des Ausgangssignals aus.
den ) ) LCD/VF SDR Preview Off: Im HDR-Modus bei aktiviertem Gamma-
Dynamikbereich Off / On Anzeigeassistenten bewahrt die Anzeige den Kontrast

dunkler und heller Bereiche des HDR-Bilds.

On: Im HDR-Modus bei aktiviertem Gamma-
Anzeigeassistenten verwendet die Anzeige einfache
Konvertierung von HDR nach SDR.

SDR Gain Wenn LCD/VF SDR Preview auf On gesetzt ist, wird damit
0dB/-1dB/...—6dB .../ die SDR-Verstirkung fiir die Anzeige auf dem LCD-
—14dB / -15dB Bildschirm/Sucher festgelegt. Wenn Rec/Out auf HDR(S-

Log3) oder sowohl Rec/Out auf HDR(HLG) als auch HDR
Paint Setting >HLG Look auf Live gesetzt sind, wird -6dB
zum Standardwert (1-dB-Schritte).

Rec Format Frequency Wihlt die Systemfrequenz aus.
Einstellungen fiir 59.94/50/29.97/25/23.98
das Aufzeich- (NTSC-Bereich: 59.94,
nungsformat PAL-Bereich: 50)
File System Wiihlt das Dateisystem aus.
exFAT / UDF / FAT
Codec Wihlt den Aufnahme- bzw. Wiedergabemodus.

XAVC-1/XAVC-L / MPEG
HD 422 / MPEG HD 420 /
DVCAM(MXF)

Video Format Legt das Aufzeichnungsformat fest.
Die verfiigbaren Einstellungen SET: Funktion festlegen.
variieren je nach den
Einstellungen fiir Frequency,
File System und Codec.

File System Frequency  Codec Auswahloptionen

exFAT 59.94 XAVC-1 3840x2160P
1920x1080P
1920x1080i
1280x720P

XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
1920x1080i 50
1920x1080i 35
1920x1080i 25
1280x720P 50

MPEG HD422 1920x1080i 50
1280x720P 50

MPEG HD420 1920x1080i HQ
1440x1080i HQ
1280x720P HQ

DVCAMMXF) 720x480i
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Rec Format 50
Einstellungen fiir

das Aufzeich-

nungsformat

XAVC-1

3840x2160P
1920x1080P
1920x1080i
1280x720P

XAVC-L

3840x2160P

1920x1080P 50
1920x1080P 35
1920x1080i 50
1920x1080i 35
1920x1080i 25
1280x720P 50

MPEG HD422

1920x1080i 50
1280x720P 50

MPEG HD420

1920x1080i HQ
1440x1080i HQ
1280x720P HQ

DVCAM(MXF)

720x576i

29.97

XAVC-1

3840x2160P
1920x1080P

XAVC-L

3840x2160P
1920x1080P 50
1920x1080P 35

MPEG HD422

1920x1080P 50
1280x720P 50

MPEG HD420

1920x1080P HQ

25

XAVC-1

3840x2160P
1920x1080P

XAVC-L

3840x2160P
1920x1080P 50
1920x1080P 35

MPEG HD422

1920x1080P 50
1280x720P 50

MPEG HD420

1920x1080P HQ

23.98

XAVC-1

3840x2160P
1920x1080P

XAVC-L

3840x2160P
1920x1080P 50
1920x1080P 35

MPEG HD422

1920x1080P 50
1280x720P 50

MPEG HD420

1920x1080P HQ
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Einstellungen
Rec Format UDF 59.94 MPEG HD422 1920x1080i 50
Einstellungen fiir 1280x720P 50
das Aufzeich- MPEG HD420 1920x1080i HQ
nungsformat 1440x1080i HQ
1280x720P HQ
DVCAM(MXF) 720x480i
50 MPEG HD422 1920x1080i 50
1280x720P 50
MPEG HD420 1920x1080i HQ
1440x1080i HQ
1280x720P HQ
DVCAMMXF) 720x576i
29.97 MPEG HD422 1920x1080P 50
1280x720P 50
MPEG HD420 1920x1080P HQ
25 MPEG HD422 1920x1080P 50
1280x720P 50
MPEG HD420 1920x1080P HQ
23.98 MPEG HD422 1920x1080P 50
1280x720P 50
MPEG HD420 1920x1080P HQ
FAT 59.94 MPEG HD420 1920x1080i HQ
1440%1080i HQ
1280x720P HQ
50 MPEG HD420 1920x1080i HQ
1440x1080i HQ
1280x720P HQ
29.97 MPEG HD420 1920x1080P HQ
25 MPEG HD420 1920x1080P HQ
23.98 MPEG HD420 1920x1080P HQ
Aspect Ratio (SD) Zum Einstellen des Seitenverhiltnisses bei DVCAM-

16:9/4:3

Aufnahmen.
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Einstellungen
Assignable <1> bis <10> Weist die belegbaren Tasten Funktionen zu.
Button Push AF/Push MF / Face Push AF/Push MF: Fiihrt Autofokus auf Knopfdruck durch.
Einstellungen zur Detection AF / ND Filter Face Detection AF: Zum Ein-/Ausschalten der
. . Position / Auto ND Filter / Push Gesichtserkennung-AF-Funktion.
Funktionszuwei-

sung an belegbare
Tasten

Auto ND / Push Auto Iris /
Turbo Gain / AGC / Shutter /
Auto Exposure Level /
Spotlight / Backlight / Flash
Band Reduce / Digital Extender
x2 / Handle Zoom /

Color Bars / Preset White
Select / ATW / ATW Hold /
Audio Monitor CH / Audio
Mon. CH Switch / Marker /
Zebra / Peaking / Video Signal
Monitor / Focus Magnifier /
Lens Info / LCD/VF Adjust /
VF Mode / Gamma Display
Assist / Display / Rec / S&Q
Motion / Clip Continuous Rec /
Picture Cache Rec / Proxy Rec
Start/Stop / Rec Review / Last
Clip Del. / Thumbnail / Shot
Mark1 / Shot Mark2 / Clip Flag
OK / Clip Flag NG / Clip Flag
Keep / NFC / Network Client
Mode / Intercom Level /
Streaming / RTMP/RTMPS /
Auto Upload (Proxy) / Direct
Menu / User Menu / Menu

ND Filter Position: Zum Umschalten der ND-Filterposition.

Auto ND Filter: Zum Ein-/Ausschalten der Auto ND Filter-
Funktion.

Push Auto ND: Fiihrt voriibergehend die Auto ND Filter-
Funktion durch.

Push Auto Iris: Fiihrt die Funktion Blendenautomatik auf
Knopfdruck durch.

Turbo Gain: Zum Ein-/Ausschalten von Turbo Gain.

AGC: Zum Umschalten der Funktion zur automatischen
Verstiarkungsregelung.

Shutter: Zum Umschalten zwischen automatischem und
manuellem Verschluss.

Auto Exposure Level: Zum Einstellen des Pegels fiir die
automatische Belichtung.

Spotlight: Zum Umschalten des automatischen
Belichtungsmodus auf Spotlight.

Backlight: Zum Umschalten des automatischen
Belichtungsmodus auf Backlight.

Flash Band Reduce: Zum Ein-/Ausschalten der Flash Band-
Korrektur.

Digital Extender x2: Zum Ein-/Ausschalten der
Bildschirmvergrofierung (x2).

Handle Zoom: Zum Umschalten der Bedienung des Zooms
am Griff.

Color Bars: Zum Ein-/Ausblenden der Farbbalken.

Preset White Select: Zum Umschalten des Werts fiir den
Voreinstellungsmodus des Weilabgleichs.

ATW: Zum Ein-/Ausschalten von ATW.

ATW Hold: Zum voriibergehenden Aussetzen der ATW-
Funktion.

Audio Monitor CH: Wechselt die Kombination der
Audiokandile.

Audio Mon. CH Switch: Wechselt die Kombination der
Audiokandile.

Marker: Zum Ein-/Ausschalten der Markierungsfunktion.

Zebra: Zum Ein-/Ausschalten der Zebrafunktion.

Peaking: Zum Ein-/Ausschalten der Konturverstirkung.

Video Signal Monitor: Zum Umschalten des
Videosignalmonitors (z. B. Histogramm).

Focus Magnifier: Zum Ein-/Ausschalten der Fokuslupe.

Lens Info: Zum Umschalten der Schirfentiefenanzeige.

LCD/VF Adjust: Zeigt die Pegelbalken zum Einstellen der
Helligkeit des LCD-/Sucherbildschirms an.

VF Mode: Zum Umschalten zwischen Farb- und Schwarz-
WeiB-Anzeige im Sucher.

Gamma Display Assist: Zum Umschalten der Gamma-
Anzeigeassistentenfunktion.

Display: Zum Ein-/Ausschalten der
Monitorbildschirmanzeigen.

Rec: Startet oder stoppt die Aufzeichnung.

S&Q Motion: Zum Ein-/Ausschalten von Zeitlupe und
Zeitraffer und Anzeigen des Bildschirms zur Einstellung
der Bildfrequenz.

Clip Continuous Rec: Zum Ein-/Ausschalten der
kontinuierlichen Clipaufnahme.
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Assignable Picture Cache Rec: Zum Ein-/Ausschalten der Bildpuffer-
Button Aufzeichnungsfunktion.
Einstellungen zur Proxy ReF: Start/Stop: Startet/stoppt unabhingige Proxy-
Funktionszuwei- Aufzglchnung. . .
sune an beleabare Rec Review: Startet die Aufnahmeriickschau.
Tl;si;en g Last Clip Del.: Fiihrt die Funktion zum Loschen des letzten

Clips durch (Take wiederholen).

Thumbnail: Zum Ein-/Ausschalten der Miniaturbildanzeige.

Shot Mark1: Zum Hinzufiigen/Loschen einer
Szenenmarkierung 1 bei dem Clip, der zurzeit
aufgenommen oder wiedergegeben wird.

Shot Mark2: Zum Hinzufiigen/Loschen einer
Szenenmarkierung 2 bei dem Clip, der zurzeit
aufgenommen oder wiedergegeben wird.

Clip Flag OK: Zum Hinzufiigen/Loschen eines OK-Markers
bei dem Clip, der zurzeit aufgenommen oder
wiedergegeben wird.

Clip Flag NG: Zum Hinzufiigen/Loschen eines NG-Markers
bei dem Clip, der zurzeit aufgenommen oder
wiedergegeben wird.

Clip Flag Keep: Zum Hinzufiigen/Loschen eines Keep-
Markers bei dem Clip, der zurzeit aufgenommen oder
wiedergegeben wird.

NFC: Fiihrt die NFC-Funktion durch.

Network Client Mode: Zum Ein-/Ausschalten des Netzwerk-
Client-Modus.

Intercom Level: Zeigt den Einstellbalken fiir den Intercom-
Pegel an.

Streaming: Startet oder stoppt das Streaming.

RTMP/RTMPS: Startet oder stoppt das RTMP/RTMPS-
Streaming.

Auto Upload (Proxy): Schaltet die automatische Ubertragung
von Proxy-Dateien ein/aus oder stellt den Blockmodus ein.

Direct Menu: Zeigt das Direktmenii an.

User Menu: Zeigt das User-Menii an.

Menu: Zeigt das Einstellmenii an.

Switch Hold FULL AUTO Button
Setting Off / Hold(On)
Einstellungen fiir

das Halten von

Funktionen

Off: Aktiviert die Taste FULL AUTO.
Hold(On): Verhindert das Ein-/Ausschalten der Taste FULL
AUTO.

Tally Front
Einstellungen fiir On / Off

Zum Ein-/Ausschalten der Aufnahme-/Tally-Anzeige (vorn).

die Aufnahme-/ Rear

Zum Ein-/Ausschalten der Aufnahme-/Tally-Anzeige (hinten).

Tally-Anzeigen On/ Off

Language Select Legt die Sprache fest.
Spracheinstellun- SET: Funktion festlegen.
gen
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Option Unteroptionen und Beschreibung
Einstellungen
Clock Set Time Zone Stellt den Zeitzonen-Unterschied zu UTC in Schritten von 30
Einstellungen fiir UTC -12:00 bis UTC +14:00  Minuten ein.
die innere Uhr Date Mode Wihlt das Anzeigeformat fiir das Datum aus.
YYMMDD / MMDDYY / YYMMDD: Jahr, Monat, Tag
DDMMYY MMDDY'Y: Monat, Tag, Jahr
DDMMYY: Tag, Monat, Jahr
12H/24H Wihlt den Anzeigemodus fiir die Uhrzeit aus.
12H / 24H 12H: 12-Stunden-Format
24H: 24-Stunden-Format
Date Legt das aktuelle Datum fest.
SET: Stellt den Wert ein.
Time Stellt die aktuelle Uhrzeit ein.
SET: Stellt den Wert ein.
Hours Meter Hours(System) Zeigt die Gesamtbetriebsstunden an (kann nicht zuriickgesetzt
Einstellungen fiir werden).
die Hours(Reset) Zeigt die Gesamtbetriebsstunden an (kann zuriickgesetzt
Stundenanzeige werden).
Reset Zum Zuriicksetzen der Hours(Reset)-Anzeige auf den Wert 0.
Execute / Cancel Execute: Funktion ausfiihren.
GPS GPS Schaltet die GPS-Funktion ein bzw. aus.
GPS-Einstellungen ~ On/ Off
Battery Alarm Low Battery Legt fest, dass bei dieser Restspannung eine Benachrichtigung

Einstellungen fiir
die
Benachrichtigung
bei niedriger
Akku-Spannung

5% 10% / 15% / .../ 45% /
50%

iiber eine geringe Akku-Restspannung angezeigt wird (in
Schritten von 5%).

Battery Empty
3% bis 7%

Legt fest, dass bei dieser Restspannung eine Warnmeldung
iiber einen leeren Akku angezeigt wird (Schritte von 1%).

DC Voltage
Alarm
Einstellungen fiir
die
Benachrichtigung
bei niedriger

DC IN-Spannung

DC Low Voltagel
11.2V bis 14.0V (11.3V)

Legt die Spannung fest, bei der eine Warnmeldung iiber eine
geringe DC IN-Eingangsspannung angezeigt wird (Schritte
von 0.1V).

DC Low Voltage2
11.0V bis 14.0V

Legt die Spannung fest, bei der eine Warnmeldung iiber eine
DC IN-Unterspannung angezeigt wird (Schritte von 0.1V).
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Option Unteroptionen und Beschreibung

Einstellungen
Menu Settings Direct Menu with <SET> Legt fest, ob durch Driicken der Taste SET die
Meniieinstellungen ~ On / Off Direktmeniifunktion gestartet werden soll.

 Bei Einstellung auf On ist die Erkennung von registrierten
Gesichtern mittels der Gesichtserkennung-AF-Funktion
nicht mehr verfiigbar. Aulerdem wird das aktuell registrierte
Gesicht geloscht.

User Menu Only Legt fest, ob nur das User-Menii angezeigt werden soll (On)
On / Off oder die Meniiliste (Off) angezeigt werden soll, wenn der
Camcorder das Menii anzeigt.
User Menu with Lock Legt fest, ob die Meniianzeige gesperrt und nur das User-
On / Off Menii angezeigt werden soll.

« Beim Betrieb mit normaler Meniianzeige wird diese Option
nicht angezeigt. Niheres zur Funktion der Meniianzeige
finden Sie unter Seite 109.

Fan Control Setting Wiihlt den Gebldsesteuerungsmodus aus.

Einstellungen fiir Auto / Minimum / Off in Rec

die

Geblisesteuerung

All Reset Reset Zum Zuriicksetzen des Camcorders auf den werkseitigen

Zuriicksetzen auf Execute / Cancel Status.

Werkseinstellun- Execute: Funktion ausfiihren.

gen Reset without Network Setzt die Meniieinstellungen auBer den Einstellungen des

Execute / Cancel Network-Meniis auf die Werkseinstellungen zuriick.

Execute: Funktion ausfiihren.

Version Version Number Zeigt der Software-Version des Camcorders an.

Anzeige der X.XX

Cam_corder- Version Up Fiihrt ein Upgrade fiir den Camcorder durch.*

Version Execute / Cancel Execute: Funktion ausfiihren.

* Diese Funktion aktualisiert die Software des Camcorders.
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Speichern und Laden von Konfigurationsdaten

Konfigurationsdaten

Sie konnen Einstellungen des Setup-Meniis im
internen Speicher des Camcorders oder auf SD-
Karten und ,,Memory Stick*“-Medien speichern.
Sie konnen auch eine ALL-Datei in einem Cloud-
Dienst speichern. Dadurch konnen Sie schnell auf
einen fiir die jeweilige Situation geeigneten Satz
Meniieinstellungen zuriickgreifen.
Konfigurationsdaten werden in den folgenden
Kategorien gespeichert.

Benutzerdateien

In Benutzerdateien werden die Einstelloptionen
und Daten des benutzerdefinierbaren User-
Meniis gespeichert.

Sie konnen auf einer SD-Karte oder einem
,.Memory Stick“-Medium bis zu 64 Dateien
speichern.

Indem Sie derartige Dateien in den Speicher des
Camcorders laden, konnen Sie das User-Menii
entsprechend einrichten.

ALL-Dateien (alle Einstellungen)

In ALL-Dateien werden die Konfigurationsdaten
aller Meniis gespeichert. Sie konnen auf einer
SD-Karte oder einem ,,Memory Stick*“-Medium
bis zu 64 Dateien speichern. Im C3 Portal (Cloud-
Dienst) konnen bis zu 120 Dateien gespeichert
werden, bestehend aus je bis zu 60 privaten und
60 freigegebenen Dateien.

« Geritespezifische Daten (Schattierung, Ausgabepegel
und andere Daten, die eine Einstellung auf das
spezifische Gerit erfordern) werden nicht gespeichert.

Szenendateien

In Szenendateien werden Einstellungen der fiir

Szenen konfigurierten Paint-Optionen

gespeichert. Sie konnen bis zu fiinf Dateien im

internen Speicher des Camcorders und bis zu

64 Dateien auf einer SD-Karte oder einem

»Memory Stick“-Medium speichern.
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Medien, auf denen
Konfigurationsdaten gespeichert
werden konnen

SDXC-Speicherkarten*
(Geschwindigkeitsklasse: 4 bis 10, kein UHS /
Kapazitit: 2 bis 32 GB, 64 GB und grofer)
SDHC-Speicherkarten*
(Geschwindigkeitsklasse: 4 bis 10, kein UHS /
Kapazitit: 2 bis 32 GB)
SD-Speicherkarten* (Kapazitiit: bis zu 2 GB)
»Memory Stick PRO-HG Duo“**
»Memory Stick PRO Duo“**
* In diesem Handbuch mit dem Begriff ,,SD-Karte*
bezeichnet.

*#* In diesem Handbuch mit dem Begriff ,,Memory
Stick* bezeichnet.

Formatieren (Initialisieren) von
Medien

SD-Karten und ,,Memory Stick*-Medien miissen
bei der ersten Verwendung im Camcorder
zunichst formatiert werden.

Eine SD-Karte oder ein ,,Memory Stick*-
Medium zur Verwendung in diesem Camcorder
muss mit der Formatierungsfunktion des
Camcorders formatiert werden. Wenn beim
Einsetzen der SD-Karte oder des ,,Memory
Stick*“-Mediums in den Camcorder eine Meldung
angezeigt wird, muss das Speichermedium
formatiert werden.

1 Setzen Sie die SD-Karte oder das
,»Memory Stick“-Medium mit dem
Etikett nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 10)
ein.

Wihlen Sie Format Media (Seite 134)
>Utility SD/MS >Execute im Media-
Menii aus. Wihlen Sie beim Anzeigen
einer Bestiitigungsmeldung erneut
Execute.

Wihrend der Formatierung werden eine
Meldung und ein Fortschrittsstatus



angezeigt, und die Zugriffsanzeige leuchtet
rot.

Nach Abschluss der Formatierung wird eine
Abschlussmeldung angezeigt. Driicken Sie
die Taste SET oder den Regler SEL/SET, um
die Meldung auszublenden.

* Beim Formatieren einer SD-Karte oder eines
~-Memory Stick“-Mediums werden alle Daten
geldscht. Die Daten konnen nicht wiederhergestellt
werden.

Uberpriifen der Restkapazitit

Die Restkapazitit auf einer SD-Karte oder einem
,Memory Stick“-Medium kann im Bildschirm
.Media Status* (Seite 18) tiberpriift werden.

* Wenn die SD-Karte oder das ,,Memory Stick*-
Medium geschiitzt ist, wird eine (¥)-Markierung
angezeigt.

¢ Um mit dem Camcorder formatierte Medien im
Einschub eines anderen Gerits zu verwenden, sichern
Sie die Daten und formatieren Sie das Medium im zu
verwendenden Gerit.

Speichern einer Benutzerdatei/
ALL-Datei

Speichern auf einer Speicherkarte

1 Setzen Sie die SD-Karte oder das
,,Memory Stick‘‘-Medium mit dem
Etikett nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 10)
ein.

Im Fall einer Benutzerdatei wihlen Sie
User File (Seite 137) >Save to Utility SD/
MS im File-Menii aus.

Im Fall einer ALL-Datei wiihlen Sie All
File >Save to Utility SD/MS im File-
Menii aus.

Es wird ein Bildschirm mit einem
Speicherort fiir Dateien angezeigt.
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Waihlen Sie mithilfe der Tasten 4/¥/«/%
oder dem Regler SEL/SET im Fenster
fiir den Speicherort eine ,,No File‘“-Zeile
aus und driicken Sie die Taste SET oder
den Regler SEL/SET.

Wenn Sie eine Zeile mit einer File ID
auswihlen, wird dadurch die ausgewihlte
Datei tiberschrieben.

Die File ID wird automatisch erzeugt; Sie
konnen sie jedoch veréndern.

Wiihlen Sie mithilfe der Tasten 4/¥/«/»
oder dem Regler SEL/SET auf dem
Bestitigungsbildschirm Execute aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Speichern einer ALL-Datei in einem
Cloud-Dienst

1 Stellen Sie von der speziellen C3 Portal-
Anwendung auf dem Smartphone aus
eine Verbindung zum Ger:iit her.

Wiihlen Sie All File >Save to
Cloud(Private) oder Save to
Cloud(Share) im File-Menii aus.

Es wird ein Bildschirm mit einem
Speicherort fiir Dateien angezeigt.

Waihlen Sie mithilfe der Tasten 4/¥/«/%
oder dem Regler SEL/SET im Fenster
fiir den Speicherort eine ,,No File‘‘-Zeile
aus und driicken Sie die Taste SET oder
den Regler SEL/SET.

Wenn Sie eine Zeile mit einer File ID
auswihlen, wird dadurch die ausgewihlte
Datei iiberschrieben. Die File ID wird
automatisch erzeugt; Sie konnen sie jedoch
verdndern.

Wiihlen Sie mithilfe der Tasten 4/¥/«/»
oder dem Regler SEL/SET auf dem
Bestitigungsbildschirm Execute aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.



Laden einer Benutzerdatei/ALL-
Datei

Laden von einer Speicherkarte

1 Setzen Sie die SD-Karte oder das
,,Memory Stick‘‘-Medium mit der
gespeicherten Datei mit dem Etikett
nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 10)
ein.

2 Im Fall einer Benutzerdatei wihlen Sie
User File (Seite 137) >Load from Utility
SD/MS im File-Menii aus.

Im Fall einer ALL-Datei wiihlen Sie All
File >Load from Utility SD/MS im File-
Menii aus.

Es wird ein Bildschirm mit einer Dateiliste
angezeigt.

3 Wiihlen Sie mithilfe der Tasten #/4/«/»
oder dem Regler SEL/SET die zu
ladende Datei aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Ein Bestitigungsbildschirm wird angezeigt.

4 Wihlen Sie Execute mithilfe der Tasten
4/¥%/«/% oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

¢ Nach dem Laden von Konfigurationsdaten startet der
Camcorder automatisch neu.

* Wenn All File >Load Network Data im File-Menii auf
Off gesetzt ist, werden alle Einstellungen der ALL-
Datei bis auf die Einstellungen des Network-Meniis
geladen.

Laden einer ALL-Datei aus einem Cloud-
Dienst

1 Stellen Sie von der speziellen C3 Portal-
Anwendung auf dem Smartphone aus
eine Verbindung zum Geriit her.

2 Wihlen Sie All File >Load from
Cloud(Private) oder Load from
Cloud(Share) im File-Menii aus.

Es wird ein Bildschirm mit einer Dateiliste
angezeigt.

3 Wiihlen Sie mithilfe der Tasten #/%/«/»
oder dem Regler SEL/SET die zu
ladende Datei aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Ein Bestitigungsbildschirm wird angezeigt.

4  Wihlen Sie mithilfe der Tasten 4/%/«/»
oder dem Regler SEL/SET auf dem
Bestiitigungsbildschirm Execute aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Speichern einer Szenendatei

Im internen Speicher

1 Wiihlen Sie Scene File >Store Internal
Memory >Execute im File-Menii aus
(Seite 137).

Es wird ein Bildschirm mit einer
Szenendateiliste angezeigt.

Falls die File ID auf das Ziel ,,Standard*
gesetzt ist, werden vorkonfigurierte
Standardeinstellungen gespeichert.

2 Wiihlen Sie mithilfe der Tasten #/%/</»
oder dem Regler SEL/SET einen
Speicherort aus und driicken Sie die
Taste SET oder den Regler SEL/SET.
Die Szenendatei wird am ausgewihlten
Speicherort gespeichert, wobei eine ggf.
vorhandene Datei iiberschrieben wird.

3 Wihlen Sie mithilfe der Tasten 4/%/«/»
oder dem Regler SEL/SET auf dem
Bestitigungsbildschirm Execute aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.



Auf einer SD-Karte oder einem ,,Memory
Stick“-Medium

1

Setzen Sie die SD-Karte oder das
,,Memory Stick‘‘-Medium mit dem
Etikett nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 10)
ein.

Wiihlen Sie Scene File >Save to Utility
SD/MS >Execute im File-Menii aus
(Seite 137).

Es wird ein Bildschirm mit einem
Speicherort fiir Szenendateien angezeigt.

Wahlen Sie mithilfe der Tasten 4/¥/«/%
oder dem Regler SEL/SET im Fenster
fiir den Speicherort eine ,,No File*“-Zeile
aus und driicken Sie die Taste SET oder
den Regler SEL/SET.

Wenn Sie eine Zeile mit einer File ID
auswihlen, wird dadurch die ausgewihlte
Datei iiberschrieben.

Die File ID wird automatisch erzeugt; Sie
konnen sie jedoch verindern.

Wiihlen Sie mithilfe der Tasten #/¥/«/»
oder dem Regler SEL/SET auf dem
Bestitigungsbildschirm Execute aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Laden einer Szenendatei

Aus dem internen Speicher

1

Wiihlen Sie Scene File >Recall Internal
Memory >Execute im File-Menii aus
(Seite 137).

Es wird ein Bildschirm mit einer
Szenendateiliste angezeigt.

Wiihlen Sie mithilfe der Tasten 4/%/«/%
oder dem Regler SEL/SET die zu
ladende Datei aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Ein Bestitigungsbildschirm wird angezeigt.
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3 Wiihlen Sie Execute mithilfe der Tasten

4/¥%/«/» oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Szenendateien konnen auch mithilfe vom
Direktmenti (Seite 44) in den Camcorder
geladen werden.

Von einer SD-Karte oder einem ,,Memory
Stick“-Medium

1

Setzen Sie die SD-Karte oder das
,»Memory Stick‘-Medium mit der
gespeicherten Datei mit dem Etikett
nach rechts weisend in den

UTILITY SD/MS-Einschub (Seite 10)
ein.

Waihlen Sie Scene File >Load from
Utility SD/MS >Execute im File-Menii
aus (Seite 137).

Es wird ein Bildschirm mit einer
Szenendateiliste angezeigt.

Wiihlen Sie mithilfe der Tasten 4/%/«/%
oder dem Regler SEL/SET die zu
ladende Datei aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Ein Bestitigungsbildschirm wird angezeigt.

Wiihlen Sie Execute mithilfe der Tasten
4/¥%/«/» oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Andern der File ID

1

Im Fall einer Benutzerdatei wihlen Sie
User File >File ID im File-Menii aus
(Seite 137).

Im Fall einer ALL-Datei wiihlen Sie All
File >File ID im File-Menii aus

(Seite 137).

Im Fall einer Szenendatei wiihlen Sie
Scene File >File ID im File-Menii aus
(Seite 137).

Ein Bildschirm zum Bearbeiten der File ID
wird angezeigt.



2  Wiihlen Sie mithilfe der Tasten 4/%/«/%
oder dem Regler SEL/SET ein Zeichen
aus und driicken Sie die Taste SET oder
den Regler SEL/SET.

3 Wiederholen Sie Schritt 2 bei Bedarf.

Wihlen Sie zum Abschluss der
Zeicheneingabe mithilfe der Tasten 4/
¥/«/% oder dem Regler SEL/SET
,,Done‘ aus und driicken Sie die Taste
SET oder den Regler SEL/SET.
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Wichtige Hinweise zum Betrieb

Verwenden des Camcorders im
Ausland

Stromversorgung

Mithilfe des Netzteils BC-UIA (mitgeliefert)
oder des gesondert erhiltlichen Ladegerits
BC-U2A konnen Sie den Camcorder in allen
Lindern/Regionen verwenden, die eine
Stromversorgung mit 100 V bis 240 V
Wechselspannung bei 50 Hz/60 Hz anbieten.

Zeitzonen-Korrekturfunktion
Stellen Sie im Ausland Clock Set >Time Zone
(Seite 152) im System-Menii ein.

Verwendung und Aufbewahrung

Gerdét vor heftigen Stdfen schiitzen
Der interne Mechanismus kann beschidigt

werden oder das Gehéduse konnte sich verformen.

Wahrend des Betriebs nicht abdecken
Wenn das Gerit mit einem Tuch o. A. abgedeckt
wird, kann sich im Gerit ein Wirmestau bilden.

Nach dem Gebrauch

Stellen Sie den Schalter ON/STANDBY stets auf
STANDBY, bevor Sie die Stromversorgung
trennen.

Vor langerer Nichtverwendung
Nehmen Sie den Akku ab.

Den Camcorder nicht mit auf die Sonne
gerichtetem Objektiv ablegen

Direkte Sonneneinstrahlung kann durch das
Objektiv eindringen, im Camcorder gebiindelt
werden und Feuer verursachen.

Das Objektiv keinen Strahlen wie Laserstrahlen
aussetzen

Der Bildsensor kann beschédigt werden und es
konnen Fehlfunktionen der Kamera verursacht
werden.

Transport

* Nehmen Sie die Speicherkarten heraus, bevor
Sie das Gerit transportieren.
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* Wenn Sie das Gerit per Lkw, Schiff, Flugzeug
oder einem anderen Transportsystem
versenden, verpacken Sie es im
Originalverpackungsmaterial.

Der Akku
So laden Sie den Akku

¢ Sie miissen den Akku laden, bevor Sie den
Camcorder in Betrieb nehmen.

So verwenden Sie den Akku effektiv

* Die Akkuleistung nimmt bei einer

Umgebungstemperatur von 10 °C und darunter

ab und die Betriebsdauer des Akkus wird

kiirzer. Sie haben in diesem Fall folgende

Moglichkeiten, um den Akku ldnger nutzen zu

konnen.

— Stecken Sie den Akku zum Erwérmen in eine
Jacken- oder Hosentasche und bringen Sie
ihn erst unmittelbar vor dem Starten der
Aufnahme am Camcorder an.

—Verwenden Sie einen Akku mit hoher
Kapazitit.

Achten Sie darauf, dass Sie den Schalter ON/

STANDBY auf STANDBY stellen, wenn Sie

den Camcorder nicht zur Aufnahme oder

Wiedergabe nutzen. Dem Akku wird auch dann

Strom entzogen, wenn sich der Camcorder im

Aufnahmebereitschaftsmodus oder in der

Wiedergabepause befindet.

Halten Sie Ersatzakkus fiir das 2- bis 3-Fache

der erwarteten Aufnahmedauer bereit und

machen Sie vor der eigentlichen Aufnahme eine

Probeaufnahme.

« Schiitzen Sie den Akku vor Wasser. Der Akku
ist nicht wassergeschiitzt.

Aufbewahrung des Akkus

* Wenn der Akku lange Zeit nicht verwendet
wird, laden Sie ihn einmal im Jahr vollstdndig
auf und entladen ihn dann mit dem Camcorder,
damit er funktionstiichtig bleibt. Nehmen Sie
den Akku zum Aufbewahren vom Camcorder
ab und lagern Sie ihn kiihl und trocken.

* Wenn Sie den Akku im Camcorder vollstindig
entladen mochten, lassen Sie den Camcorder im
Aufnahmebereitschaftsmodus, bis er sich
ausschaltet (Seite 24).



Lebensdauer des Akkus

» Die Akkukapazitit nimmt im Laufe der Zeit
und mit wiederholtem Gebrauch ab. Wenn sich
die Betriebsdauer des Akkus erheblich verkiirzt,
sollten Sie ihn gegen einen neuen austauschen.

» Die Akkulebensdauer hidngt von den Lager-,
Betriebs- und Umgebungsbedingungen ab.

Laden des Akkus
¢ Laden Sie ausschlieBlich die angegebenen
Akkus mit dem Ladegerit (mitgeliefert) auf.
Wenn Sie andere Akkutypen aufladen, besteht
die Gefahr, dass diese auslaufen, iiberhitzen,
platzen oder einen elektrischen Schlag
verursachen und es dadurch zu Verbrennungen
und anderen Verletzungen kommt.
* Nehmen Sie den aufgeladenen Akku aus dem
Ladegerit heraus.
 Die Ladeanzeige des mitgelieferten Ladegeriits
blinkt auf die folgenden zwei Arten:
Schnelles Blinken...Die Anzeige schaltet sich
im Abstand von ca. 0,15 Sekunden ein und aus.
Langsames Blinken...Die Anzeige schaltet sich
im Abstand von ca. 1,5 Sekunden ein und aus
und bleibt dann ca. 1,5 Sekunden lang aus.
Diese Abfolge wird wiederholt.
Wenn die Ladeanzeige schnell blinkt, nehmen
Sie den aufzuladenden Akku heraus und setzen
Sie ihn dann fest wieder ein. Wenn die
Ladeanzeige weiterhin schnell blinkt, ist der
Akku moglicherweise beschidigt oder Sie
verwenden einen nicht geeigneten Akkutyp.
Vergewissern Sie sich, dass Sie einen Akku des
geeigneten Typs verwenden. Ist dies der Fall,
nehmen Sie ihn heraus und setzen Sie einen
ganz neuen Akku bzw. einen erwiesenermafien
funktionsfihigen Akku ein, um zu iiberpriifen,
ob das Ladegerit richtig funktioniert.
Funktioniert das Ladegerit richtig, dann ist der
Akku moglicherweise beschidigt.
Wenn die Ladeanzeige langsam blinkt, befindet
sich das Ladegerit im Bereitschaftsmodus und
der Ladevorgang ist unterbrochen. Wenn die
Umgebungstemperatur nicht im geeigneten
Temperaturbereich liegt, unterbricht das
Ladegerit automatisch den Ladevorgang und
wechselt in den Bereitschaftsmodus. Wenn
wieder eine geeignete Umgebungstemperatur
erreicht ist, setzt das Ladegerit den
Ladevorgang fort und die Ladeanzeige leuchtet
wieder. Es empfiehlt sich, den Akku bei einer
Umgebungstemperatur zwischen 10 °C und
30 °C zu laden.
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Umgang mit dem Camcorder

Betrieb und Pflege

* Lagern und verwenden Sie den Camcorder und

das Zubehor nicht an folgenden Orten.

—Orte mit extremen Temperaturen.

Setzen Sie den Camcorder und das Zubehor
nie Temperaturen von iiber 60 °C aus, wie
sie z.B. in direktem Sonnenlicht, in der Nihe
von Heizungen oder in einem in der Sonne
geparkten Auto auftreten konnen.
Andernfalls kann es zu Fehlfunktionen
kommen oder Teile konnen sich verformen.

—In der Nihe von starken Magnetfeldern oder
mechanischen Erschiitterungen.

Andernfalls kann es am Camcorder zu
Fehlfunktionen kommen.

—In der Nihe von starken Radiowellen oder
Strahlung.

Andernfalls ist eine einwandfreie Aufnahme
mit dem Camcorder unter Umstidnden nicht
moglich.

—In der Nidhe von AM-Empféingern und
Videogeriten.

Andernfalls kann es zu Interferenzen
kommen.

— An Sandstridnden oder in staubiger
Umgebung.

Wenn Sand oder Staub in den Camcorder
gelangt, kann es zu Fehlfunktionen kommen.
Unter Umstinden kann das Geriit irreparabel
beschédigt werden.

—In Fensterndhe oder im Freien, wo der LCD-
Bildschirm, der Sucher oder das Objektiv
direktem Sonnenlicht ausgesetzt ist.
Dadurch werden innere Bauteile des Suchers
oder LCD-Bildschirms beschadigt.

— An Orten mit hoher Luftfeuchtigkeit.

Verwenden Sie fiir den Betrieb mit Gleich- oder

Netzstrom das in dieser Bedienungsanleitung

empfohlene Zubehor.

Schiitzen Sie den Camcorder vor Nisse wie z.

B. Regen oder Meerwasser. Wenn der

Camcorder nass wird, kann es zu

Fehlfunktionen kommen. Unter Umstédnden

kann das Gerit irreparabel beschiddigt werden.

Sollten Fremdkarper oder Fliissigkeiten in das

Gehiuse gelangen, trennen Sie den Camcorder

von der Netzsteckdose und lassen Sie ihn von

einem Sony-Héndler iiberpriifen, bevor Sie ihn
wieder benutzen.



¢ Gehen Sie sorgsam mit dem Gerit um, zerlegen
und modifizieren Sie es nicht und schiitzen Sie
es vor StoBen, lassen Sie es nicht fallen und
treten Sie nicht darauf. Bitte behandeln Sie das
Objektiv mit besonderer Sorgfalt.

Verformte oder beschédigte Akkus diirfen nicht
verwendet werden.

Belassen Sie den Schalter ON/STANDBY in
der Position STANDBY, wenn Sie den
Camcorder nicht verwenden.

Wickeln Sie den Camcorder wihrend des
Betriebs nicht in ein Tuch o. A. ein. Andernfalls
kann sich im Inneren des Gerits ein Wérmestau
bilden.

Ziehen Sie zum Trennen des Netzkabels immer
am Stecker und nicht am Kabel.

Achten Sie darauf, das Netzkabel nicht zu
beschidigen. Stellen Sie beispielsweise keine
schweren Gegenstinde darauf.

Halten Sie die Metallkontakte sauber.
Bewabhren Sie die drahtlose Fernbedienung und
die Knopfbatterie auerhalb der Reichweite von
Kindern auf. Falls eine Batterie verschluckt

wird, wenden Sie sich umgehend an einen Arzt.

Wenn die Batteriefliissigkeit ausgelaufen ist:

—Wenden Sie sich an den autorisierten Sony-
Kundendienst vor Ort.

—Waschen Sie die Fliissigkeit ab, falls sie mit
der Haut in Beriihrung gekommen ist.

— Wenn die Fliissigkeit in Ihre Augen gelangt
ist, waschen Sie sie mit viel Wasser aus und
suchen Sie einen Arzt auf.

Wenn Sie den Camcorder lange Zeit nicht

benutzen

¢ Schalten Sie den Camcorder etwa einmal im
Monat ein und lassen Sie Bilder aufnehmen
bzw. wiedergeben, damit er lange Zeit in
optimalem Zustand bleibt.

« Entladen Sie den Akku vollstindig, bevor Sie
ihn aufbewahren.

Feuchtigkeitskondensation

Wird der Camcorder direkt von einem kalten an
einen warmen Ort gebracht, kann sich im
Camcorder Feuchtigkeit niederschlagen und es

kann zu Fehlfunktionen am Camcorder kommen.

Wenn sich Feuchtigkeit niedergeschlagen hat
Warten Sie etwa 1 Stunde, bevor Sie den
Camcorder einschalten.

Hinweis zur Feuchtigkeitskondensation
Feuchtigkeit kann sich niederschlagen, wenn Sie
den Camcorder von einem kalten an einen
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warmen Ort bringen (oder umgekehrt) oder den

Camcorder in folgenden Situationen benutzen:

* Wenn Sie den Camcorder von einer Skipiste in
einen beheizten Raum bringen.

* Wenn Sie den Camcorder von einem
klimatisierten Auto oder Raum in die Hitze
draufen bringen.

* Wenn Sie den Camcorder nach einem Gewitter
oder Regenschauer benutzen.

* Wenn Sie den Camcorder an einem heiffen und
feuchten Ort benutzen.

So vermeiden Sie Feuchtigkeitskondensation
Wenn Sie den Camcorder von einem kalten an
einen warmen Ort bringen, stecken Sie ihn in eine
Plastiktiite und verschlieBen Sie diese sorgfiltig.
Nehmen Sie den Camcorder aus der Tiite heraus,
sobald die Lufttemperatur in der Tiite der
Umgebungstemperatur entspricht. Das dauert
etwa 1 Stunde.

LCD-Bildschirm

* Driicken Sie nicht zu stark auf den LCD-
Bildschirm. Andernfalls kann er beschédigt
werden.

* Wenn Sie den Camcorder in einer kalten
Umgebung benutzen, kann ein Nachbild auf
dem LCD-Bildschirm zu sehen sein. Dies ist
keine Fehlfunktion.

* Beim Betrieb des Camcorders kann sich die
Riickseite des LCD-Bildschirms erwidrmen.
Dies ist keine Fehlfunktion.

So reinigen Sie den LCD-Bildschirm

Die Oberflidche des LCD-Bildschirms ist

beschichtet. Wenn Sie die Oberfliche zerkratzen,

kann sich die Beschichtung 16sen.

Beachten Sie beim Reinigen und im Umgang mit

dem LCD-Bildschirm Folgendes:

* Wenn Fingerabdriicke (Fette) oder Handcreme
langer auf dem Bildschirm bleiben, kann sich
die Beschichtung leichter ablosen. Entfernen
Sie solche Verunreinigungen moglichst bald.

* Die Beschichtung kann zerkratzt werden, wenn
Sie den Bildschirm mit einem Papiertuch o. A.
abwischen.

* Entfernen Sie vor dem Abwischen Staub und
Sand mit einem Staubbliser o. A.

* Reinigen Sie den LCD-Bildschirm behutsam
mit einem weichen Tuch (z. B. einem
Brillenputztuch).

Pflege des Gehéduses
* Wenn das Gehéduse des Camcorders
verschmutzt ist, reinigen Sie es mit einem



weichen Tuch, das Sie leicht mit Wasser
angefeuchtet haben. Wischen Sie das Gehiduse

anschlieend mit einem weichen Tuch trocken.

Vermeiden Sie Folgendes, damit das Gehduse

nicht beschidigt wird.

—Verwenden Sie keine Chemikalien wie
Verdiinner, Benzin, Alkohol, keine chemisch
imprignierten Reinigungstiicher, keine
Repellents (Insektenabwehrmittel), keine
Insektizide und keine Sonnenschutzmittel.

— Beriihren Sie das Gehéduse nicht mit den oben
genannten Substanzen an den Hénden.

— Achten Sie darauf, dass das Gehiuse nicht
lingere Zeit mit Gummi- oder
Vinylmaterialien in Beriihrung kommt.

Pflege und Aufbewahrung des Objektivs

* Reinigen Sie die Objektivlinse in folgenden
Fillen mit einem weichen Tuch:

— Wenn sich Fingerabdriicke auf der
Objektivlinse befinden.

—In heiBler oder feuchter Umgebung

— Wenn das Objektiv in salzhaltiger
Umgebung, wie z. B. am Meer, verwendet
wird.

* Bewahren Sie das Objektiv an einem Ort mit
guter Luftzirkulation und méglichst wenig
Staub oder Schmutz auf.

¢ Damit sich kein Schimmel bilden kann,
reinigen Sie das Objektiv regelméfig wie oben
beschrieben.

Laden des werkseitig installierten Akkus

Der Camcorder verfiigt iiber einen
vorinstallierten Akku, um Datum, Uhrzeit und
andere Einstellungen auch dann zu speichern,
wenn der Schalter ON/STANDBY auf
STANDBY gesetzt ist. Der werkseitig installierte
Akku wird immer geladen, solange der
Camcorder tiber das Netzteil an eine
Netzsteckdose angeschlossen oder der Akku am
Camcorder angebracht ist. Nach etwa drei
Monaten ist der werkseitig installierte Akku
vollstdndig entladen, wenn Sie den Camcorder in
dieser Zeit weder iiber das Netzteil noch iiber den
Akku mit Strom versorgt haben. Laden Sie den
werkseitig installierten Akku, bevor Sie den
Camcorder verwenden.
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So verhindern Sie elektromagnetische
Interferenzen durch traghare Telefone,
drahtlose Gerdte usw.

Die Verwendung von tragbaren Telefonen,
drahtlosen Geriten usw. in der Nihe dieses
Geriits kann zu Fehlfunktionen und Interferenzen
mit Audio- und Videosignalen fiihren.

Es empfiehlt sich, solche Gerite in der Nihe
dieses Gerits auszuschalten.

Der LCD-Bildschirm

¢ Achten Sie darauf, den LCD-Bildschirm nicht
direktem Sonnenlicht auszusetzen, da der LCD-
Bildschirm andernfalls beschiddigt werden
konnte.

¢ Driicken Sie nicht zu fest auf den LCD-
Bildschirm, wischen Sie nicht zu fest dariiber
und legen Sie keine Gegenstinde darauf ab, da
es andernfalls zu Fehlfunktionen wie
BildunregelmifBigkeiten usw. kommen kann.

* Der LCD-Bildschirm kann sich wihrend des
Betriebs erwidrmen. Dies ist keine Fehlfunktion.

Pixelfehler

Der LCD-Bildschirm/der organische EL-
Bildschirm dieses Gerits wird mit
Hochprizisionstechnologie hergestellt und die
Anzahl der funktionsfihigen Pixel liegt bei
mindestens 99,99%. Ein sehr geringer Anteil von
Pixeln kann jedoch eventuell , hdngenbleiben®,
entweder immer aus (schwarz), immer an (rot,
griin oder blau), oder blinkend. Dariiber hinaus
konnen solche ,,Pixelfehler” aufgrund der
physischen Eigenschaften eines
Fliissigkristallbildschirms oder organischen EL-
Bildschirms nach langer Nutzungsdauer auch
spontan auftreten. Diese Fehler stellen keine
Fehlfunktion dar und werden nicht auf dem
Aufnahmemedium aufgezeichnet.

Die Anzeige auf dem organischen EL-
Bildschirm

Aufgrund der physischen Eigenschaften des
organischen EL-Bildschirms konnen Bilder
einbrennen und unter Umsténden ist die
Helligkeit gering.

Solche Probleme stellen keine Fehlfunktion dar
und behindern nicht den problemlosen Betrieb
des organischen EL-Bildschirms.



Wenn Sie Thre Blickrichtung im Sucher dndern,
werden ggf. einige Grundfarben sichtbar. Dies ist
jedoch keine Fehlfunktion.

Diese Farben werden nicht auf die Speicherkarten
aufgenommen.

VerschleiBteile

« Liifter und Batterie des Gerits sind
Verbrauchsmaterialien, die regelméfig ersetzt
werden miissen.

Wenn das Geriit bei Raumtemperatur betrieben
wird, sollten die Teile ca. alle 5 Jahre ersetzt
werden. Diese Ersatzfristen stellen jedoch nur
eine allgemeine Richtlinie und keine Garantie
der Lebensdauer dieser Teile dar. Weitere
Informationen zum Austausch von
Komponenten erhalten Sie bei IThrem Hindler.
Die Lebensdauer des Netzteils und des
Elektrolytkondensators betrigt bei normalen
Betriebstemperaturen und normaler
Verwendung etwa 5 Jahre (8 Stunden pro Tag;
25 Tage pro Monat). Falls die Nutzung die
normale Nutzungshiufigkeit iiberschreitet, ist
die Lebensdauer ggf. entsprechend geringer.
Der Batteriekontakt dieses Gerits (der
Anschluss fiir Akkus und Netzteile) ist ein
Verbrauchsteil.

Das Gerit wird moglicherweise nicht richtig
mit Strom versorgt, wenn die Stifte des
Batteriekontakts durch St6Be oder Vibrationen
verbogen oder deformiert sind, oder wenn sie
aufgrund lidngerer Verwendung im Freien
korrodiert sind.

Regelmifige Kontrollen werden empfohlen,
um richtige Funktion und lange Lebensdauer
des Gerits sicherzustellen.

Wenden Sie sich fiir weitere Auskiinfte tiber
Kontrollen am Gerit an Thren Sony-
Kundendienst oder -Héndler.

Hinweis zur Anzeige

* Wenn Sie die folgenden Funktionen ausfiihren,
ist das Bild auf dem LCD-Bildschirm und auf
dem Sucherbildschirm moglicherweise
verzerrt:

—Wechseln des Videoformats
— Starten der Wiedergabe iiber die
Miniaturbildanzeige
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Dateifragmentierung

Wenn keine ordnungsgemife Aufnahme/
Wiedergabe moglich ist, versuchen Sie, das
Aufnahmemedium zu formatieren. Wenn Sie
iiber einen lingeren Zeitraum ein Medium
wiederholt fiir die Aufnahme bzw. Wiedergabe
verwenden, kann es zu einer Fragmentierung der
Dateien auf dem Medium kommen, was die
ordnungsgeméle Aufnahme/Wiedergabe
verhindert. Erstellen Sie in diesem Fall
Sicherungskopien der Clips auf dem Medium und
formatieren Sie das Medium dann mit Format
Media (Seite 134) im Media-Menii.

Hinweise zur Sicherheit im Internet

* Verwenden Sie den Camcorder hinter einer
Firewall mit geeigneten Sicherheitsfunktionen.
Verbinden Sie den Camcorder nicht mit einem
Netzwerk, mit dem nicht vertrauenswiirdige
Gerite eine Verbindung herstellen konnen.

* Verwenden Sie moglichst FTPS. Bei der
Verwendung von FTP werden Inhalte,
Benutzernamen und Passworter nicht
verschliisselt.

» SONY KANN KEINE HAFTUNG FUR

SCHADEN JEDER ART DURCH

UNTERLASSENE GEEIGNETE

SICHERHEITSMASSNAHMEN AN

UBERTRAGUNGSGERATEN, DURCH

UNVERMEIDBARE DATENPREISGABE

AUFGRUND DER

UBERTRAGUNGSSPEZIFIKATIONEN

ODER DURCH SICHERHEITSPROBLEME

JEGLICHER ART UBERNEHMEN.

Je nach Betriebsumgebung konnen unbefugte

Dritte im Netzwerk unter Umsténden auf dieses

Gerit zugreifen. Achten Sie beim Verbinden

des Gerits mit dem Netzwerk darauf, dass das

Netzwerk gut abgesichert ist.

Der Kommunikationsinhalt kann von

unautorisierten Dritten in der Nihe des Signals

abgefangen werden, ohne dass Sie es merken.

Wenn Sie die WLAN-Kommunikation nutzen,

implementieren Sie geeignete

Sicherheitsmafnahmen, um den

Kommunikationsinhalt zu schiitzen.

Aus Sicherheitsgriinden sollten Sie unbedingt

die werkseitig eingestellten Werte fiir die

Zugriffseinschrinkung dndern, wenn das Gerit

mit dem Netzwerk verbunden ist (Seite 139).

Bei einer Verbindung mit einem offenen



Netzwerk ist stets Vorsicht geboten.

Es wird auch empfohlen, das Passwort
regelmiBig zu dndern.

Rufen Sie keine andere Website im
Webbrowser auf, wihrend Sie Einstellungen
vornehmen oder nachdem Sie Einstellungen
vorgenommen haben. Da der Anmeldestatus
beim Webbrowser gespeichert bleibt, schliefen
Sie den Webbrowser, wenn Sie die
Einstellungen abgeschlossen haben, um zu
verhindern, dass unautorisierte Dritte das Gerit
nutzen oder schéidliche Programm ausfiihren.

GPS

Beim GPS-System (Global Positioning System)
kann mithilfe hochst préziser US-
Weltraumsatelliten eine geografische Position
berechnet werden. Das heif3t, mit diesem System
konnen Sie Ihre genaue Position auf der Erde
feststellen.

Die GPS-Satelliten umkreisen die Erde in
20.000 km Hohe auf sechs Erdumlaufbahnen.
Das GPS-System besteht aus mindestens 24 GPS-
Satelliten. Uber einen GPS-Empfinger werden
Funksignale von den Satelliten empfangen, aus
denen sich auf der Grundlage der Bahndaten der
Satelliten (Almanach-Daten) und der
Signallaufzeit usw. die aktuelle Position des
Empfingers berechnen lisst.

Die Positionsbestimmung erfolgt mithilfe der
,,Triangulation®. Ein GPS-Empfinger kann den
Breitengrad und Léingengrad einer Position
anhand der Signale von mindestens 3 Satelliten
bestimmen.

« Da die Positionen von GPS-Satelliten stdndig
wechseln, kann die Positionsbestimmung
lédngere Zeit dauern. Je nachdem, wo und wann
Sie den Camcorder verwenden, kann der
Empfinger die Position moglicherweise gar
nicht bestimmen.

* Mit dem GPS-System lisst sich die
geografische Position durch die Triangulation
der Funksignale von GPS-Satelliten
bestimmen. Verwenden Sie den Camcorder
dazu moglichst nicht an Orten, an denen
Funksignale blockiert oder reflektiert werden,
z. B. an einer von Gebéuden oder Biumen usw.
umgebenen Stelle im Schatten. Verwenden Sie
den Camcorder unter freiem Himmel, wo nichts
den Empfang stort.
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* An folgenden Orten bzw. in folgenden Fillen
konnen unter Umsténden keine Positionsdaten
aufgenommen werden, weil der Camcorder
keine Funksignale von den GPS-Satelliten
empfangen kann.

—In Tunnels, in Gebduden oder im Schatten
von Gebduden.

—Zwischen hohen Gebiuden oder in engen
Stralenschluchten.

— An unterirdischen oder von dichten Baumen
umgebenen Orten, unter hohen Briicken oder
an Orten, an denen Magnetfelder erzeugt
werden, z. B. in der Nihe von
Hochspannungskabeln.

—In der Néhe von Geriten, die Funksignale im
vom Camcorder genutzten Frequenzbereich
erzeugen, also in der Nihe von
Mobiltelefonen usw. im 1,5-GHz-
Frequenzbereich.

* Wenn Sie Bilder, die bei Einstellung von GPS
auf On aufgenommen wurden, hochladen oder
teilen, kann der Aufnahmeort im Internet
aufgedeckt werden, selbst wenn dies nicht Thre
Absicht ist. Wenn Sie die Positionsdaten nicht
aufzeichnen wollen, setzen Sie GPS auf Off
(Seite 152).

Abweichungen bei der Triangulation

¢ Wenn Sie sich unmittelbar, nachdem Sie GPS
im Menii auf On gesetzt haben, an einen
anderen Ort begeben, braucht der Camcorder
unter Umstidnden mehr Zeit, die Triangulation
zu starten, als wenn Sie am gleichen Ort
bleiben.

* Abweichung aufgrund der Position von GPS-
Satelliten Der Camcorder nimmt automatisch
eine Triangulation Ihrer aktuellen Position vor,
wenn der Camcorder die Funksignale von
mindestens drei GPS-Satelliten empfingt. Bei
der Triangulation mithilfe der Signale von den
GPS-Satelliten kann es zu einer Abweichung
von etwa 10 m kommen. Je nach der Umgebung
der Position kann die Abweichung auch héher
ausfallen. In diesem Fall entspricht Ihre aktuelle
Position unter Umstinden nicht der anhand der
GPS-Daten berechneten Position auf der Karte.
AuBerdem unterstehen die GPS-Satelliten dem
Verteidigungsministerium der USA und die
Genauigkeit wird unter Umstédnden absichtlich
reduziert.

* Abweichung wihrend des Triangulationsvor-
gangs



Der Camcorder empfingt wihrend der Triangu-
lation regelmiBig Positionsdaten.

Einschrankungen beim Gebrauch von GPS
Verwenden Sie GPS je nach Situation und in
Ubereinstimmung mit den Vorschriften der
Liander bzw. Regionen, in denen Sie es einsetzen.

Das geografische Koordinatensystem
Verwendet wird das geografische
Koordinatensystem ,,WGS-84.
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Videoformate

Aufnahmemedien

Aufnahmemedien und kompatible Formate

M Normale Aufnahme

Dateisystem SxS Pro+ SxS Pro SxS-1 XQD SDXC SDHC
XAVC-1 exFAT  3840x2160 O - - O - -
1920x1080 O O - O - -
1280720 O - - O - -
XAVC-L  exFAT 3840x2160 @] @] O O - -
1920x1080 @] O @] O @] -
1280x720 @] O @] O @] -
MPEG exFAT @) [@) O @) O -
HD422 "ypF [¢) [¢) ) ¢ - -
MPEG exFAT @] (@] O @] O -
HD420  "ypF O [¢) ¢ O - -
FAT - - - - - O
DVCAM  exFAT @] @] @] O @] -
UDF O @] O @] - -

O: Kompatibel
—: Nicht kompatibel

M Zeitlupen- & Zeitraffermodus
Dateisystem SxS Pro+ SxSPro  SxS-1 XQD SDXC SDHC

XAVC-1 exFAT O - - O - -
XAVCL ) o) O ) - -
"MPEG HD422 O [®) @) O O -
"MPEG HD420 e} [®) @) O O -

O: Kompatibel
—: Nicht kompatibel

Fiir andere als Sony SxS-Speicherkarten und Sony XQD-Speicherkarten (G-Serie, S (EB Stream)-Serie)
kann der Betrieb nicht garantiert werden.
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Spezialaufnahmemodi und kompatible Formate

XAVC-I| XAVC-L|MPEG HD422 |MPEG HD420 DVCAM
exFAT |[exFAT |exFAT UDF exFAT UDF FAT
Intervallaufnahme @] O O - @] - - -
Kontinuierliche O O O O ©) ©) - -
Clipaufnahme
Aufnahme mit Bildpuffer O O O O O @) @) -
Zeitlupe und Zeitraffer O O @] - O - - -
Simultanaufzeichnung in2 O O O O ©) ©) - -
Einschiiben
4K- und HD (Sub)- O O - - - - - -
Aufnahme
O: Kompatibel
—: Nicht kompatibel
Maximale Aufnahmedauer fiir einen Clip
Aufzeichnungsformat Kontinuierliche Maximale
Aufnahmedauer (je = Aufnahmedauer bei
Medium) kontinuierlicher
Aufzeichnung
XAVC-I ca. 24 Stunden ca. 24 Stunden
XAVC-L ca. 24 Stunden ca. 24 Stunden
MPEG HD422 ca. 24 Stunden ca. 24 Stunden
MPEG HD420 ca. 24 Stunden ca. 24 Stunden
DVCAM ca. 24 Stunden ca. 24 Stunden
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Ausgabeformate und Beschrankungen

Videoformate und Ausgangssignale

Ausgabeformate fiir den Anschluss SDI OUT

* SDI-Ausgang und HDMI-Ausgang konnen nicht gleichzeitig auf 3840x2160P eingestellt werden.

Einstellung fiir das Aufnahmeformat

Einstellung fiir die SDI-
Ausgabe

Ausgangssignal/
Konvertierungsmethode

Rec Format
>Frequency im
System-Menii

Rec Format >Video
Format im System-
Menii

Output Format >SDI
im Video-Menii

Ausgangssignal

59.94 3840x2160P 3840x2160P 3840x2160 59.94P
1920x1080P (Level A) 1920x1080 59.94P Level-A
1920x1080P (Level B) 1920x1080 59.94P Level-B
1920x1080i 1920x1080 59.94i

1920x1080P 1920x1080P (Level A) 1920x1080 59.94P Level-A
1920x1080P (Level B) 1920x1080 59.94P Level-B
1920x1080i 1920x1080 59.94i
720x486i 720x486 59.94i

1920x1080i 1920x1080i 1920x1080 59.94i
720x4861 720%x486 59.94i

1440x1080i 1920x1080i 19201080 59.94i
720x486i 720x486 59.94i

1280x720P 1280x720P 1280x720 59.94P
720x4861 720x486 59.94i

720x486i 720x486i1 720%x486 59.94i

29.97 3840x2160P 1920x1080PsF 19201080 29.97PsF

1920x1080P 1920x1080PsF 1920x1080 29.97PsF
720x4861 720x486 59.94i (PsF)

1280x720P 1280x720P 1280x720 59.94P (2-2RP)
720x4861 720x486 59.94i (PsF)

23.98 3840x2160P 1920x1080PsF 19201080 23.98PsF
1920x1080i (2-3PD) 19201080 59.94i (2-3PD)

1920x1080P 1920x1080PsF 1920x1080 23.98PsF
1920x1080i (2-3PD) 19201080 59.94i (2-3PD)
720x486i (2-3PD) 720x486 59.94i (2-3PD)

1280x720P 1280x720P (2-3PD) 1280x720 59.94P (2-3PD)

720x486i (2-3PD)

720x486 59.94i (2-3PD)
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Einstellung fiir das Aufnahmeformat Einstellung fiir die SDI-| Ausgangssignal/
Ausgabe Konvertierungsmethode
Rec Format Rec Format >Video |Output Format >SDI | Ausgangssignal

>Frequency im
System-Menii

Format im System-
Menii

im Video-Menii

50 3840x2160P 3840x2160P 3840x2160 50P
1920x1080P (Level A) 1920x1080 50P Level-A
1920x1080P (Level B) 1920x1080 50P Level-B
1920x1080i 1920x1080 50i

1920x1080P 1920x1080P (Level A) 1920x1080 50P Level-A
1920x1080P (Level B) 1920x1080 50P Level-B
1920x1080i 1920x1080 50i
720x576i 720%x576 50i

1920x1080i 1920x1080i 1920x1080 50i
720x5761 720%x576 50i

1440x1080i 1920x1080i 1920x1080 50i
720x576i1 720576 50i

1280x720P 1280x720P 1280x720 50P
720x576i 720%x576 50i

720x576i 720x576i 720x576 50i

25 3840x2160P 1920x1080PsF 1920x1080 25PsF

1920x1080P 1920x1080PsF 1920x1080 25PsF
720x5761 720x576 50i (PsF)

1280x720P 1280x720P 1280x720 50P (2-2RP)
720x576i 720%x576 50i (PsF)
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Ausgabeformate fiir den Anschluss HDMI OUT

* SDI-Ausgang und HDMI-Ausgang konnen nicht gleichzeitig auf 3840x2160P eingestellt werden.

Einstellung fiir das Aufnahmeformat

Einstellung fiir die
HDMI-Ausgabe

Ausgangssignal/

Konvertierungsmethode

Rec Format
>Frequency im
System-Menii

Rec Format >Video
Format im System-
Menii

Output Format >SHDMI
im Video-Menii

Ausgangssignal

59.94 3840x2160P 3840x2160P 3840x2160 59.94P
1920x1080P 1920x1080 59.94P
1920x1080i 1920x1080 59.94i

1920x1080P 1920x1080P 1920x1080 59.94P
1920x1080i 1920x1080 59.94i
720x480i 720x480 59.94i
1920x1080i 1920x1080i 19201080 59.94i
720x4801 720%x480 59.94i
1440x1080i 1920x1080i 19201080 59.94i
720x480i 720x480 59.94i
1280x720P 1280x720P 1280x720 59.94P
720x4801 720x480 59.94i
720x486i 720x480i 720%x480 59.94i
720x480P 720x480 59.94P

29.97 3840x2160P 3840x2160P 3840%x2160 29.97P
1920x1080i 1920x1080 59.94i (PsF)

1920x1080P 1920x1080i 1920x1080 59.94i (PsF)
720x480i 720x480 59.94i (PsF)

1280x720P 1280x720P 1280x720 59.94P (2-2RP)
720x480i 720x480 59.94i (PsF)

23.98 3840x2160P 3840x2160P 3840x2160 23.98P
1920x1080P 1920x1080 23.98P
1920x1080i (2-3PD) 19201080 59.94i (2-3PD)

1920x1080P 1920x1080P 1920x1080 23.98P
1920x1080i (2-3PD) 19201080 59.94i (2-3PD)
720x480i (2-3PD) 720x480 59.94i (2-3PD)

1280x720P 1280x720P (2-3PD) 1280x720 59.94P (2-3PD)

720x480i (2-3PD)

720x480 59.94i (2-3PD)
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Einstellung fiir das Aufnahmeformat

Einstellung fiir die
HDMI-Ausgabe

Ausgangssignal/
Konvertierungsmethode

Rec Format
>Frequency im
System-Menii

Rec Format >Video
Format im System-
Menii

Output Format >HDMI
im Video-Menii

Ausgangssignal

50 3840x2160P 3840x2160P 3840x2160 50P
1920x1080P 1920x1080 50P
1920x1080i 1920x1080 50i

1920x1080P 1920x1080P 1920x1080 50P
1920x1080i 1920x1080 50i
720x576i 720%x576 50i
1920x1080i 1920x1080i 1920x1080 50i
720x576i 720%x576 50i
1440x1080i 1920x1080i 1920x1080 50i
720x5761 720%x576 50i
1280x720P 1280x720P 1280x720 50P
720x576i1 720576 50i
720x576i 720x576i 720%x576 50i
720x576P 720%x576 50P

25 3840x2160P 3840x2160P 3840x2160 25P
1920x1080i 19201080 50i (PsF)

1920x1080P 1920x1080i 1920x1080 50i (PsF)
720x5761 720x576 50i (PsF)

1280x720P 1280x720P 1280x720 50P (2-2RP)
720x576i 720%x576 50i (PsF)

Ausgaheformate fiir den Anschluss GENLOCK IN/VIDEO OUT

Videoausgangssignal

Einstellung fiir das Aufnahmeformat

Ausgangssignal/Konvertierungsmethode

Rec Format
>Frequency im
System-Menii

Rec Format >Video
Format im System-
Menii

Synchronisationssignal

Ausgangssignal

59.94

3840x2160P HD-Sync 1920x1080 59.94i
HD-Y 1920x1080 59.94i
1920x1080P HD-Sync 19201080 59.94i
HD-Y 19201080 59.94i
Composite 720x486 59.94i
1920x10801 HD-Y 1920x1080 59.94i
Composite 720x486 59.94i
1440x10801 HD-Y 1920x1080 59.94i
Composite 720x486 59.94i
1280x720P HD-Sync 19201080 59.94i
Composite 720%x486 59.94i
720x4861 Composite 720x486 59.94i
SD-Sync 720x486 59.94i
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Einstellung fiir das Aufnahmeformat

Ausgangssignal/Konvertierungsmethode

Rec Format
>Frequency im
System-Menii

Rec Format >Video
Format im System-
Menii

Synchronisationssignal

Ausgangssignal

29.97 3840%x2160P HD-Sync 1920%x1080 59.94i
HD-Y 1920x1080 29.97PsF
1920x1080P HD-Y 1920x1080 29.97PsF
Composite 720%486 59.94i (PsF)
1280x720P HD-Sync 1920%x1080 29.97PsF
Composite 720%x486 59.94i (PsF)
23.98 3840%x2160P HD-Sync 1920%x1080 23.98PsF
HD-Y 1920x1080 23.98PsF
1920x1080P HD-Y 1920x1080 23.98PsF
HD-Sync 1920x1080 23.98PsF
Composite 720x486 59.94i (2-3PD)
1280x720P HD-Sync 19201080 23.98PsF
Composite 720%486 59.94i (2-3PD)
50 3840%x2160P HD-Sync 1920%x1080 50i
HD-Y 1920x1080 50i
1920x1080P HD-Sync 1920x1080 50i
HD-Y 1920x1080 50i
Composite 720x576 50i
1920%x1080i HD-Y 1920%x1080 50i
Composite 720x576 50i
1440x1080i HD-Y 1920x1080 50i
Composite 720%x576 50i
1280x720P HD-Sync 1920x1080 50i
Composite 720x576 50i
720x5761 Composite 720x576 50i
SD-Sync 720%x576 50i
25 3840x2160P HD-Sync 1920x1080 50i
HD-Y 1920x1080 25PsF
1920x1080P HD-Y 1920x1080 25PsF
Composite 720%576 50i (PsF)
1280x720P HD-Sync 1920%x1080 25PsF
Composite 720576 50i (PsF)

« Falls die BildgroBe des Wiedergabeclips kleiner als die unter Output Format >SDI oder HDMI im Video-Menii
konfigurierte ist, wird das Videosignal nicht an diesem Anschluss ausgegeben.
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Netzwerk und Videoausgangskombinationen

SDI HDMI VIDEO Kabelgebundenes | Modem/ WLAN LCD-Bildschirm
Netzwerk Smartphone
ON ON ON OFF OFF ON
ON OFF OFF ON OFF OFF Energiesparmodus
ON OFF OFF OFF ON OFF Energiesparmodus
OFF ON OFF ON OFF OFF Energiesparmodus
OFF ON OFF OFF ON OFF Energiesparmodus
OFF OFF ON ON OFF OFF Energiesparmodus
OFF OFF ON OFF ON OFF Energiesparmodus
OFF OFF OFF ON OFF ON
OFF OFF OFF OFF ON ON
 Hinweis
¢ Im Energiesparmodus ist die Helligkeit des LCD-Bildschirms reduziert.
Beschrankungen zwischen Aufnahmefunktionen
Recording-Menii |[S&Q Interval |Picture Clip Simul [4K & HD |Proxy
Motion |Rec Cache Rec |Continuous |Rec (Sub) Rec |Rec
Rec
S&Q Motion - X X X X X X
Interval Rec X - X x X X X
Picture Cache Rec |x X - X X X X
Clip Continuous X X X - X X @)
Rec
Simul Rec X X x X - X X
4K & HD (Sub) Rec|x X X x X - X
Proxy Rec X X X ©) X x -

O: unterstiitzt, x: nicht unterstiitzt
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In einer All File/Scene File gespeicherte Optionen

Tabellenerlduterung

O: gespeichert

x: nicht gespeichert

—: nicht gespeichert (temporire Einstellung)

Camera

Option Unteroption All File Scene File

Focus Face Detection AF
ND Filter Presetl
Preset2

X

Preset3

Gain Gain<L>

Gain<M>

Gain<H>

Gain <Turbo>

High Sensitivity Mode
Shockless Gain
Shutter Mode

Shutter Speed

Shutter Angle

ECS

ECS Frequency

Auto Exposure Level
Mode

Speed

Auto ND Filter
AGC

AGC Limit
AGC Point
Auto Shutter
A.SHT Limit
A.SHT Point
Clip High light
Detect Window

Detect Window Indication

Average Peak Level Ratio
Custom Width
Custom Height

Custom H Position

Custom V Position

Color Bars Setting
Type

O| x| O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] ©| O] O
X[ x| x|x|x|x|x|Ox|x|OlO|]O]O|O|O|]OlOlOl O O] O] O] 0| O] O] O] O] O] O] O O] O] O
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Option

Unteroption

All File

Scene File

Flicker Reduce

Mode

@)

Frequency

Flash Band Reduce

Setting

Handle Zoom

Setting

High

Low

O| 0| O x| O

X| X| X| X| X

Auto Black Balance

Auto Black Balance

Auto FB Adjust

Auto FB Adjust

Video Light Set

Video Light Set

Paint

1) Nicht gespeichert, wenn Scene File >Scene White Data im File-Menii auf Off gesetzt ist.

Option

Unteroption

All File

Scene File

HDR Paint Setting

HLG Look

HDR Black Offset

HDR Knee

HDR Knee Point

HDR Knee Slope

White

Preset White

x| O] O] O] O] O

Color Temp <A>

ob

Color Temp Balance <A>

oY

R Gain <A>

oY

B Gain <A>

ob

Color Temp <B>

ob

Color Temp Balance <B>

o

R Gain <B>

oY

B Gain <B>

ob

White Setting

Shockless White

ATW Speed

ATW Mode

‘White Switch<B>

Filter White Memory

Offset White

Offset White <A>

Warm Cool <A>

‘Warm Cool Balance <A>

Offset White <B>

‘Warm Cool <B>

Warm Cool Balance <B>

Offset White<ATW>

Warm Cool<ATW>

‘Warm Cool Balance<ATW>

Black

Setting

Master Black

O| Ol O] O] O] O] O] O] O] O] O] O] O] O] O] O] O O] O O] O] O] O] O] O] O] 0| O] 0| O

Ol Ol x| x| x| x| x| x| x|x|x|x| O] O x| x

175



Option

Unteroption

All File

Scene File

Gamma

Setting

Master Gamma

Gamma Category

Gamma Select

Black Gamma

Setting

Range

Master Black Gamma

Low Key Saturation

Setting

Level

Range

Saturation Mode

Saturation Mode

Knee Saturation

Black Gamma

Low Key Saturation

Noise Suppression

Setting

Level

Knee

Setting

Auto Knee

Point

Slope

Knee Saturation

Knee Saturation Level

White Clip

Setting

Level

Detail(QFHD)

Manual Setting

Level

H/V Ratio

Crispening

Frequency

Knee Aperture

Knee Aperture Level

‘White Limit

Black Limit

V Detail Creation

Detail(HD)

Manual Setting

Level

H/V Ratio

Crispening

Frequency

Knee Aperture

Knee Aperture Level

White Limit

Black Limit

V Detail Creation

O| O] O] O] O] O] O] O] O] O] O] O| O| O] O] O] O] O] O| O] O] x| O] O| O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O| O] O] O| O

O| O] O] O] O] O] O] O] O] O] O] O| O] O] O] O] O] O] O] O] O] O] O] O| O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O| O] O] O| O
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Option

Unteroption

All File

Scene File

Detail(SD)

Manual Setting

O

O

Level

H/V Ratio

Crispening

Frequency

Knee Aperture

Knee Aperture Level

‘White Limit

Black Limit

V Detail Creation

Skin Detail

Setting

O| O] O] O] O] O O] O] O] O

O| O] O] O] O] O O] O] O] O

Area Detection

Area Indication

Level

Saturation

Hue

Width

Aperture

Setting

Level

Matrix

Setting

Adaptive Matrix

Preset Matrix

Preset Select

User Matrix

User Matrix Level

User Matrix Phase

User Matrix R-G

User Matrix R-B

User Matrix G-R

User Matrix G-B

User Matrix B-R

User Matrix B-G

Multi Matrix

Setting

Area Indication

x| O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O| O| O| O] x

x| O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O| O] O| O] x

Color Detection

Reset

Axis

Hue

Saturation

Maintenance

Test Saw

O| O] O| x

x| O] O] x




Audio

Option

Unteroption

All File

Scene File

Audio Input

CH2 EXT Input Select

O

X

CH3 Input Select

CH4 Input Select

INPUT1 MIC Reference

INPUT2 MIC Reference

Internal MIC Level

Line Input Reference

Reference Level

CH1 Wind Filter

CH2 Wind Filter

CH3 Wind Filter

CH4 Wind Filter

Limiter Mode

CH1&2 AGC Mode

CH3&4 AGC Mode

AGC Spec

1kHz Tone on Color Bars

Audio Output

Monitor CH

Headphone Out

Alarm Level

HDMI Output CH

Analog Output CH

O| O] O] O] O] O] O] O] O] O] O] O] O] O] O] O| O O] O] O] O

X | X| X[ X| X[ X[ X]| X[ X[ X]|X[X|X|X|X|X|X[|X]|X|X|X

Video

Option

Unteroption

All File

Scene File

Output On/Off

SDI

O

X

HDMI

VIDEO

Output Format

SDI

HDMI

VIDEO

Output Display

SDI/HDMI/VIDEO

SDI/HDMI Rec Control

Setting

Down Converter

Down Converter

O| O] O] x| O] O] O] O

X| X| X[ X| X| X[ X] X
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LCD/VF

Option

Unteroption

All File

Scene File

LCD Setting

Brightness

X

VF Setting

Brightness

Color Mode

Peaking

Setting

Type

Normal Peaking Frequency

Normal Peaking Level

Color

Color Peaking Level

Marker

Setting

Color

Center Marker

Safety Zone

Safety Area

Aspect Marker

Aspect Mask

Aspect Safety Zone

Aspect Safety Area

Aspect Select

Guide Frame

100% Marker

User Box

User Box Width

User Box Height

User Box H Position

User Box V Position

Zebra

Setting

Zebra Select

Zebral Level

Zebral Aperture Level

Zebra2 Level

Gamma Display Assist

Setting

O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] ©

X[ X| X[ X[ X| X[ X|X]|X[X|X[|X|X|X[X[X]|X[X|X]|X[X|X]|X|X|X]|X|X]|X]|X|X]|X
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Option

Unteroption

All File

Scene File

Display On/Off

Network Status

O

X

File Transfer Status

Rec/Play Status

Tally

NCM/Streaming Status

Battery Remain

Focus Mode

Focus Position

Focus Macro

Face Detection Frame

Lens Info

Rec Format

Frame Rate

Zoom Position

Digital Extender

UWP RF Level

GPS

SteadyShot

Gamma

SDI/HDMI Rec Control

Gamma Display Assist

Proxy Status

Focus Assist Indicator

Focus Assist Area

Media Status

Video Signal Monitor

Clip Name

White Balance

Scene File

Auto Exposure Mode

Auto Exposure Level

Timecode

ND Filter

Iris

Gain

Shutter

Audio Level Meter

Video Level Warning

Clip Number

Notice Message

O| O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O] O| O O] O] O] O

X | X| X[ X| X| X[ X]| X[ X[ X]|X[X|[X[][X[X|X]|X[X|X[X|X|X[X[|X]|X[|X|X]|X[X|X]|X|X|X|X|X]|X]|X|X]|X
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TC/UB

Option Unteroption All File Scene File
Timecode Mode O x
Run O 3
Setting 3 X
Reset - -
TC Format O X
Users Bit Mode @] X
Setting 3 X
HDMI TC Out Setting O X
Recording
Option Unteroption All File Scene File
S&Q Motion Setting O x
Frame Rate O X
Interval Rec Setting 3 3
Interval Time O 3
Number of Frames O X
Pre-Lighting O x
Picture Cache Rec Setting O X
Cache Rec Time O x
Clip Continuous Rec Setting O 3
Find Mode O X
Simul Rec Setting @] X
Rec Button Set O X
4K & HD (Sub) Rec Setting O X
Proxy Rec Setting ] X
Proxy Format ] x
Audio Channel @] x
Chunk O -
Rec Review Setting O X
Thumbnail
Option Unteroption All File Scene File

Display Clip Properties

Set Shot Mark Delete Shot Mark1 - -
Delete Shot Mark2 - -
Set Clip Flag Add OK - _
Add NG - _
Add KEEP — _

Delete Clip Flag
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Option

Unteroption

All File

Scene File

Lock/Unlock Clip

Select Clip

Lock All Clips

Unlock All Clips

Delete Clip

Select Clip

All Clips

Copy Clip

Select Clip

All Clips

Copy Sub Clip

All Clips

Transfer Clip

Select Clip

All Clips

Transfer Clip (Proxy)

Select Clip

All Clips

Set Index Picture

Thumbnail View

Essence Mark Thumbnail

Clip Thumbnail

Filter Clips

OK

NG

KEEP

None

All

Customize View

Thumbnail Caption

Media

Option

Unteroption

All File

Scene File

Update Media

Media(A)

Media(B)

Format Media

Media(A)

Media(B)

Utility SD/MS

USB

Select Folder

View Clip List

Rename Folder

Error Check

Format USB

Copy to USB

Media Remain

Clip Naming

Auto Naming

Title Prefix

Number Set

Planning Metadata

Load from Media(A)

Load from Media(B)

Properties

Clear Memory

Clip Name Display

Sort by
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File

Option

Unteroption

All File

Scene File

User File

Load from Utility SD/MS

Save to Utility SD/MS

File ID

X

Load Customize Data

Load White Data

All File

Load from Utility SD/MS

Load from Cloud(Private)

Load from Cloud(Share)

Save to Utility SD/MS

Save to Cloud(Private)

Save to Cloud(Share)

File ID

Load Network Data

Scene File

Recall Internal Memory

Store Internal Memory

Load from Utility SD/MS

Save to Utility SD/MS

File ID

Scene White Data

Network Public Key

Key Export

Key Clear

Create Key Date

Network

Option

Unteroption 1

Unteroption 2

All File

Scene File

Setup for Mobile App

Setup

Access Authentication

User Name

Input Password

Generate Password

Show Settings

Wireless LAN

Setting

O x| x| x| x

X| X| X| X| X

WPS

NFC

MAC Address

AP Mode Settings

Channel

Camera SSID & Password

Regenerate Password

IP Address

Subnet Mask
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Option

Unteroption 1

Unteroption 2

All File

Scene File

ST Mode Settings

Camera Remote Control

O

X

Connected Network

SSID

Security

Password

DHCP

IP Address

Subnet Mask

Gateway

DNS Auto

Primary DNS Server

Secondary DNS Server

Scan Networks

SSID

Security

Password

DHCP

IP Address

Subnet Mask

Gateway

DNS Auto

Primary DNS Server

Secondary DNS Server

Manual Register

SSID

Security

Password

DHCP

IP Address

Subnet Mask

Gateway

DNS Auto

Primary DNS Server

Secondary DNS Server

Wired LAN

Setting

Camera Remote Control

Detail Settings

DHCP

IP Address

Subnet Mask

Gateway

DNS Auto

Primary DNS Server

Secondary DNS Server

Modem

Setting

Camera Remote Control

Ol O] O] O] O] O] O] O] O] O| O] O] O] O] O] O] O] O] x| O] O] O] O] O] O] O] O] O| x| O] O] O] O] O] O] O] O] O| x| O O

X | X | X[ X| X[ X[ X]| X| X[ X]|X|X|X]|X|X|X|X[X|X|X[X|X|X|X|X|X[X|X[X|X]|X[X|X|X|X|X|X|X]|X|X|X

Modem! IP Address

Modem! Subnet Mask

Modem?2 IP Address

Modem?2 Subnet Mask
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Option Unteroption 1 Unteroption 2 All File Scene File
Network Client Mode Setting - O X
NCM Settings Select - O X
NCM Settings1 Display Name O x
CCM Address O x
CCM Port O x
User Name X X
Password 3 X
CCM Certificate 3 X
CCM Certificate Status 3 X
Camera Control O X
Camera Setting 3 X
Reset - -
NCM Settings2 Wie NCM Settingsl.
NCM Settings3 Wie NCM Settingsl.
File Transfer Auto Upload - O X
Auto Upload (Proxy) - @]
Default Upload Server - @]
Clear Completed Jobs - - -
Clear All Jobs - - _
View Job List - - -
Server Settings(NCM) Display Name O -
Service O -
Server Settings1 Display Name O X
Service O X
Host Name @] x
Port @] x
User Name X X
Password X X
Passive Mode O X
Destination Directory O X
Using Secure Protocol @] X
Root Certificate x X
Root Certificate Status x x

Reset

Server Settings2

Wie Server Settings1.

Server Settings3

Wie Server Settings1.
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Option Unteroption 1 Unteroption 2 All File Scene File
Streaming Setting - X 3
Destination Select - O X
Destination Settings1 Display Name O X
Streaming Type O x
Streaming Format O x
Audio Channel O 3
Destination Address O X
Destination Port O x
Reset - -
Destination Settings2 Wie Destination Settings1.
Destination Settings3 Wie Destination Settings1.
RTMP/RTMPS Setting - X X
RTMP Settings Select - O X
RTMP Settings1 Display Name O X
Streaming Format O 3
Destination URL b3 X
Stream Name X X
RTMPS Certificate - -
RTMPS Certificate Status - -
Load from Utility SD/MS - -
Reset - -
RTMP Settings2 Wie RTMP Settings1.
RTMP Settings3 Wie RTMP Settings1.
Replace Default - - -
Certificates
Reset Default Certificates |— - -
Default Certificates Status |— - -
Network Reset Reset - - -
System
Option Unteroption All File Scene File
Base Setting Shooting Mode O -
HDR Setting Rec/Out O -
LCD/VF SDR Preview O -
SDR Gain O -
Rec Format Frequency O X
File System O x
Codec O X
Video Format O X
Aspect Ratio (SD) O X
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Option

Unteroption

All File

Scene File

Assignable Button

<1>

O

X

<2>

<3>

<4>

<5>

<6>

<7>

<8>

<9>

<10>

Switch Hold Setting

FULL AUTO Button

Tally

Front

Rear

Language

Select

Clock Set

Time Zone

Date Mode

12H/24H

O] O] O] O] O] O] O] O] O] O] O] O] ©| O] O O

X | X| X[ X| X]| X[ X|X| X[ X| X[ X|X]| X|X|X

Date

Time

Hours Meter

Hours(System)

Hours(Reset)

Reset

GPS

GPS

Battery Alarm

Low Battery

Battery Empty

DC Voltage Alarm

DC Low Voltagel

DC Low Voltage2

Menu Settings

Direct Menu with <SET>

User Menu Only

User Menu with Lock

Fan Control

Setting

O x| O] O] O] O] O] O] ©

X| X| X| X| X]| X[ X]| X]| X

All Reset

Reset

Reset without Network

Version

Version Number

Version Up

187



Fehlerbehebung

Stromversorgung

Symptom

Ursache

Losung

Der Camcorder kann nicht
eingeschaltet werden.

Es ist kein Akku angebracht und es
liegt keine Spannung am Anschluss
DC IN an.

Bringen Sie einen Akku an (Seite 23) oder
schlieBen Sie das Gerit liber ein Netzteil
(Seite 24) an die Netzstromversorgung an.

Der Akku ist vollstindig entladen.

Tauschen Sie den Akku gegen einen vollstdndig
geladenen aus (Seite 23).

Die Stromversorgung wird
im Betrieb unterbrochen.

Der Akku ist entladen.

Tauschen Sie den Akku gegen einen vollstandig
geladenen aus (Seite 23).

Der Akku ist sehr schnell
entladen.

Die Umgebungstemperatur ist sehr
niedrig.

Dies geschieht aufgrund der Akkueigenschaften
und ist kein Defekt.

Der Akku ist unzureichend geladen.

Laden Sie den Akku auf (Seite 23).

Falls der Akku schon bald entladen ist, nachdem
Sie ihn vollstindig geladen haben, hat er
moglicherweise das Ende seiner Lebensdauer
erreicht. Ersetzen Sie ihn durch einen neuen.

Aufnahme/Wiedergahe

Symptom

Ursache

Losung

Die Aufnahme beginnt
nicht, wenn Sie die
Aufnahmetaste driicken.

Die SxS-Speicherkarte ist
schreibgeschiitzt.

Entfernen Sie den Schreibschutz oder ersetzen
Sie die Karte durch eine nicht geschiitzte SxS-
Speicherkarte.

Die SxS-Speicherkarte ist voll.

Karte durch neue mit ausreichend Speicherplatz
ersetzen.

Die SxS-Speicherkarte muss
wiederhergestellt werden.

Stellen Sie die Speicherkarte wieder her
(Seite 29).

Audioaufnahme ist nicht
moglich.

Die Regler AUDIO LEVEL (CH1/
CH2/CH3/CH4) sind auf
Minimalpegel eingestellt.

Stellen Sie die Audio-Aufnahmepegel mit den
Reglern AUDIO LEVEL (CH1/CH2/CH3/CH4)
ein (Seite 41).

Der aufgenommene Ton
ist verzerrt.

Der Audiopegel ist zu hoch.

Stellen Sie die Audio-Aufnahmepegel mit den
Reglern AUDIO LEVEL (CH1/CH2/CH3/CH4)
ein (Seite 41).

Der aufgenommene Ton
besitzt einen hohen
Rauschpegel.

Der Audiopegel ist zu niedrig.

Stellen Sie die Audio-Aufnahmepegel mit den
Reglern AUDIO LEVEL (CH1/CH2/CH3/CH4)
ein (Seite 41).

Wenn Sie ein externes Mikrofon auswihlen,
passen Sie zusitzlich die Einstellung INPUT
MIC Reference unter Audio Input im Audio-
Menii an (Seite 124).

Clips kdnnen nicht
wiedergegeben werden.

Der Clip wird gerade bearbeitet.

Je nach Status des Camcorders werden Fehler
oder Warnungen ggf. nicht angezeigt. Dies ist
keine Fehlfunktion.

Der Clip wird gerade auf einem
anderen Gerit aufgezeichnet.

Clips konnen nicht wiedergegeben werden, wenn
Sie Dateinamen oder Ordner gedndert haben oder
der Clip auf einem Computer in Verwendung ist.
Dies ist keine Fehlfunktion.
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Externe Gerate

Symptom

Losung

Der Camcorder wird vom
Computer nicht erkannt.

Trennen Sie das USB-Kabel vom Computer und schlieBen Sie es erneut ordnungsgemaf
an.

Trennen Sie das USB-Kabel vom Computer, starten Sie den Computer neu und fiihren Sie
die Schritte erneut in richtiger Reihenfolge durch.

Clips konnen nicht auf den
Computer geladen werden.

Trennen Sie das USB-Kabel vom Computer, starten Sie den Camcorder neu und schlieien
Sie ihn erneut an.

Um Clips auf den Computer zu laden, muss Anwendungssoftware installiert werden
(Seite 103).

WLAN-Verbindung

Die Kommunikation zwischen Camcorder und WLAN-Zugangspunkt oder Terminal-Geriit kann durch Hindernisse,

elektromagnetische Stérungen und die Betriebsumgebung (Wandmaterialien) in der Reichweite eingeschrinkt oder
ganz verhindert werden. Verlegen Sie den Camcorder in diesen Fillen an einen anderen Standort oder verringern Sie
seinen Abstand zum Zugangspunkt/Terminal-Gerit, und priifen Sie danach die Verbindung und den

Kommunikationsstatus.

Symptom

Losung

Ein Terminal-Gerit kann
nicht auf den Camcorder
zugreifen.

« Priifen Sie die WLAN-Verbindung (IP-Adresse usw.).

» Die Kommunikationseinstellungen von Zugangspunkt und Client sind moglicherweise
nicht aufeinander abgestimmt. Niheres finden Sie in der Bedienungsanleitung des
Zugangspunkts.

Anmeldung am
Camcorder ist nicht
moglich.

Priifen Sie den von Ihnen festgelegten Benutzernamen und das Passwort.

Die Web-Fernbedienung
wird nicht angezeigt.

Uberpriifen Sie die eingestellte IP-Adresse.

Internet-Verbindung

Symptom

Losung

Das Hochladen von
Dateien schligt fehl.

Benutzername und Passwort des Servers sind ggf. nicht korrekt.
Geben Sie Benutzername und Passwort korrekt ein.

Das Hochladen von
Dateien ist nicht
verfiigbar.

Die 3G/4G-Signalbedingungen sind ggf. schlecht.
Suchen Sie einen anderen Standort auf und versuchen Sie es erneut.

189



Regler ND Filter

Falls sich der ND-Filter nicht bewegt, konnen Sie ihn manuell auf die CLEAR-Position bewegen, indem
Sie wie folgt vorgehen.

1. Stellen Sie den Schalter ON/STANDBY auf STANDBY.
2. Entfernen Sie den runden Deckel an der Unterseite.

3. Fiihren Sie einen Schraubendreher in das Loch ein und drehen Sie diesen entgegen dem
Uhrzeigersinn.
Der ND-Filter bewegt sich durch Drehen entgegen dem Uhrzeigersinn in die CLEAR-Position.
Drehen Sie den Schraubendreher, bis die CLEAR-Position erreicht ist.
Verwenden Sie einen Schraubendreher mit hochstens 2,4 mm Durchmesser. Die Einfiihrtiefe des
Schraubendrehers betrégt etwa 3,2 cm.

9
5
V=N

4@

Schraubendreherloch (Deckel abgenommen)

4. Stellen Sie den ND FILTER-Modusschalter (Seite 9) auf PRESET und stellen Sie den Schalter ND
FILTER (Seite 9) auf CLEAR.

« Fiihren Sie den oben genannten Vorgang nicht wihrend des normalen Betriebs durch. Fiihren Sie den Vorgang nur
durch, wenn sich der ND-Filter nicht bewegt. Falls Sie den Vorgang wihrend des normalen Betriebs durchfiihren, wird
der ND-Filter moglicherweise beschidigt.

* Wenden Sie sich nach Durchfiihren des oben genannten Vorgangs an ein Sony-Kundendienstzentrum, um den
Camcorder reparieren zu lassen.

« Falls nach Durchfiihren des oben genannten Vorgangs dennoch eine Fehlermeldung erscheint, ist Aufnehmen trotzdem
moglich.
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Fehler-/Warn-/Vorsichtsanzeigen

Der Camcorder informiert Sie mithilfe von Meldungen auf dem Sucherbildschirm, der Aufnahme-/Tally-
Anzeige und einem Warnton iiber Situationen, in denen eine Warn- oder Vorsichtsmeldung vorliegt oder
eine Funktionspriifung erforderlich ist.
Der Warnton wird iiber den integrierten Lautsprecher oder den an die Kopfhorerbuchse angeschlossenen

Kopfhorer ausgegeben.

Fehleranzeigen

Bei den folgenden Anzeigen wird der Camcorder angehalten.

Fehleranzeige auf Warnton Aufnahme-/ Ursache und Mafinahme

LCD-/ Tally-
Sucherbildschirm Anzeige
E + der Fehlercode Zeitweilig  Schnell Weist auf eine Storung beim Camcorder hin. Die
blinkend Aufzeichnung wird angehalten, auch wenn im Sucher ,,@Rec*
angezeigt wird.
Schalten Sie den Camcorder aus, und priifen Sie die
angeschlossenen Gerite, Kabel und Datentriger. Falls der
Fehler nach dem erneuten Einschalten weiterhin auftritt,
wenden Sie sich an die zustindige Sony
Kundendienstvertretung.
(Wenn das Gerit nicht ausgeschaltet werden kann, indem Sie
den Schalter ON/STANDBY auf STANDBY schalten,
entnehmen Sie den Akku und/oder trennen Sie die DC IN-
Quelle.)
Je nach Status des Camcorders werden Fehler oder
‘Warnungen ggf. nicht angezeigt.
Warnanzeigen
Wenn eine der folgenden Meldungen auftritt, befolgen Sie die angezeigten Anweisungen.
Warnanzeige auf LCD-/ Warnton Aufnahme-/ Ursache und MaBnahme
Sucherbildschirm Tally-
Anzeige
Battery Near End Zeitweilig  Blinkt Der Akku ist bald leer.
Laden Sie den Akku schnellstmdoglich auf.
Battery End Kontinuier-  Schnell Der Akku ist leer. Die Aufnahme ist nicht moglich.
lich blinkend Halten Sie den Camcorder an, und wechseln Sie
den Akku.
Temperature High Zeitweilig  Blinkt Die Innentemperatur ist zu hoch.
Schalten Sie den Camcorder aus, und warten Sie,
bis die Temperatur sinkt.
Voltage Low Zeitweilig  Blinkt Die DC IN-Spannung ist zu niedrig (Stufe 1).
Priifen Sie die Stromversorgung.
Insufficient Voltage Kontinuier-  Schnell Die DC IN-Spannung ist zu niedrig (Stufe 2). Die
lich blinkend Aufnahme ist nicht moglich.

Schliefen Sie eine andere Stromversorgung an.
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Warnanzeige auf LCD-/ Warnton Aufnahme-/ Ursache und Mafinahme
Sucherbildschirm Tally-
Anzeige

Media Near Full Zeitweilig  Blinkt Auf der SxS-Speicherkarte ist nicht mehr genug
Speicherplatz frei.

Ersetzen Sie sie schnellstmoglich durch eine
andere.

Media Full Kontinuier-  Schnell Auf der SxS-Speicherkarte ist kein Speicherplatz

lich blinkend mehr frei. Die Aufnahme sowie das Kopieren und
Teilen von Clips sind nicht moglich.
Ersetzen Sie die Speicherkarte.

Clips Near Full Zeitweilig  Blinkt Die Anzahl weiterer Clips, die auf der SxS-
Speicherkarte aufgezeichnet werden konnen, sinkt
ab.

Ersetzen Sie sie schnellstmoglich durch eine
andere.

Clips Full Kontinuier-  Schnell Die Hochstanzahl von Clips, die auf der SxS-

lich blinkend Speicherkarte aufgezeichnet werden konnen, ist
erreicht.
Es ist nicht moglich, weitere Clips aufzunehmen
oder zu kopieren. Ersetzen Sie die Speicherkarte.

Last Clip Recording Zeitweilig  Blinkt Der gegenwirtig aufgenommene Clip ist der letzte,
der aufgezeichnet werden kann, da die
Hochstanzahl Clips erreicht wurde.

Bereiten Sie eine neue SxS-Speicherkarte vor.

Media(A) Near Full" Zeitweilig  Blinkt Bei Verwendung der Funktion zur gleichzeitigen
Aufnahme

Media(A) Full” Kontinuier-  Schnell Bei Verwendung der Funktion zur gleichzeitigen

lich blinkend Aufnahme

Media(A) Clips Near FullV Zeitweilig  Blinkt Bei Verwendung der Funktion zur gleichzeitigen
Aufnahme

Media(A) Clips Full" Kontinuier-  Schnell Bei Verwendung der Funktion zur gleichzeitigen

lich blinkend Aufnahme

Media(A) Last Clip Rec!) Zeitweilig  Blinkt Bei Verwendung der Funktion zur gleichzeitigen

Aufnahme

Transfer Jobs Near Full

Es konnen nur noch wenige weitere FTP-
Dateiiibertragungen registriert werden.

Transfer Jobs Full

Die Anzahl registrierbarer FTP-Dateiiibertragungen
hat den oberen Grenzwert erreicht. Um eine weitere
Ubertragung hinzuzufiigen, 16schen Sie zunichst

unerwiinschte Ubenragungen.z)

1),,Media(B)* fiir die Karte in Einschub B. .
2) Sie konnen mithilfe von File Transfer >View Job List (Seite /44) im Network-Menii Ubertragungen auswihlen und
I6schen. Sie konnen auBerdem Ubertragungen von der Content Browser Mobile-Jobliste 1schen.
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Warn- und Funktionsmeldungen

Auf dem Bildschirm konnen folgende Warn- und Funktionsmeldungen erscheinen. Befolgen Sie die
angezeigten Anweisungen, um das Problem zu beheben.

Meldung im Sucher

Ursache und MaBnahme

Battery Error
Please Change Battery

Es wurde ein Fehler beim Akkusatz festgestellt.
Der Akku muss dann durch einen normalen Akku ersetzt werden.

Unknown Media(A)”
Please Change

Eine partitionierte Speicherkarte oder eine, die eine hohere Anzahl
aufgezeichneter Clips enthilt als fiir diesen Camcorder zuldssig ist, ist
eingesetzt.

Die Karte kann nicht in diesem Camcorder verwendet werden und muss
ersetzt werden.

Cannot Use Media(A)”
Unsupported File System

Es wurde eine Speicherkarte mit fremdem Dateisystem oder eine
unformatierte Speicherkarte eingesetzt.

Die Karte kann nicht in diesem Camcorder verwendet werden und muss
ersetzt oder vom Camcorder formatiert werden.

Media Error
Media(A) Needs to be Restored "

Ein Speicherkarten-Fehler ist aufgetreten. Die Karte muss
wiederhergestellt werden.
Stellen Sie die Speicherkarte wieder her.

Media Error
Cannot Record to Media(A)l)

Die Speicherkarte ist moglicherweise defekt und kann nicht mehr fiir die
Aufzeichnung verwendet werden.

Die Wiedergabe ist ggf. moglich. Es wird empfohlen, eine Kopie zu
erstellen und die Speicherkarte zu ersetzen.

Media Error
Cannot Use Media(A)] )

Die Speicherkarte ist moglicherweise defekt und kann nicht mehr fiir
Aufzeichnung oder Wiedergabe verwendet werden.

Die Karte kann nicht in diesem Camcorder verwendet werden und muss
ersetzt werden.

Media(A) Error!)
Recording Halted
Playback Halted

Die Aufzeichnung und die Wiedergabe wurden angehalten, weil beim
Zugriff auf die Speicherkarte ein Fehler aufgetreten ist.
Sollte das Problem fortbestehen, muss die Speicherkarte ersetzt werden.

Media Reached Rewriting Limit
Change Media(A)”

Die Speicherkarte hat das Ende ihrer Lebensdauer erreicht.

Erstellen Sie eine Sicherheitskopie, und ersetzen Sie die Karte. Wenn Sie
diese Karte weiterhin verwenden, funktionieren Aufzeichnung bzw.
Wiedergabe eventuell nicht ordnungsgemas.

Einzelheiten dazu finden Sie in der Bedienungsanleitung der
Speicherkarte.

Copy All Sub Clips

NG: Reached Clip Number Limit
NG: Same File Already Exists
NG: Not Enough Capacity

Aufgrund der in der Meldung genannten Ursache wurden nicht alle Sub-
Clips mit Copy All Sub Clips kopiert.

» Die Hochstzahl an Clips ist erreicht.

« Es gibt bereits eine Datei gleichen Namens.

« Es ist nicht genug Speicherkapazitit fiir das Kopieren vorhanden.
Tauschen Sie das Medium aus.

Invalid setting value was reset:

Media/Clip Naming/Camera Position

Please save All File again

Die Einstellung fiir das Clip Naming-Format wurde zuriickgesetzt, weil
eine ungiiltige ALL-Datei geladen wurde.

Konfigurieren Sie die gewiinschten Formateinstellungen, und versuchen
Sie, die ALL-Datei erneut zu speichern.

The specified address is invalid.

Die angegebene Adresse ist ungiiltig.
Vergewissern Sie sich, dass die Einstellung korrekt ist.

Cannot Use Specified Port Number

Die angegebene Portnummer ist ungiiltig.
Vergewissern Sie sich, dass die Einstellung korrekt ist.
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Meldung im Sucher

Ursache und Mafinahme

Accessing the memory card failed.

Der Zugriff auf die Speicherkarte ist fehlgeschlagen.

Dieser Fehler tritt moglicherweise auf, wenn Sie wihrend der Aufnahme
mit XAVC-13840x2160P 59.94/50P nicht auf das Medium im UTILITY
SD/MS-Einschub zugreifen konnen. Versuchen Sie es nach Beendigung
der Aufnahme erneut.

Failed

Dieser Fehler tritt moglicherweise auf, wenn DHCP auf On gesetzt ist
und keine Adresse bezogen werden kann.
Priifen Sie die Einstellungen beziiglich des DHCP-Servers.

Addition of auto upload job failed.

Die Hochstanzahl Ubertragungen wurde erreicht.

Loschen Sie alle nicht erwiinschten Ubertragungen. Die Einstellung fiir
das Ziel zum automatischen Hochladen von Original- oder Proxy-
Dateien ist ggf. ebenfalls fehlerhaft. Vergewissern Sie sich, dass die
Einstellung korrekt ist.

<SSID>Not found.

Es wurde kein Netzwerk (Zugangspunkt) mit der angegebenen <SSID>
gefunden.
Vergewissern Sie sich, dass die Einstellung korrekt ist.

<SSID>Authentication Failed

Die Authentifizierung beim Netzwerk (Zugangspunkt) mit der
angegebenen <SSID> ist fehlgeschlagen.

Vergewissern Sie sich, dass das Passwort und andere Einstellungen
korrekt sind.

An IP address conflict has occurred. Please
check the network settings.

Zwischen den Netzwerkadressen des WLAN, des verkabelten LAN, des
Modems/Smartphones oder zwischen Modems/Smartphones besteht ein
Konflikt.

Andern Sie die Adresse manuell oder indern Sie die Einstellungen am
Netzwerk-Router.

The IP address of the Wireless LAN Access
Point Mode has been changed due to an IP
address conflict.

Die IP-Adresse des WLAN-Zugangspunktmodus wurde aufgrund eines
Konflikts der Netzwerkadressen des WLAN, des verkabelten LAN oder
des Modems/Smartphones geédndert.

Uberpriifen Sie die eingestellte IP-Adresse.

1),,Media(B)* fiir die Karte in Einschub B.

Meldungen, wenn der Camcorder-Betrieb nicht durchgefiihrt werden

kann

Der Camcorder-Betrieb kann je nach

Beispiel 1: Grund ist die Einstellung des

Kamerastatus und individuellen Einstellungen in WeiBabgleichs A

einigen Fillen nicht durchgefiihrt wurden.

In diesem Fall werden die folgenden

Meldungsarten drei Sekunden lang auf dem White: A

LCD-/Sucherbildschirm angezeigt.

Priifen Sie die Meldung und beseitigen Sie dann Beispiel 2: Grund ist die Einstellung des
das Problem. Aufnahmeformats

Cannot Proceed

Félle, in denen der Grund identifiziert

werden kann

Cannot Proceed
XAVC-1
1920x1080 59.94i

Der Vorgang, der nicht durchgefiihrt werden

kann, wird in Zeile 1 angezeigt.

Der Grund wird in den Zeilen 2 und 3 angezeigt.
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Félle, in denen der Grund nicht
identifiziert werden kann

Der Vorgang, der nicht durchgefiihrt werden
kann, wird in Zeile 1 angezeigt.

Der mogliche Grund wird in den Zeilen 2 und 3
angezeigt.

Beispiel 1: Moglicher Grund ist die Einstellung
des WeiBabgleichs A

Cannot Proceed. Possible Factor
White: A

Beispiel 2: Vermutlicher Grund ist die
Einstellung des Aufnahmeformats

Cannot Proceed. Possible Factor
XAVC-1
1920x1080 59.94i
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Blockschaltbilder

Erginzende Informationen siehe unter ,, Festlegen der aufzunehmenden Audiosignale “ (Seite 41) und

,,Liste der Elemente im Einstellmenii* (Seite 112).

Audio Input (CH1&2)

INPUT1

Internal
MIC

Il‘r—

|
Q
|
- —

[CH2 EXT Input Select]

INPUT1
INPUT2

14 N
| |
I
| |
| |
- -7 - TN TN |
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<CH1 INPUT SELECT> [CH1 Wind Filter] <CH1 LEVEL CONTROL> <CH1 INPUT LEVEL> | | |
INT on AUTO 0-10 | |
EXT off MAN | 1|
MI SHOE | o |
; M| 1
I . “
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<CH2 INPUT SELECT> [CH2 Wind Filter] <CH2 LEVEL CONTROL> <CH2 INPUT LEVEL> [Limiter Mode] [CH182 AGC Mode]
INT On AUTO 0-10 Off, —6dB Mono
EXT off MAN —9dB, —12dB Stereo
MI SHOE —15dB, —17dB

°1

-
[Color Bar]

[1kHz Tone on Color Bar]

eines oder beides
aktiviert
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Audio Input (CH3&4)

OFF
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CH1
CH2
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:
A 4

CH3

CH4

Audio Output
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Technische Daten

Allgemeines

Gewicht

ca. 2,6 kg (nur Gehiuse)
ca. 3,0 kg (mit Gegenlichtblende (1),
Augenmuschel (1), Akku BP-U35 (1), SxS-
Speicherkarte (1))
Abmessungen (Breite / Hohe / Tiefe)

178,4 mm x 202,0 mm X 426,3 mm
Maximalabmessungen.
Die Tiefe bezeichnet die Linge von der
Vorderseite der Gegenlichtblende bis zur
grofen Augenmuschel.

Betriebsspannung
12V DC (11 V bis 16,5 V)
Leistungsaufnahme

ca.24 W
bei Aufnahmen mit ausgeschaltetem LCD-
Bildschirm, eingeschaltetem Sucher, kein
externes Gerit angeschlossen
ca.36 W
bei Aufnahmen mit eingeschaltetem LCD-
Bildschirm, eingeschaltetem Sucher, mit
HD SDI, HDMI und externem Gerit
ca.36 W
beim Kopieren auf ein USB-Medium

Betriebstemperatur
0 °C bis 40 °C
Lagertemperatur
—20 °C bis +60 °C
Betriebszeit im Dauerbetrieb
Bei Verwendung des Akkus BP-U35:
ca. 1 Stunde 20 Minuten
(bei Aufnahmen mit ausgeschaltetem LCD-
Bildschirm, eingeschaltetem Sucher, kein
externes Gerit angeschlossen)

Aufzeichnungsformat (Video)

XAVC Intra

XAVC-1 QFHD-Modus: VBR, max. 600 Mbit/s,
MPEG-4 AVC/H.264

XAVC-1 HD-Modus: CBG, max. 222 Mbit/s,
MPEG-4 AVC/H.264

XAVC Long

XAVC-L QFHD-Modus: VBR, max. 150 Mbit/s,
MPEG-4 H.264/AVC

XAVC-L HD 50-Modus: VBR, max. 50 Mbit/s,
MPEG-4 H.264/AVC

XAVC-L HD 35-Modus: VBR, max. 35 Mbit/s,
MPEG-4 H.264/AVC

XAVC-L HD 25-Modus: VBR, max. 25 Mbit/s,
MPEG-4 H.264/AVC

MPEG-2 Long GOP

MPEG HD422-Modus: CBR, max. 50 Mbit/s,
MPEG-2 422P@HL

MPEG HD420 HQ-Modus: VBR, max.
35 Mbit/s, MPEG-2 MP@HL

DVCAM
CBR, 25 Mbit/s

Proxy

AVC/H.264 Main Profile, 4:2:0 Long GOP,
VBR

1920x1080/9 Mbit/s, 1280x720/9 Mbit/s,
1280%720/6 Mbit/s, 640x360/3 Mbit/s,
480x270/1 Mbit/s, 480x270/500 kbit/s

Aufzeichnungsformat (Audio)
XAVC Intra
XAVC-I-Modus: LPCM, 24 Bit, 48 kHz,
4 Kanile

XAVC Long
XAVC-L-Modus: LPCM, 24 Bit, 48 kHz,
4 Kanile

MPEG-2 Long GOP

MPEG HD422-Modus: LPCM, 24 Bit, 48 kHz,
4 Kanile

MPEG HD420 HQ-Modus: LPCM, 16 Bit,
48 kHz, 4 Kanile

DVCAM
LPCM, 16 Bit, 48 kHz, 4 Kanile

Proxy
AAC-LC, 128 kbit/s, 2 Kaniile




Bildrate bei der Aufzeichnung

XAVC Intra
XAVC-I QFHD-Modus: 3840%x2160/59.94P,
50P, 29.97P, 23.98P, 25P
XAVC-I HD-Modus: 1920x1080/59.94P,
59.94i, 50P, 50i, 29.97P, 23.98P, 25P
1280%720/59.94P, 50P

XAVC Long

XAVC-L QFHD-Modus: 3840x2160/59.94P,
50P, 29.97P, 23.98P, 25P

XAVC-L HD 50-Modus: 1920x1080/59.94P,
50P, 59.94i, 50i, 29.97P, 23.98P, 25P

1280x720/59.94P, 50P

XAVC-L HD 35-Modus: 1920x1080/59.94P,

50P, 59.94i, 50i, 29.97P, 23.98P, 25P

XAVC-L HD 25-Modus: 1920x1080/59.94i, 50i

MPEG-2 Long GOP
MPEG HD422-Modus: 1920x1080/59.94i, 50i,
29.97P, 23.98P, 25P
1280x720/59.94P, 50P, 29.97P, 23.98P, 25P
MPEG HD420 HQ-Modus: 1920x1080/59.94i,
50i, 29.97P, 23.98P, 25P
1440%x1080/59.94i, 50i
1280x720/59.94P, 50P

DVCAM
720x480/59.94i, 29.97PsF
720%x576/50i, 25PsF

Aufnahme-/Wiedergabezeit

XAVC Intra
XAVC-1 QFHD-Modus

Mit SBP-128B (128 GB): ca. 22 Minuten
XAVC-1 HD (1920x1080)-Modus

Mit SBP-128B (128 GB): ca. 57 Minuten
XAVC-1 HD (1280x720)-Modus

Mit SBP-128B (128 GB): ca. 105 Minuten

XAVC Long
XAVC-L QFHD-Modus

Mit SBP-128B (128 GB): ca. 86 Minuten
XAVC-L HD 50-Modus

Mit SBP-128B (128 GB): ca. 230 Minuten
XAVC-L HD 35-Modus

Mit SBP-128B (128 GB): ca. 310 Minuten
XAVC-L 25-Modus

Mit SBP-128B (128 GB): ca. 420 Minuten

MPEG-2 Long GOP
MPEG HD422-Modus

Mit SBP-128B (128 GB): ca. 215 Minuten
MPEG HD420 HQ-Modus

Mit SBP-128B (128 GB): ca. 330 Minuten

DVCAM
Mit SBP-128B (128 GB): ca. 405 Minuten

4K- und HD (Sub)-Aufzeichnung
XAVC-I QFHD-Modus

Mit SBP-128B (128 GB): ca. 20 Minuten
XAVC-L QFHD-Modus

Mit SBP-128B (128 GB): ca. 62 Minuten

¢ Die Aufnahme- bzw. Wiedergabezeit kann
aufgrund der Nutzungsbedingungen und
Speichereigenschaften schwanken.

Objektiv

Objektivgewinde
Fest

Zoomverhiiltnis
17x

Brennweite

5,6 mm bis 95,2 mm
(35-mm-Aquivalent zu 30,3 mm bis 515 mm)

Fokusbereich
AF/MF/Full MF auswihlbar
800 mm bis eo (Makro OFF)
50 mm bis e (Makro ON, Weitwinkel)
800 mm bis e (Makro ON, Tele)
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Iris
automatisch/manuell auswihlbar
F1.9 bis F16 und C (SchlieBen)

Bildstabilisierung
ON/OFF auswihlbar, Shift Lens

Filterdurchmesser

¢77 mm, 0,75 mm Steigung

Makro
ON/OFF auswihlbar

Kamera

Bildgebungsger:it
CMOS-Bildsensor ExmorR 3, 1/2 Zoll

Effektive Bildelemente
3840 (H) x 2160 (V)

Optisches System

Prismensystem, F1.6

Eingebaute Filter

ND-Filter

CLEAR: Loschen

1: 1/4AND

2: 1/16ND

3: 1/64ND

Linear variabler ND-Filter (ca. 1/4 ND bis 1/128
ND)

Empfindlichkeit (2000 Ix, 89,9% Reflexion)

F12 (typisch, Modus 1920x1080/59.94P)

F13 (typisch, Modus 1920x1080/50P)

F12 (typisch, 3840x2160/59.94P,
Hochempfindlichkeitsmodus)

F13 (typisch, 3840x2160/50P,
Hochempfindlichkeitsmodus)

Mindestbeleuchtung
0,0013 Ix (typisch, 1920x1080/59.94i) (F1.9,
+42 dB Hochempfindlichkeitsmodus, mit
Akkumulation von 64 Vollbildern)

Rauschverhiltnis
63 dB (Y) (typisch)

Horizontale Auflosung
Mindestens 2000 Fernsehzeilen (Modus
3840%x2160P)
Mindestens 1000 Fernsehzeilen (Modus
1920x1080P)

Verschlussgeschwindigkeit
64F bis 1/8000 s
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Zeitlupe und Zeitraffer
XAVC Intra, XAVC Long
2160P: 1 bis 60 fps
1080P: 1 bis 60, 100, 120 fps
720P: 1 bis 60 fps

MPEG HD422
1080P: 1 bis 30 fps
720P: 1 bis 60 fps

MPEG HD420 HQ
1080P: 1 bis 30 fps
720P: 1 bis 60 fps

WeiBabgleich
Voreinstellungsmodus (3200K)
Memory A-Modus, Memory B-Modus,
ATW-Modus

Gain
-3,0,3,6,9, 12, 15, 18 dB, 42 dB (Turbo Gain
aktiviert), AGC

Gammakurve
‘Wihlbar

WLAN

Unterstiitzte Standards
IEEE 802.11a/b/g/n/ac

Frequenzbénder

2,4 GHz
5,2/5,3/5,6 GHz (nur PXW-Z280V)

Sicherheit

WEP/WPA-PSK/WPA2-PSK
konform zu NFC Forum Type 3 Tag

Ein-/Ausgénge

Audioeingang
XLR-Typ, 3-polig (2), Buchse, LINE/MIC/
MIC+48V umschaltbar
LINE: +4dBu/0dBu/~3dBu (/EBUL) / 10 kQ
MIC: —-80dBu bis —30dBu / 3 kQ
(Referenzeingangspegel 0 dBu=0,775 Vrms)

Audioausgang
Multi/Micro USB

Videoausgang
BNC-Typ (1), umschaltbar mit Anschluss
GENLOCK IN, HD-Y-/HD-SYNC-/
Composite-Signal
1,0 Vp-p, 75 Q

SDI-Ausgang
BNC-Typ (1), 12G/3G/HD/SD auswiihlbar




Timecode-Eingang
BNC-Typ (1), umschaltbar mit Anschluss TC
ouT
0,5V bis 18 Vp-p, 3,3 kQ

Timecode-Ausgang
BNC-Typ (1), umschaltbar mit Anschluss TC IN
1,0 Vp-p, 75 Q

Eingang GENLOCK
BNC-Typ (1), umschaltbar mit Anschluss
VIDEO OUT
1,0 Vp-p, 75 Q

USB-Anschluss

Multi/Micro USB (1)
Host: USB 3.0/2.0 Typ A (1), USB 2.0 Typ A

(€Y)

Kopfhorerausgang

Stereominibuchse (1)
—16 dBu, 16 Q

Lautsprecherausgang

Monaural
Ausgangsleistung: 500 mW

Gleichstromeingang

Gleichstrombuchse

HDMI-Ausgabe
HDMI-Anschluss (Typ A)

Anschluss REMOTE
Stereo-Mini-Minibuchse (42,5 mm)

Anschluss fiir verkabeltes LAN

RJ-45(1), 1000BASE-T, 100BASE-T,
10BASE-T

Anzeige

Sucher
BildschirmgroBe: 1,3 cm (0,5 Zoll)

Effektive Pixelanzahl: ca. 2,36 Millionen Punkte

LCD-Bildschirm
Bildschirmgrofe: 8,8 cm (3,5 Zoll)

Effektive Pixelanzahl: ca. 1,56 Millionen Punkte

Internes Mikrofon

Internes Mikrofon

Ungerichtetes Stereo-Elektret-
Kondensatormikrofon
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Medieneinschiibe

Typ
ExpressCard/34 (2)
SD/MS (1)

Im Lieferumfang enthaltenes
Zubhehor

Akku (1)

Netzteil/Ladegerit (1)

USB-Kabel (1)

Gegenlichtblende (1)

GroBe Augenmuschel (1)
Schulterriemen (1)

Vor Verwendung dieses Geriits (1)
Garantieunterlagen (1)

Software-Downloads

Wenn das Gerit mit einer PC-Verbindung
verwendet wird, laden Sie benétigte Treiber,
Plugins und Anwendungssoftware von der
folgenden Website herunter.

Sony-Website fiir professionelle Produkte:
Japan  https://www.sony .jp/professional/
Alle anderen Lénder
https://pro.sony/ (Klicken Sie unten auf
der Seite auf [Change Country, Region
or Language] und wihlen Sie die Region
und Sprache aus.)

Die Daten zu den Aufnahmen werden zwar auf
mehrere Dateien und Ordner verteilt gespeichert,
aber mit der dedizierten Anwendungssoftware
konnen Sie die Clips problemlos handhaben,
ohne die Daten- und Verzeichnisstruktur zu
beriicksichtigen.

* Wenn Sie Funktionen wie das Kopieren von Clips auf
einer SxS-Speicherkarte mit dem Explorer (Windows)
oder Finder (Macintosh) ausfiihren, gehen die in den
Clips enthaltenen ergidnzenden Daten moglicherweise
verloren.

Bauart und Spezifikationen kénnen ohne
Vorankiindigung geédndert werden.


https://www.sony.jp/professional/
https://pro.sony/

Hinweise

¢ Fiihren Sie immer eine Probeaufnahme aus,
und bestitigen Sie, dass die Aufnahme
erfolgreich war. SONY KANN KEINE
HAFTUNG FUR SCHADEN JEDER ART,
EINSCHLIESSLICH ABER NICHT
BEGRENZT AUF KOMPENSATION ODER
ERSTATTUNG, AUFGRUND VON
FEHLFUNKTION DIESES GERATS ODER
SEINER DATENTRAGER, EXTERNEN
SPEICHERSYSTEMEN ODER
JEGLICHEN ANDEREN
DATENGRAGERN ODER
SPEICHERSYSTEMEN ZUR AUFNAHME
VON INHALTEN JEDER ART
UBERNEHMEN.

Bestitigen Sie vor dem Gebrauch immer, dass
das Gerit richtig arbeitet. SONY KANN
KEINE HAFTUNG FUR SCHADEN JEDER
ART, EINSCHLIESSLICH ABER NICHT
BEGRENZT AUF KOMPENSATION ODER
ERSTATTUNG, AUFGRUND VON
VERLUST VON AKTUELLEN ODER
ERWARTETEN PROFITEN DURCH
FEHLFUNKTION DIESES GERATS ODER
AUS JEGLICHEM ANDEREN GRUND,
ENTWEDER WAHREND DER
GARANTIEFRIST ODER NACH ABLAUF
DER GARANTIEFRIST, UBERNEHMEN.
SONY KANN KEINE HAFTUNG FUR
ANSPRUCHE JEDER ART VON DEN
BENUTZERN DIESES GERATS ODER
VON DRITTER SEITE UBERNEHMEN.
SONY KANN KEINE HAFTUNG FUR
VERLUST, RETTUNG ODER
WIEDERHERSTELLUNG VON DATEN IM
INTERNEN SPEICHERSYSTEM, AUF
AUFZEICHNUNGSMEDIEN, EXTERNEN
SPEICHERSYSTEMEN ODER ANDEREN
MEDIEN BZW. SPEICHERSYSTEMEN
UBERNEHMEN.

SONY KANN KEINE HAFTUNG FUR DIE
BEENDIGUNG ODER EINSTELLUNG
VON DIENSTLEISTUNGEN BEZUGLICH
DIESES GERATS GLEICH AUS
WELCHEM GRUND UBERNEHMEN.
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Marken

* XDCAM ist eine Marke der Sony Corporation.
* XAVC und sind eingetragene Marken
der Sony Corporation.
+ XQDC und JCQA D sind Marken der
Sony Corporation.
¢ Microsoft, Windows, Windows Vista und
Windows Media sind Marken oder
eingetragene Marken der amerikanischen
Microsoft Corporation in den USA und anderen
Lindern.
Mac und Mac OS sind eingetragene Marken
von Apple Inc. in den USA und anderen
Lindern.
Die Begriffe HDMI und HDMI High-
Definition Multimedia Interface sowie das
HDMI-Logo sind Marken oder eingetragene
Marken von HDMI Licensing Administrator,
Inc. in den Vereinigten Staaten und anderen
Lindern.
Adobe, das Adobe-Logo und Adobe Acrobat
sind eingetragene Marken oder Marken von
Adobe Systems Incorporated in den USA und/
oder anderen Lindern.
~.Memory Stick®, ,,Memory Stick Duo®,
,.Memory Stick PRO Duo*, ,,Catalyst Browse*,
,,Content Browser Mobile* und das ,,Content
Browser Mobile*“-Logo sind Marken oder
eingetragene Marken der Sony Corporation.
SxS, SxS PRO und SxS-1 sind Marken der
Sony Corporation.
Der ExpressCard-Schriftzug und das
ExpressCard-Logo sind Eigentum der Personal
Computer Memory Card International
Association (PCMCIA) und werden von der
Sony Corporation in Lizenz verwendet. Alle
anderen Marken und Handelsnamen sind
Eigentum der jeweiligen Rechteinhaber.
Das SDXC-Logo ist eine Marke von SD-3C,
LLC.
iOS ist eine eingetragene Marke oder Marke
von Cisco Systems, Inc. und/oder seinen
Tochtergesellschaften in den USA und
bestimmten anderen Léndern.
Android, Google Play sind Marken von Google
Inc.
Wi-Fi, das Wi-Fi-Logo und Wi-Fi
PROTECTED SETUP sind Marken oder
eingetragene Marken der Wi-Fi Alliance.



* Die N-Markierung ist eine Marke oder
eingetragene Marke von NFC Forum, Inc. in
den USA und anderen Landern.

* QR Code ist ein Markenzeichen der Denso
Wave Inc.

Alle weiteren Firmen- und Produktnamen sind

eingetragene Marken oder Marken ihrer

jeweiligen Eigentiimer. Geschiitzte Objekte sind
in diesem Dokument nicht durch ™ oder ®
gekennzeichnet.

Lizenzen

DIESES PRODUKT WIRD UNTER DER AVC
PATENT PORTFOLIO LICENSE FUR DEN
PRIVATEN UND NICHT KOMMERZIELLEN
GEBRAUCH DURCH DEN BENUTZER
LIZENZIERT, UND ZWAR ZUM

(i) CODIEREN VON VIDEODATEN IN
UBEREINSTIMMUNG MIT DEM AVC-
STANDARD (,,AVC-VIDEO*) UND/ODER
(i) DECODIEREN VON AVC-VIDEODATEN,
DIE VON EINEM BENUTZER IM PRIVATEN
UND NICHT KOMMERZIELLEN RAHMEN
CODIERT WURDEN UND/ODER VON
EINEM VIDEO-ANBIETER STAMMEN, DER
UBER EINE LIZENZ ZUM ANBIETEN VON
AVC-VIDEOS VERFUGT.

FUR JEGLICHE ANDERE VERWENDUNG
WIRD KEINE LIZENZ ERTEILT, DIES
WEDER AUSDRUCKLICH NOCH IMPLIZIT.
WEITERE INFORMATIONEN SIND BEI
MPEG LA, L.L.C., ERHALTLICH. SIEHE
HTTP://WWW MPEGLA.COM

Auf der Grundlage von Lizenzvertrigen
zwischen Sony und den Software-
Rechteinhabern verwendet dieses Produkt freie
Software. Um den Anforderungen der Software-
Rechteinhaber gerecht zu werden ist Sony
verpflichtet, Sie tiber den Inhalt dieser Lizenzen
informieren.

Zugriff auf Software, fiir welche die GPL/LGPL
gilt

Dieses Produkt verwendet Software, fiir welche
die GPL/LGPL gilt. Dies bedeutet, dass Sie
berechtigt sind, auf Quellcode fiir diese
Softwareprogramme unter den Bedingungen von
GPL/LGPL zuzugreifen, ihn zu modifizieren und
zu verbreiten.

Der Quellcode ist im Internet verfiigbar.
Verwenden Sie die folgende URL, und befolgen
Sie die Anweisungen zum Herunterladen.
http://www.sony.net/Products/Linux/common/
search.html

Bitte sehen Sie nach Moglichkeit davon ab, sich
beziiglich des Inhalts des Quellcodes mit uns in
Verbindung zu setzen.

Lizenzen (in englischer Sprache) sind im internen
Speicher Ihres Gerits gespeichert.

Stellen Sie eine Massenspeicherverbindung
zwischen dem Gerit und einem Computer her,
um die Lizenzen im Ordner ,,PMHOME"* -
L,LICENSE® zu lesen.



Index

A

Akku 23

All File 137, 154

All Reset 153

Anschluss AUDIO INPUT1 41
Anschluss AUDIO INPUT2 41

Anschluss GENLOCK IN/VIDEO OUT

100, 171
Anschluss HDMI OUT 100, 170
Anschluss SDI OUT 100, 168
Aperture 122
Assignable Button 150
ATW 39
Audio 36
Audio Input 124
Audio Output 125
Audio-Menii 124
Audiosignale priifen 36
Aufnahmetaste 33
Ausgangssignal 168
Auto Black Balance 116
Auto Exposure 114
Automatische Weilwertanpassung 39
Automatischer Weilabgleich 40

Battery Alarm 152
Belegbare Taste 47
Belegbare Tasten 47
Bildstabilisierung 43
Black 119

Black Gamma 119
Blendenring 37

C

Camera-Menii 113

Clip 34, 93,94, 103, 135
Clip Continuous Rec 131
Clipname 34

Clock Set 152

Color Bars 115
Customize View 133
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D

Datum und Uhrzeit 25

Delete Clip 133

Detail (HD-Modus) 121

Detail (SD-Modus) 122
Display Clip Properties 95, 132
Display On/Off 128

Down Converter 126

E
Einstellmenii 106, 108, 112, 154
Externer Monitor 100

F

Fehleranzeigen 191
File-Menii 137

Filter Clips 133
Flicker Reduce 115
Fokuslupe 36
Fokussierring 35
Format Media 134
Formatieren 28, 30, 31
Full MF-Modus 35

G

Gain 113

Gamma 119

Gegenlichtblende mit Objektivschutz 25
Gesichtserkennung-AF 13, 44

GPS 152

H

Handle Zoom 116
HDMI TC Out 130
Hours Meter 152

Intercom-Anrufe 81

K

Knee 120
Kondensation 161
Kopthérerbuchse 36

L

Ladegerit 23
Language 151



LCD Setting 126 Scene File 138, 154

LCD-Bildschirm 13 Schalter FOCUS 35

LCD/VF-Menii 126 Schalter GAIN 38

Lock/Unlock Clip 133 Schalter INPUT1 41
Schalter INPUT2 41

M Schalter RIS 37

Maintenance 123 Schalter WHT BAL 40

Marker 127 Schulterriemen 11

Matrix 123 SD-Karten 30

MEAD-SDO02 30 Set Clip Flag 132

Media Full 29 Set Index Picture 133

Media Near Full 29 Set Shot Mark 132

Media-Menii 134 Shutter 114

Medienadapter 30 Simul Rec 131

Memory A-Modus 39 Skin Detail 122

Memory-B-Modus 39 SteadyShot 43

Miniaturbildanzeige 92 Sucher 13

Multi Matrix 123 Dioptrienausgleichsregler 26
SxS-Speicherkarten 27

N System-Menii 146

ND Filter 113

ND-Filter 38 T

Network-Menii 138 Taste MENU 108

Netzsteckdose 24 Taste PUSH (Entriegelung der

Netzteil 24 Gegenlichtblende) 25

Nichtlinearer Schnitt 104 Taste SLOT SELECT 28
Taste WB SET 39

o) TC/UB-Menii 130

Objektiv 162 Tele 34

Output Display 125 Thumbnail View 133

Output Format 125 Thumbnail-Menii 132

Output On/Off 125 Timecode 43, 130

P U

Paint-Menii 117 Uhr 25

Peaking 126 Update Media 134

Planning Metadata 136 USB-Kabel 103

Planungsmetadaten 57 User File 137, 154

Proxy-Aufnahmemodus 132 User-Bits 43
User-Menii 112

R Users Bit 130

Rec Format 147 UTC 25

Recording-Menii 130

Regler SEL/SET 108 V'

RTMP/RTMPS-Streaming 82 Version 153
Verstiarkung 38

S Verwenden des Camcorders im Ausland

S&Q Motion 130 159
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VF Setting 126

Video Light Set 116
Videoformat 168
Video-Menii 125
VOLUME-Tasten 36
Voreinstellungsmodus 39

w

Warn- und Funktionsmeldungen 193
Warnanzeigen 191
Web-Fernbedienung 85
WeiBlabgleich 39
Weitwinkelbereich 34

Werkseitig installierter Akku 162
White 117

White Clip 120

White Switch 118

X
XQD-Speicherkarten 30

y4

Zebra 128

Zeitdaten 43

Zeitzone 25

Zoom 34

Zoom am Griff 35
Zoomhebel 34
Zoombhebel am Griff 35
Zoomring 35
Zoomschalter am Griff 35
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